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SOFTWARE LICENSE AGREEMENT

ACI grants you a non-transferable, non-exclusive license to use this
copy of the program and accompanying materials according to the
following terms:

LICENSE:

You may:

a) use the program on only one computer at a time;

b) make one (1) copy of the program in machine readable form solely
for backup purposes, provided that you reproduce all proprietary
notices on the copy;

c) physically transfer the program from one computer to another,
provided that the program is used on only one computer at a time; and
d) transfer the program onto a hard disk only for use as described
above provided that you can immediately prove ownership of the
original diskettes.

You may not:

a) use the program in a network unless you pay for a separate license
for each terminal or workstation from which the program will be
accessed;

b) modify, translate, reverse engineer, decompile, disassemble, cre-
ate derivative works based on, or copy (except for the backup copy) the
program or accompanying materials;

c) rent, transfer or grant any rights in the program in any form or
accompanying materials to any person without the prior written consent
of ACI which, if given, is subject to the conferee’s consent to the terms
and conditions of this license; or

d) remove any proprietary notices, labels or marks on the program and
accompanying materials.

This license is not a sale. Title and copyrights to the program, accom-
panying materials and any copy made by you remain with ACI.
TERMINATION

Unauthorized copying of the program (alone or merged with other
software) or the accompanying materials, or failure to comply with the
above restrictions will result in automatic termination of this license and
will make available to ACI other legal remedies. Upon termination you
will destroy or return to ACI the program, accompanying materials and
any copies.

LIMITED WARRANTY AND DISCLAIMER

THE PROGRAM AND ACCOMPANYING MATERIALS ARE PRO-
VIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE.

ACI does not warrant that the functions contained in the program will
meet your requirements or that the operation will be uninterrupted or
error free. The entire risk as to the use, quality, and performance of the
program is with you. Should the program prove defective, you, and not
ACI, assume the entire cost of any necessary repair.

However, ACl warrants the diskettes on which the program is furnished
to be free from defects in materials and workmanship under normal use
for a period of ninety (90) days from the date of delivery to you as
evidenced by a copy of your receipt. The duration of any implied
warranties on the diskettes is limited to the period stated above. ACI's
entire liability and your exclusive remedy as to the diskettes (which is
subject to you returning the diskettes to ACI or an authorized dealer
with a copy of your receipt) will be the replacement of the diskettes or,
if ACI or the dealer is unable to deliver a replacement diskette, the
refund of the purchase price and termination of this Agreement.

SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN
IMPLIED WARRANTY LASTS SO THE ABOVE LIMITATION MAY
NOT APPLY TO YOU. THIS WARRANTY GIVES YOU SPECIFIC
LEGAL RIGHTS. YOU MAY ALSO HAVE OTHER RIGHTS WHICH
VARY FROM STATE TO STATE.

LIMITATION OF LIABILITY

IN NO EVENT WILL ACI BE LIABLE FOR ANY DAMAGES, INCLUD-
ING LOSS OF DATA, LOST PROFITS, COST OF COVER OR OTHER
SPECIAL, INCIDENTAL, CONSEQUENTIAL OR INDIRECT DAM-
AGES ARISING FROM THE USE OF THE PROGRAM OR ACCOM-
PANYING MATERIALS, HOWEVER CAUSED AND ON ANY THE-
ORY OF LIABILITY. THIS LIMITATION WILL APPLY EVEN IF ACI OR
AUTHORIZED DEALER HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE. YOU ACKNOWLEDGE THAT THE LICENSE
FEE REFLECTS THIS ALLOCATION OF RISK. SOME STATES DO
NOT ALLOW LIMITATION OR EXCLUSION OF LIABILITY FOR
INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE
LIMITATION MAY NOT APPLY TO YOU.

GENERAL

This Agreement will be governed by the laws of France. In any dispute
arising out of this Agreement, AC| and you each consent to the
jurisdiction of the courts of France.

Use, duplication or disclosure by the U.S. Government is subject to
restrictions stated in paragraph (c) (1) (ii) of the Rights in Technical Data
and Computer Software clause at 252.227-7013.

Licensor: ACl, 5 Rue Beaujon, 75008 Paris, France

This Agreement is the entire agreement between us and supersedes
any other communications with respect to the program and accompa-
nying materials.

If any provision of this Agreement is held to be unenforceable, the
remainder of this agreement shall continue in full force and effect.

If you have any questions, please contact: ACl Customer
Service, (33) 1 42 27 37 25 or write us at the above address.
SIGN AND MAIL THE REGISTRATION CARD TODAY.
Return of the registration card is required to receive any
product updates and notices of new versions or enhance-
ments.

All trade names referenced are the trademark or registered trademark
of their respective holder.

4th DIMENSION, 4D Runtime, 4D, and the abstract 4 logo are trade-
marks of ACIUS, Inc. and ACI.



DESIGN .

CONTENTS

PREFACE xxi

About The Manuals  xxiv

About This Manual xxiv
Chapter Descriptions  Xxv
Aids to Understanding  xxvi

Chapter 1 4th DIMENSION BASICS 1

Starting 4th DIMENSION 3
Creating a New Database 3
Opening an Existing Database 5
4th DIMENSION Desktop Files 5
Duplicating a 4th DIMENSION Database 7
Making Backups 8
The Environments 8
The Design Environment 8
The User Environment 10
The Runtime Environment 10
Changing Environments 11
Design Environment Editors 12
The Structure Editor 12
The Layout Editor 13
The Procedure Editors 14
The Menu Editor 16
The Password Access Editor 16
The List Editor 17
The 4th DIMENSION Interface 18
4th DIMENSION Menus 18
4th DIMENSION Editor Windows 19
Reduced View and Scrolling 21
Expanding and Collapsing Hierarchical Lists 22
Displaying a Different File 23
The File and Edit Menus 24
Using the File Menu 24
Using the Edit Menu 25
Setting Preferences 26

CONTENTS v



vi

Chapter2 DESIGNING A DATABASE STRUCTURE 29

Databases and Database Structures 31
Database Basics 31
Files 32
Single-File Structures 32
Multiple-File Structures 33
Subfiles 34
Basic Steps for Creating a Database Structure 35
Using the Structure Editor 36
Manipulating File Images 37
Selecting a File Image 37
Moving a File Image 37
Resizing a File Image 38
Creating a New File 38
Renaming a File 39
Creating and Modifying Fields 40
Creating New Fields 41
Field Types 43
Alpha 43
Text 44
Real 44
Integer 44
Long Integer 45
Date 45
Time 45
Boolean 45
Picture 45
Subfile 46
Field Attributes 46
Mandatory 46
Display only 47
Can’t modify 47
Indexed 47
Unique 48
Choices 48
Modifying Fields 48
Related Files 49
Related Fields 50
The One File and the Many File 51
The Relating Field and the Related Field 53
Automatic and Manual Relations 53
Entering Data in Related Files 54
Using Wildcard Look-ups 54
Creating a New Record in the One File 57
Searching and Sorting Records 58
Maintaining Relational Integrity 59



Chapter 3

DESIGN

Creating a Relation Between Files 60
Removing Relations 63

CREATING AND MODIFYING LAYOUTS 65

Layouts, Files, and Fields 68
Active Objects and Graphic Objects 69
Creating a New Layout 71
Selecting Fields for the Layout 73
Selecting Fields From the Master File 74
Selecting Fields from a Related One File 75
Using Included Layouts for Files and Subfiles 77
Using Layout Templates 80
Template Choices 80
Establishing Input and Output Layouts 82
Deleting Layouts 83
Changing a Layout Name 84
Using the Layout Editor 84
Layout Editor Overview 85
The Layout Palette 86
The Layout Menu 87
The Object Menu 88
The Font Menu 89
The Style Menu 90
Opening a Layout in the Layout Editor 90
Viewing and Printing Layout Pages 91
Handling Layout Objects 92
Selecting Objects 92
Selecting Multiple Objects 93
Moving Objects 94
Resizing Objects 95
Using the Rulers 96
Drawing Objects 98
Grouping Objects 100
Aligning Objects 101
Using the Alignment Tools 101
Using the Invisible Grid 103
Duplicating Objects 104
Copying All the Objects on a Layout 105
Layering Objects 106
Deleting Objects 107

CONTENTS

Vii



Changing the Appearance of Objects 108
Fonts, Styles, Sizes, and Justification 109
Line Widths 110
Fill Patterns 110
Border Patterns 111
Creating a Border 111
Colors 135
Text Areas 113
Creating a Multi-Page Layout 114
Adding a Layout Page 114
Moving from Page to Page 115
Deleting a Layout Page 116
Adding Fields to a Layout 116
Data Entry Order 118
Viewing and Changing the Data Entry Order 119
Setting the First Object in the Data Entry Order 120
Using a Data Entry Group 121
Restoring the Standard Data Entry Order 122

Chapter 4 DESIGNING THE INTERFACE 123

Interface Design Options 125
Standard Interface 126
Custom Interface 127
Interfaces Using Scripts and Procedures 128
Active Objects 129
Fields in a Layout 130
Field Definition Dialog Box 130
Placing Fields in a Layout 132
Modifying a Field in a Layout 133
Field Display Formats 134
Date Field Formats 134
Time Field Formats 135
Number Field Formats 136
Placeholders 137
Decimal Point 137
Other Characters 138
Formats for Positive, Negative, and Zero 138
Scientific Notation 139
Number Styles 139
Examples 139
Alpha Field Formats 141
Alpha Styles 142

viii



DESIGN .

Boolean Field Formats 142
Formatting a Boolean Field as Radio Buttons 143
Formatting a Boolean Field as a Check Box 143
Picture Field Formats 144
Truncated 145
Scaled to Fit 145
On Background 146
Data Entry Controls 146
Setting the Enterable and Mandatory Attributes 147
The Enterable Attribute 147
The Mandatory Attribute 147
Assigning Lists 148
Choice Lists 148 -
Required Lists 149
Excluded Lists 149
Assigning a List 149
Using Entry Filters 149
Entry Filter Codes 150
Initiating a Filter 150
Arguments 151
Placeholders 152
Display Characters 153
Dead Characters 154
Examples 154
Entry Filter Styles 155
Setting Maximum and Minimum Values 155
Default Values 156
Adding a Scroll Bar to a Text Field 157
Creating Styles 157
Using Styles 158
Printing With Variable Frame 159
Using Scripts 161
Active Objects in a Layout 163
Object Definition Dialog Box 163
Creating an Active Object 166
Modifying an Object 166
Display Formats for Objects 167
Data Entry Controls for Enterable Objects 167
Scripts for an Object 167
Assigning a Keyboard Shortcut 168
Types of Active Objects 169
Enterable and Non-enterable Objects 169

CONTENTS  ix



Chapter 5

Automatic Buttons 170
Noaction Button 172
Accept and Cancel Buttons 172
Delete Record Button 172
Record Buttons 172
Page Buttons 172
Included Record Buttons 173
Check Boxes 173
Radio Buttons and Radio Pictures 174
Pop-up Menus and Scrollable Areas 175
Graph Areas 176
External Areas 176
Thermometers, Rulers, and Dials 176
Objects on Grid 178
Using Included Layouts 180
Entering Data in an Included Layout 181
Displaying Data in an Included Layout 182
Printing Data in an Included Layout 183
Creating an Included Layout 185
Modifying an Included Layout 187
Using Layout Menus 187

CREATING LAYOUTS FOR OUTPUT DISPLAY AND
REPORTS 191

Output Layouts 193

Output Control Lines 195

Moving Output Control Lines 196
Using Layouts for Screen Display 197
Report Designs 198

Columnar Reports 199

Summary Information in Reports 200

Additional Break Levels 201

Summary Reports 202

Creating Additional Control Lines 203
An Example Report 204

The Report Layout 206

The Report Scripts 207
Basic Steps for Creating a Report 208
Printing Included Layouts, Pictures, and Text Fields 210
Printing Labels 211
Using Embedded Fields and Variables 213



DESIGN

Chapter 6 CREATING PROCEDURES 215

4th DIMENSION Procedures 217
Scripts 217
Layout Procedures 218
File Procedures 218
Global Procedures 218
The Procedure Editors 219
Creating a New Procedure 220
Creating a Global Procedure 220
Creating a File or Layout Procedure 221
Creating a Script 221
Opening an Existing Procedure 222
Using the Listing Editor 223
Writing a Procedure 225
Typing Text 225
Selecting Procedure Elements 226
Using the Wildcard Character 226
Checking and Correcting Syntax Errors 226
Finding and Replacing Text 227
Managing the Listing Editor Window 228
The Flowchart Editor 228
The Flowchart Menu 230
Creating a Flowchart Procedure 230
Creating Steps and Tests 231
Creating a Formula 231
Drawing Flow lines 232
Specifying a First Step 233
Editing a Flowchart Procedure 233
Formula Syntax Errors 235

Chapter 7 CREATING CUSTOM MENUS 237

Designing Menus 239
Creating Menus 240
Basic Steps for Creating Menus 240
Creating a Menu Bar 241
Adding Menus 242
Adding Menu Items 244
Assigning Procedures to Menu Items 245
Enhancing Menus 245
Changing Font Styles 246
Enabling and Disabling Menu Items 246
Adding Separator Lines 247
Assigning Keyboard Equivalents 247

CONTENTS  xi



Editing Menus and Menu Items 248
Copying and Moving Menus 248
Deleting Menus 249
Deleting Menu Items 250
Previewing Custom Menus and Adding a Splash
Screen 250
Menus and Runtime Applications 251

Chapter 8 MANAGING PASSWORD ACCESS 253

Access System Overview 256
An Access Hierarchy Scheme 257
Users’ Access to Environments 259
Group Owners 260
Guests 260
Using Startup Procedures 260
Initiating the System 260
Assigning Users and Groups 261
Adding Users and Passwords 261
Creating Access Groups 263
Assigning Users to Groups 264
Removing Users from Groups 264
Nesting Groups 265
Removing Nested Groups 265
Saving and Loading Groups 266
Assigning a Group to Menus, Procedures, Layouts,
and Files 266
Assigning a Group to a Menu Item 266
Assigning a Group to a Procedure 267
Assigning a Group to a Layout 268
Assigning a Group to File Operations 269
System Maintenance 270
Administrator and Group Owner Procedure 270
Viewing Usage 271

Chapter 9 CREATING LISTS 273

Designing Lists 276
Linked Lists 277
Required and Excluded Values 278
Non-sequential Ranges of Values 279
Creating Lists 280
Adding Items to Lists 281
Deleting Items and Lists 282
Copying Lists 282

Xii



DESIGN -
Linking Lists 282

Specifying Ranges in a List 284
Sorting a List 284
Making a List Modifiable 285

Chapter 10 4th DIMENSION SPECIAL TOPICS 287

Setting Single-User or Multi-User 289
Updating Structure and Data Files 290

How 4th DIMENSION Uses Memory 291

4th DIMENSION Under MultiFinder 292
Optimizing 4th DIMENSION Performance 292
Repairing Damage 293

INDEX 295

CONTENTS  Xiii



Xiv

Figures

Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure

Welcome screen 3

Macintosh files and a 4th DIMENSION file image 4
Structure and data files 5

The “Open data file” dialog box 6

Cloning a database 7

The Design environment 9

The User environment 10

An application in the Runtime environment 11
Structure editor 12

Layout editor 13

Procedure editor (listing) 15

Procedure editor (flowchart) 15

Menu editor 16

Passwords Access editor 17

Lists editor 18

Menus added to the menu bar 19

Design menu listing open windows 19

Open windows 20

Scrolling to move hidden material into view 21
Reduced View of a database structure 22
Collapsed and expanded filenames 22

Cycling to display another file 23

The File menu that appears when the Layout editor is active

The Edit menu 25

Preferences dialog box 26

Files and fields 32

A single file keeps track of people 32
Multiple files keep track of people and their companies
Unrelated files 34

A subfile 35

Structure editor 36

Selected file 37

Dragging a file image 37

Resizing a file image 38

The File Attributes dialog box 40
Creating a new field 42

Field dialog box 42

Related files structure 50

Data in related fields 50

Company name specifies one company 51
Company name specifies many people 52
Another file added to the structure 52
Completing an entry with a wildcard 55
List displayed to select the entry 55

33

24



Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure

2-20
2-21
2-22
2-23
2-24
2-25
2-26
2-27

1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1

0 LI LI LY W L) LW WERIER N DN DN DN DN DN D = = e e e et = = = O 001NN BN =

OO NPHEANONN—L OO NPRE WD, OOVOIAANRS WD —O

DESIGN -

Complete list of all the companies 56

Choosing the additional field 57

Entering a new value in the relating field 57
Selections based on values in the related file 58
Files related in a series 59

Drawing the line to create a relation 61

The Relation dialog box 62

Files related 63

A basic layout 67

A customized layout 67

Input and output layouts 68

Several layouts for one file 69

Active objects and graphic objects on a layout 70
Layout dialog box 71

New Layout dialog box 72

Files displayed in the New Layout dialog box 74
Selecting fields from the master file 75
Selecting fields from a related file 76

Layout that displays fields from a related file 76
Included layout area 77

Expanding a file before selecting fields 78
Selecting fields from a related Many file 79
Layout with included layout area for related records 79
Nine layout templates 80

Template 1 as an output layout 81

Template 2 as an output layout 81

Template 3 as an output layout 81

Template 4 as an input layout 81

Template 5 as an input layout 81

Template 6 as an input layout 81

Template 7 as an input layout 81

Template 8 as an input layout 81

Automatic Buttons on Template 7 81

Input and output designations 82

Layout editor window 85

Layout palette 86

Layout menu 87

Object menu 88

The Layout dialog box 90

Page border lines show area that can be printed 92
Selecting objects with a selection rectangle 93
Moving an object 94

Resizing an object 95

The “object coordinates” dialog box 96

Object markers in the rulers 97

“Define units” dialog box 97

CONTENTS

XV



Figure 3-39  Object icons on the layout palette 98

Figure 3-40 Drawing objects 99

Figure 3-41 Several objects grouped 100

Figure 3-42  Alignment tools on the layout palette 101

Figure 3-43  Aligned and unaligned objects 102

Figure 3-44  An invisible grid to align objects 103

Figure 3-45 “Define grid” dialog box 103

Figure 3-46 Relative placement of duplicated objects 105
Figure 3-47 Layered objects 107

Figure 3-48 Justification 110

Figure 3-49  Fill patterns 110

Figure 3-50 Border patterns 111

Figure 3-51 Color submenu 112

Figure 3-52 Text objects 113

Figure 3-53 Textarea 113

Figure 3-54 Layout with multiple pages 115

Figure 3-55 New Layout dialog box after Add to Layout 117
Figure 3-56 Added fields using a different template 118
Figure 3-57 Standard data entry order 119

Figure 3-58 Custom data entry order 119

Figure 3-59 Changing the data entry order 120

Figure 3-60 Creating a data entry group with a selection rectangle 121
Figure 3-61 Standard entry order within the enclosed objects 122
Figure 4-1 Layout for data entry in the User environment 126
Figure 4-2 Customized layout for data entry in the User environment 127
Figure 4-3  Complex data entry layout 128

Figure 4-4  Active objects on a layout 129

Figure 4-5  Field Definition dialog box 130

Figure 4-6  Selecting a field from the field list 132

Figure 4-7  Choosing a date display format 134

Figure 4-8  Choosing a time display format 135

Figure 4-9 Choosing a number display format 136

Figure 4-10 Typing an alpha display format 141

Figure 4-11 Boolean display formats 142

Figure 4-12  Standard Boolean field display 142

Figure 4-13  Entering button labels for a Boolean field 143
Figure 4-14  Entering check box label for a Boolean field 144
Figure 4-15 Choosing a picture display format 144

Figure 4-16 Truncated Picture field 145

Figure 4-17 Scaled to Fit Picture field 145

Figure 4-18 On Background picture field 146

Figure 4-19 Layout attributes 147

Figure 4-20 Lists for fields and enterable objects 148

Figure 4-21 Creating an entry filter 150

Figure 4-22 Placeholder as an underline 153

Figure 4-23 Placeholder as an X 153

Xvi



DESIGN -

Figure 4-24 Entering values for Minimum or Maximum 155
Figure 4-25 Entering a Default value 156

Figure 4-26 Text fields with scroll bars 157

Figure 4-27 The Styles dialog box 158

Figure 4-28 Styles used for the format and filter 159

Figure 4-29 The “Print with Variable Frame” check box 159
Figure 4-30 Layout and result of variable frame printing 160
Figure 4-31 Elements placed next to variable frame field 160
Figure 4-32  Script window 162

Figure 4-33  Object Definition dialog box 163

Figure 4-34 Object types in the Type pop-up menu 164

Figure 4-35 Choosing a display format for an enterable object 167
Figure 4-36 Key dialog box 168 :

Figure 4-37 Creating an non-enterable object 170

Figure 4-38 Button, invisible button, and highlight button 171
Figure 4-39 Creating a button 171

Figure 4-40 Button Actions 171

Figure 4-41 Creating a check box 173

Figure 4-42 Radio buttons and radio pictures 174

Figure 4-43  Creating a radio button 175

Figure 4-44 Pop-up menu and a scrollable area 175

Figure 4-45 Entering a procedure name 176

Figure 4-46 A thermometer, a ruler, and a dial 177

Figure 4-47 Scale and indicator settings 177

Figure 4-48 Objectsona grid 178

Figure 4-49 “Grid object” dialog box 178

Figure 4-50 An active object in first cell of a grid 179

Figure 4-51 Active objects on the grid 180

Figure 4-52 Included layouts 180

Figure 4-53 Included layout and input layout 181

Figure 4-54  Setting data entry options for included layouts 182
Figure 4-55 Multi-line layout displays several records 183
Figure 4-56a Variable frame print option for included layout 184
Figure 4-56b Fixed frame (truncation) print option for included layout 184
Figure 4-56c¢ Fixed frame (multiple records)print option for included layout 184
Figure 4-57 Included Layout dialog box 185

Figure 4-58 Expanded list of layouts 186

Figure 4-59  Associating a menu bar with a layout 188

Figure 4-60 Layout menu displayed on the right 189

Figure 5-1 An output layout in the User environment 194

Figure 5-2 A printed report 194

Figure 5-3  Control lines define areas 195

Figure 5-4  Control markers and labels 196

Figure 5-5  Output layout screen display in User environment 198

Figure 5-6  Output layout screen display in Runtime environment 198
5-7

Figure A columnar report 199

CONTENTS  xvii



XViii

Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure
Figure

o0
W
(o

e le le IR EENEEN BEN B N IR I o) e le) e le) e ) He) e le) le) e )l e Ne) WV, IV, IR, IR0, IV, IV, IV, IS, I, 0, IV, IRV, IV, I

o0 OO0 00 OO0 OO OO

1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1 | 1 1 1 1 1 1 1 1 1 1 1 1 1
W =00~ WA LWLWN === =000~ W B QDN = D DD F e e et et e e = \O 00

O 00N B~

T OV NNDE WD ~O

W —=O

)

Columnar report with subtotals and total 200

Changed report using the same records 201
Subtotals at two Break levels 202
Summary report 202

Additional control lines for additional areas
A typical report 205

Control lines and control areas 206
Included layout area in report layout 210
Report that prints included records 210
Variable printing repeats a slice of the layout
The label width marker 212

Designing a label layout 212

Form letter with fields and variable 213
Choosing from pop-up menus to embed fields
The Procedure editor (listing) 219

The Procedure editor (flowchart) 219
Procedure dialog box 220

The Listing editor 223

203

211

214

Routines displayed in groups and in alphabetical list

A sample procedure 225

Syntax errors marked with bullets 226
Search menu 227

Dragging the Hide Keywords divider 228
The Flowchart editor 229

Flowchart menu 230

The Flowchart formula editor 231
Drawing a flow line 232

Resizing an object 234

Menu bar, menus, and menu items 239
Menu bars dialog box 241

Menu editor 242

Adding a new menu 243

Using the Menu editor to enhance menu items
Menu with separator line 247

Custom menu bar 250

Custom splash screen 251

Assigning access privileges 256

Opening a database with a password 256

246

Access error for menu items and layouts 257

Access error for procedures and files 257
An access hierarchy 257

The Password Access editor 261

Edit User dialog box 262

The Edit Group dialog box 263

Assigning a user name to a group 264
Dragging a group name 265

224



DESIGN .

Figure 8-10 Assigning a group to a menu item 267

Figure 8-11  Assigning a group to a procedure 268

Figure 8-12  Assigning a group to a layout 268

Figure 8-13 File Attributes dialog box 269

Figure 8-14 Sample user profile 271

Figure 9-1 A choice list for data entry 276

Figure 9-2  Divided lists 277

Figure 9-3 Nested lists 278

Figure 9-4  Interlocking lists 278

Figure 9-5 Using a list for non-sequential ranges 279
Figure 9-6  The List editor 280

Figure 9-7  Entering an Item in a list - 281

Figure 9-8 Adding a list as an item 283

Figure 9-9 Adding another list as an item 284

Figure 9-10 Special User environment List editor 285
Figure 9-11  Check mark shows list is user modifiable 286
Figure 10-1 Special dialog box for single-user or multi-user setting 289
Table 3-1 Keystroke equivalents for automatic buttons 82
Table 3-2 Layout dimensions 91

Table 4-1 Date display formats 135

Table 4-2 Time display formats 136

Table 4-3 Number format placeholders 137

Table 4-4 Number field examples 140

Table 4-5 Entry filter equivalents 135
Table 4-6 Data entry filter examples 154
Table 4-7 Calculated default values 156
Table 5 Control line labels 206

Table 7- Reserved keystrokes 248

CONTENTS  xix



XX



DESIGN .







DESIGN -

4th DIMENSION is a powerful relational database application and
development tool for Apple’s family of Macintosh computers.

You can use 4th DIMENSION to manage your own data or develop
custom applications for different kinds of database management tasks.

For example you can

m Create a database structure of files and fields.

m  Design layouts for entering, modifying, and displaying records.
m  Search and sort records.
m  Create reports and labels from information in the databases.

m Import and export data between 4th DIMENSION databases and
other applications.

With 4th DIMENSION, you can enhance conventional data management
tasks with these features:

m  The powerful Layout editor that works like a full-featured drawing
program to let you add object-oriented graphics and fonts to your
layouts.

m  The capacity to store graphics in database files.
m A password access system to protect sensitive data.

s Graphing functions that let you generate a variety of business
graphs from your data.

m  The capability to create custom applications from 4th DIMENSION
with your own custom menus, dialog boxes, and buttons.

m A full-featured programming language that lets you incorporate
procedures written in other languages.

4th DIMENSION’s flexibility and power makes it ideal for a complete
range of information management tasks. Novice users can quickly create
databases and begin managing their data. Experienced users without
programming experience can customize their databases with

4th DIMENSION’s development tools. More experienced developers can
use 4th DIMENSION’s powerful programming language to add
sophisticated features and capabilities to their databases, including file
transfer and communications.

When you design a custom database with 4th DIMENSION, all the
components of the Macintosh’s user interface are at your disposal. You
can add menus, dialog boxes, buttons, and windows to enhance your
databases and make users more productive.
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About the Manuals

The 4th DIMENSION Design Reference is a reference guide to

4th DIMENSION’s Design environment and provides detailed
descriptions of 4th DIMENSION operations that you can perform in
this environment. You should use it in conjunction with the other
volumes in your documentation package.

The 4th DIMENSION Quick Start and 4th DIMENSION Tutorials lead you
through example lessons where you create and use a 4th DIMENSION
database. These examples provide hands-on experience and help you
become familiar with the concepts and features of 4th DIMENSION.

The 4th DIMENSION User Reference provides a description of the
environment where you will use the databases and layouts to enter
and manipulate data.

The 4th DIMENSION Language Reference is a guide to using the
4th DIMENSION language. Use this manual to learn how to use the
language to customize a database.

The 4th DIMENSION Utilities Guide provides a guide to the utilities
available with 4th DIMENSION, such as 4D Tools, 4D Customizer,
and 4D External Mover.

The 4th DIMENSION Glossary and Master Index provides a glossary
that defines terms and an index to all 4th DIMENSION documents.

About This Manual

This manual describes 4th DIMENSION Design environment. The
Design environment is where you create a database, before you enter
data into records. This manual assumes that you are familiar with basic
Macintosh operations, such as clicking, double-clicking, and choosing
a menu command. To use the Design Reference effectively, you should

m  Use the Quick Start and Tutorials volumes to work through the
database examples as needed.

m Begin creating your own databases, referring to the Design
Reference and User Reference when you need to review a procedure
or explanation.

m Refer to the other manuals as needed.
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Chapter Descriptions

This manual is divided into ten chapters:

m  Chapter 1, “4th DIMENSION Basics,” introduces you to basic
4th DIMENSION operations, such as starting, manipulating desktop
files, and using the File and Edit menus. It also describes all of the
environments, and it contains an overview of all the editors in the
Design environment.

s Chapter 2, “Designing a Database Structure” introduces the
Structure editor and explains how to create files, fields, and related
files.

m Chapter 3, “Creating and Modifying Layouts,” introduces the
Layout editor and explains how to create layouts. It covers how to
create any kind of graphic object and how to change the appearance
of any object.

m  Chapter 4, “Designing the Interface,” explains how to use
4th DIMENSION’s powerful layout design features to create a
custom interface for a database that includes various field display
formats, active objects such as buttons and pop-up menus, scripts,
and layouts that display information from other files.

m  Chapter 5, “Creating Report Layouts,” explains how to create a
layout for printing a report. It includes how to create subtotals and
other summary calculations using scripts.

m  Chapter 6, “Creating Procedures,” introduces the two 4th
DIMENSION Procedure editors. It explains how to use both the
Listing Procedure editor and the Flowchart Procedure editor to
create procedures and scripts.

m  Chapter 7, “Creating Custom Menus,” explains how to use the
Menu editor to create custom menus.

m  Chapter 8, “Managing Password Access,” explains how to use the
Password Access editor to create a system to control access to files,
layouts, procedures, and menu items.

m  Chapter 9, “Creating Lists,” explains how to create lists with the
Lists editor, and how to use lists during data entry.

m  Chapter 10, “4th DIMENSION Special Topics,” provides
information about specialized topics, such as how to set
4th DIMENSION for multi-user operation, how to update structure
and data files, and so on.

PREFACE xxv
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Aids to Understanding

This manual, and the other manuals in your documentation package,
uses visual aids to help you understand the material.

Here are some examples of the visual aids in the manual:

ﬁ Note: Text emphasized like this provides annotations and shortcuts that
will help you become more productive with 4th DIMENSION.

Important: Notes like this alert you to important pieces of information.

", warning: Warnings like this alert you to situations where data
might be lost.
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4th DIMENSION BASICS

This chapter provides basic information about 4th DIMENSION
and the Design environment. The chapter includes

m instructions for starting 4th DIMENSION

instructions for handling 4th DIMENSION desktop files
instructions for backing up 4th DIMENSION files
instructions for duplicating 4th DIMENSION databases

a description of the three 4th DIMENSION environments

an overview of the Design environment editors you use to
create a database '

m instructions for performing standard 4th DIMENSION operations
with menus, windows, and lists

m instructions for setting preferences for 4th DIMENSION

Starting 4th DIMENSION

When you start 4th DIMENSION you can either create a new database
Or open an existing one.

Creating a New Database

If you want to start 4th DIMENSION and create a new database,
follow these steps:

2.0 1. Double-click the 4th DIMENSION application icon. Or select the
4th DIMENSION application icon and choose Open from the File menu.

4th DIMENSION displays the welcome screen, as shown in Figure 1-1.

Mark Uernon
ACIUS

3 Tutorial DB’s

2 Personnel 03f = Lightweight
3 Personnel 04f
4th DIMENSION (3 Personnel 05
database folder £1 Personnel 06§
C Personnel 07§
3 Personnel 08f
[ Personnel 09f
[0 Personnel 10f
[ Personnel MPLf

Figure 1-1
Welcome screen
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4th DIMENSION
Database folder

Macintosh files
for the database

4th DIMENSION
File

If no 4th DIMENSION databases exist in the same folder as the application,
no filenames appear in the list of files, and the Open button is disabled.

Click New.

4th DIMENSION displays a create-file dialog box so that you can enter the
filename for the new database.

Type a database name and click Save.
You can use any valid Macintosh filename of up to 25 characters.

Although you can’t see the operation, 4th DIMENSION creates a folder for
the new database and also creates the Macintosh files it needs to maintain
the database, as shown in Figure 1-2. The name of the folder is your
database name with an “f” at the end. 4th DIMENSION saves the
Macintosh files in this folder.

4th DIMENSION displays the Structure window for the new database. The
Structure window displays the image of the first database file, as shown in
Figure 1-2. You can now begin adding fields and creating additional files
to create the database structure.

See Chapter 2 for detailed information about creating a database structure.

Lightweight

2 items 20,209K in disk 20,134K available

Systemn Folder
It Contactsf
2 iterns 20,209 in disk  20,134K availay
Work Stuff
Contabts data
———n - — 184
| [E=== structure for Contacts =0} ES

Figure 1-2
Macintosh files and a 4th DIMENSION file image
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Opening an Existing Database

If you are starting 4th DIMENSION and want to open an existing
database, follow these steps:

1. Double-click the 4th DIMENSION application icon. Or select the
4th DIMENSION application icon and choose Open from the File menu.

4th DIMENSION displays the welcome screen. The screen contains a file
list from which you can choose the filename of the database you want.

If the database you want to open is not in the same folder as the
application, change folders (or disk drives) until the desired folder appears
in the window.

2. Select the database you want and click Open.

If a password is required, you are prompted to enter your password. The
database opens in the environment you previously specified in the
Preferences dialog box.

ﬁ Note: You can open any 4th DIMENSION database by double-clicking either
of its icons in the Finder.

4th DIMENSION Desktop Files

4th DIMENSION creates two files for each database: a structure file and a
data file. They are initially placed together in a new folder when the
database is created. You may want to put these files in different locations.

The structure file contains all the specifications for the database structure
(files, fields, field attributes), layouts, procedures, menus, password access
groups, and lists. The data file contains the data that has been entered into
records. When first created, of course, both files are empty.

Each file has a name that identifies whether it is a structure file or a data
file. The structure file has the same name as the database. The data file’s
name is the database name followed by “.data”. Figure 1-3 shows both

) files from a database.
Data file

Structure file

.0 I
—
Folder has l

database name - T _
with italic f Contactsf  Contacts  Contacts data

Figure 1-3
Structure and data files

If you open a 4th DIMENSION structure file, the application opens the data
file that has the same name as the structure file followed by “.data”. If the
application cannot find the data file, the “Open data file”” dialog box
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appears so that you can select the data file you want to use or create a new
data file. Figure 1-4 shows the “Open data file” dialog box.

Open data file... Z

&3 Peoplef
0O People.data — Lightweight

Figure 1-4

The “Open data file” dialog box

You can use any 4th DIMENSION data file with any structure file. The
data file does not have to have the same name as the structure file. The
data in the data file must be compatible with the structure you want to use.
That is, the data must fit into the fields, the number of fields in the
structure must be at least as large as the number in the data file, and the
data must agree with the field types.

If you create a new data file, 4th DIMENSION opens the database using the
original structure but with no records.

When you use a different data file or a new data file with a structure file,
4th DIMENSION records the path to that data file. The path specifies the
location of a file. For example, a file may be located on the Mydisk hard
disk, in a folder named Databases which contains the folder Contactsf and
the Contacts and Contacts.data files. The path to the Contacts.data file is
Mydisk:Databases:Contactsf:Contacts.data. Once you have used the “Open
data file” dialog box to locate a data file for a particular database, 4th
DIMENSION subsequently opens the same data file automatically, as long
as it remains in the same path.

If you move the data file again, you will need to locate it again.

Note: If you hold down the Option key while opening any database,
4th DIMENSION displays the “Open data file” dialog box so that you
can choose a different data file or create a new one.




Data file
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Duplicating a 4th DIMENSION Database

You can create a clone (an exact copy) of any 4th DIMENSION database
structure simply by duplicating the 4th DIMENSION structure file for that
database. You can also create a copy of the information in the database by
duplicating the data file. Figure 1-5 shows duplicated structure and data
files.

Structure file

New folder for
clone of database

Copy created by
Duplicate
command

Lightwej 1

5 items 20,231KEL/=— Contactsf ==L

2 iterns 20 ,231K in disk 20,112K avy

= &
System Folder L
= e |

Contacts Contacts data, —

&2l [ofE

by

“Work Stuff

New Contacts
e Contate Copy of Contacts

Figure 1-5
Cloning a database

There are two ways to duplicate files. Here is the first method:
In the Finder, select the structure file you want to duplicate.
Choose Duplicate from the File menu.

The Macintosh creates a new file with “Copy of...” inserted before the
filename. This file contains a copy of the original database structure.

If you want a duplicate of the information as well, duplicate the data file
also.

Here is the second method:
Create a new folder to hold the duplicate database.

Hold down the Option key while you drag the structure file’s icon into the
new folder.

The Macintosh puts a copy of the file into the new folder, leaving the
original in its own folder.

If you want a duplicate of the information as well, duplicate the data file
also.

ﬁ Note: If you duplicate the structure, move it to another folder, and double-click
it, it still opens the original data file. However, if you duplicate both files and
place them in the same folder, double-clicking the duplicate structure file
opens the duplicate data file.
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Making Back Ups

As you work on databases it is a good idea to develop a consistent method
of backing up your work. Unexpected interruptions, such as a power
failure or computer failure, can damage a database. Although

4th DIMENSION and 4D Tools can usually recover your database after
such damage, having a backup is wise insurance.

After you have been working in the Design environment, you should make
a copy of the structure file (the file without a suffix). After you have been
entering or modifying data, you should make a copy of the data file (the
file with the .data suffix). You can use either of the methods described in
the previous section to copy the files.

Once a database is in use, the data file changes as new records are added
and old records are modified. If a database is used infrequently, with
perhaps only a few changes each day, backing up the data file once a week
or even less often is probably sufficient. If a database is heavily used, a
more structured backup system is needed. For example, the following
system may be used:

Make a backup at the end of each day. Use five separate disks, tapes or
other media, one for each day.

At the end of the week, store the last backup permanently in a safe place.

Reuse the first four backups from the previous week for the next week’s
backups.

A backup system like the one above ensures that you always have at least
five backup copies available.

The Environments

You work with 4th DIMENSION in a series of environments. Each
environment is a system of editors, windows, and pull-down menus that
allow you to perform database operations. There are three environments:

m  Design
m  User

m Runtime
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The Design Environment

The Design environment is where you create a database. This environment
provides editors that you use to build and modify a database. Use the
Design environment to

create database files in which to store data

m create layouts for entering, displaying, and printing data

m  write procedures for performing calculations, manipulating data,
and executing menu commands

m create custom menus for executing procedures or controlling
a runtime application (a stand-alone application based on
4th DIMENSION)

m set up a system of passwords to control access to databases, files,
layouts, menus, and procedures

m create lists of choices that simplify and control data entry

Figure 1-6 shows the Design environment being used to create a database.
Complete information about each of the Design environment features is
found in this book.

& File Edit Use Design Lists Items
Structure for Contacts
Procedure: Procedurel
Passwords
Users... Groups...
P Designer K| o
P Administrator
SIE==————=— lists =—"——"——=V1)7
Lists... Items...
) &
o] ]
[T
7] I

Figure 1-6
The Design environment
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The User Environment

The User environment is where you enter and manage data
after you’ve created a database structure in the Design environment.
The User environment is used for

entering and modifying data

viewing and printing data

searching and sorting records in the database files
creating reports and labels

creating graphs

importing and exporting data
m executing procedures

Figure 1-7 shows the User environment

L‘ File Edit Use Enter Select Report Special ]
=—————— (ontacts: 0of S4 =—————T
<
There are no selected records for: Contacts
-

a

oyt
—
<] = |

Figure 1-7
The User environment

The Runtime Environment

The Runtime environment is a special environment that is used to run a
custom application—an application that uses 4th DIMENSION but has its
own menu system and screen design. It is called the Runtime environment
because you can use a database designed for this environment with

4th DIMENSION Runtime, a low-cost version of 4th DIMENSION used to
run, but not create, 4th DIMENSION databases.
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You create a runtime application in the Design environment. You control
everything about the runtime application, from the menus and layouts it
uses to the procedures necessary to accept, process, and display data.

The Runtime environment can be completely different for each application
you create. From the user’s standpoint, the Runtime environment is a
complete application for a specific kind of information management.

Figure 1-8 shows a sample Runtime environment window displaying an
application created with 4th DIMENSION.

[ & File Edit Selection Record Special |
l% Enter a New Contact %E&I
: i
®WEDDB  Contacts
First Name .Last Name Keywords
Mr. I Joe ‘Lindblatt

Titlei Manager

Company Mame: Able Equipment Co.
1441 State Street

Address

City, State, zip: San Jose ‘CA 195012

(Cmd-Tab to add Keyword)
Location HNumber Extension Comments
Work (408) 555-12871223 3| [Very good customer

Beeper (408) 253-12328
=

&4

=

Figure 1-8
An application in the Runtime environment

Changing Environments

You change from one environment to another by choosing a command
from the Use menu. A check mark in the menu indicates which
environment you are in.

vDesign &Y
User ®U
Runtime &I

You can move between the Design and User environments at any time.
Once you have created a custom menu, you can enter the Runtime
environment from either the Design or the User environment. If no
custom menu exists, the Runtime choice in the Use menu is disabled.

From within the Runtime environment, choosing Quit takes you to the
User environment.

CHAPTER 1: 4th DIMENSION BASICS 11



12

Design Environment Editors

You use 4th DIMENSION editors to create and modify the various
components of your database design. Each editor is dedicated to one
aspect of a design.

The Design environment contains these editors:
m  Structure editor

m Layout editor

m Procedure editors

m  Menu editor

m  Password Access editor

m Lists editor

Each editor has its own window, with appropriate tools and menu
commands.

The Structure Editor

The Structure editor is your starting point for all design operations.

The Structure editor displays the images of the files in a database
and graphically shows the relationships (if any) between the files.
Figure 1-9 shows the Structure window.

[ ® File Edit Use Design Structure

[=————— structure for Contacts
Contacts
First Name A
g § Last Name A
] Company Hame A
Lo::;::“ n i |Homeaddresst A
Nun:ber A % Home Address2 A&
. ; 3 HomeCity A Companies
Extension A i
H HomeSf,ate A 3 Company Name
z HomeZip Code A Address1
s Phones & Address2
gree———— Keywords = City
F Cornments LY State
Photo P Zip Code
Keywords Salutation A Qty of Macs
Word A Title Marne A Tty of 4D
40 Standard
§ MNotes
Dealer
Developer

Figure 1-9
Structure editor
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Use the Structure editor to

m create files and subfiles in a database

m create fields and subfields in database files
m specify field types and attributes

m relate files

m modify filenames and field names

m establish the access rights to files

m view the file structure of a database

See Chapter 2 for more information on using the Structure editor.

The Layout Editor

You use the Layout editor to create and modify layouts—forms for
entering, searching, and displaying the contents of your databases. Almost
an application by itself, the Layout editor lets you create sophisticated
forms for managing data. Figure 1-10 shows the Layout editor being used
to create a layout.

[ & File Edit Use Design Layout Object Font Style |
N -
oA <D ] Contacts
o] [ Fitrst Marne Last Marme Keywords

= [popud ([First Name ] [Last Mame [ [keywords
=1|E8 Title{[Title Name |
== Comnpany Mame |l;|3mpanu Marme I

= [jan P [Address |
||_|| m "= [UniqueCoAddress
1_'% City, State, Zipi[City [[5tay[Zip Code
=) TE (Cmd-Tab to add K
L= : Location Nurnber Extension Comments
T Fhones Cormments

Figure 1-10
Layout editor
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Use the Layout editor to
® add fields to a layout
m include fields and layouts from other files and subfiles in a layout

m add graphic objects to the layout—including text, lines, rectangles, and
ovals, or paste in pictures or graphics from the scrapbook

m edit and manipulate layout elements

add objects that make the layout easier to use—for example, buttons,
check boxes, and radio buttons

specify fonts and font styles for objects that contain text
specify line and fill patterns for layout objects
align objects on the layout

specify display formats for data displayed and entered in the layout

establish access rights to each layout

See Chapter 3 for a detailed discussion of how to create a layout and how
to use the Layout editor’s graphic features. See Chapter 4 for information
about using the Layout editor to control the interface of the database:
display formats, data entry, and scripts. See Chapter 5 for information
about using the Layout editor to design a report.

The Procedure Editors

Procedures are programming instructions that process the information in
files. Procedures can perform computations on values in the files, transfer
data between files, or validate data as it is entered. Procedures are
especially important for developing runtime applications.

4th DIMENSION provides a high-level programming language for writing
these procedures, two different Procedure editors, and a library of
commands and functions.

The two 4th DIMENSION procedure editors are the Listing editor and the
Flowchart editor. Each of these editors can be used to create procedures.
The choice of which to use is up to you and depends on which editor you
prefer to work with. Chapter 6 describes the use of each editor. Figure 1-11
and Figure 1-12 show both editors being used to create procedures.
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[ & File Edit Use Design Search ]

Procedure: Search Listing

“Search Routine

If (x=1)
SEARCH SELECTIONC[Employees])
OUTPUT LAYOUT([Employees];"Employee List")
DISPLAY SELECTION([Employees])
DUTPUT LAYOUT([Employees];"Employee List™)
End if |

‘Return to calling procedure or menu

Keywords * Employees -+ Routines
= Last Name ¢ Arrays
If First Narne Boolean
Else Communications
End if ompiler Directives
Case of
End case

While

Figure 1-11
Procedure editor (listing)

| € File Edit Use Design Flowchart
IS()=————— Procedure: Search Flowchrt

EHP! SELECTIONE [Ermployees])

*Search Routine

UTPUT
AYOUTE[Erploy ees]; "Erploy ee
ist™)

UTPUT
‘KUUTL [Employees];"Employee

fluPL AY SELECTIO xNL[Empmuep,]}J

|

*Return to calling
rocedure oF meny

Figure 1-12
Procedure editor (flowchart)

Use either Procedure editor to

m create global procedures for custom menus

m create layout procedures for specified layouts

m create file procedures for managing database files

m create scripts that are associated with individual layout objects

m establish access rights to procedures
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See Chapter 6 for more information on writing procedures. See the
4th DIMENSION Language Reference for comprehensive information about
the language you use to write procedures.

The Menu Editor

When you create runtime applications with 4th DIMENSION, you use the
Menu editor to create menu bars, menus, and menu items. You can also
attach menus to any layout that you use for data entry. Figure 1-13 shows
the Menu editor being used to create a menu bar.

E[J&=——— Menubar ¥1| E——""+=
Menus ltems Procedures
File Add Contact [ r| Adde <
Contacts
Modify Contact ModC
— | —
i [ I
EKegbuard:E‘ [JBold
O Line [ 1talic
[ Enabled [J underline
[] outline
Password:[alGroups | [] Shadow
|
Figure 1-13
Menu editor

Use the Menu editor to

m create menu bars

m create and modify custom menu titles and menu items
m assign global procedures to menu items

m preview the menus and menu bars as they will appear in the finished
application

m include graphic elements for screens that display with each menu bar
m establish access rights to menu items
m set keystroke equivalents for commands in your custom menus

m enable or disable menu items

See Chapter 7 for a detailed discussion of adding custom menus and menu
bars to your applications.

The Password Access Editor

4th DIMENSION lets you add passwords to files, procedures, menus, and
layouts so that you can control access to your applications and databases.
Figure 1-14 on the following shows the Password Access editor.



[[=——— Passwords —————[|

Users... Groups...

® Designer Q [JJ sales £

® Administrator [44 Marketing

[J Patti

[J Ron
= =

[{sales i |8 Administrator [
| | |@ Patti ||
1 | Mark ]

5
Figure 1-14

Password Access editor
Use the Password Access editor to
m create access groups and user passwords

m allow designated people to add users and change user passwords

m  set startup procedures for users

] revent application users from entering 4th DIMENSION Design and
p pp g g
User environments

m monitor database use by individual users
m review and modify user passwords

See Chapter 8 for a detailed discussion of the Password Access editor.

The Lists Editor

You use the Lists editor to create and modify lists. Lists make the entry
and management of data easier. Users can select an entry from a list
instead of typing. With lists, you prevent entry of misspelled words and
incorrect data.

You can also use lists to specify valid or invalid entries for a field. Figure
1-15 shows the Lists editor being used to create a list.
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Lists... Items...
Phones AdAgency
Page Apple
Anniversaries Artist
Requests Beta Site
Keywords Co-Marketing
Salutations Distributor
Type Evaluation
Evangelist
5 Fan
Figure 1-15
Lists editor

Use the Lists editor to

m create lists

m add items to a list

m delete lists or individual items in a list
m sort choices in a list

m connect lists to other lists

® make a list modifiable by the user

See Chapter 9 for a detailed discussion of lists.

The 4th DIMENSION Interface

In the Design environment, you communicate with 4th DIMENSION by
means of a comprehensive and consistent system of menus and windows.
You can collapse and expand hierarchical lists and use lists to select from
different files in dialog boxes. This section describes how to use the
menus, windows, hierarchical lists, and file displays in dialog boxes.

4th DIMENSION Menus

The five leftmost menus on the 4th DIMENSION menu bar remain the
same no matter which editor you are using. Additional menus are added to
the right side of the menu bar for each editor. The added menus provide
commands for the editor being used. Figure 1-16 shows the additional
menus added when the Lists editor is open.



Standard menus

Added menu

Open windows
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Regions| i

Central Region
North East Region
South Region

Central CentralRegion [
North East Morth East Regio
South South Region

West west Region

West Region
Job Code

<[
<

A
Wy

Figure 1-16
Menus added to the menu bar

When several editor windows are open, the active editor determines which
menus are added to the menu bar. You choose commands from these
menus as you would in any Macintosh application. For complete
instructions for choosing from a menu, see the documentation that came
with your Macintosh.

4th DIMENSION Editor Windows

Each 4th DIMENSION editor is displayed in a separate window. There may
be several editor windows open at once. You can have more than one
editor open at one time, and some of the editors can display several
windows at the same time. A list of open windows is displayed at the
bottom of the Design menu, as shown in Figure 1-17.

® File Edit Use JIGSNHM Layout Object Font Style
Structure
Layout... #®L _ - 1
:“: Procedure... ®P [/5" i
§ Menu... #M g
Passwords r
Lists ort

Layout: Input
Layout: Activity Report

O ER O T
i
[l

Layout: To Do List

Menubar #1 los/City>, </Compal
rocedure: STRRTUP

TeaTTTYpT T TrrocName > <Last Name > [

il

Figure 1-17
Design menu listing open windows
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You can move between the open windows as you work. Only one editor
window is active at any time. The active editor determines which menus
are added to the right of the menu bar.

To make a window active you can click anywhere in the window, or you
can choose the window’s name from the the Design menu. Figure 1-18
shows several windows open on the screen.

& File Edit Use Design Layout Object Font Style
I
Zoom box — Layout: To Do List - ||
rv; s - _ -
= Menubar #1 ll/Sf »
Close box H — ) [
- _.':‘h : , Procedure: STARTUP | !m/i?sls‘m[m
=] Layouty Activity Report —=—ox——1F|
. , —] Al =
Active window = ] Ao f/V/I_'f/ Ré'pOf 7 P
% O L gH
S é 0|l [Date ] (51
Title bar SHistoryjCompany>| <fCompaniesfCity>, quonW_qHz
<Contact Type > - <[Contacts]First Name > <Last Name > :100
[Nofes L
r4 D
[ZT 1 -1
Size box

L 1 | T
50 189 150 200 250 300 350 aa] 11 —

Figure 1-18
Open windows

You can move a window anywhere on the screen by dragging its title bar.

You can expand the window to full-screen size by clicking the zoom box
in the upper-right corner of the window. You can make the window any
size you want by dragging the size box in the lower-right corner of the
window.

You can close a window by clicking the close box in the upper-left corner
of the window, or by choosing Close Editorname from the File menu.

ﬁ Tip: To close all the open windows (except the Structure editor window),
hold down the Option key as you click the close box of the active window.

You work with windows in 4th DIMENSION the same way as in most
Macintosh applications. For complete instructions for manipulating
windows, see the documentation that came with your Macintosh.



Scroll bar

DESIGN

Reduced View and Scrolling

As you build a database, the design in some of the editors can become
so large that it is difficult to view the entire structure, layout, or flowchart.

You can scroll to change your view of the window’s contents, or you can
click the Show Page box to show a reduced view.

Click to move slightly in
direction of arrow

Drag to move

T
El
I

Layout: input a5

| {I<> D1 Contacts  [Pes

anywhere in the
layout

Click to move

one screen full

Click Show Page
box for reduced
view

3! ;
a0
OA:
(:] D Eicst Name. Last Mame Keuaord:
EH— popud i[First Name _][Last Name || [keuwords
=|E8 Title [Title Name |
=(= | company Namei[Cormpany Name | |
= _— [addressl
A "*%* [OniqueCoAddress
TR z T
City, State, 2ipi[City [5ta;[Zip Code
%Iﬁ (Crnd-Tab to a
Location Numnber Extension Comments
EB Phones Comments

Figure 1-19

Scrolling to move hidden material into view

You scroll the window as you would in any Macintosh application.
For complete instructions for scrolling, see the documentation that
came with your Macintosh.

When you click the Show Page box, 4th DIMENSION reduces the view
of the structure, layout, or flowchart so you can see the entire contents at
a glance. A dotted-line rectangle identifies the portion of the contents
that currently appears in the editor window. To specify a new view area
for the window, drag this rectangle to where you want it, and click OK.
Figure 1-20 shows a reduced view of the Structure window.
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View frame

Figure 1-20
Reduced view of a database structure

Expanding and Collapsing Hierarchical Lists

4th DIMENSION displays names of fields, layouts, and procedures
in hierarchical lists in dialog boxes. All of the hierarchical lists in
4th DIMENSION work the same way. Whenever an item in a list is
displayed in bold, additional items may exist beneath that item. You
expand a list to choose one of the items, and you collapse the list if
you need room to view another part of the list.

Figure 1-21 shows a hierarchical list with expanded and collapsed items.

[ Layout... r[-ﬁ.

Collapsed filename fContacts
|—— | sy
Cemelded 0 | asmseecee
Expanded filename Kiciticed
Output 0

Activity Repart || e
mvanies ([ New ]
Companies

fpen

i

| Done

Expand/Collapse

button Collapse [ tnput Name: “ l

[ Butput

Access: l l

Figure 1-21
Collapsed and expanded filenames



DESIGN -

You can click the item or use the Up Arrow and Down Arrow keys
to highlight other items on the list.

To expand a list item, follow these steps:

Select the item that you want to expand.

Click Expand, or press the Right Arrow key.

4th DIMENSION displays the names of all available fields, layouts, or
procedures for a selected item.

When a selected item is expanded, the Expand button becomes a Collapse
button.

To collapse a list item, follow these steps:
Select the item that you want to collapse.

You can click the item or use the Up and Down Arrow keys to highlight
other items on the list.

Click Collapse, or press the Left Arrow key.

4th DIMENSION collapses the names of the fields, layouts, or procedures
and shows only the filename.

When a selected item is collapsed, the Collapse button becomes an Expand
button.

Note: You can expand a collapsed item, or collapse an expanded one, by
double-clicking the item.

Displaying a Different File

In some dialog boxes, 4th DIMENSION allows you to select field names
and layout names from lists. To select a field name or layout name from
another file, you can change the file displayed. You change the file by
clicking one of the cycle arrows on either side of the filename bar.
Figure 1-22 shows the cycle arrows used to display a different file.

Cycle arrow
Filename

+ Contacts Ek

Fields displayed in
a list

First Mame ¥
Last Name
Company Name
Home Addressi
Home Address2
HomeCity
HomeState
HomeZip Code

Figure 1-22
Cycling to display another file
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ltems that remain
the same

Items that
change from
editor to editor

ltems that remain
the same

Click either arrow to cycle through the files in the database.
4th DIMENSION displays files in the order in which they were created.
When you cycle through all the files, the first file is displayed again.

Tip: If you click on the filename between the cycle arrows and hold the mouse
button down for a moment, a pop-up menu of all the files is displayed.
You can then choose one of the filenames to immediately switch to that file.

The File and Edit Menus

The File and Edit menus on the left side of the Design environment menu
bar provide standard file and editing operations appropriate for the active
editor. The File menu changes slightly, depending on which editor is
active. '

Using the File Menu

|_Open Database...

In the Design environment, 4th DIMENSION’s File menu provides
standard Macintosh file operations. Figure 1-23 shows the File menu.

New Database...

- |

Close Layout: Input W
Save Layout: Input %S
|_Revert to Saved

Preferences...

Payge Setup..
Printi. wE
|_Print Scripiy,..

Quit *®0

Figure 1-23
The File menu that appears when the Layout editor is active

Some File menu commands remain the same for every editor:

= New Database: You can create a new database at any time.
4th DIMENSION saves changes to the current database before
opening the new database.

m  Open Database: You can open an existing database at any time.
4th DIMENSION saves changes to the current database before
opening the next database.

m Preferences: You can set preferences at any time. For complete
information, see “Setting Preferences,” later in this chapter.

m Page Setup: You can set the specifications for printing at any time.
Page Setup information is stored with each layout.
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m Print: You can print the contents of any editor window at any time.
The actual output changes, depending on the editor.

®  Quit: You can quit 4th DIMENSION at any time. 4th DIMENSION
saves your work before quitting.

Other File menu commands change, depending on the active editor:

m  Close Editorname: You can close editor windows at any time.
4th DIMENSION saves the contents of the window before closing it.
You cannot close the Structure editor window.

® Save Editorname: You can save the contents of an editor’s window at
any time without closing the window. 4th DIMENSION automatically
saves the contents of an editor when you close the window, change to
a new environment, or quit the application.

m  Revert to Saved: You can revert to the last saved version of the
contents of the Layout editor or either of the Procedure editors. This
command replaces the contents of the active editor with the last
version saved.

m Print Scripts: Using the Layout editor, you can attach scripts—short
procedures—to objects in the layout. The Print Scripts command
allows you to print scripts associated with one or more objects in a
layout. You first select the objects whose scripts you want to print,
then you choose Print Scripts. For information about creating scripts,
see “Scripts” in Chapter 4.

Using the Edit Menu

In the Design environment, 4th DIMENSION’s Edit menu provides
standard Macintosh editing operations. Figure 1-24 shows the Edit menu.

Undo %82
Cut #H
Copy #C
Paste L
Clear

Select All %A
Show Clipboard

Figure 1-24
The Edit menu
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These are the operations provided by the Edit menu:

m  Undo: Use Undo to go back one step while working with an editor.
This command is useful when you make a mistake and want to do
something over again.

m  Cut, Copy, Paste: You can select something on the screen and either
cut or copy it. In either case, a copy of the selected object is placed on
the Clipboard. You can then paste the object into a new location in the
same window or in another window.

m  Clear: Use Clear to erase a selected object. No copy is placed on the
Clipboard.

m  Select All: Use Select All to select every object in the current editor.
For example, use Select All before adjusting all the elements of a
layout.

s Show Clipboard: You can view the current contents of the Clipboard
at any time. Sometimes you’ll want to view the Clipboard prior to
pasting its contents.

Setting Preferences

You can set preferences for database operations—for example, how often
data should be saved, and whether procedure titles should be printed when
you print procedures. You set preferences only in the Design environment,
and the settings apply only to the current database.

The specifications that you select in the Preferences dialog box take effect
immediately, except for those that cannot take effect until the database is
opened again (such as Startup Environment). Figure 1-25 shows the
Preferences dialog box.

@® Thermometers

Preferences... Save data every IE' minutes
 Printing ———  Procedure Editor —
B Print titles [J Hide keywords

— Startup Environment 4 ~ Procedure Default -
 Design (Structure) ) Listing
@ User ) Flowchart
) Runtime ® No Default
Process Indicator — — Desktop

[Q Numbers [ Remember

(Editstytes..] [ cancel | [ ok |

Figure 1-25
Preferences dialog box
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Here are the items in the Preferences dialog box:

m Save data every..minutes: Specify a time period for saving data
automatically.

4th DIMENSION saves your data at regular intervals. You can
specify any time interval between 1 and 120 minutes. As a default,
4th DIMENSION saves your data every 15 minutes. The application
also saves your data each time you change to another environment
or quit the application.

When you anticipate entering a lot of data, consider setting a brief
time period between saves. In case of a power failure, you will lose
only the data entered since the previous save.

If each save involves a long pause for disk activity, it’s a sign that you
should adjust the setting. The long pause means that 4th DIMENSION
is saving many records to disk. A briefer period between saves is thus
more efficient.

m  Printing: Select whether to print procedure titles.

Unless you specify otherwise, 4th DIMENSION automatically prints
procedure titles. If you deselect the “Print titles” check box,

4th DIMENSION omits the title when printing a procedure. See
Chapter 6 for more information on creating and editing procedures.

m  Procedure Editor: Select whether to hide keywords in
4th DIMENSION’s Listing Procedure editor.

Unless you specify otherwise, 4th DIMENSION automatically displays
keywords, fields and layouts from each file, and 4th DIMENSION
routines in scrollable lists in the Listing editor. If you select the “Hide
keywords” check box 4th DIMENSION displays the Listing Procedure
editor with the lists hidden. You can bring them into view by dragging
the window divider. See Chapter 6 for more information on the Listing
Procedure editor.

m  Startup Environment: Select the environment in which you want the
database to open.

Unless you specify otherwise, 4th DIMENSION automatically opens
the database in the Design environment.

m  Procedure Default: Specify a default Procedure editor for creating
scripts and certain other procedures.

4th DIMENSION provides two editors for creating and modifying
scripts and procedures. Unless you specify a default editor in
Preferences, 4th DIMENSION asks you to select an editor when you
create a new script, layout procedure, or file procedure.
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4th DIMENSION always asks for a type for a new global procedure.
See Chapter 6 for more information on creating and editing scripts and
procedures.

Progress indicator: Select a progress indicator.

You can tell 4th DIMENSION to display the progress of a process
(such as sorting or indexing) through a number display or a graphic
thermometer. The thermometer is slower, but easier to read. The
numbers are faster, but they don’t always refer to records processed.
For example, when 4th DIMENSION performs a sort, the numbers also
show the number of comparisons made.

Desktop: Instruct 4th DIMENSION to remember the desktop.

Unless you specify otherwise, when you open a database,

4th DIMENSION automatically opens any windows that were

open the last time you quit the database, and displays them in

the same location in which they appeared previously. If you deselect
the Remember check box, 4th DIMENSION opens only one window,
displayed in its standard location.

Edit Styles: A style is a display format or an entry filter that you
name. After you create a style, you can use the style name instead
of having to create the format or filter. Styles are convenient for
formats and filters that you use often.

If you click the Styles button, 4th DIMENSION displays the Styles
dialog box. For more information on creating styles, see “Using
Styles” in Chapter 4.
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DESIGNING A DATABASE STRUCTURE

This chapter tells you how to use 4th DIMENSION’s Structure editor to
create and modify database structures. A database structure consists of
files and fields used to store information, and the relationships between the
files and fields.

This chapter tells you how to

m manipulate file images in the Structure window
m create files

m create subfiles

m relate files

m create fields

m set field types

m set field attributes

m modify fields

Databases and Database Structures

The structure of a database consists of files and the relationships
between those files. The structure of a database is like the
foundation of a house—it provides the basis for everything else.
This section gives a general description of databases, and of how to
design database structures to meet different information storage
needs.

Database Basics

A database is any collection of information, organized so that it can
be used efficiently. A telephone book is a good example of a
database. So is a dictionary, a calendar, or a cookbook.

The information in a database is organized in the form of records.
Each record contains all of the information about one person or
thing in the database. For example, each record in the telephone
book contains one person’s address and telephone number.

Each record is organized by fields. A field contains a particular type
of information. For example, in the telephone book database, one
field contains the person’s name; a second field contains the
person’s address; and a third field contains the person’s telephone
number. Every record contains each of these fields, and every
record can contain information in these categories.
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A field name usually identifies the information that goes into the
field. A field name is something like Name, Address, Phone
Number, and so on. Each field has a field type that identifies the
nature of the actual entries. Field types specify the kind of
information that can be entered in a field: numbers, dates,
alphanumeric characters, and others. Limiting a field to a specific
type of data makes it possible for a database to perform calculations
and other operations on the information in the fields.

The set of records makes up a database file. The information is
stored in the fields, arranged in a series of records in the file. Each
database can contain several separate files. Figure 2-1 shows how
these concepts are related. '

Fields define
categories of
information

¢ ebwaﬂ

Records are
added one at a
time

* .
v, M pptt 14430

\ce
pavid N ppt (5440

fot, 02 June 44378
0sc3" Rl Auguﬁ\ \B.AM

uly
Waso™ . pugust 16300

a0’

Figure 2-1

Files and fields

4th DIMENSION can reorganize the records and perform various kinds of
computation on the information so that the information is useful. For
example, 4th DIMENSION can calculate the total of values in a field and
present the total in a report. It can sort the records in order by date, or by
name. It can calculate a total for each salesperson and display a graph that
shows how the sales compare.

Files

Before information can be entered into the fields, to be stored

as records in a file, the file and fields must be created. 4th DIMENSION
allows you to create one file or many files. This gives you the ability to
create a structure that meets your exact needs.

Single-File Structures

Many databases are based on a single file. You use this structure if one file,
with as many fields as necessary, is all that is needed for a single category
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of things—such as people, companies, or inventory. A file structure with a
single file is often called a flat-file database.

¥ Peaple
File in FirstName A
Des_‘gn Last Mame &
environment Address A
Phane A
First Mame Last Marne Address Fhaone
Records in Eaft [avis £29 Elm St T58-3652
User Shirley Ranzome Q027 Ridge Road 252-6892
environment Lance “wWolftarm I33 Main Street 895-6686
Denniz Hanzon 4557 Rernmington P1. 456-9256
Lydia Vernon 972 Ortega St. 682-6983
Andy \enable 10092 Oregon Rd. SEZ-ZE54

Figure 2-2

A single file keeps track of people

In Figure 2-2, every person’s record needs the same kinds of data.
The database grows in accordance with the number of people stored.

Multiple-File Structures

A database can often store and access data more efficiently by
using more than one file. A database that keeps track of both people
and companies is a good example. Figure 2-3 shows a multiple-file
database in which two files are related.

Feople Cornpanies
First Marme A :, Company Name A
Last Name A Address A
Address A FPhone A
Phone A Total Sales R
Company A
Figure 2-3

Multiple files keep track of people and their companies

In this database, the data for each person is stored in the [People]
file. But data about each company is stored in a separate file.

The files are related in ways that allow a user to create a screen
display or a printout that automatically obtains information about
the correct company for each person.
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Contacts file image

Layout displaying
a Contacts record

4th DIMENSION is called a relational database because it can use
multiple files and relate them in various ways. For a complete
discussion, see “Related Files,” later in this chapter.

Sometimes you need a multiple-file structure in which files are not

directly related. It may be convenient to have one database to store

different kinds of information, such as a contact list and an expense
file, as shown in Figure 2-4.

— Contacts
First Name
Last Name
Company
Title

FPhone

> > >

895-1285

Expenses file image [ Expenzes Ex penses
Expense Type A
Date D Expense Type |Dinner
Amount R
Receipt B Date 5/6/89
Layout displaying PG l——$43
an Expenses Receipt @ Yes O No
record .
Figure 2-4
Unrelated files

4th DIMENSION allows up to 100 files in each database. A file can
have up to 511 fields. Using multiple files, virtually any kind of
database structure is possible.

Subfiles

Occasionally you will need to store a variable amount of
information for each record in a file. 4th DIMENSION allows you to
create a file structure that includes a subfile, a file subordinate to a
parent file.

For example, suppose you want to keep track of the children of the

people in your file. Some people have no children, and some people
have many children. You can use a subfile to store this information.
Figure 2-5 shows a subfile.
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Record in the People fil
ecord in the People file People
People file C Feopie
First Name & First Marme
Last Mame A
Address A Last Name  |Davis
Phone A
Company A Address |689 Elm St.
Children x
Phone |758-3652
Children subfile Children
TR Company | Johson Lumber Co.
Age R .
Children:
Name Age K
Subrecords in the BiTT Jr.
Children subfile Muffy
Tommy
Figure 2-5
A subfile

This subfile allows you to create a varying number of subrecords
for each record in the People file. If a person has three children, you
can store three subrecords for that record. If a person has no
children, you can store zero subrecords.

A subfile is useful for subrecords that you need to see and use only
when its parent record is being used. For example, you could easily
find the average age of one person’s children, but it would be
difficult to find the average age of all people’s children. If
performing this kind of calculation on the data is a requirement for
the database, it would be better to use a separate file for Children,
not a subfile.

Basic Steps for Creating a Database Structure

Every database has a structure that consists of at least one file and at least
one field. These elements must exist before the database can store records.

Typically you create a structure with the following steps:
1. Create a new database.
4th DIMENSION automatically creates the first file.

2. Rename the automatically created file (optional). See “Renaming a File,”
later in this chapter.

3. Create fields for the file. See “Adding and Modifying Fields,” later in this
chapter.

CHAPITER 2: DESIGNING A DATABASE STRUCTURE 35



36

Field names

Add additional files and fields as necessary. See “Creating Files,” later in
this chapter.

Relate one file to another, if necessary, by drawing a line between fields in
the two files. See “Related Files,” later in this chapter.

Using the Structure Editor

The Structure editor, shown in Figure 2-6, lets you manage the database
structure—the files and their relationships. It gives you control over files,
filenames, fields and field types.

L € File Edit Use Design Structure |
I===——— structure for Contacts =————————[-|

People
First Marne
Last Marne

Field type symbols

Company
Title
Salary

x>

Figure 2-6

Structure editor

The Structure editor gives you a graphic view of a database’s structure and
provides menus for performing design operations.

Each file is represented by a file image in the Structure editor. It shows the
fields and their types. 4th DIMENSION automatically creates the first file.
You can add files as you need to.
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Manipulating File Images

To manipulate a file image in the Structure editor window, you first need to
select the file image. You can then move or resize the file image.

Selecting a File Image

To select a file, click the file image. 4th DIMENSION highlights the
filename and adds a scroll bar to the right side of the file image.
Subsequent actions affect the selected file. Figure 2-7 shows a selected file.

Highlighted filename

First Narme
Last Marne
Cornpany
Title
Salary

Added scrollbar

Figure 2-7
Selected file

If the list of fields is longer than the length of the file image, you can use
the scroll bar to bring other field names into view.

Moving a File Image

As you add files to your database, you may want to move the file images to
get better views of the database’s overall organization—this feature is
especially useful when a database structure includes lines to subfiles and
related files.

To move a file image, drag the filename bar.

Drag the filename bar only. Clicking other parts of the file image may
produce different effects—such as creating a new field or changing the
size of the file image. Figure 2-8 shows a file image being dragged.

People  |»
First Nam &
Last Narnei &
Campany A

A
R

Title
Salary

Figure 2-8
Dragging a file image
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If the file image that you move is related to another file or subfile, the
connecting lines move correspondingly, maintaining their attachment to
the other file or subfile.

Resizing a File Image

You can make a file image larger to show more field names, or smaller so
that the file image takes up less space in the Structure window. Resizing
may hide some of the file’s field names from view, but you can use the file
image’s scroll bar to view any field names that have been hidden.

To resize a file image, follow these steps:

Position the pointer over the bottom edge of the file image you want to
resize.

e The pointer changes into an up-down arrow.

With the up-down arrow, drag the lower edge of the file image up or down
to make the image smaller or larger.

Dragging the up-down arrow to the left or right has no effect on the width
of the file image—4th DIMENSION automatically maintains a file image
width established by the longest field or filename. The maximum is

15 characters, plus a space for the character that identifies field type.
Figure 2-9 shows a file image being resized.

First Name
Last Name
Company
Title
Salary

Figure 2-9
Resizing a file image

Creating a New File

When you create a new database, 4th DIMENSION automatically creates
the first file in the database. If you need additional files, you can create
them at any time. You create additional files in order to use a multi-file
database.

4th DIMENSION names the first file of a new database “Filel”.

4th DIMENSION names additional files sequentially, up to File10. You can
rename the files at any time. See “Renaming a File,” later in this chapter,
for more information on naming files.
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Important: You cannot delete files. If you create an unwanted file, move it to
an unused part of the window and ignore it. You can use the file later if you
find you need more files. If you accidentally choose New File, you can cancel
the operation by immediately clicking in the menu bar.

To create a new file, follow these steps:

Structure
New File... #N _
Rename File... %R The pointer becomes a miniature file icon.

1.  Choose New File from the Structure menu.

New Field... 38F
{ haage Field...

If you want to cancel the operation, move the pointer to the menu bar, and
click.

2. Move the pointer to the location in the Structure window where you want
the upper-left corner of the new file image to be, and click.

4th DIMENSION creates a new file image, which becomes the selected file
image in the Structure window.

Repeat steps 1 and 2 for each file you want to add to the database.

Renaming a File

4th DIMENSION automatically names files. You will usually want to
rename a file so that the filename identifies its contents or purpose. For
example, if [Filel] will contain student records, you might rename it
[Students].

You can rename files at any time. If you have used the old filename in a
procedure or script, 4th DIMENSION automatically changes it to the new
name everywhere it occurs (except if the procedure or script is currently
open).

Do not use the same name for two files in the same database. If you
inadvertently create a duplicate filename, 4th DIMENSION recognizes only
the file you created first, ignoring any files subsequently created with the
same name.

To rename a file, follow these steps:
1. Select the image of the file you warnt to rename.

You can rename a file only when its image is selected in the Structure
editor.

2. Choose Rename File from the Structure menu.

4th DIMENSION displays the File Attributes dialog box, shown in
New Field...  %F Figure 2-10 on the following page.

{hange Fiald,,

Structure

New File... #EN

Rename File... #R
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File Attributes...
Filename: | XTI

- Record Access

Load: |l Groups ]
save: [All Groups )
|
|

Add:  [All Groups

Delete: [All Groups

Cancel [ 0K

Figure 2-10
The File Attributes dialog box

In addition to the area for the filename, the File Attributes dialog

box contains pop-up menus for assigning password access groups for
various file operations. For complete information about access rights,
see Chapter 8, “Managing Password Access.”

Type a new filename.

You can enter up to 15 characters in the Name area. The filename must
begin with a letter. You can use any letters or numbers, the space, and the
underscore. 4th DIMENSION truncates filenames longer than 15 characters
and removes spaces at the beginning or end of the name.

Click OK.

The new filename appears in the selected file image.

Creating and Modifying Fields

After you create your database files, you need to create the fields that
hold the data you want to store and manage.

When you create fields, you must assign each field a field type that
describes the kind of information that will be stored in the field.

4th DIMENSION uses this field type to perform different kinds of
operations on the contents of that field. For example, if a field will contain
a date, you will want to identify it as a Date field so that 4th DIMENSION
can compute date values, such as length of service or qualification for
benefits. Field types are described in detail later in this chapter.
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In addition to the field type, each field in a database file can possess any of
six attributes. Attributes describe conditions for entering, displaying, or
modifying data in the fields. They are described in detail later in this
chapter.

After you create a field, you can return to it to change the field type or any
of its attributes (except for a subfile).

Creating New Fields

Each time you add a new field to a file, you perform these steps:
®  Name the field.
m Specify a field type.

® Select field attributes (optional).

You can add up to 511 fields to a database file or subfile. 4th DIMENSION
adds fields to the file image in the order that you create them. You cannot
reorder field names. You can, however, order the fields any way you want
in the input and output layouts you will use to enter and manage the data.
See Chapter 3 for information about layouts.

Do not use the same name for two fields in the same file. If you
inadvertently create a duplicate field, 4th DIMENSION recognizes only the
field you created first, ignoring the subsequently created field. Do not
leave a field name blank.

Important: You cannot delete fields. If you create an unwanted field, leave it
at the end of the field list and name it Unused. You can use the field later if
you find you need more fields.

To create a field, foilow these steps:
1. Select the file image in the Structure editor.

You create fields within files. Before you can create a field, you must
select the file you want it to belong to.

2. Choose New Field from the Structure menu. Or double-click on the blank
part of the file image below the field names (if any). See Figure 2-11 on
the following page.

New File... N
Rename File... 3R

#F

New Field...
{ haage field...
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Rename File... 3R
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{hange field..,
First Name
Last Name
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...double-click Title

; Sal
in blank area to <lerd

create a field

Figure 2-11

Creating a new field

4th DIMENSION displays the Field for Filename dialog box in which you
specify the field description. This dialog box always identifies the file to
which the field belongs. Since the filename changes in practice, throughout
this book this dialog box is called simply the Field dialog box. Figure 2-12
shows the dialog box.

—

Field for file People

Name: [T

— Attributes
- Alpha [[J™Mandatory
Texnt Snisplag only
Can't modify
. [ Indexed
Integer [ #nisus
Long Integer| | (] Choices

21)- Date
- Time

Picture
-+ Subfile (_cancet J{_ ok ]

Figure 2-12
Field dialog box
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3. Type the field name in the Name area.

You can enter up to 15 characters in the Name area. The field name

must begin with a letter. You can use any letters or numbers, the space, and
the underscore. 4th DIMENSION truncates field names longer than

15 characters and removes spaces at the beginning or end of the name.

4. Select a field type.
For information, see “Field Types,” later in this chapter.
5. Select any attributes.
For information, see “Field Attributes,” later in this chapter.

6. Click OK to save the field description and élose the dialog box. Or click
OK & Next to save the field description and display the Field dialog box
for another new field.

If you decide not to create the field, click Cancel.

Repeat steps 3 through 6 to create additional fields for the file.

Field Types

You must specify a field type for each field. Field types affect how
4th DIMENSION manipulates and stores the data in a field, and how
you enter or display data in layouts.

Fields can have display formats that affect the way they are displayed.
They can also have data entry filters that control data entry into the field.
Both display formats and data entry filters are established in individual
layouts. For information on display formats and entry filters, see
Chapter 4, “Designing the Interface.”

You set the field type in the Field dialog box. There are ten field types.
A Alpha

An Alpha field contains alphanumeric characters (letters and numbers),
punctuation marks, and special characters such as the asterisk (*), percent
sign (%), hyphen (-), and so on. You would use an Alpha field to contain
any information that must be treated as text, and that has a known length.

Alpha is the most common field type. Typically, you use this field type for
names, addresses, telephone numbers, United States Zip codes, and so
forth. Zip codes are best placed in an Alpha field for two reasons: Number
fields do not display leading zeros, and some Zip codes contain a hyphen.
The general rule for deciding between a Number field or an Alpha field is
make it an Alpha field unless it will be used in a numerical calculation or
searched or sorted based on numeric values.
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You can set the maximum length of an Alpha field to be between 2 and 80
characters long. During data entry, an Alpha field accepts any character,
number, punctuation mark, or special character.

An Alpha field can be indexed (whereas a Text field cannot be indexed).

Alpha fields support string manipulations, such as concatenation or
extraction of substrings.

=== Text

A Text field can hold up to 32,767 alphanumeric characters. You would
use a Text field to hold blocks of text longer than 80 characters, such as
comments or descriptions.

During data entry, Text fields provide basic text editing features: scrolling;
word wrap within the area set for the field display; double-clicking to
select a word; arrow key control over the insertion point; and standard cut,
copy, and paste operations. A Text field accepts a carriage return during
data entry to create a new paragraph.

In an input layout, a Text field can be given a vertical scroll bar. In a
printed report, the Text field area can expand as necessary to print all the
information, even if it covers several pages.

You can paste text into Text fields, including text from word processors.

You cannot index a Text field, but you can perform a search based on
characters in the field.

Real

Use a Real field type for any field that must hold decimal numbers (Price,
Salary, Expenses, and so on). Real number fields can hold any number in
the range of £1E1022. Calculations on values in Real fields retain
accuracy to 19 digits.

PR IE. ..... : Integer

Use an Integer field type for any field that stores numbers without
decimals (Record Number, Invoice Number, and so on). Integer fields are
16-bit. They can contain whole numbers between —32,767 and +32,767.
Calculations on Integer fields are accurate to 4 digits.
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.[0}. Long Integer

Use a Long Integer field type for any field that stores numbers without

decimals that are too large for an Integer field. Long Integer fields are

32-bit. They can contain whole numbers between —2,147,483,647 and

+2,147,483,647. Calculations on Long Integer fields are accurate to 9 digits.
~{4T] Date

A Date field can store any date value (month, day, year) entered in a
MM/DD/YYYY format between the year 100 and the year 32,767.

(U Time

A Time field can store any time value entered in HH:MM:SS format.
Use this field type to manage times such as current time, meeting time,
billed time, and so on.

E Boolean

Boolean, or logical, fields contain TRUE or FALSE values. A Boolean entry
can be one of only two choices: Yes/No, True/False, 1/0, Male/Female, and
SO on.

You can format a Boolean field as either a check box or as a pair of radio
buttons. A check box that contains a check is TRUE; empty, it is FALSE.
Either the first radio button is selected (TRUE), or the second button is
selected (FALSE).

ﬁ Tip: You should name a Boolean field so that you can ask the question, “Is
fieldname true?” This question is useful for searching because during a search,
4th DIMENSION looks for TRUE and FALSE in a Boolean field. For example,
name a field Male instead of Sex. Your search condition can then be written
“Male is equal to true,” instead of “Sex is equal to true.”

[&al.. Picture

A Picture field stores graphics created in a Macintosh graphics application
such as MacPaint or MacDraw II. A Picture field can store pictures of
unlimited size, subject to the amount of memory available to display the
picture. Use Picture fields to store digitized photographs, diagrams, maps,
and illustrations.

A Picture field can store bitmapped graphics or object graphics in the PICT
or PICT?2 formats. Some Macintosh applications store extra information
with pictures. This information “tags along” when the picture is copied and
pasted into a picture field. This information may provide special instructions
when used by an output device such as a PostScript printer. 4th DIMENSION
uses this extra information when printing the picture to an appropriate
device.
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Subfile

A Subfile field is actually a complete file associated with an individual
record in a file. A single subfile can contain up to 32,767 subrecords, and
each subrecord can have as many as 511 subfields.

The record to which a subfile is attached is called the parent record; the file
that contains the parent record is called the parent file. Each subfile has its
own set of fields, called subfields.

Records in subfiles can also contain subfile fields. This means that you
can nest subfiles. 4th DIMENSION allows up to five levels of subfiles,
but such a structure is not recommended. Because 4th DIMENSION loads
subfiles into memory when it loads their parent records, the number of
subfiles and subrecords is limited by the amount of available memory.

A good maximum for subfiles is 100 subrecords per parent record.

Use subfiles to manage a variable number of records that may be
associated with records in the parent file. For example, you may want

to create a student file in which each record contains data about the
student’s honors and the dates of the awards. Instead of having to create a
number of fields such as Honor 1, Honor 2, and so on, to store the data,
you can create a subfile to which you can add records as the awards
accumulate.

You add subfields to a subfile in exactly the same way that you add fields
to files.

Important: After you define a field as a Subfile field, you cannot assign it
another field type.

Field Attributes

Attributes

[1Mandatory
[J Display only
[J Can't modify
[J Indered

O gaigus

[ Choices
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Field attributes are optional additions to a field’s instructions. Each field in
a database file can possess several attributes.

You set the field attributes in the Field dialog box. Attributes that cannot be
selected for a particular field type are disabled and dimmed. A description
of each of the field attributes follows.

Mandatory

When the Mandatory attribute is set for a field, the user must enter a value
in that field during data entry. 4th DIMENSION does not accept a record
that contains an empty mandatory field. You would set the Mandatory
attribute for a field that contains essential information for your database.
The field that uniquely identifies each record is a good candidate for the
Mandatory attribute. Social security numbers, invoice numbers, certain
dates, or employee numbers might need to have the Mandatory attribute
set, to protect the integrity of the records.
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You can also set the Mandatory attribute for any field in a particular
layout. For information, see Chapter 4.

Display only

The user cannot enter values from the keyboard into a field that has the
“Display only” attribute set. You must use a default value for such a field,
or write a script or procedure that inserts a value in the field. A field with
the “Display only” attribute is useful for displaying values that you don’t
want database users to modify, such as calculated totals.

You can also make any field nonenterable on a particular layout. For
information, see Chapter 4.

Can’t modify

If the “Can’t modify” attribute is set for a field, 4th DIMENSION accepts
the value initially entered in the field, but does not allow the user to
modify the value after the user saves the record. The user can edit an entry
in such a field only during the initial creation of the record, before it is
accepted. Once the user saves the record, the value in the field is
unchangeable, except by a script or procedure.

Use “Can’t modify” for fields that must provide an audit trail, such as Date
Received, Date Paid, and so on.

Indexed

The Indexed attribute causes 4th DIMENSION to create an index table for
the field. The table allows 4th DIMENSION to perform rapid searches and
sorts on a field. When searching or sorting on a nonindexed field,

4th DIMENSION moves through data sequentially, examining each record
in order. An index allows 4th DIMENSION to search and sort without going
through every record.

You can index Alpha, Real, Integer, Long Integer, Time, Boolean, and
Date fields. As you add and delete records, 4th DIMENSION automatically
updates its index table. If you assign the Indexed attribute to an existing
field, 4th DIMENSION automatically indexes the existing data when you
leave the Design environment. You can specify as many indexed fields as
you want. The Structure editor displays indexed fields in boldface.

An index increases the size of the database, taking storage space. Using
many indexes may also increase the time needed to save a record, since
4th DIMENSION updates the index table with each entry.
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Unique

Setting the Unique attribute ensures that a field contains a unique value in
each record. This prevents duplicate values. This attribute is useful as a
validation for fields that store employee numbers, Social security numbers,
purchase order numbers, and so on. If you want to set the Unique attribute
for a field, you must first make it an indexed field.

Unique prevents duplication of empty values as well as positive entries. An
empty field cannot be duplicated in another record.

If you apply the Unique attribute to a Subfile field, although you generally
would not, the attribute ensures that no subrecord contains a duplicate
value. The Unique attribute applies to all subrecords for all parent records;
no subrecord for any parent record can contain a duplicate value.

Choices

Use this attribute if you want to display a list of choices for entry in the
field. To use this attribute you need to create a list of choices with the Lists
editor. For information, see Chapter 9.

Use the Choices attribute whenever you want to standardize entries in the
field and avoid misspellings. Use a choices list for a field that has a limited
number of valid entries, or a limited number of usual entries. Displaying a
list of choices does not prevent a user from typing another value.

You can also supply a list of choices for any field in a particular layout. In a
layout, you can also prevent a user from typing in a different value by
making the list required. For information, see Chapter 4.

Modifying Fields

You can change a field’s name, attributes, or type at any time, whether or
not you have entered data into the field.

If you change the field name, 4th DIMENSION automatically updates the
name anywhere the field is used in procedures, layouts, and in User
environment definitions such as saved search conditions and Quick Report
designs.

Do not use the same name for two different fields in the same file. If you
inadvertently create a duplicate field, 4th DIMENSION recognizes only the
field you created first, ignoring the fields created later with the same name.

If you change field attributes, the change usually does not affect data
already entered into the field. For example, if you set the Unique attribute,
only entries made after that are checked for uniqueness; field entries made
up to that point may include duplicates. However, if you set the Indexed
attribute, all field values (both old and new) are included in the index.
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If you change the field type before entering any data into the field,
4th DIMENSION simply changes the field type. The only restriction is upon
the Subfile field type, which cannot be changed to any other field type.

If you change the field type after entering data into the field,

4th DIMENSION converts the data if possible. Data from a Picture field
converted to any other type does not display. Data from a field converted
to a Picture or Subfile field type does not display.

When you convert a field type, 4th DIMENSION retains the field’s original
value until you modify the record. For example, if a Text field contains
text such as “over 10” and you change the field type to Integer, the
modified field displays “10”. But if you change the field back to a Text
field without editing the field value, 4th DIMENSION displays “over 10”
again.

To modify a field, follow these steps:

In the Structure editor, select the field you want to modify, and then choose
Change Field from the Structure menu. Or double-click the field name.

4th DIMENSION displays the Field dialog box for that field. The dialog
box displays the field name, type, and attributes that you have previously
assigned to the field.

Make any changes you want to make.

Click OK to save the field description and close the dialog box.

Related Files /_23/S

Related files allow data stored in one file to be accessed from another file.
With related files, you can store data efficiently, update data in one place
and have the change reflected everywhere that the data is used, and do
searches and sorts in one file that are based on data in another file.

For example, suppose you create a database for people and their
companies. You can use two related files to gain access to the information:
One file stores information about the people, and another file stores the
company information. Figure 2-13 on top of the following page shows two
related files.
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Related fields

Feople Companies

First Marme A Company Hame A

Last Mame & Phone &

Title A Address A

Phane A City A

Company A State A
Zip A

Figure 2-13

Related files structure

The [People] file contains one record per person. The [Companies] file
contains one record per company. For each person you can view the
corresponding company information—the address, city, state, Zip code,
and company telephone number. For each company, you can view all the
personal information—the name, title, and personal telephone number—
for each person in the company.

Related Fields

The basic purpose for relating files is to instruct 4th DIMENSION which
record or records to make current in one file based on which record is
current in the other file. The related files make use of data in two related
fields to identify corresponding records.

In this example, the Company field in the [People] file and the Company
Name field in the [Companies] file relate the two files. When you enter a
company name in a person’s record, 4th DIMENSION can automatically
display the company address in that person’s record. If you view a
company’s record, 4th DIMENSION can automatically list all the people
who work at that company in that company’s record. The field that stores
the company name in each file is the field that relates the two files.
Figure 2-14 shows how one company name identifies several records in
the [People] file, and one record in the [Companies] file.

T 1
First Mame |Last Mame [Title Compan[; CompangI Name City St |Phone

Biff Davis Salesperson |Howard Battery Co. Howard Battery Co. [Arcadia [CA|818-576-25324
Andy VYenable Engineer Howard Battery Co.

Bryan Pfaff Secretary |Howard Battery Co.

Kathy Forbes Secretary |Howard Battery Co.

Figure 2-14

Data in related fields

4th DIMENSION requires that, in one of the related files, the field that
relates the files contain only unique values, not duplicated in any record. In
this example, it is the [Companies] file. The Company Name field cannot
contain any duplicate company names. In the other file, the Company field
can contain duplicated values. Since you have records for several people
who work at the same company, the Company field often contains the
same company name.
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Data from
[Companies] file
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The One File and the Many File

Two related files are always called the One file and the Many file,

depending on how many records can be specified by the relation. In this
example, the [Companies] file is the One file and the [People] file is the
Many file. This section explains the One file and the Many file in detail.

When any record in the [People] file is made current, 4th DIMENSION
loads the corresponding single record from the [Companies] file and
displays the address. Because the relation is specifying exactly one record
in the other file, only one company address is displayed. Figure 2-15
shows how a company name in a record in the [People] file specifies one
record in the [Companies] file, so that the [People] file record can display
the company’s address.

People

First Name  |[sikRg

Last Name  |Davis

Title |Salesperson

— Company |Howard Battery Co.

Address 243 Second Ave.

City Arcadia

State CA

Phone 818-576-2534
Figure 2-15

Company name specifies one company

Conversely, when any record in the [Companies] file is made current,

4th DIMENSION loads and displays the many corresponding records from
the [People] file. Because the relation is specifying several records in the
other file, the names and titles of many people are displayed. Figure 2-16
shows how a company name in a record in the [Companies] file specifies
several records in the [People] file, so that the [Companies] file record can
display a list of people employed at that company.
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Many people are
“related” to one
company

Companies

Company Narne IHoward Battery Co.

Address Q43 Second Ave.

City |Arcadia State CA
First Name Last Name Title 4 p
BEift Davis Salesperson
Andy Yenable Engineer
Bryan Pfaff Secretary
Kathy Forbes Secretary

Figure 2-16

Company name specifies many people

The distinction between the One file and the Many file is specific to a
particular relation. A file may be the One file in one relation, and the Many
file in another.

For example, suppose you decide to send a package of sample merchandise
to everyone in your [People] file. You add a [Postal Rates] file that contains
Zip codes and the postal rate for each Zip code. Using this structure enables
you to print an address label for each person that includes the amount of
postage needed to mail the package. Figure 2-17 shows the [Postal Rates]
file added to the database structure.

People [ Cornpanies Postal Rates
First Name A Company Name A Zip Code A
Last Name A Address A Rate R
Entry Date D City A
Salary R State A
Title A Zip A
Company A Phone A
Figure 2-17

Another file added to the structure

Each Zip code in the [Postal Rates] file is unique, so the [Postal Rates] file
is the One file. The Zip field in the [Companies] file can contain duplicate
Zip codes, for companies that are near each other. The [Companies] file is
therefore the Many file in relation to the [Postal Rates] file.

Whether a file is a One file or a Many file, therefore, depends on its relation
with the other file. The [Companies] file is the Many file in relation to the
[Postal Rates] file, and it is the One file in relation to the [People] file.
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The Relating Field and the Related Field

Whenever you use information from related files, you start from one of the
files. If you are in the Many file, you can relate to one record, making use
of the information from the single record the relation specifies. If you are
in the One file, you can relate to many records, making use of the
information from the many records the relation specifies.

You will occasionally need to differentiate the relating field (where you
start) from the related field (where you end). Unlike the difference
between the One file and the Many file, the difference between the relating
field and the related field depends only on where you start. The relating
field is the field that connects to the other file; the related field is the field
that is connected in the other file.

For example, when you are using a layout for the [People] file, the
Company field is the relating field, and the Company Name field in the
[Companies] file is the related field. Conversely, when you are using a
layout for the [Companies] file, the Company Name field is the relating
field, and the Company field in the [People] file is the related field.

Automatic and Manual Relations

The relation that specifies one record in the One file and many records in
the Many file is either automatic or manual.

In an automatic relation, whenever a record in a related file is made
current, 4th DIMENSION selects the corresponding record or records and
loads them into memory. The record or records so specified can then be
viewed, printed, modified, or used in searches and sorts. No programming
is required.

In a manual relation, you can exercise control over whether

4th DIMENSION loads the corresponding record or records into memory.
To exercise this control, you need to do some programming. For complete
information about creating the procedures that control related files, see the
4th DIMENSION Language Reference. [ 2,15

You will usually choose to relate files automatically. You would use a
manual relation if you wanted to optimize the performance of specific
applications that do not need all corresponding records loaded each time.
You would also use a manual relation if you wanted to relate two files with
two separate relations. Only one automatic relation can exist between two
files. Any number of manual relations can exist between two files.

CHAPTER 2: DESIGNING A DATABASE STRUCTURE 53



54

Entering Data in Related Files

You can display fields from one file in a layout for a related file. The user
can use these fields to enter and edit data directly in the records of the
related file.

If the relation is automatic, you can display fields simply by selecting
them. Information entered into the displayed fields is automatically saved
in the field’s file. For complete information, see “Selecting Fields for the
Layout,” in Chapter 3.

If the relation is manual, procedures must exist to display the fields and to
save the information entered. 4th DIMENSION automatically generates
certain minimal procedures when layouts are created, so that the
information can be displayed in the related file’s layout, but you must
create procedures to transfer and save any entered data.

For complete details about entering data into fields from related files, see
the 4th DIMENSION User Reference.

Using Wildcard Look-ups

When files are related, 4th DIMENSION allows the user to look up values
in the One file when entering data into the relating field in the Many file.
The user simply uses the standard wildcard character (@) in the relating
field. Doing so causes 4th DIMENSION to look up the corresponding entry
in the related field.

The wildcard character can be used in two ways: to complete a partial
entry or to display a list of valid entries. When a list is displayed, the user
can select the entry from the list. An additional field can be displayed
with the related field.

For example, suppose the user is creating a record in the People file.
Instead of typing Apple Computer, Inc. in the Company field, the user
can type Ap@, and then press Tab to move to the next field. Because @
is the 4th DIMENSION wildcard character, this entry means “this value
starts with Ap and is followed by anything else.” 4th DIMENSION looks
in the related field for the entry. If it finds one, it completes the entry and
selects the next field in the data entry order. Figure 2-18 shows how this
use of the wildcard works.



People

First Name [Alan
Last Name Hull

Company |4pg]

Salary 0

People
First Name |Alan

Last Name Hull

Company |Apple Computer, Inc.
selory X
Figure 2-18

Completing an entry with a wildcard

If 4th DIMENSION finds more than one entry that meets the requirement,
it displays a list of entries so that the user can select the correct one.
Figure 2-19 shows such a list being displayed.

% File Edit Use Enter Select Report Special

10 Entry for People |

E()=— Selection

Peopld

Appalachian Steel Chizago
Cuperting

First Name Alan #pplication Systems Sunny vale
Last Name Hull

Company apa@

Salary

<l

<]

il EE

Figure 2-19
List displayed to select the entry

You can specify a second field for the list, to help the user decide which
company to select. Figure 2-19 shows the list of companies displaying the
city as well as the company name.
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The additional field assists the user who doesn’t know whether the
company is named Appalachian Steel or Appleton Steel, but remembers
that the company is located in Chicago.

To see a list of all companies in the [Companies] file, the user enters @
only. 4th DIMENSION then displays a list of all the companies so that the
user can select the correct one. Figure 2-20 shows a complete list of
companies being displayed.

® File Edit Use Enter Select Report Special
Entry for fooste z
3 ~ECI=——— Sselection
P e p I € | Apple Computer, Inc. Cupertino —
Application Systems Sunnyvale
X Howard Battery Co. Arcadia
First Name |Alan Photronics Chicago
Santa Barbara Valet Santa Barbara
Last Name Hull Smith Tool Co. San Francisco
E Company 9]
s Salary q
u
i
Cancel
<
<] ' B2 |
Figure 2-20

Complete list of all the companies

If the relation is automatic, the wildcard look-up feature exists
automatically. You can choose an additional field to display with the
related field when you create the relation. Figure 2-21 shows the additional
field being selected.
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Figure 2-21

Choosing the additional field

If the relation is manual, procedures must exist to provide the look-up
feature. The procedure can specify the additional field. For information, see
“Managing File Relations” in the 4th DIMENSION Language Reference.

Creating a New Record in the One File

The user enters records in the One file as in any other file—by typing
information into an input layout, or by importing the data. Occasionally, the
user will need to create a new record for the One file while creating a
record in the Many file.

For example, suppose that, while creating a record in the [People] file,

the user enters a company name that doesn’t exist in the [Companies] file.
If 4th DIMENSION requires a match in the related file, 4th DIMENSION will
automatically give the user the opportunity to create a new record in the
[Companies] file. Figure 2-22 shows the message displayed when a user
enters a new company name.

& File Edit Use Enter Select Report Special

Entry for People

( Enter ] Dananla |
| s This record does not exist in file
"Companies”.

What do you want to do?

[0

[ Create It ] [[ Try Again ]]
§alarg 0

]

Figure 2-22
Entering a new value in the relating field

CHAPTER 2: DESIGNING A DATABASE STRUCTURE 57



If the relation is automatic, 4th DIMENSION requires that the corresponding
record exist in the related file. The chance to create a new record in the One
file is provided to the user automatically.

If the relation is manual, 4th DIMENSION requires the corresponding record
to exist only if the field in the Many file has the Mandatory attribute set.

If the relating field does have the Mandatory attribute set, 4th DIMENSION
provides the user with the chance to create a new record in the One file. If
the relating field does not have the Mandatory attribute set, 4th DIMENSION
ignores the failure to specify a record in the related file.

Searching and Sorting Records

When files are related, the user can perform searches and sorts that use
information from one file to manipulate records in the related file. Searches
that create a selection are used for graphs, reports, and labels in the User
environment. Sorting is used for reports and labels.

For example, the user can display a list of people whose companies are
located in San Francisco by searching in the [People] file with the following
search condition:

“[Companies]City is equal to Cupertino”

4th DIMENSION creates a selection in the [People] file based on information
in the [Companies] file. Figure 2-23 shows the results of this search.

[ % File Edit Use Enter Select Report Special

— People: 4 of 54
First Name Last Name City
Alan Hull Cupertino
George Lyle Cupertino
Mike Krause Cupertino
Laurence Manneman Cupertino
“
Figure 2-23

Selection based on value in the related file



DESIGN

Conversely, the user can search for companies that employ people named
Johnson. If the user is in the [Companies] file when the search is performed,
the selection is based on information in the related file (in this case, the
[People] file).

You can also do a sort based on information in the One file. The user must
perform the sort from the Many file. For example, the user can display a list
of people sorted by the city and state stored in the [Companies] file.

If the relation is automatic, these capabilities are automatic.

If the relation is manual, searches and sorts must be created by procedures.

Maintaining Relational Integrity

4th DIMENSION protects the integrity of related files by inactivating
relations that would distort the selection of records in any related file. The
material in this section will be of interest only to experienced database
designers. In general, 4th DIMENSION handles related files as you would
reasonably expect.

4th DIMENSION automatically detects relational situations that would cause
data to be inaccurate and prevents them. This is done by not establishing the
relation that would corrupt the integrity of the data. Using the People and
Companies files example, suppose you are entering a record for a person,
and you need to view the record for the person’s company. Normally,
displaying the company record would load all the people who work for this
company. In this situation, doing so could cause the person’s record to
become just one of several records in the selection in the People file. In this
case, 4th DIMENSION simply does not load the related people while in the
company file.

4th DIMENSION allows you to relate files in sequence, as you have seen in
the example database. This means, for example, that if you select a record in
the [People] file, a corresponding record in the [Companies] file is loaded,
and another corresponding record in the [Postal Rates] file is also loaded.
Figure 2-24 shows the Structure window with files related in a series.

People [ Companies
First Name - Company Name
Last Name Address
Entry Date City
Salary State
Title Zip
Company Fhone

Fostal Rates

> 00O »»
xR R RS

Figure 2-24
Files related in a series
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If the relation is automatic, the continuous loading of corresponding
records always moves from the Many file to the One file. When a record
from the Many file is loaded, 4th DIMENSION loads the corresponding
record from the One file. If that file is a Many file in relation to another
file, 4th DIMENSION loads the corresponding record from that One file.
This process continues until the last One file is reached. It is conceivable
that you could create a file structure that loops back upon itself, each file
related to the next in a circle.

4th DIMENSION stops loading records at the last relation. In other words,
4th DIMENSION does not get trapped in an endless loop of loading
corresponding records.

From the One file to the Many file, 4th DIMENSION performs only one
loading of corresponding records. For example, if a record in the

[Postal Rates] file is made current, 4th DIMENSION loads all the records
that have the corresponding Zip code in the [Companies] file. But the
loading stops there; no records from the [People] file are loaded.

If the relation is manual, procedures control which records are loaded. You
can control which files load records in either direction, from Many to One,
and from One to Many.

Creating a Relation Between Files

You must have at least two files in your database to create a relation.

You create a relation by drawing a line between two fields. The field where
you start drawing must be in the Many file (in the previous examples, the
People file). The field where you end the line must be in the One file (in
the previous examples, the Companies file).

The related fields must have the same field type. You can use these field
types for the related fields:

m  Alpha
Number (Real, Integer, Long Integer)
Date

Time

Boolean
The One file must have unique entries in the related field.

If the user inadvertently enters a duplicate entry in the related field in the
One file, 4th DIMENSION always loads the first record and ignores the
remaining records.
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For the relation to work automatically, the related fields must be indexed.
If the fields do not have the Indexed attribute set, 4th DIMENSION
automatically indexes them when you change environments.

You can create a relation between files at any time. If the related fields are
indexed, the relation is established immediately. If the related fields are not
indexed, the indexes are built when you change to another environment.

For information about including fields from related files in layouts, see
Chapters 3 and 4. For information about entering information into related
files, see the 4th DIMENSION User Reference. i 42,

To create a relation between files, follow these steps:

In the Structure window, in the Many file move the pointer over the name
of the field that you want to use to relate the files.

Hold down the mouse button and drag toward the file to be related.

As you move the pointer, 4th DIMENSION selects the field and draws a
thin line, as shown in Figure 2-25.

[' ® File Edit Use Design Structure

—_——— Structure for Contacts

The Many file

People w Companies
First Marme A Company me
Last Marne Addrese™

Entry Date ey

Salary o State

Title Zip

Company Fhone

> >

Figure 2-25
Drawing the line to create a relation
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Automatic Relation
check boxes

Move the pointer over the key field in the One file, and release the mouse
button.

The Relation dialog box appears, as shown in Figure 2-26.

Choose field from
the One file to
display in wildcard
choice list

— Automatic — Wildcard Choice ——
£ Relate one Company Name
< Relate many iiddress

Figure 2-26
The Relation dialog box

The automatic relations are preselected.

Relate to One causes 4th DIMENSION to load the corresponding record in
the One file when a record in the Many file is made current.

Relate to Many causes 4th DIMENSION to load all corresponding records
in the Many file when a record in the One file is made current.

You would deselect one or both only if you wanted to prevent one or the
other automatic relation from taking place, or if you wanted to control the
relation with procedures.

From the list on the right, select the additional field to display in a
wildcard lookup choice list from the list.

If you want only the related field to display in the look-up choice list,
select it in this dialog box.

Click OK.

4th DIMENSION displays the Structure window and draws a line between
the two fields, as shown in Figure 2-27. In a color display, the line appears
in color.
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[ ® File Edit Use Design Structure

I=——————— Structure for Contacts
One file
Many file
LI 2
People Companies
First Name & A Company Name A
Last Name & Address A
Entry Date D City A
Salary R State A
Title A Zip A
Company A Phone A

Related fields

Figure 2-27
Files related

The arrowhead on the line points to the One file.

Removing Relations

4th DIMENSION lets you remove a relation by deleting the arrow that
relates the two fields.

1. In the Structure window, in the Many file, move the pointer over the field
name of the relating field.

2. Hold down the mouse button and drag over any empty area between file
images.

3. Release the mouse button.

4th DIMENSION removes the arrow. The files are no longer related.
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CREATING AND MODIFYING LAYOUTS

Layouts allow you to control how information is entered, displayed, and
printed. Layouts are the primary method by which a user interacts with the
data in a database.

4th DIMENSION offers you both simplicity and power. Your layouts can
provide exactly what your database needs. With a few simple steps, you
can create a basic layout, as shown in Figure 3-1.

Fields

Field labels

People
irst Name irst Name ]
ast Name ast Name ]
epartment HDepartment ]
alary
Figure 3-1

A basic layout

You can use the basic layout as it stands, or you can customize it at any
time. Figure 3-2 shows a layout that has been customized.

T
L]

Layout: Input =————— N

[ [« D] Contacts

g

o|x First Name Last Narne Keywords
E— [popud {[First Hame | [Last Name | [keywords
=|E8 Tite [Title Name ]
= Ei Company Name {Compang Name J
= | Wbt Address AUQFESS]
[ UnigueCoAddress : .
City, State, 2ip [City J[Sta;[zip Code ]

(Cmd-Tab to a

Location MNumber Extension Comments
Phones Comments

Figure 3-2
A customized layout
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This chapter tells you how to

m create layouts for your database

m use the Layout editor to create and modify layout elements
®m customize layouts

m copy layouts

m change the data entry order of the fields

m delete layouts

m rename layouts

Layouts, Files, and Fields -

Each file must have at least one layout so that information can be entered
into the fields and displayed on screen. A file can have any number of
layouts, used for different purposes.

In 4th DIMENSION, layouts are designated to be used in two fundamental
ways—for input and for output. Generally, you use an input layout to enter
and modify information and to view a single record, and you use an output
layout to print and display information from several records. However, you
can use any layout for either input or output. Your database can feature a
single layout for both input and output, or a large number of layouts that
perform specific functions. Figure 3-3 shows an input layout and an output
layout.

People

First Name [First Name |

Last Name  [Last Name |

Department  [Department |

Salary Salar
Output layout I
Field label |Eirst Marne {Last Narne l[ﬁapav'trnent |Sa1arg
Field |F1rstlﬂame ”l_l_azt Manne J!fDenartment ||Salar'u ]
Figure 3-3
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Input and output layout

Every layout is associated with a file. The file with which the layout is
associated is called its master file. A layout can display fields from more
than one file, so one layout may provide data entry or display capabilities
for several files.
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A particular layout can use some of the fields in a file, or all of the fields.
You might have two input layouts, for example—one for use by a clerk
and one for use by supervisors—neither of which contains all the fields.
You might use another group of fields for the screen display, and yet a
fourth group for a printed report.

Some layouts use no fields at all. A dialog box that you create for a
runtime application is a layout, but it does not need to use any fields. It can
accept information through enterable variables. Figure 3-4 shows several
layouts for a single file.

People People
g}seff ?('j' First Name Fist ane
ellelds Last Name Last Name
) Department Department
Uses a field Satary Manager  [Manager ]
from another |
file 1
People
Uses some Enter a Name to search for:
. irs
Of the fleldS A First Name First Name
Last Name [fName ———u— |
T Department
the fields
(dialog box)

Figure 3-4
Several layouts for a file

Layouts can be modified at any time, whether or not you have entered data
into the database. Changes to a layout do not affect the data stored on disk
in any way.

Active Objects and Graphic Objects

There are two kinds of objects in a 4th DIMENSION layout: active objects
and graphic objects.

Active objects perform operations on data or provide a customized user
interface. Active objects include

m fields, including fields from other files
m objects (variables) for entering or displaying data
m Dbuttons for accepting, canceling, or deleting a record

m  buttons for moving to other records in the database or to other pages in
the layout

®m  objects such as radio buttons, check boxes, scrollable areas, graph
areas, and pop-up menus that use scripts to perform an operation
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Fields (active objects) People

Text (graphic object) —_First Name
Last Name

-[Salarg

Field labels
(graphic objects)

Thermometer (active
object)

Buttons (active
objects)

m  external areas that use programs written in other programming
languages

m thermometers, rulers, or dials that show relative values

m included layouts that display layouts from other files and subfiles

Graphic objects are geometric or textual elements that enhance the
appearance of the layout. Graphic objects include

m shapes, such as rectangles, ovals, circles

m text

m grids

m graphics from applications other than 4th DIMENSION

Figure 3-5 shows several objects on a layout, and identifies which are
active and which are graphic objects.

$0 $100,000

( 0K ][ Ca?cm

i

Border (graphic
object)

Figure 3-5

Active objects and graphic objects on a layout

All objects, whether active or graphic, are handled in the same way: they
are created by being drawn; they can be selected and moved or resized,;
they can be aligned to each other or to an invisible grid; and their
appearance can be changed.

Graphic objects have no impact on the data. You can create a graphic
object on a layout simply by drawing it and making any necessary
modifications to its appearance. For example, when you create a text area,
you draw the area, then you type the text you want to display. You can
change the text at any time, without affecting the data.

Active objects require instructions about their relation to the data. When
you draw an active object, 4th DIMENSION provides a dialog box that lets
you select and enter the necessary specifications. For example, when you
place a field on a layout, you draw the field area; then you instruct

4th DIMENSION which field you want to occupy the area. You can change
the appearance of the field on the screen (changing its font, style, and
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size). You can add data entry controls, and you can associate a script with
the field as well.

“Handling Layout Objects,” later in this chapter, gives detailed
information about working with objects. Chapter 4 provides complete
information about active objects.

Creating a New Layout

Layout... J:ﬁ:
-
et | Depar tments fglete
Expenses _
halag
New
W Done
Expand [ tnput Name: || J
f32:2¢
O Buiput ficiasss l |
Figure 3-6

You use one of nine layout templates provided by 4th DIMENSION to
create the layout. You can then use the Layout editor to modify the layout
to suit your needs. This section gives the basic steps for creating a layout.
Later sections provide detailed information about selecting fields, using
templates, and so on.

To create a new layout, follow these steps:

Choose Layout from the Design menu. Or double-click the filename bar of
the file for which you want to create a layout.

4th DIMENSION displays the Layout dialog box, as shown in Figure 3-6.

Layout dialog box

You use the Layout dialog box to create a new layout, to select an existing
layout to work on, and to establish other important specifications for a
layout.

4th DIMENSION highlights the first filename in the list of files.
Select any of the filenames to create a new layout for that file.

If you opened the Layout dialog box by double-clicking the filename bar
in the Structure window, 4th DIMENSION displays only that filename and
displays the names of its associated layouts beneath the filename.
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Field from master file —|

Relating field

Unrelated file

Select the file for which you want to create a new layout.

This will be the master file for the layout, the file to which the layout
belongs.

When you select a filename, the New button becomes active.
Click New.
4th DIMENSION displays the New Layout dialog box, shown in Figure 3-7.

-
New layout for Peopie (0 9 point

Font size: @ 12 point

Select fields:

Last Marne
| |Department [Departmentis]
Salary

omas co=

[Departments]

Related file

[Exp

E CusTom

Layout templates

Layout Name:

=] LagoutB

[ Enterable related fields

([ gspang | | setect || [ cancel | [ ok ]

Figure 3-7

New Layout dialog box

Every time you create a new layout, you use the New Layout dialog box.
This dialog box provides a list of all the files and fields in the database.
You can select any field to display in the layout. In addition, you can
choose from nine layout templates, set the font size, and name the new
layout.

All the fields from the master file are displayed in the “Select fields” panel.
Subfiles are displayed in bold. A related One file is displayed in brackets to
the right of the relating field, and all files (whether related or not) are
displayed in brackets below the fields from the master file. You select
fields for your layout from the “Select fields” panel.

Select the fields you want on your layout.

If you want to use all the fields from the master file, do not select any. If
you don’t select any fields, 4th DIMENSION acts as if all the fields from
the master file were selected.

For complete details about selecting fields for the layout, see “Selecting
Fields for the Layout,” the next section in this chapter.
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Select the template you want to use for your layout.

For complete details about selecting templates for the layout, see
“Using Layout Templates,” later in this chapter.

Select the default font size you want for your layout.

You can select 9-point or 12-point. This choice determines the default font
size for objects that display text. You can set a new default font size in the
Layout editor. You can also change the font size for any object in the layout.

Type the name you want to use for your layout.
You can enter up to 15 alphanumeric characters for the layout name.
Click OK. '

4th DIMENSION displays the layout in a Layout editor window. You can
customize the layout as necessary. For complete information about
customizing the layout, see “Handling Layout Objects,” later in this chapter
and all of Chapter 4.

Selecting Fields for the Layout

You select the fields that you want to appear in the layout in the New Layout
dialog box. You can select any field from any file in the database, except
picture fields. Picture fields must be added to a layout after it has been
created.

The order in which you select the fields determines the order in which they
first appear in the layout. You can move and modify fields after you create
the layout.

You can also add fields to the layout after it has been created.

Using the New Layout dialog box, you can create layouts that display fields
from

m the master file

m arelated One file (if the master file is the Many file in the relation)

You can create included layouts that display fields from
m subfiles of the master file
m arelated Many file (if the master file is the One file in the relation)

m unrelated files

Figure 3-8 shows how the various files and fields are displayed in the
New Layout dialog box.
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Field from master file

Select fields:

First Name
" - Last Name 1
Relatmg field IDepartment [Departments]
. Salary
Subfile Review
. [Departments]
Unrelated file [Exp 1
Related file
[
Figure 3-8

Files displayed in the New Layout dialog box
You can expand any file or subfile to display its fields and subfields.

The following sections explain how to select fields from the master file
and from a related One file, and how to create an included layout to
display fields from a subfile, a related Many file, or an unrelated file.

Selecting Fields From the Master File

If you do not select any fields before you create the layout,
4th DIMENSION includes all the fields from the master file in the new
layout, displaying them in the order in which they were created.

If you want to select fewer than all the fields, if you want to select fields
from a related file or a subfile, or if you want to change the order in which
fields are displayed in the layout, you must select the fields you want to
use.

To select fields from the master file, select the name of the first field that
you want to include in the layout, then click Select. Or double-click the
field name.

4th DIMENSION displays the order number “1” next to the field name.

If a field in the master file is a relating field, double-clicking does not
select it. Instead, it expands or collapses the related file’s list of fields. You
must select a relating field for the layout by selecting the field and then
clicking the Select button.

Repeat this step for each field you want to add to the layout. As you select
the fields, 4th DIMENSION displays the order number next to the field
name.
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Order
number select fields:

o = prf——d

[Departments]

[Departments]

[Expenses]

Figure 3-9
Selecting fields from the master file

To deselect fields, do the following:

m Select the name of the field and click Select. Or double-click the field
name.

4th DIMENSION removes the order number that appeared next to the field
name, and adjusts the remaining order numbers if necessary. If you select
the field again, 4th DIMENSION moves it to the bottom of the selection
order.

Selecting Fields From a Related One File

You can use fields from a related One file on a layout. The filename of a
related file is displayed in brackets next to the relating field.

To select fields from a related One file, follow these steps:
1. Expand the related file to display its fields.

You can expand the file by selecting the relating field and then clicking
Expand, or you can double-click the relating field.

2. Select the fields you want to use in the layout, including the fields from the
related file.

4th DIMENSION numbers the selected fields in order.

Notice that you cannot use the double-click shortcut to select the relating
field, since 4th DIMENSION takes that as a signal to expand and collapse
the related file’s field names. If you want to include the relating field in
your layout, you must use the Select button. You do not have to include the
relating field.

Figure 3-10 on the following page shows how fields are selected from the
One file in the New Layout dialog box.
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Figure 3-10

Selecting fields from a related file

If you want to enter data into the related fields, be sure that “Enterable
related fields” is selected.

“Enterable related fields” is selected by default. If you inadvertently
deselect the check box, you can set Enterable as a layout attribute for each
of the affected fields. For information about the Enterable layout attribute,
see “Data Entry Controls” in Chapter 4.

When you have completed the steps for creating a new layout and clicked
OK, as described earlier in this chapter, 4th DIMENSION creates a layout
that includes the fields from the related file. Figure 3-11 shows a layout
that displays fields from both a master file and a related One file.

People

Last Mame ast Mame |
Field; from master file First Mame |_[First Mame ]
in plain type

Salary Salar
Fields from Department Jepartment ]
relatgg file in Manager Manager |
bold type

Budget 1 Budget

Figure 3-11
Layout that displays fields from a related file
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Using Included Layouts for Files and Subfiles

When you want to use fields from a related Many file, from a subfile, or
from an unrelated file, you use an included layout area. The included
layout area can display several records at once. 4th DIMENSION can
automatically create an included layout area for fields you select in the
New Layout dialog box.

Using an included layout area allows you to view the related records or
subrecords. You can also enter information into records and subrecords
that are displayed in an included layout. Figure 3-12 shows how a layout
with an included layout area looks when displayed in the User
environment. '

Departments

Mame |Engineering

Fields from master file

Manager| |[Mr. Johnson

Budget 785000

First Name Last Name Salary
Records from efer Jones 38500
related Many file Ann Burke 42000
Included layout area l
Figure 3-12

Included layout area

You can display fields from a related Many file or an unrelated file in an
included layout area. If you include fields from a related Many file, the
relation determines which records are displayed in the included layout
area. If you include fields from an unrelated file, the current selection of
records from that file is displayed in the included layout area.

You can include subfields from a subfile in an included layout area. The
subrecords for the parent record are displayed in the included layout area.
To display different subrecords, the user must display a different parent
record.

For complete information about all the features of included layout areas,
see “Included Layouts™ in Chapter 4.
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Filenames in bold
with brackets

To create an included layout area with fields from a file or subfile, follow
these steps:

Select from the master file the fields that you want to appear above the
included layout area.

Expand the subfile, related Many file, or unrelated file from which you
want to use fields.

You can expand the file or subfile by selecting it and then clicking Expand,
or you can double-click the file or subfile. Figure 3-13 shows an expanded
file.

Select fields:

Narne
Manager

First Name
Last Name
Departrnent
Salary

[Expenses]

Figure 3-13
Expanding a file before selecting fields

Select the file or subfile as if it were one of the fields you want in the
layout.

In order to create the included layout area, you must select the file or
subfile you want to display in the included layout area. You cannot use the
double-click shortcut to select the file or subfile, since 4th DIMENSION
takes that as a signal to collapse the list of fields or subfields. To include
the file or subfile on your layout, you must use the Select button.

4th DIMENSION places an order number next to the file or subfile you
have selected. The order number is required; it indicates the location of the
included layout area in the layout.

Select the fields you want to use from the file you have expanded, or select
the subfields from the subfile you have expanded.

4th DIMENSION starts the order numbers for these fields or subfields from
number one again. This subsidiary order number applies to the order in
which the fields or subfields will be displayed within the included layout
area. Figure 3-14 shows fields from a related Many file selected.
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Order numbers ]
within the master file New layput ror Departments Font size: & ? puint
select fields: ® 12 point
s . |' ame ™1 ﬁ
Fields from master file Manager 2 semas ==
LBudget z
[[People] L4
. |__First Name 1
Expanded fields Last Name 2
from related [_ Salsy CusToM
Many file |[Expenses]
Order numbers within Layout Name:
the related Many file 5 [Includeq ]
[<d Enterable related fields
[ fspang ] [L Select ]] [ cancel | [ 0K ]
Figure 3-14
Selecting fields from a related Many file
5. Select any other fields you want to appear below the included layout.
When you have completed the steps for creating a new layout and clicked
OK, as described earlier in this chapter, 4th DIMENSION creates a layout
with an included layout area to display the fields or subfields. Only the
included layout area is displayed, not the fields or subfields you have
selected. The fields or subfields become visible when the layout is used in
the User or Runtime environment.
Departments
Fields from Harme e I
master file Manager | [Manager

Budget

[Feople]

Included layout area

Figure 3-15
Layout with included layout area for related records
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Output layouts

Input layouts

Using Layout Templates

The 4th DIMENSION layout templates are displayed on the right side of
the New Layout dialog box. 4th DIMENSION uses the template you select
as the basis for the layout.

CusTom
= | |
Figure 3-16

Nine layout templates

The first eight templates produce automatic layout designs.

4th DIMENSION creates the layout for you, incorporating the fields
you have chosen. Each layout template uses a graphic design that you
can modify and adapt to your own needs. The Custom layout template
is an empty layout. You add all the fields and layout elements.

Although layouts can be used for either input or output, the templates are
designed to fit specific needs. Here are some guidelines:

m  Use the single-line templates (1-3) for output—for printed reports or
screen display. These layouts let you display records in tabular form
which makes it easy to view multiple records.

m  Use the boxed templates (4-8) for input—for entering records. In
these layouts, records appear one at a time. They are designed for
entering single records.

To select a layout template, click one of the nine layout templates
displayed on the right side of the dialog box.

4th DIMENSION highlights the selected layout template. You can select
any template until you click OK to create the new layout.

Template Choices

Each template provides a distinct layout design. Template 7 provides
automatic buttons for handling records; it is discussed at the end of this
section. Figures 3-17 through 3-24 show the type of layout produced by
each of the layout templates.
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Figure 3-17 Figure 3-18 Figure 3-19
Template 1 as an Template 2 as an Template 3 as an
output layout output layout output layout
Employees Employees
Last ame

First Mame Tom

Start Date 1/5/87

Start Date 1/5/87 ;

Figure 3-20 Figure 3-21 Figure 3-22
Template 4 as an Template 5 as an Template 6 as an
input layout input layout input layout
Employees 1

Last Mame

First Name |Tom

Start Date 1/5/87

7 Last Name Johnson

i | i First Name Tom

o Start Date 1/5/87
Figure 3-23 Figure 3-24
Template 7 as an Template 8 as an
input layout input layout

Template 7 provides automatic buttons to handle records. Each button
features a distinctive graphic that identifies its funciton.

First Previous Next

Last Delete Previous
Reciord Reciord Record Reclord Reci)rd Palge Palge

Next Enter
I I

Cancel

Figure 3-25

Automatic buttons on layout 7
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Each button is named; its automatic action is specified; and it has a unique
keystroke equivalent. For complete details about creating automatic
buttons, see “Automatic Buttons,” in Chapter 4.

The following table gives the keystroke equivalents assigned to each
button. For complete details about creating keystroke equivalents, see
“Setting a Keystroke,” in Chapter 4.

Table 3-1

Keystroke equivalents for automatic layout buttons
Button Keystroke

First Record None

Previous Record

Next Record
Last Record

Delete Record

Previous Page
Next Page
Enter
Cancel

Command-Left Arrow
Command—-Right Arrow
None

None

Page Up

Page Down

Enter key
Command—period

Establishing Input and Output Layouts

Each file has one current input layout and one current output layout.
They may be the same layout, or they may be different layouts. Typically,
you use a single-record layout for input and a multi-line layout for output.

You can change the input and output designations at any time. The user
can also establish which layouts to use for input and output, in the User
environment.

In the Layout dialog box, a letter “I”” appears next to the input layout
name, and a letter “O” appears next to the output layout name.
A “B” appears if one layout is used for both input and output.
Figure 3-26 shows how these letters appear in the Layout dialog box.

Input layout

Output layout

Layout for both

Layout...

f= Input

t= Output

Companies
In/Out
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I

|
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Figure 3-26

Input and output designations
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To designate input and output layouts, follow these steps:
Choose Layout from the Design menu.
4th DIMENSION displays the Layout dialog box.

Select the file whose layout you want to set and click expand to view the
layouts.

Select the layout you want to use for input.

Click the Input check box.

4th DIMENSION places an “I” next to the layout name.
Select the layout you want to use for output.

Select the Output check box.

4th DIMENSION places an “O” next to the layout name.

Deleting Layouts

You can delete any layout that is not currently designated as an input
layout or an output layout (or both). The Delete button is disabled when
you select an input or output layout.

Choose Layout from the Design menu.
4th DIMENSION displays the Layout dialog box.

Select the file whose layout you want to delete and click expand to view
the layouts.

Select the layout you want to delete.

When you select a deletable layout name, the Delete button becomes
active.

Click Delete.

4th DIMENSION asks you to confirm the deletion.
Click OK.

4th DIMENSION deletes the layout.
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Changing a Layout Name

You can change the name of a layout at any time.
To rename a layout, follow these steps:
Choose Layout from the Design menu.
4th DIMENSION displays the Layout dialog box.

Select the file whose layout you want to rename and click expand to view
the layouts.

Select the layout you want to rename from the list of layouts on the left
side of the dialog box.

Look at the thumbnail display to double-check that this is the correct
layout.

Edit the name in the Layout name box, or type a new name.
Click Done or Open.
4th DIMENSION changes the name of the layout.

ﬁ Note: Changing a layout name can invalidate any scripts, procedures,
or formulas that use the old layout name. Each such item has to be updated
in order to work.

Using the Layout Editor

After you create a layout, you can change anything in it. For example, you
can add fields to or remove fields from the layout. You can move, resize,
and otherwise modify any layout element until the design suits your needs
exactly.

This section provides an overview of the Layout editor and describes the
tools available for editing layouts. This section also explains how to open a
layout in the Layout editor, and describes how a page size is shown on the
screen. Subsequent sections describe in detail how to work with the
editor’s tools.
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Layout Editor Overview

4th DIMENSION’s Layout editor is a powerful graphics editor that includes
features for working with both graphic objects and active objects. Figure
3-27 shows the Layout editor window.

Output control

lios ® File Edit Use Design Layout Object Font Style

Layout: Custom

Palette of tools

Label width triangle

Rulers

Figure 3-27

Layout editor window

The Layout editor provides a large area in which you can work with
objects. The rulers on the side and bottom help you position objects in the
layout. You can change the units the ruler uses, so that it measures in
inches, centimeters, or points.

The palette of 22 icons provides tools that allow you to create graphic
objects for the layout, or add active objects, such as fields, buttons, and
included layouts.

The output control lines let you customize a layout for displaying and
printing database records. The label width triangle on the horizontal ruler
controls the width of a label when you create a layout for printing mailing
labels.

The layout menus added to the 4th DIMENSION menu bar provide
commands that allow you to change the data entry order of the fields; hide
and display the rulers; add a custom menu bar to the layout; control the
line width, fill pattern, and color of objects; and change the font and style
of the data as it is displayed.
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The Layout Palette

The layout palette provides a collection of layout tools for manipulating
and modifying the layout. Figure 3-28 shows the Layout palette.

_S“____ Arrow tool
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Figure 3-28
Layout palette
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Here is a list of the types of tools provided by the palette, with references
to the full discussion of their use.

m  Arrow tool: Used to select, move, and resize objects in the layout. See
“Handling Layout Objects,” later in this chapter, for complete
information.

m  Text Area tool: Used to create display text in the layout for labels,
titles, instructions, and so on. See “Text Areas,” later in this chapter,
for complete information.

m  Object tools: Used to draw graphic objects such as circles, lines, and
boxes. See “Handling Layout Objects,” later in this chapter, for
complete information.

m Included Layout tool: Used to create an area that displays records

from another file. See “Included Layouts,” in Chapter 4, for complete
information.

® Add Field tool: Used to place a field in a layout. See “Fields in a
Layout,” in Chapter 4, for complete information.

m Create Active Object tool: Used to create active objects such as
buttons, scrollable areas, pop-up menus, and thermometers. See
“Working with Active Objects,” in Chapter 4, for complete
information.
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m Layout Grid tool: Used to create a grid on which you can arrange a
series of objects. See “Aligning Objects,” later in this chapter, for
complete information.

m Alignment tools: Used to align objects in the layout. See “Aligning
Objects,” later in this chapter, for complete information.

® Layering tools: Used to move objects to the front or back in a set of
overlapping objects. See “Layering Objects,” later in this chapter, for
complete information.

m  Duplicate tool: Used to duplicate objects. See “Duplicating Objects,”
later in this chapter, for complete information.

m  Grid On/Off tool: Used to turn on or off an invisible grid to which
new objects are aligned. See “Aligning Objects,” later in this chapter,
for complete information.

m  Page tools: Used to move to the next page or previous page, or to add
additional pages to the layout. See “Creating a Multi-Page Layout,”
later in this chapter, for complete information.

The Layout Menu

Use the Layout menu to organize layout elements. Some Layout menu
options duplicate operations that you can perform by selecting icons on the
layout palette. Figure 3-29 shows the Layout menu.

Entry Order...
b ients on brid..

Turn Grid On
Hide Rulers %R

Define Grid...
Define Ruler Units...

enu bar...

Add to Layout...

feinte Page

Figure 3-29
Layout menu

®  Entry Order. Used to create a custom entry order for data entry
objects in an input layout. See “Data Entry Order,” later in this
chapter, for complete information.

m  Objects on Grid. Used to create a series of active objects on a layout
grid. See “Objects on a Grid,” in Chapter 4, for complete information.
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m  Hide Rulers/Show Rulers: Used to hide or display the rulers. See
“Moving Objects,” later in this chapter, for complete information.

m Define Grid: Used to define the scale of an invisible grid to which
objects are aligned. See “Aligning Objects,” later in this chapter, for
complete information.

m  Turn Grid On/Off: Used to turn on or off the invisible grid. See
“Aligning Objects,” later in this chapter, for complete information.

m  Define Ruler Units: Used to set the scale of the layout rulers. See
“Moving Objects,” later in this chapter, for complete information.

®  Menu Bar: Used to link the layout to a menu bar. See “Layout
Menus,” in Chapter 4, for complete information.

m Add to Layout: Used to return to the New Layout dialog box to add
fields to the layout. See “Creating a Multi-Page Layout,” later in this
chapter, for complete information.

m Delete Page: Used to delete a page from the layout. See “Creating a
Multi-Page Layout,” later in this chapter, for complete information.

The Object Menu

Use the Object menu to modify and manipulate layout objects. Some
Object menu commands display a submenu of choices. Figure 3-20 shows
the Object menu.

Line Width
Fill...
Border...
Color

Move to Front &F
Move to Back 3B

Hroup 43
ngroup HH

Position...
Align to Grid 8

Duplicate 30
format... K

Figure 3-30
Object menu

m Line Width: Displays a submenu of line-width choices for lines and
borders. See “Changing the Appearance of Objects,” later in this
chapter, for complete information.

m Fill: Displays a submenu of fill-pattern choices for objects. See
“Changing the Appearance of Objects,” later in this chapter, for
complete information.
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m  Border: Displays a submenu of border—pattern choices for objects.
See “Changing the Appearance of Objects,” later in this chapter, for
complete information.

m  Color: Displays a submenu of color choices for objects. See
“Changing the Appearance of Objects,” later in this chapter, for
complete information.

m  Move to Front: Used to move an object in front of all other objects.
See “Layering Objects,” later in this chapter, for complete
information.

m  Move to Back: Used to move an object in back of all other objects.
See “Layering Objects,” later in this chapter, for complete
information.

m  Align to Grid: Used to align an object to an invisible grid in the
layout. See “Aligning Objects,” later in this chapter, for complete
information.

®  Group: Used to combine multiple objects in the layout into groups
that you can manipulate as a single object. See “Grouping Objects,”
later in this chapter, for complete information.

m  Ungroup: Used to break grouped objects into individual objects. See
“Grouping Objects,” later in this chapter, for complete information.

m  Position: Used to redefine the boundaries of a selected object, thereby
changing its shape and location. See “Resizing Objects,” later in this
chapter, for complete information.

m  Duplicate: Used to duplicate objects. See “Duplicating Objects,” later
in this chapter, for complete information.

m  Format: Used to display the definition dialog box for a field, active
object, or included layout. See Chapter 4 for complete information.

The Font Menu

Use the Font menu to apply a font to objects in the layout, and to specify a
default font for text objects that you subsequently add to the layout. The
appearance of the Font menu depends on the screen fonts that you have
installed on your system.

See “Changing the Appearance of Objects,” later in this chapter, for
complete information.
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The Style Menu

Use the Style menu to apply a text style, alignment, and point size to
objects in the layout, or to specify these attributes as defaults for objects
that you subsequently add to the layout.

See “Changing the Appearance of Objects,” later in this chapter, for
complete information.

Opening a Layout in the Layout Editor

When you create a new layout, it is displayed in the Layout editor. You can
begin customizing it immediately. You can return to any layout to
customize it at any time, even after you have used it to enter data.

To open a layout in the Layout editor, follow these steps:

Choose Layout from the Design menu. Or double-click the filename bar of
the file that you want.

4th DIMENSION displays the Layout dialog box, as shown in Figure 3-31.
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Access: [All Groups ]

Figure 3-31
The Layout dialog box
4th DIMENSION highlights the first filename in the list of files in the

database. You can expand any of the filenames to display the layouts
associated with it.

If you double-clicked a filename bar in the Structure window,
4th DIMENSION displays only that filename and expands it to show
its associated layouts.
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If necessary, expand the filename that contains the layout you want to
work on.

You can expand the filename either by selecting the filename and clicking
Expand, or by double-clicking the filename.

Select the name of the layout you want to work on, and then click Open.
Or double-click the name of the layout you want to work on.

4th DIMENSION displays the layout in a Layout editor window.
Viewing and Printing Layout Pages

Each 4th DIMENSION layout has an area of about 144 square feet. You
scroll to bring hidden portions of the layout into view.

Table 3-2 gives the maximum layout page dimensions in all three layout
measurement scales.

Table 3-2
Layout dimensions

Dimension Points Cerntimetgrs Irjgtiaisi
Horizontal 10,400 367 144
Vertical 10,250 362 142

For viewing on screen, your layout design can use this entire area. You can
view any element you place in the layout.

For printing, layout elements must fit across a single page, but may be
several pages in length. The actual size of a page depends on your printing
device, the paper it is using, and the specifications you enter in the Page
Setup dialog box. 4th DIMENSION displays page border lines in the
Layout editor. These lines indicate the page limits. The page border lines
respond to any page setup changes. The page setup specifications are
stored with the layout when it is closed. Figure 3-32 on top of the
following pageshows the page border lines.
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Figure 3-32
Page border lines show area that can be printed

Handling Layout Objects

You customize a layout by creating and manipulating objects in the layout.
You use the Layout editor to draw the objects, modify them, arrange them,
and delete them.

You can select and modify any object in a layout, including fields and
graphic objects created with a template.

Selecting Objects

Before you can perform any operation on an object (such as changing a
line width or font), you need to select the object that you want to modify.

To select an object, follow these steps:
Click the Arrow tool in the layout palette.

When you move the cursor into the layout area, it becomes a standard
arrow-shaped pointer.

Click the object you want to select.

Four resizing handles identify the selected object. To deselect an object,
click outside the object’s boundary, or Shift-click the object.
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Selecting Multiple Objects

You may want to perform the same operation on more than one layout
object—for example, to move the objects, align them, or change their
appearance. 4th DIMENSION lets you select several objects at the same time.
There are two ways to select multiple objects:

m Hold down the Shift key and click the objects you want to select.

m  Start at a location outside the group of objects you want to select, and
drag a selection rectangle around the objects. You must start dragging in
an area that contains no objects.

You can draw a selection rectangle (sometimes called a marquee) by using
the arrow pointer. It is a temporary rectangle whose only purpose is to select
objects it surrounds or touches.

When you release the mouse button, if any part of an object lies within
the boundaries of the selection rectangle, that object is selected. Figure 3-33
shows a selection rectangle being drawn to select several objects.

Layout: Custom ="—"——— 1=

Figure 3-33
Selecting objects with a selection rectangle

ﬁ Tip: If you hold down the Control key while you draw a selection rectangle,
the editor will select only those objects that are completely enclosed by the
rectangle.

To deselect an object that is part of a set of selected objects, hold down the
Shift key and click the object. The other objects remain selected. To deselect
all the selected objects, click outside the boundaries of all the objects.
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Moving Objects

You can move any graphic or active object in the layout, including fields
and objects that 4th DIMENSION provided in the original layout.

When moving an object, you have two options:

®  Move the object by dragging it.

®  Move the object one pixel at a time with the arrow keys.
To move an object by dragging, follow these steps:

Select the object or multiple objects you want to move.

Move the pointer over the selected object or one of the objects in a
selected set of objects, and drag to the new location.

4th DIMENSION displays markers that show the location of the object’s
boundary in the rulers, so that you can place the object exactly where you
want it.

Be careful not to drag a handle. Dragging a handle resizes the object.
Release the mouse button to complete the move.

Figure 3-34 shows an object being dragged to a new location.
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Figure 3-34
Moving an object

To move an object one pixel at a time, follow these steps:
Select the object or multiple objects you want to move.
Use the arrow keys on the keyboard to move the object.

Each time you press an arrow key, the object moves one pixel in the
direction of the arrow.
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Resizing Objects

You can change the size of any object that appears in the layout window.
4th DIMENSION lets you stretch or shrink objects on the layout.

When resizing objects, you have two options:
m Resize an object by dragging a resizing handle.

m  Use the Position command to enter pixel coordinates for a rectangle
that defines the object’s dimensions.

To resize an object by dragging, follow these steps:
Select the object you want to resize.

Move the pointer over one of the four handles that appear on the selected
object.

The pointer changes into a multi-directional arrow.

Drag the handle toward the center of the object to shrink it, or away from
the object’s center to enlarge it.

4th DIMENSION resizes the object.

As you drag the handle, the corner of the object opposite the dragging
handle remains stationary.

Figure 3-35 shows an object being resized.

Layout: Custom ——EE};]
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Figure 3-35
Resizing an object

ﬁ Tip: If you press Shift and then drag the handle, the movement is
constrained. Lines can then be only vertical or horizontal; rectangles can
then be only square, and ovals can then be only circular.
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To resize an object by position, follow these steps:

Select the object you want to resize, and then choose Position from the
Object menu. Or hold down the Control key and click the object.

The “Object coordinates™ dialog box appears, displaying the selected
object’s coordinates in pixels, centimeters, or inches (depending on the
ruler units). Each pixel corresponds to a dot on the screen. The upper-left
coordinates of the layout area are 0,0. Figure 3-36 shows the “Object
coordinates” dialog box.

Object coordinates...
[61
201 305
146 I
[ Cancel ] [[ 0K ]]

Figure 3-36
The “Object coordinates” dialog box

Enter new values in the coordinate entry areas and click OK.

4th DIMENSION moves the boundaries of the object to the positions you
defined in the dialog box. The effect is to resize and/or move the object.

Using the Rulers

The 4th DIMENSION Layout editor rulers extend the entire height and
breadth of the layout, so you can always see where you are. Use the rulers
to position objects in precise locations.

You can hide the rulers to acquire more working space in the Layout editor
window. You can display the rulers again when you need them.

You can change the units the rulers use, to suit your preference.

The rulers contain markers that show the position of the pointer when
creating or resizing an object. While you are moving the object, the
markers change to show the top and bottom of the object, and the left and
right sides. Figure 3-37 shows the rulers and object markers.
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Figure 3-37
Object markers in the rulers

The object markers allow you to align other objects to the same position
on the rulers.

To hide or display rulers, choose Hide Rulers (or Show Rulers) from the
Layout menu.

To define ruler units, follow these steps:
Choose Define Ruler Units from the Layout menu.

4th DIMENSION displays the “Define units” dialog box, shown in
Figure 3-38.

Define units...
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Figure 3-38
“Define units” dialog box

Click the measurement scale you want to use

m  Click Points to display rulers that provide measurement in printer’s
points. One point is equal to the width of one pixel. There are
72 points in an inch.

m  Click Centimeters to display metric scale rulers.

m  Click Inches to display rulers that use feet and inches.
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3. Click OK.

4th DIMENSION changes the measurement units to the scale you have
selected. The Object Coordinates dialog box uses the same units. For
information about this dialog box, see “Resizing Objects,” earlier in this
chapter.

Drawing Objects

Use the tools provided on your layout palette to add active objects and
graphic objects to your layout. You select the type of object to draw by
clicking the appropriate icon in the palette. Figure 3-39 shows the drawing
tool icons on the layout palette.

Line e
Oval | A Text
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Create Included area % _— Add Field
Create Active Object BH Layout Grid

Figure 3-39

Object icons on the layout palette

m Line tool: Used to draw a straight line. The line is drawn with the
current line width.

m  Oval tool: Used to draw an oval. The oval is drawn with the current
line width and fill pattern.

m Text Area tool: Used to create a static text area anywhere in the
layout. Use the text tool to add elements such as field labels and
instructions.

2 Rounded Rectangle tool: Used to draw a rectangle with rounded
corners. The rectangle is drawn with the current line width and fill
pattern.

m  Rectangle tool: Used to draw a rectangle. The rectangle is drawn with
the current line width and fill pattern.

2 Included Layout tool: Used to draw an area in which to display
layouts from subfiles or other files.

® Add Field tool: Used to to draw an area for a field in the layout.

m  Create Active Object tool: Used to draw an area for an active object

on the layout.
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m Layout Grid tool: Used to to draw a visible grid in the layout. The
grid is drawn with the current line width and fill pattern.

To draw an object, follow these steps:

Select the type of object you want to draw by clicking its icon in the
palette.

The pointer becomes a crosshair when it is in the layout portion of the
layout window, indicating that you can use the mouse to draw the object.
The pointer becomes an arrow again when it is positioned over a menu,
ruler, or the palette, so that you can use it to select.

Drag to create an area for the object.

For two-dimensional objects (ovals, rectangles, fields, grids, text areas,
active objects, and included layout areas), drag diagonally. These objects
are created within a dotted rectangle that follows the pointer as you drag it.
Lines are created between the beginning and end points. Text areas are
sized in steps according to the current font and size. Figure 3-40 shows an
object being drawn.
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Figure 3-40
Drawing an object

ﬁ Tip: Press Shift as you draw to constrain the object to a regular shape.
Ovals are constrained to circles; rectangles are constrained to squares;
lines are constrained to horizontal or vertical.

When you have created a satisfactory area or line, release the mouse
button.

4th DIMENSION creates the object. It is the currently selected object. The
Arrow tool is automatically selected, and the pointer becomes an arrow.

CHAPTER 3: CREATING AND MODIFYING LAYOUTS 99



100

If you created an active object or a layout grid, 4th DIMENSION also
displays a dialog box for additional information.

ﬁ Tip: When you draw several objects of the same type, you may want to avoid
having to click the icon each time you want to draw. If you hold down the
Command key when you click the layout area, the editor automatically selects
and uses the last object tool you used.

Grouping Objects

Group has handles and
individual objects do not
have handles

4th DIMENSION lets you group objects so that you can select, move, and
modify the group as a single object.

Objects that are grouped retain their position in relation to each other. You
would typically group a field and its border, an invisible button and its
icon, and scrollable areas that you use in tandem.

When you resize a group, all the objects in the group are resized
proportionally (except text areas, which are resized in steps according to
their font sizes).

Groups can be part of other groups. Figure 3-41 shows objects grouped.
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Figure 3-41
Several objects grouped

You can ungroup a group of objects to treat them as individual objects
again.

An active object that has been grouped must be ungrouped before you can
change its definition or script.

Grouping affects objects only in the Layout editor. In the User
environment, grouped objects act exactly the same as if they were
ungrouped.
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To group objects, follow these steps:

Select the objects that you want to group.

Choose Group from the Object menu.

4th DIMENSION marks the boundary of the newly grouped object with
handles. No handles mark the boundary of any of the grouped objects.

Now, when you modify the grouped object, you change all the objects that
make up the group.

To ungroup an object, follow these steps:

Select the grouped object that you want to ungroup.

Choose Ungroup from the Object menu.

If Ungroup is dimmed, this means that the object is already separated
into its simplest form.

4th DIMENSION marks the boundaries of the individual objects with

handles.

Aligning Objects

The Layout editor’s alignment tools and grid tools let you align objects to
each other or to an invisible grid on the layout. When you align an object
to another object, you can align it to the top, bottom, side, or horizontal or
vertical center of the other object. When you use the invisible grid, you
can align an object or collection of objects to grid points on the layout.

Using the Alignment Tools

The alignment tools on the layout palette, shown in Figure 3-42, allow you
to quickly align selected objects with each other.

Align Left

Align Center Horizontal

Align Top

Figure 3-42
Alignment tools on the layout palette

The arrangement of dashes on the icons represents the function of each
tool. For example, the Align Right tool shows the dashes aligned vertically
on the right side. The Align Center Vertical shows the dashes aligned

vertically

in the middle.
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Obijects aligned left

In a set of objects, 4th DIMENSION aligns the collection to the backmost
object. You use Move to Back to establish the base object.

Figure 3-43 shows aligned and unaligned objects.
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Figure 3-43
Aligned and unaligned objects

To align a set of objects, follow these steps:
Select the object to which you want the other objects to align.

Click the Move to Back icon, or choose Move to Back from the Object
menu.

4th DIMENSION uses the backmost object as the base object. Other objects
are aligned to it.

Select the objects that you want to align to the first object.

You can select one object or several objects. For information about
selecting objects, see “Selecting Objects,” earlier in this chapter.

Click the Alignment tool that corresponds to the alignment you want.

4th DIMENSION aligns the selected objects according to the alignment you
selected.
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Using the Invisible Grid

4th DIMENSION provides a grid of invisible horizontal and vertical lines
that help you place and align objects in a layout.

You can

m specify the dimensions of the grid

m turn the invisible grid on or off

If you add an object to the layout while the grid is on, the object’s upper
left corner is positioned at an intersection of the grid.

Existing layout objects are not aligned to the grid when it is turned on.
Instead, each existing object is automatically aligned to its relation to the
nearest intersection. If you then move the object, it aligns to the
intersections of the grid using the same relation. To align these objects to
the new grid, you use the Align to Grid menu command.

Fiéure 3-44
An invisible grid to align objects

To define the invisible grid, follow these steps:
Choose Define Grid from the Layout menu.

4th DIMENSION displays the “Define grid” dialog box.

Define grid...

H-axis steps (in points):
Y-axis steps (in points):
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Figure 3-45
“Define grid” dialog box
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Hide Rulers %R

Font Style
Line din »
Fill... »
Border... »
Color b

Move to Front 3F
Move to Back 3B

Hroup b
dagroup HEH

Enter a number of points (72 points to an inch) for each step on the x-axis
and y-axis.

Grids are always defined in points.

In effect, you are defining rectangles that are x points wide and y points
high. For example, you might specify 10 points for x-axis steps and
20 points for y-axis steps.

If you want the x-axis and y-axis steps to be equal, enter identical point
values in the boxes.

The fewer the number of points in a step, the denser the grid. Whatever the
density of the grid is, it is always invisible.

Click OK to accept the grid settings.
Click Cancel to cancel the settings.

To turn the grid on and off, click the Grid On/Off tool on the layout palette
to turn it on.

The Grid On/Off tool is highlighted when it is on, and dimmed when it is
off.

You can also turn the grid on and off by choosing Turn Grid On (or Turn
Grid Off) from the Layout menu.

If you choose Turn Grid Off, the Grid On/Off tool on the layout palette is
dimmed. If you choose Turn Grid On, the Grid On/Off tool is highlighted.

To align existing objects to the grid, follow these steps:

With the grid turned on, select the object or objects you want to align to
the grid.

Choose Align to Grid from the Object menu.

4th DIMENSION aligns the upper-left corner of the object, or of each
object, to the nearest point on the invisible grid.

If you subsequently move the objects, they snap to align with intersections
of the invisible grid.

Duplicating Objects

Position...
Align to Grid

Duplicate *®D
Farmat.., B3 4

You can create exact duplicates of any object in the layout, including
active objects.

Each duplicate is a complete copy of the original object, and retains all the
features of the original. Copies of active objects, such as fields and
buttons, retain all the specifications for the original, including name, type,
action, display format, and any script associated with the object.
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If you duplicate an object, move the copy to another location in the layout,
and then duplicate the copy (without selecting something else first), the
second copy is automatically placed in the same relation to the first copy
as the first copy was in relation to the original object. Figure 3-46 shows
the same relative placement of the second copy.

Original object ‘—-
First copy —.
Copy moved to new

Second copy

automatically placed

in relation to its

original Figure 3-46
Relative placement of duplicated objects

To duplicate an object, follow these steps:

1. Select the object or objects that you want to duplicate.

=1 2.  Click the Duplicate tool on the layout palette. Or choose Duplicate from
"""" the Object menu.

4th DIMENSION creates an exact copy of each selected object and places
:::9 Width : the copy in front and slightly to the side of the original.
gg;’fr“' : 3. Move the copy (or copies) to the desired location.
Moive To Frant RS If you choose Duplicate again, 4th DIMENSION creates another copy of
Move to Back B each object, and moves it the exact same distance and direction from the
§eoup %6 first copy.
#ngroup HH . .

Copying All the Objects on a Layout
Position...
Align to Grid 34 You can copy all the objects in a layout page, some of them, or one object.
Dinticats You can use the copied objects in another 4th DIMENSION layout, in the
farmat... K same database or in another database.

You can copy objects and save them in the Scrapbook for later use. For
example, suppose you create several custom buttons. You can use the same
buttons in any layout in any database, simply by copying them to the
Scrapbook and then pasting them into another layout.
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Each copy is a complete copy of the original object, and retains all the
features of the original. Copies of active objects, such as fields and
buttons, retain all the specifications for the original, including name, type,

action, display format, and any script associated with the object.

ﬁ Note: A script copied with an object and placed in a different context may

lose its meaning unless it is updated. For example, if you copy an object with
a script that refers to a field, and if you place the copy of the object in a
database that does not have that field, the script loses its meaning.

To copy all the objects in a layout, follow these steps:

Choose Select All from the Edit menu.

4th DIMENSION selects every object on the current layout page.
Choose Copy from the Edit menu.

4th Dimension places a copy of the layout on the Clipboard.
Create a new layout, using the Custom template.

The new layout is blank.

Choose Paste from the Edit menu.

The new layout is an exact copy of the previous layout page. The output
control lines are not associated with objects, so they must be positioned on
the new layout. See Chapter 5 for information about output control lines.

Layering Objects

As you add objects to your layout, you will sometimes have to rearrange
objects that are obstructing your view of other objects in the layout.

For example, you may have a graphic that you want to appear behind the
fields in a layout. 4th DIMENSION provides two commands, Move to Back
and Move to Front, that let you “shuffle” objects in the layout window.
Figure 3-47 on the following page shows objects in front of and behind
other objects.
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JIIIT}
Ll

Layout: Custom

Figure 3-47
Layered objects

To move an object to the back, follow these steps:

Ef_'l 1. Select the object or objects that you want to move to the back.
2. Click the Move to Back tool on the layout palette. Or choose Move to
- e 4 Back from the Object menu.
totor : 4th DIMENSION moves the selected object or objects behind all the other
Move to Front 3F layOUt ObjeCtS'

MInE LS S ﬁ Note: When you move an object to the back it may be hidden by objects in

front of it. To see the object, select the object in front and send it to the back.

To move an object to the front, follow these steps:

1. Select the object or objects that you want to move to the front.

Click the Move to Front tool on the layout palette. Or choose Move to
Front from the Object menu.

r |

Line Width »
Fill... b
Border...

»
Color » 4th DIMENSION moves the selected object or objects in front of all the

obe T Tt other layout objects.

Move to Back B Deleting ObjeCtS

You can delete any object in a layout. If you want, you can have

4th DIMENSION place a copy of the deleted object on the Clipboard.
Objects placed on the Clipboard can later be pasted to new locations in the
layout.

1. Select the object or objects you want to delete.

2. Choose Clear from the Edit menu. Or press the Delete (Backspace) key on
your keyboard.
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4th DIMENSION deletes the selected object or objects.
Or choose Cut from the Edit menu.

4th DIMENSION removes the selected object or objects and places
a copy on the Clipboard.

If you change your mind, choose Undo from the Edit menu.
4th DIMENSION restores the deleted object or objects.

Changing the Appearance of Objects

You can change the appearance of any object in a layout. For any object
that uses text (a field, a text area, a button, and so forth) you can change
the ‘

m font
m style
m size

m alignment within the object’s area

For any object that uses lines, fill patterns, or colors, you can change the
® line width

= fill pattern

m border pattern

m color

When you create any object, 4th DIMENSION uses the default settings for
these features. You can establish new default settings at any time.

For example, if you establish a new default font, 4th DIMENSION uses that
font for any object you subsequently create that displays text.

You can change the settings for a selected object, without changing the
default settings. 4th DIMENSION changes the appearance of the selected
object, but the change affects only that object. 4th DIMENSION continues
to use the default settings for objects created in the layout.

For example, if you change the font for one text area, the change affects
only that area, not subsequently created fields or text areas.

This section gives the basic steps for establishing default settings, and for
changing the settings for selected objects. It then describes in detail each
option for the appearance of objects in a layout.
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To establish default settings, follow these steps:

Make sure that no object in the layout is selected.

Use the commands in the Font, Style, and Object menus to choose the
font, size, style, text justification, line width, fill pattern, border pattern, or

color.

To change a selected object, follow these steps:

Select the object or objects you want to modify.

Use the commands in the Font, Style, and Object menus to choose the
font, size, style, text justification, line width, fill pattern, border pattern, or

color.

The sections that follow describe the options in detail.

Fonts, Styles, Sizes, and Justification

You can specify the font, style, size, and text justification for any object
that uses text. These objects can include graphic objects, such as text areas
and labels. They can also include active objects, such as fields, buttons,
and variables that appear as text when the layout is displayed or printed.

You can specify any font and size supported by the Macintosh system
software that you are using. Typically you can make the style

m Plain
m Bold
m [talic

m  Underline
m Outline

m  Shadow

The font, size, and style settings apply to any text that appears in the

object.

4th DIMENSION also lets you specify how you want text or other data
justified in an object’s area. Justification applies to text within a text
object, and to data within active objects. There are four options for

justification:

m  Align on the right of the area.

m  Align on the left of the area.

m  Align in the center of the area.

m  Use the default justification. The default justification aligns numbers
to the right. Text, dates, and times are aligned to the left.
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Left-justified text

Figure 3-48 shows the different kinds of justification.

Right-justified text

Centered text

Default justification

Left-justified number

Line Width
Fill...
Border...
Color

Moue o front
Moue 1o Bagk

Gy Sy
gagroup el

Position..,
ftiga o brid S

0b je
Line Width p

Border... »
Color 4

Mpup o frapt e
Mutie 1o Bask %8B

SR

iy

Broup

NN

|[bEEE

Hagroup

Position...
fitigan o brid Hd

Black fill _

Gray fill

People
First Name [Tom
Last Name | Johnsan
Company | ABC Corp.
Salary | $35,600
Bonus |$1,000
Figure 3-48
Justification
Line Widths

4th DIMENSION lets you specify different line widths for lines and objects
that have lines—ovals, grids, and rectangles.

Choose one of the five line widths displayed in the Line submenu of the
Object menu. The first width is a hairline, the thinnest line your printer can
create.

If you choose Other, 4th DIMENSION displays a dialog box in which you
can specify any line width up to 72 points.

Fill Patterns

You can apply a fill pattern to any two-dimensional graphic object in the
layout—an oval, a rectangle, a line, a grid object, and the area enclosed
in a text object.

Choose one of the patterns displayed in the Fill submenu of the
Object menu. Double-clicking an object also displays the Fill submenu.
Figure 3-49 shows examples of areas filled with patterns.

Employee Information

First Name
Last Name
Company

Salary

Title

Figure 3-49
Fill patterns
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Border Patterns

TN You can set patterns for the borders of any object in the layout that has a
Fil L border—an oval, a rectangle, and a grid object. The border patterns
Color available to you are the same as the fill patterns. The appearance of

the border also depends on the line width you have specified for the
border.

Moue 1o Frant
Mpue 1o Bae

Broup
dngroup Bgti

=+ Choose one of the patterns displayed in the Border submenu of the Object
menu. Figure 3-50 shows examples of borders using different patterns.

Positian..,
ftign to brid

Bupticate B
faymat.,. b3

Figure 3-50
Border patterns

Creating a Border

4th DIMENSION lets you automatically create a box to surround and act as
a border for a selected object.

To create a border, follow these steps:
1. Select the object.

2. Hold down the Command key and type a number to specify how many
pixels you want between the object and the border.

4th DIMENSION draws the border, using the current line width and border
pattern.

For example, to obtain a standard Macintosh appearance, data entered in a
12-point Chicago font should have a 3-pixel border. You select the object
and press Command-3 to create the border.

Colors

4th DIMENSION lets you add colors to layout objects for display on a
color monitor or (if your printer supports color) for color printing. By
combining selected colors with fill patterns, you can display thousands of
different color shadings.

ﬁ Note: Colors usually appear black on a black and white monitor. They appear
as shades of gray on a gray scale monitor. The color palettes display shades
on a gray scale monitor.
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You can specify different colors for foreground pixels (“on” pixels that
appear black on a black-and-white monitor) and background pixels (“off”
pixels that appear white on a black-and-white monitor). On a color display,
the mixing of foreground and background colors allows you to create
custom tints and shades.

Choose the colors from the Color submenu of the Object menu. The upper
palette determines the color of the foreground, and the lower palette
determines the color of the background. Figure 3-51 shows the color
submenu.

Line Width
Fill...
Border...

Foreground

Move to Front
Move to Back

.
) %%ﬁlll!llll'glﬂi
ey frifsy
B EEEEEEEEE
LRI nEER
B
Position... m%muuhllllll
Align to Grid
: Background
Duplicate D—am 3
Farmat..,
Figure 3-51

Color submenu

If your monitor supports 16 colors, choose the colors from the first
16 colors on each palette. If your monitor supports 256 colors (or more),
any colors you choose will display properly.

ﬁ Note for advanced designers: If you copy a color palette resource into a
database structure, 4th DIMENSION uses that palette for the database.
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Text Areas

Use text areas to provide labels, titles, and descriptions in your layouts.

Em Layout: Text Objects —=——ooo-————0|
T

OlA; : - [

oo Title Lo

== I

=|EH Field Labels o :Field Labels : ;100

Z|E TField Labels | Field Labels )

= [ ) I

- F150

il {1 [

i "0ther Information such as on-screen [

=i instructions can be presented with a 1200

[:F] tent object. As you can see text objects

Lan contain as much text as you like.

250

Figure 3-52
Text objects

Text you create in a text area is different from the text contained in a Text

field. A Text field contains data stored in the database. The contents can be
different in each record. Text in a text area remains the same whenever the
layout is displayed. A text area is a graphic object; it is not active.

When you use a layout template to create a layout, 4th DIMENSION
automatically creates field labels for the fields. You can modify these
labels as you would modify any other text area you add to the layout.

As you draw a text area, it snaps to a size that reflects the font size.

After you create a text area, the text box displays a text insertion point.

Text Areal

Figure 3-53
Text area

Type text in the text area. When the text you are typing reaches the edge
of the text area, 4th DIMENSION automatically wraps the text to the next
line in the area.

If you enter more text than the area can display, the text is not visible until
you resize the text area.

You can edit text inside a text area with the standard Macintosh text
editing commands.
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To modify text in a text area, follow these steps:
Click the Text Area icon.
Select the text you want to modify, or click to insert an insertion point.

Use the standard Macintosh editing commands to edit the text.

Creating a Multi-Page Layout

You can create multiple pages for a layout. If you have more fields than
will fit on one screen, you may want to create additional layout pages to
display them. Multiple pages allow you to

m  Place the most important information on the first page, less important
information on other pages.

m  Arrange fields in smaller groups for easier use.
m Display the same information in different ways on different screens.
m  Reduce or eliminate scrolling during data entry.

m Provide space around the layout elements for an attractive screen
design.

ﬁ Important: Layout pages are a convenience used for data entry.
They are not for printed output. When a layout is printed, only the
first layout page is printed.

There are no restrictions on the number of pages a layout can have. A
practical limit may be about 10, which takes the user’s needs into account.
The same field can appear any number of times in a layout, and on as
many pages as you want.

This section tells you how to add and delete layout pages, how to move
from page to page, and how to add fields to a new page.

You can re-open the New Layout dialog box to select fields for the
additional pages, or you can place fields with the Add Field tool.

Adding a Layout Page

Every layout has a first page. 4th DIMENSION adds pages sequentially
after the last layout page. The current page number appears in a box in the
lower-right corner of the layout window.

Figure 3-54 shows a layout with several pages.
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Figure 3-54
Layout with multiple pages

To add a page, follow these steps:

FF;] 1. Move to the last page on the layout, then click the Next Page icon in the
layout palette.

4th DIMENSION displays a dialog box asking if you want to add a page.
2. Click OK to add another page to the layout.

A new, blank layout page appears in the Layout editor window. The page
indicator box in the lower-right corner of the window displays the number
of the page you are viewing.

You can now add fields and other layout elements to the new page.
Moving from Page to Page

When a layout has more than one page, you need to move from page to
page in order to work on the layout.

To move to the next page, click the Next Page icon on the layout palette.

To move to the previous page, click the Previous Page icon on the layout
palette.

iz ]33

4th DIMENSION displays the layout page immediately following or prior
to the current page.

If you click Previous Page while viewing the first page of the layout,
nothing happens.

If you click Next Page while viewing the last page of the layout,
4th DIMENSION asks if you want to create another page for the layout.
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Entry Order...
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Deleting a Layout Page

Turn 6rid On
Hide Rulers %R

Define Grid...
Define Ruler Units...

Menu Bar...

Add to Layout

Delete Page

Entry Order...
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Hide Rulers #R

Define Grid..
Define Ruler Units...

Menu Bar...

You can delete unwanted pages from a multiple-page layout. Any fields or
other objects on the deleted pages are deleted as well. The remaining pages
are renumbered. You cannot delete the first page.

To delete a page from the layout, follow these steps:

Click the Next Page or Previous Page icon to display the layout page you
want to delete.

Choose Delete Page from the Layout menu.

A dialog box appears, asking if you are certain that you want to delete the
page from the layout.

Click OK.

4th DIMENSION removes the layout page, and any objects on the page,
from the layout.

Adding Fields to a Layout

Every new layout page is blank. You add fields to a new layout page just
as you would to any new layout created with the Custom template.

You can add fields in the following ways:
m  Use the Add Field icon to place each field.

m  Copy fields from other pages or from other layouts, and paste them
onto this page.

m Use Add to Layout to return to the New Layout dialog box, in which
you can select fields, template, and font size.

The Add to Layout command allows you to add fields to a layout quickly.
Usually you use this command when you have added a new page, but you
can use it at any time to add fields to any layout.

To add fields with Add to Layout, follow these steps:

Choose Add to Layout from the Layout menu.

The pointer becomes a corner mark.

Click the upper-left corner of where you want the fields to be added.

4th DIMENSION displays the New Layout dialog box, as shown in
Figure 3-55 on the next page.
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Figure 3-55

New Layout dialog box after Add to Layout

Use this dialog box just as you did when you first created the layout. You
select the fields, designate the font size, and select the template you want.
In addition, you can change the master file by choosing from the Master
File pop-up menu.

You would change the master file only if you wanted to use a template to
add fields that look like they belong to the new master file. The title of the

layout frame will be the new master filename and the primary fields you
can select are from the new master file.

3. Click OK.

4th DIMENSION adds the fields to the layout where you clicked the corner-
shaped pointer. The added fields obey the font size and template choices
you made in the New Layout dialog box.

Figure 3-56 on the following pageshows fields added with a different
template and font size than were used to create the original layout.
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Figure 3-56
Added fields using a different template

You can modify the added elements just as you can any elements in a
layout.

Data Entry Order

The data entry order is the order in which fields, included layouts, and
other enterable objects are selected as you tab through an input layout.

If you don’t specify a custom entry order, 4th DIMENSION always selects
the upper-left object first, and moves right and down. If two objects are
exactly the same distance from the top, 4th DIMENSION selects the
leftmost object first. But, if an object is even one pixel higher than an
object to the left, the slightly higher object will have precedence.

In some layouts, a custom data entry order is needed. For example,

Figure 3-57 shows fields from an employee database. The fields are placed
in groups. However, the standard data entry order forces the user to enter
the information in an awkward way.
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Figure 3-57
Standard data entry order

The custom data entry order, shown in Figure 3-58, allows you to enter the
information in a more logical order.

lagout: Side Bg Side E§|
Employee Information:
Last Name Start Date I@
First Name  |First Marne#
[ Departmen; Departeent
Addr [Address d /
: Sal [Satar ]
city [y =—r}srfedevfEpved vk
il /

a1
Phone Spouse

Emergency Phone  [Emergesicy Phd Doctor

Figure 3-58
Custom data entry order

Viewing and Changing the Data Entry Order

The Entry Order command lets you view the current entry order of all
fields in a layout, and allows you to create a custom entry order.

1. Choose Entry Order from the Layout menu.

Entry Order... . . .
firray on Grid... The pointer turns into an entry order pointer (a small arrow), and
4th DIMENSION draws a line in the layout, showing the order in which it

selects objects during data entry.
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Viewing and changing the data entry order are the only things you can do
until you click an icon in the layout palette.

To change the data entry order, position the pointer on an object in the
layout and drag to the object you want next in the data entry order.

4th DIMENSION adjusts the data entry order.

Figure 3-59 shows the data entry order being changed.
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Figure 3-59
Changing the data entry order

Repeat step two as many times as necessary to set the data entry
order you want.

When you are satisfied with the data entry order, click an icon in
the layout palette.

4th DIMENSION returns to the Layout editor.

Setting the First Object in the Data Entry Order

All enterable objects are part of the data entry order. To establish one of
the objects as the first to be selected, follow these steps:

Choose Entry Order from the Layout menu.

Drag from the current first object to the object you want to make the first
object.

The desired first object becomes second in the data entry order.
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Drag from the desired first object to the current first object.

The desired first object becomes the first object, and the object that was
first becomes second. You can now drag from object to object in order to
create the data entry order you want.

When you have finished, click any icon in the layout palette.

Using a Data Entry Group

While you are changing the data entry order, you can select a group of the
objects in a layout so that the standard data entry order applies to the
objects within the group.

To create .a data entry group, follow these steps:
Choose Entry Order from the layout menu.

Drag a selection rectangle around the objects you want to group for data
entry.

When you release the mouse button, the objects enclosed or touched by
the rectangle take the standard data entry order. The data entry order for
the remaining objects adjusts as necessary.

Figure 3-60 shows several fields being selected as a data entry group.
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Figure 3-60
Creating a data entry group with a selection rectangle
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Figure 3-61 shows the resulting data entry order.
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Figure 3-61
Standard data entry order within the enclosed objects

Restoring the Standard Data Entry Order

You can restore the standard data entry order at any time.
Choose Entry Order from the Layout menu.
Drag a selection rectangle around all the objects on the layout.

When you release the mouse button, the objects enclosed or touched by
the rectangle take the standard data entry order.
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DESIGNING THE INTERFACE

4th DIMENSION allows you to control almost every aspect of the interface
between the user and the database. These aspects include: numeric
formats; maximum and minimum acceptable values for a field; and
buttons, menus, and other controls. You can use 4th DIMENSION to create
an interface that helps the user enter, view, and manipulate information
and navigate through the database.

This chapter tells you how to
m place fields and other active objects in the layout

m set display formats for fields and active objects that display numbers,
dates, or pictures '

m set data entry controls for fields and enterable objects, such as
maximum value, minimum value, or required values

m place buttons that accept, cancel, and delete records

m place buttons that move from record to record, or from layout page to
layout page

m add pop-up menus where appropriate

m add scrollable areas to display information

m create a grid of active objects

m use scripts to control fields and other active objects

®m use included layouts

® add custom menus to layouts

Interface Design Options

4th DIMENSION places no restrictions on how your layout is designed.

To begin entering and using information quickly, you can use the standard
interface provided by 4th DIMENSION. You can spend a little time making
adjustments to the layout so that it becomes more effective for your
specific database. Or you can take more time to create a sophisticated
interface that uses 4th DIMENSION'’s programming language. You can
design an interface that suits the purpose of the database and the context
in which it will be used.
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Accept button

Navigation icons

Standard date

Standard Interface

The standard layout templates are designed to work with the controls in
the User environment. The arrangement of fields, field labels, and borders
is one aspect of the interface. Another aspect is the set of controls in the
control panel. Figure 4-1 shows a typical layout used with the standard
4th DIMENSION controls.

= —————— El'ltl'y for Contacts %mg
——— Enter |
Contacts
First Name  |Joe
Last Name |Linbiatt

Date Entered  [5/25/89
Salary 2500

Delete |
Cancel

display format

el

&l [

Figure 4-1

Layout for data entry in the User environment

The Enter, Delete, and Cancel buttons work like standard Macintosh
buttons. They perform the essential tasks of accepting and deleting
records, and of canceling a record that has not yet been accepted.

The navigation icon allows the user to move to the previous record, the
next record, and the first record in the database.

The Next Page and Previous Page icons are dimmed in Figure 4-1,
because the standard 4th DIMENSION layout is a single-page layout. The
user can scroll around the page to find all the fields in a large layout. But
you can create a multi-page layout to work more easily with a large
number of fields. The Next Page and Previous Page icons then become
active in the control panel.

You can create your own buttons to replace the Enter, Cancel, and Delete
buttons, and to replace the navigation and page icons. You can place these
buttons in a layout without programming. For complete information, see
“Automatic Buttons,” later in this chapter.

The date and number display formats control the way dates and numbers
are displayed. The standard display formats are adequate for many
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purposes. You can set the display formats to suit your needs. For example,
you can include commas and dollar signs when dollar amounts are
displayed. For complete information, see “Field Display Formats,” later in
this chapter.

Custom Interface

4th DIMENSION provides interface design features that allow you to
change the interface quickly and without programming. These features can
make data entry faster, double-check and validate the entries themselves,
and provide an attractive and effective display of the information.

Figure 4-2 shows a layout that provides the same features as the standard
interface, but is arranged for the particular tasks required.

[ & File Edit Use Enter Select Report J
e Entry for Contacts e |
o

IRIEY Contacts

First Name Last Marne Keywords
[ | Joe ‘Lindblatt Distributor
Title: Manager

Company Name : ACer Paint Technology

9087 Industrial Boulevarad
Address

City, State, 2ip: San Carlos CA 197834
Location Hurnber Extension Comments
Work (415) 555-1284 K3 [6ood customer]
Beeper (415) 555-9563
-
%
K] =
Figure 4-2

Customized layout for data entry in the User environment

In this layout, custom buttons have replaced the control panel, fields have
been moved to more effective locations, display formats have been
changed, information from a related file is displayed in an included layout
area, and pages have been added to the layout. Invisible changes include
choice lists and default values that make data entry easier, data validation
controls that reduce errors, and keyboard shortcuts to use in place of the
buttons.

These kinds of changes can make a layout fit your needs more exactly.
And you can make all these changes simply by providing specifications
for the objects. 4th DIMENSION allows you to drag fields into place,
place additional fields and buttons, and create basic data validation
controls with little effort.
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Scrollable area

Radio buttons

Information about making these kinds of changes can be found in the
appropriate places in the remainder of this chapter.

Interfaces Using Scripts and Procedures

4th DIMENSION gives you the power to work with more complex
interface features. For example, you might need a scrollable list of choices,
or a graph that reflects values in a subfile, or icons that work like radio
buttons.

4th DIMENSION provides a programming language so that you can use
scripts to control fields, variables, and other objects in your layout. You
can attach a script to objects; the script is activated when the user selects
or changes the object on the screen.

You can also create global procedures that the user activates by choosing
menu items. You can add menus to the standard 4th DIMENSION menus
for a particular layout. Whenever that layout is displayed, the user can
choose from the menus to activate the procedure.

Figure 4-3 shows an example of a layout with features that use scripts to
control them. The layout includes a scrollable area, a graph area, an added
menu, and radio buttons. The layout also uses scripts that load values into
fields before a record is displayed, change a record in another file based on
entries in this layout, and save the other file’s record after the record is
accepted.

[ ® File Edit Use Enter Select Report ]
I=——— Entry for Contacts —=——————U=|1

| B [ Contacts

First Name Last Name Kl uords

] Joe ‘Lindblatt Distributor

Title: Manager

Company Mame: Acer Paint TEChl’IO]Dgg

9087 Industrial Boulevarad
Address

City, State, 2ip} SN Carlos CA 197834

Purchase History

oy cop

O)Net 10
) Net 30

Graph area

N

] ' =

Figure 4-3
Complex data entry layout
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For information about attaching a script to an object, see “Scripts,” later in
this chapter. For complete information about using the 4th DIMENSION
programming language in scripts and procedures, see the 4th DIMENSION
Language Reference.

Active Objects

4th DIMENSION uses two kinds of objects: graphic objects and active
objects. Graphic objects, such as borders, field labels, text areas, and titles,
perform no active function in the database. Active objects are important
elements of an interface, and are discussed in detail in this chapter.

In 4th DIMENSION, an active object is anything in a layout that performs a
database or interface function. There are many kinds of active objects.
Fields are the primary active objects. Other active objects—buttons,
enterable objects, pop-up menus, and so on—store data, invoke a
command, or perform some task such as moving from one record to
another. Included layouts let you view information from other files and
subfiles, and allow you to use their corresponding input layouts. Figure 4-4
identifies several active objects in a layout.

[ & File Edit Use Enter Select Report ]
I=—————ntry for Contacts =——————4

Buttons pp———— o
[ mpp]  Contacts
Pop-up menu i
First Name Last Name Keywords
| ] i Joe ‘Lindblatt i [pistributor
Field Title | Manager

Included layout area

Company Name : ACer Paint Technology

39087 Industrial Boulevarad
Address

City, State, Zipi San Carlos CA 59?834
Location Mumber Extension Commments
Wark (415) 555-1284 K [goed customer]
Besper (415) 555-9563
v e
Q] =) |
Figure 4-4

Active objects on a layout
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Format pop-up menu

Field list

Fields in a Layout

Fields provide locations in the layout where you can enter data into a
record or where you can display the contents of a record.

When you create a new layout with one of the standard layout templates,
you select the fields to include in the layout. Once the layout exists, you
can set specifications for each field. You can

= set display formats
m assign data validation controls

m attach a script

These specifications apply only to one layout. You can set the same
specifications for other layouts, or you can use different specifications. You
can modify the field specifications at any time, and you can place
additional fields in or delete fields from any layout.

Field Definition Dialog Box

Whenever you place a field in a layout, or modify the field specifications
for a layout, you use the Field Definition dialog box, shown in Figure 4-5.

- Field

I HomeState

Format display area

Data entry controls

HormeZip Code
Comments
Photo
Salutation
Title

Date Entered

=

130

- Data Entry
Entry filter:
Enterable
Mandatory
Chmc.es g:ﬁ'" Minimum:
Required [List... )
Excluded List... Manimunn

Text with scroll bar pefaut: [ |

[ Print variable frame [Script...] [Cance|] [( 0K 7]

Figure 4-5
Field Definition dialog box
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Here are the settings available in the Field Definition dialog box.

Field list: This list lets you select a field from any file in the database.
The fields at the top of the list are from the master file. The names of
the other files appear in brackets in the field list. You can expand any
filename to show its fields.

When you modify a field, you can exchange a field for any other field,
simply by selecting the field you want from this list. This is useful
when you have accidentally selected the wrong field in the New
Layout dialog box, or when you add several fields to a layout at the
same time with the Duplicate tool.

Selecting a field from the field list is described in “Placing Fields in a
Layout,” later in this chapter.

Display formats: When you select a Number, Date, Time, or Picture
field, 4th DIMENSION displays the possible formats for that field in
the Format pop-up menu. For example, if the selected field is a Date
field, the Format pop-up menu shows a list of date formats. You set the
display format by choosing it from the pop-up menu. When the format
is chosen, it is displayed in the format display area, where you can edit
it if necessary.

If the selected field is an Alpha or Boolean field, you set the display
format for the field by typing it in the format display area.

For complete information about display formats, see “Field Display
Formats,” later in this chapter.

Data Entry controls: Use the data entry controls to set attributes,
lists, a data entry filter, maximum or minimum values, or a default
value for the field. For complete information about data entry controls,
see “Data Entry Controls,” later in this chapter.

Script button: Use the Script button to attach a script to the field. For
information about scripts, see “Using Scripts,” later in this chapter.

Text with scroll bar: You select this check box to add a scroll bar to a
text field. The scroll bar allows the user to scroll hidden text into view.
For complete information about displaying a scroll bar for a Text field,
see “Adding a Scroll Bar to a Text Field,” later in this chapter.

Print with variable frame: You select this check box if you want the
Text or Picture field to expand during printing. For complete
information about printing with a variable frame, see “Printing With
Variable Frame,” later in this chapter.
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Placing Fields in a Layout

Fields from master file

When you first create a layout, you typically use one of the

4th DIMENSION layout templates to place the fields in the layout.
Occasionally, however, you need to place one or more fields in a layout
manually. You need to place fields manually in a layout when

m you are using a Picture field

m you discover you need a field you didn’t choose in the New Layout
dialog box

® you add a field to the database and need to add it to a layout so that
you can use it

m you select the custom template in the New Layout dialog box

When you place a field in a layout, you can immediately set a display
format, set data entry controls, or add a script.

To place a field in a layout, follow these steps:

If the field does not exist in the database, use the Structure editor to create
the field.

Open the layout to which you want to add the field.

In the Layout editor window, click the Add Field tool on the layout palette.
When you move the cursor into the layout area, it becomes a crosshair.
Position the crosshair where you want to place one corner of the field.

Drag diagonally to define the size of the field, and then release the mouse
button.

4th DIMENSION displays the Field Definition dialog box. You select the
field you want from the field list, shown in Figure 4-6.

Filenames that can
be expanded

Salary
Start date

t
eople] .
[Companies]

[Parts]

Figure 4-6

Selecting a field from the field list

If the field name you want is not visible, scroll the list until you see it. If
the field you want is in another file, double-click the filename to expand
the list of fields in that file, then select the field.
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6. Select the field you want from the field list.

When you select a field, 4th DIMENSION displays the possible formats for
the new field in the Format pop-up menu. For example, if a selected field is
a Date field, the submenu shows date display options.

7. (Optional) Choose any display format and data entry controls you want, set
printing and display controls for a text field, or attach a script to the field.

These are optional steps. You can perform them now, or return to this field’s
Field Definition dialog box at any time. The options available in this dialog
box are discussed in later sections of this chapter.

8. When you have finished, click OK.

The new field appears in the layout where you drew the field area. The field
area displays the name of the field you selected.

After you place a field in a layout, you can handle it as you would any other
layout object. You can resize it, change the font, choose colors for display
on a color monitor, and so on. And you can return to its Field Definition
dialog box to modify the field definition at any time.

ﬁ Note: Fields from the master file appear twice, once at the top of the list of
fields (beneath the empty brackets), and once in the filename’s expanded list.
If you select the field from the top list, 4th DIMENSION takes this to mean
“field in this position in the master file.” If you select the field from the
filename’s expanded list, 4th DIMENSION takes this to mean “this field from
this file.”

For example, if you select the third field from the top list, and then copy and
paste the field into another file's layout, in the new layout it would become the
third field in the new master file. If you select the field from the filename’s
expanded list, and then copy and paste the field into another file’s layout, it
would remain the same field from the same file.

Modifying a Field in a Layout

You can modify the field definition of any field placed in a layout. If the
field has been grouped with another object, you must ungroup it first.

F::}iwidth : To modify a field’s specifications, follow these steps:
Border... | 4 .
Color »| 1. Select the field you want to work with, and then choose Format from the

Object menu. Or double-click the field you want to work with.
Move to Front 38F

Move to Back  %B 4th DIMENSION displays the Field Definition dialog box for that field.

i;:f;fzw z You can change any setting. You can even select a new field to appear in
- the layout.

Position...

Align to 6rid ~ %J| 2 Make any changes you want, and then click OK.

Lol - 4th DIMENSION establishes the new specifications for the field.

Foemat...
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Field Display Formats

The display formats provided by 4th DIMENSION give you a convenient
and flexible method of arranging stored values for screen display and
printing. You can determine how the contents of any field except a Text
field should be displayed. The format you use to display the contents of a
field does not affect the actual value stored by 4th DIMENSION.

You define a display format appropriate to the purpose of the database and
the field itself. In a field that stores dollar amounts, for example, you might
display a number with dollar signs, commas, and two digits following the
decimal point. In a scientific database, you might want a number displayed
with 10 digits following the decimal point.

The display format for a field can be different in different layouts. For
example, you may want to show a value without dollar signs in an input
layout, and display it with dollar signs in an output layout.

You set display formats in the Field Definition dialog box. Different
formats appear in the Format pop-up menu, depending on the type of field
you select.

Date Field Formats

When you choose a date format, you control the way dates appear when
displayed or printed. For data entry, the user must enter dates in the
MM/DD/YYYY format, regardless of the display format. Figure 4-7 shows
date formats in the Format pop-up menu.

Short
Abbreviated
Long

Short 2

- Field

Title A
Entry Date 3]
Comments T
R
C

~ Data Entry
Entry filter:

Enterable
[ Mandatory
[Jchoices  [(List...] - ;
(JRequired  [List...) Minimum:
O Escluded [List...] Magimum:
O ¥est wsith scrnll bay Default:

[ #rint gariabie frams [script,_,] [Cancel] [[ 0K ]]

Figure 4-7
Choosing a date display format
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Table 4-1 shows the Date field display formats.

Table 4-1
Date Display Formats

Choice Example

Short 1/16/90 .
Abbreviated  Tues, Jan 16, 1990 -
Long Tuesday, January 16, 1990

Short 2 01/16/1990

Time Field Formats

When you choose a time format, you control the way times appear when
displayed or printed. For data entry, the user must enter times in the
24-hour HH:MM:SS format, or the 12-hour HH:MM:SS P format, regardless
of the display format. Figure 4-8 shows time formats in the Format pop-up
menu.

- Field
Entry Date D = =
Comments T HH MM 55 |
Bonus R HH:MM
Start Date D Hour MiniSec
Start Time H Hour Min
[Companies]
~ Data Entry
Entry filter:
[ Enterable
[1Mandatory
[ Choices —
[ Required
[ Excluded Maximum:
[ #esst szt scvnd bay Default:
[ #riat sariabie frams LSCriDt---] [ cancel } [[ 0K ]]

Figure 4-8
Choosing a time display format
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Table 4-2 shows the Time field display formats.

Table 4-2
Time Dlsplay Formats

Choice Example

HH:MM:SS 02:15:34 -
HH:MM 02:15

Hour Min Sec 2 hours 15 minutes 34 seconds
Hour Min 2 hours 15 minutes

H:MM AM/PM  2:15 AM

Number Field Formats

When you choose a number format, you control the way numbers appear
when displayed or printed. For data entry, the user must use numbers, a
decimal point if necessary, and a minus sign if necessary, regardless of the
display format. Number fields include Real, Integer, and Long Integer
fields. Figure 4-9 shows number formats in the Format pop-up menu.

#aw g :I
22 L#%0.00

E223 JBug mes g

san B8 00 aun ,#%0.00-
sus sw) (oum ""0)

#us wug (®we =20 00)

#un L#%0.00 uua ,##0 00CR
$cnnu w30 _$a#a 830

Start date
Call Tirne
Dept

I nata Entrg ?333’330 ($ass aum
= wEE SH0 00 -§HRE 80 00
::';s;:l::]erg ;### ##5 Qo (:883 2#0 DU)
[ Choices (List... o 00.00; .0,
[J Required List... | i y, 0.00)
7Y *¥¥ ¥50 00 *%¥ £30.00
[] Excluded List... | §x8% 120 00 (gnes H10.50)

[0 e wsith scradf bar : Lo **O'OD;VID'D

Oerint sarisbie frame (Script... ] [ cancel | [ ok )

Figure 4-9
Choosing a number display format

You can choose the format from the pop-up menu or type it in the format
display area. You can edit any number format in the format display area.
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Placeholders

In each of the number display formats, the number sign (#) Zero (O)

caret (1), and asterisk (* ) are placeholders. You use one placeholder for
each digit you expect to display. For example, if you want to display three
numbers, you could use ###. If the user enters more digits than the format
allows, 4th DIMENSION displays <<< in the field to indicate that there is a
disparity.

Each placeholder character has a different effect on the display of a
leading or trailing zero. (A leading zero is a zero that starts a number
before the decimal point; a trailing zero is a zero that ends a number after
the decimal point.) The # displays nothing; the 0 displays a zero; the *
displays a space; and the * displays an asterisk.

For example, suppose you used the format ##0 to display three digits. If
the user entered nothing in the field, the field would display 0. If the user
entered 26, the field would display 26.

If the user enters a negative number, the leftmost character displays as a
minus sign (unless a negative display format has been specified). So if ##0
were the format, a negative 26 would display as —26; a negative 260 would
display as <<< because the minus sign needs a placeholder to display and
there are only three placeholders.

Table 4-3 shows the effects of each placeholder.

Table 4-3
Number format placeholders

Placeholder  Effect for Ieading or trailing zero

# Displays nothing

0 Displays 0

A Displays a space (see note below)
*

Dlsplays an asterisk

Note: The caret (") generates a non-breaking (hard) space character
(ASCII 202), rather than the true space character (ASCII 20). This is
because a non-breaking space is the same width as a digit.

Decimal Point

You can use one decimal point in the format. If you want the decimal to
display whether or not the user types it in, it must be between zeros.
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Other Characters

You can use any characters other than the placeholders and the decimal
point in the format. If they are used alone, or placed before or after
placeholders, they always appear. For example, if the format were

$##0

a dollar sign would always appear because it is placed before all the
placeholders.

If characters are placed between placeholders, they appear only if digits
are displayed on both sides. For example, if you define the format

#Hit# ##0

a comma would appear only if the user enters at least four digits.
Spaces are treated as characters in number display formats.
Formats for Positive, Negative, and Zero

A number display format can have three parts. The three parts allow you
to specify display formats for positive, negative, and zero values. The
three parts are separated by semicolons:

Positive;Negative;Zero

If you use just one part, 4th DIMENSION uses it for all numbers, putting
a minus sign in front of negative numbers. If you use two parts,

4th DIMENSION uses the first part for positive numbers and zero, and the
second part for negative numbers. If you use three parts, the first is for
positive numbers, the second for negative numbers, and the third for zero.

Here is an example of a number display format that shows dollar signs and
commas, places negative values in parentheses, and displays nothing for
Zero:

$### #H0.00;(S### ##0.00);

The presence of the second semicolon instructs 4th DIMENSION to use
nothing to display zero. Here is a similar format:

S #0.00; (S###,##0.00)

The absence of the second semicolon instructs 4th DIMENSION to use the

positive number format for zero. In this case the display for zero would be
$0.00.
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If you want to display numbers in scientific notation, use the ampersand
(&) followed by a number to specify the number of digits you want to
display. For example, the format

Scientific Notation

&3

would display 759.62 as

7.60e+2
Note: The scientific notation format is the only format that will automatically
round the displayed number. Note in the example above that the number
rounded up to 7.60e+2 instead of truncating to 7.59e+2.

Number Styles

You can use a 4th DIMENSION style to enter a number display format.
Type a vertical bar followed by the style name in the format display area.
For example, the entry

IDollars
installs the style named Dollars as the display format for the field.

For information about creating styles, see “Creating Styles,” later in this
chapter.

Examples

Table 4-4 shows examples of how different formats affect the display of
numbers. The Displays Positive column shows how 1234.50 would be
displayed. The Displays Negative column shows how —1234.50 would

be displayed. The Displays Zero column shows how 0 would be displayed.
The tilde character (~) here represents an Option—space, used to show

that a space was entered or that 4th DIMENSION displays a space. The
Option—space key combination generates a non-breaking space (also called
a hard space). A non-breaking space is the same size as a number for all
fonts. Use non-breaking spaces to easily align formatted numbers.
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Table 4-4
Number field examples

Format Displays Displays Displays
Entered Positive Negative Zero
#it# << <<

HHHH 1234 <<

HEHHHAH 1234 —1234

HHHHH HH# 1234.5 -1234.5

####0.00 1234.50 —1234.50 0.00
H#HH##H#H0 1234 -1234 0
O, 00 +1234 -1234 0
####H#HODB  #####0CR; 0~ 1234DB 1234CR 0~
HHHHHO~; (HH##HH0) 1234~ (1234) 0~
### ##0 1,234 -1,234 0
## ##0.00 1,234.50 -1,234.50 0.00
AAAAAAA romins] 234 mm[234  mmersmis
AN ~~~1234 ~~—1234 o~ 0
ANN NN} ~~1,234 ~—1,234 =~~~ 0
AN AN)L00 ~1,234.50 -1,234.50  ~~~m~ 0.00
***’**O **1’234 *_1’234 ******0
* k40,00 *1,234.50 —-1,234.50 *EE*%0.00
$*,*%0.00;—$*,**0.00 $1,234.50 -$1,234.50 $#*%%0,00
$ANAN) $~1234 $-1234 $~~~~0
~SANN(;—SANN( ~$1234 -$1234 ~$~mn()
~$ANNO~; ($AN0) ~$1234~ ($1234) ~$~mn O~
~$AAN0.00~;($7,10.00) ~$1,234.50 ($1,234.50) ~$~~~~0.00
&2 1.2e+3 -1.2e+3 0.0e+0
&/ﬁ’é 1.23450e+3  -1.23450e+3 0.00000

Note: The <<< characters represent numbers too large for a given

format to display.
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Alpha Field Formats

When you type a display format for an Alpha field, you control the way
the alphanumeric characters appear when displayed or printed. Figure 4-10
shows an alpha format being entered in the format display area.

- Field

Start date
Call Time
[ept

Fhone Nurber

(###) ###-####1

[Companies]
[Parts]

~ Data Entry

Enterable
[JMandatory

[J Choices | List... |
[JRequired [List...]
[JExcluded [List... ]

Entry filter:

Default:

BT [St.ript...‘l [ Cancel |

Figure 4-10
Typing an alpha display format

You type and edit the format in the format display area.

The number sign (#) is the placeholder for an Alpha field display format.
You can include the appropriate dashes, hyphens, spaces, and any other
punctuation marks.

You use the actual punctuation marks you want, and the number sign for
each character you want to display.

For example, a U.S. telephone number display format would be,
(H#HE) HHHH-HHHE

When the user enters 1234567890, the field displays

(123) 456-7890

The field actually contains "1234567890".

If the user enters more characters than the format allows, 4th DIMENSION
displays the last characters. For example, if the format is

(##H)

and the user enters HAPPY, the field displays
(PPY)

The field actually contains "HAPPY".
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Alpha Styles

You can use a 4th DIMENSION style to enter an Alpha field’s display
format. Type a vertical bar followed by the style name in the format
display area. For example, the entry

[Phone
installs the style named Phone as the display format for the field.

For information about creating styles, see “Creating Styles,” later in this
chapter.

Boolean Field Formats

Boolean fields can contain one of two values, TRUE or FALSE. A Boolean
field can be displayed as either a pair of radio buttons or as a check box.
Figure 4-11 shows Boolean field formats in the User environment.

Boolean field

contains true ———————[X 21 or Older
Boolean field

contains false — [ Married

Check box label I

Boolean field name Sex ® Male (O Female

Radio button labels

Figure 4-11

Boolean display formats

If you do not create a display format for a Boolean field, 4th DIMENSION
automatically displays the field as a pair of radio buttons labeled Yes and
No, as shown in Figure 4-12.

Fieldname ——————pregnant? (O ves @ No

Figure 4-12

Standard Boolean field display

You use the format display area to create other labels for radio buttons, or
a check box with any label. If you want to display only the button labels,
and not the field name, you can delete the field label in the layout.



Display format entry

Result in User
environment

Formatting a Boolean Field as Radio Buttons

You format a Boolean field as a pair of radio buttons by entering two
labels in the format display area, separated by a semicolon. For example,
a field for sex could have one button named Male and one button named
Female. To create these buttons, you would type

Male;Female

The buttons are displayed side by side. If you use labels with different
first letters, the user can select the radio button by typing the first letter.
For example, the user can press M to select Male.

The following rules apply when the field is being used for data storage: If
the first button is selected, the field is TRUE; if the second button is
selected, the field is FALSE. The field is by default FALSE.

Figure 4-13 shows a Boolean field’s display format, and the result in the
User environment.

Field

8]
Married E ] I
Over 21 Male;Female
Blue Eyes

[Contacts]

[History]

Sey 1 ) Male @ Fema]el

Figure 4-13
Entering button labels for a Boolean field

You do not see the radio buttons and their labels in the Design
environment. They are visible in the layout in the User environment.

Formatting a Boolean Field as a Check Box

You create a check box by entering a single label in the format display
area. For example a field for Available Now could have one check box
labeled Yes. To create this check box you would enter

Yes

To create a check box with no label, enter a space in the format display
area.

The following rules apply when the field is being used for data storage: If
the check box is selected, the field is TRUE; if the check box is deselected,
the field is FALSE. The field is by default FALSE.
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Figure 4-14 shows a Boolean field’s display format, and the result in the
User environment.

Field
Sex
Over 21 Married
Blue Eyes :
[Contacts]
[History]

Display format entry

Result in User
environment Figure 4-14

Entering check box label for a Boolean field

| O Married I

You do not see the check box and its label in the Design Environment.
They are visible in this layout in the User environment.

Picture Field Formats

When you choose a picture format, you control the way pictures appear
when displayed or printed. For data entry, the user always enters pictures
by pasting them from the Clipboard, regardless of the display format.
Figure 4-15 shows picture formats in the Format pop-up menu.

- Field

Call Time
Dept
Phone Murnber

Truncated I
Scaled to Fit

On Background

[Peoplel
[Companies]
[Parts]

- Data Entry

[ Enterable
[0 Mangaioryg

O ¢ anisas

Eatry filter

[ &euuires M
SHEHELT st Marimum

[ £ e tusste ]

D est wsith scrad bay fatault

O Print variable frame  [script...] [ Cancel

Figure 4-15
Choosing a picture display format

When the user enters a picture into a Picture field, the entire picture is
saved in the database file. Only the display is affected by the display
format.
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Truncated

A Truncated format causes 4th DIMENSION to center the picture in the field
and crop any portion that does not fit within the field area. 4th DIMENSION
crops equally from each edge and from the top and bottom. Figure 4-16
shows a picture displayed in a field with a Truncated display format.

A. :

Figure 4-16
Truncated Picture field

Scaled to Fit

The Scaled to Fit format causes 4th DIMENSION to resize the picture to fit
the dimensions of the field area. Because 4th DIMENSION may have to
compress or elongate the graphic to fit the field, the picture may appear
distorted in the layout. Figure 4-17 shows a picture in a Picture field with a
Scaled to Fit format.

Figure 4-17
Scaled to Fit Picture field
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On Background

On Background makes the picture transparent. Any object behind the
graphic is visible through the graphic. When a Picture field is in this
format, the user can move the picture around the inside of the Picture field
by dragging. 4th DIMENSION remembers the position. Figure 4-18 shows
a field with an On Background format.

Figure 4-18
On Background picture field

ﬁ Note: Pictures that are stored in the On Background format are printed as
bitmaps.

Data Entry Controls

You can establish data entry controls for fields (and for enterable objects).
Data entry controls usually restrict what the user can enter into the field or
enterable object. You can

set the Enterable attribute or the Mandatory attribute
display a choice list

establish lists of required values or excluded values
set an entry filter that defines allowable characters
set maximum and minimum allowable values

set default values

add a scroll bar to text fields
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Setting the Enterable and Mandatory Attributes

You use the two layout attributes, Enterable and Mandatory, to control
fields in a layout. You can prevent a user from entering a value into a field
by deselecting the Enterable check box. And you can make an entry
mandatory by selecting the Mandatory check box. Figure 4-19 shows the
Enterable and Mandatory check boxes.

Data Entry —

(<] Enterable
[JMandatory

Figure 4-19

Layout attributes

If a field already has the “Display only” attribute assigned in the Structure
editor, you cannot make it enterable with the Enterable layout attribute. If
a field already has the Mandatory attribute assigned in the Structure editor,
you cannot make it non-mandatory by deselecting the Mandatory layout
attribute.

The Enterable Attribute

Every field is by default enterable. If you want to make a field
non-enterable for that layout, you can deselect Enterable.

A field from a related file may not be enterable, if you deselected
“Enterable related fields” in the New Layout dialog box. You can make
the related field enterable by selecting Enterable.

For enterable objects, the Enterable check box is dimmed. You can make
an enterable object non-enterable by changing the definition of the object
from enterable to non-enterable. For information about enterable objects,
see “Enterable and Non-enterable Objects,” later in this chapter.

The Mandatory Attribute

No field or enterable object is mandatory by default. If you want to
make a field or enterable object mandatory for a particular layout,
you canselect Mandatory.

Selecting Mandatory makes a field or enterable object mandatory for that
layout. 4th DIMENSION does not accept a record if the field or object does
not contain a value. For information about enterable objects, see
“Enterable and Non-enterable Objects,” later in this chapter.
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Assigning Lists

You can assign lists to a field or enterable object in a layout. The list can
serve as a choice list, as a list of required entries, or as a list of excluded
entries. Figure 4-20 shows the List check boxes.

Lists...

Hotels
Airlines

]

[ Cancel ] [[ Select ]]

Figure 4-20

Lists for fields and enterable objects

Assigning a list through the Layout editor gives you the freedom to vary
data entry from layout to layout. For example, a field in one input layout
can display a choice list, while the same field in another layout does not
present a list.

You can assign a list as a field attribute in the Structure editor. The list
assigned serves as a choice list, and it appears when the field is selected in
any input layout. If you assign a different list to the field in the Layout
editor, then for that layout, that list overrides the list assigned in the
Structure editor.

Before you can assign a list, you must have created the list in the Lists
editor. See Chapter 9 for information on creating lists.

Choice Lists

Assigning a list to a field or enterable object with the Choices check box
causes 4th DIMENSION to display the list as a choice list during data entry.
A choice list appears when the field or enterable object is selected in the
User environment. The user can then select the entry from the list. The
user can overwrite the entry chosen from the choice list by typing (unless
the list is also a required list).
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Assigning a list to a field or enterable object with the Required check box

limits the valid entries to the items on the list. For example, you may want
to require a list of job titles so that valid entries are restricted to titles that

have been approved by management.

Required Lists

Note: Making a list required does not automatically display the list when the
field is selected. If you want a required list displayed, assign the same list with
the Choices check box also.

Excluded Lists

Assigning a list to a field or enterable object with the Excluded check box
prevents the items on the list from being entered. For example, you may
want to create such a list for discontinued part numbers.

Assigning a List
To assign a list to a field or enterable object, follow these steps:

In the Field Definition dialog box, select Choices, Required, or Excluded,
and then click the corresponding List button.

4th DIMENSION displays the List dialog box. It shows the lists you have
created in the Lists editor.

Select the list you want, and then click Select.

4th DIMENSION assigns the list you have selected to the field or enterable
object.

Using Entry Filters

You can apply an entry filter to a field or an enterable object. An entry
filter controls exactly what the user can type during data entry. For
example, if a part number always consists of three letters followed by
three digits, you could restrict the user to that pattern.

An entry filter operates only during data entry. It has no effect on data
display after the user leaves the field. Usually, you create a matching
display format when you use an entry filter. For complete information
about display formats, see “Field Display Formats,” earlier in this chapter.

An entry filter evaluates each character as it is typed. If the user attempts
to type an invalid character (a number instead of a letter, for example),
4th DIMENSION simply does not accept it. The character space remains
unchanged until the user types a valid character.
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You create the entry filter by typing it into the Entry Filter box.
Figure 4-21 shows an entry filter being typed.

Entry filter:
1200(H##) #uH-RERE

Figure 4-21
Creating an entry filter

The following sections describe how to write the code for an entry filter.
Entry Filter Codes

An entry filter code has three parts:

initiator "argument" placeholders

The initiator informs 4th DIMENSION that the subsequent argument is to
be used as a filter during data entry in the field. The argument defines the
allowable characters. The placeholders define the places available for the
characters.

For example, the following entry filter allows only the letters “a”, “b”, “c”,

Pl

g’ to be entered in two places:
&"a;b;c;g"##
In this example, the ampersand (&) is the initiator; the “a;b;c;g” is the
argument; and the number signs (#) are the placeholders. The filter can be

read as, “Allow the letters ‘a’, ‘b’, ‘c’, or ‘g’ in two places.” Thus the user
a”, “ac” or any other combination of

LE I3

may enter “ag”, “gc”, “ba”, “ab”, “a
the four allowed characters.
Entry filters can be combined. The following entry filter allows only the

letters “a”, “b”, “c”, or “g” to be entered in two places, followed by the
numbers 1, 3, or 8 in one place:

&"a;b;c;g"##&"1;3:8"#

The user must use two of the allowed letters, followed by one of the
allowed numbers.

Initiating a Filter

Two characters initiate a filter, the ampersand (&) and the tilde (~) These
characters instruct 4th DIMENSION to use the argt argument that follows
immediately as the filter for the subsequent placeholders.

In addition, the tilde _(_~_2 also instructs 4th DIMENSION to make any letters
uppercase. It does not prevent a lowercase letter from being typed; it
simply changes it to an uppercase letter.
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The following entry filters are equivalent in their effects:

&"P"#

~"'p"#

The difference between them is that the filter initiated with the ampersand

(&) does not accept a lowercase p; the filter initiated with the tilde (~)
accepts the lowercase p but converts it to uppercase.

Because no letters are involved, the following entry filters are equivalent:
&"1:;5:8"#

~"1;5;8"#

Arguments

A filter argument follows the initiator and defines the characters that are
allowed in the subsequent placeholders. To create a filter argument,
surround the allowable characters with quotation marks.

Arguments are made up of lowercase letters, uppercase letters, numbers,
punctuation marks, and special characters (!@#$%"&*(){ }[1":";7><,./ ~).
If you use a lowercase letter in the argument, only the lowercase form of
the letter can be typed by the user; if you use an uppercase letter in the
argument, only the uppercase form of the letter can be typed by the user.

An argument may be a single character (a letter or a number); for example,
leH’ ||Jl|’ Or H6l|.

An argument may be a set of characters separated by semicolons; for
example, "a;r;t" or "1;5".

An argument may include ranges of characters. A range is defined by the
first character, a hyphen, and the last character. Examples are, "a-c" and
"1-5". The "a-c" argument is equivalent to "a;b;c", and "1-5" is equivalent
to "1;2;3;4;5".

An argument may include single letters, single numbers, and one or more
ranges; for example, "a;m-z;3;5-9".
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Table 4-5 shows useful shorthand versions of arguments. They are used in
filters without quotation marks.

Table 4-5
Entry Filter equivalents

@éracterf ~Meaning Equivalent

9 Allow numbers "0-9"

a Allow lowercase and uppercase "a-z;A-Z"

A Allow uppercase "A-Z"

@ Allow alphanumeric "a-z;A-7;0-9"

The following entry filters are equivalent:
&9#

&"0-9"#

&"1;2:3;4:5;6;7:8;9;0"#

The following entry filters are equivalent:
&att

&"a-z;A-Z"#

The following entry filters are equivalent:
&A#

&"A-Z"#

Placeholders

The number sign (#) is the only placeholder. You use one number sign
for each character the user can enter in the field.

For example, the following entry filter allows the user to enter letters
in four places:

&att##

The following entry filter allows the user to enter uppercase letters in
three places, followed by numbers in two places:

SAH#HH#H&OH#H#

If you show no placeholders, the filter code allows any number of
characters. The following entry filter allows the user to enter only
numbers, but it does not limit the length of the entry:

&9

You can set the number of characters allowed in an Alpha field in
the Structure editor.
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Entry filter
placeholders
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Display Characters

When a field with an entry filter is selected for data entry, 4th DIMENSION
displays an underline for each placeholder. As the user types the entry,
each underline is highlighted and replaced with the typed character.

Figure 4-22 shows a field displaying underlines.

Parts
Description [L I

Part No

Qty

Figure 4-22
Placeholder as an underline

You instruct 4th DIMENSION which character to substitute for the ’
underline by beginning the entry filter with an exclamation point (!)
and the character you want. For example, the following entry filter
displays the letter “X” in four places prior to data entry:
IX&"A-M"#iH##

Figure 4-23 shows X’s being used as display characters.

Parts

Description lZwie Billet

Part No B

Oty

Figure 4-23

Placeholder as an X

You can substitute any character for the underline. Any character other
than an underline, however, is saved if nothing is typed over it. For
example, if you display “XXXX" in the four places allowed, and if
the user types only two of the allowed characters (say they are “AA”)
the field will contain “AAXX”" when the record is saved.
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Dead Characters

Dead characters are displayed during data entry, but they are skipped over
by the cursor, and are not entered as part of the data. Any characters,
punctuation marks, and spaces can be used as dead characters.

The characters you want to use as dead characters are placed before, after,
and between placeholders. They are displayed during data entry for clarity.

For example, the following filter requires three letters followed by three
numbers. The two groups of placeholders are displayed as X’s enclosed in
parentheses.

IX&a(##H#) &9(#H#H#)

The screen display looks like this when the field is selected for data entry:
Fxx) (XxX)

If the user enters “abc 123, the screen looks like this:

(abc) (123)

before the user tabs out of the field.

However, the field actually contains this:

abc123

If you want the field to display (abc) (123), you need to create the
following display format for the field:

(H##) (#H##)
Examples

Table 4-6 provides several examples of data entry filters.

Table 4-6
Data entry filter examples

Filter Meaning . N
&O(H#itHt) Hitt-HitH# Allow numbers within parentheses and before
and after hyphen. (U.S. telephone number format.)
X &O#HH-H#H-HHHH# Display x for each placeholder. Allow nine
numbers separated by hyphens as shown.
(U.S. Social Security number format.)

& OHHHHH-HHHH Allow 9 numbers separated by a hyphen.
(U.S. 5-4 Zip code format.)
&O#~attH#H & OHHH# Allow one number followed by three letters made

uppercase, followed by three numbers.
(U.S. state license plate format.)



DESIGN

Entry Filter Styles

You can use a 4th DIMENSION style to enter an entry filter. Type a vertical
bar followed by the style name in the Entry Filter box. For example, this
entry

[Phone
installs the style named Phone as the entry filter for the field.

For information about creating styles, see “Creating Styles,” later in this
chapter.

Setting Maximum and Minimum Values

You can restrict a Number, Date, or Time field or enterable object by
entering maximum and minimum values in the corresponding boxes.

Figure 4-24 shows minimum and maximum values being entered.

Minimum: 100
Masimum: |10000
Figure 4-24

Entering values for Maximum or Minimum

During data entry, if the user enters a value below the minimum or
above the maximum, an appropriate warning message is displayed.
4th DIMENSION returns the user to the field so that a valid entry
can be made.

To set a maximum or minimum value, type the value you want to define
the limit. Use the data entry format appropriate for the type of field or
enterable object for which you are setting a limit. For example, for a
Date field or object, use the date entry format to set the maximum or
minimum value.

The value you set is inclusive. That is, if the user enters the same value
you have set as a maximum or minimum value, the entry is allowed.
Only entries lower than a minimum or higher than a maximum are
disallowed. For example, if the value you set as a maximum is 15, the
user can enter 15, but not 16.

You can also use a required list to create ranges of allowable values.
For information, see Chapter 9, “Creating Lists.”
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Default Values

You can assign a default value to be entered in a field or enterable
object. The default value is entered when a new record is first displayed.
You can change the value unless the field or entry area has been defined
as non-enterable.

Figure 4-25 shows a default value being entered.

Default: LZSI][‘ |

Figure 4-25
Entering a Default value

You create a default value by typing the value you want in the Default
value box. The default value must be appropriate for the field type.

4th DIMENSION calculates default values for date, time, and sequence
number. The date and time are taken from the system date and time.
4th DIMENSION automatically generates a sequence number.

Table 4-7 shows the codes to use for calculated default values.

Table 4-7
Calculated default values

Code  Meaning
#D Current date
#H Current time
L Q% #N Sequence number

You can use a sequence number to create a unique number for each
record. A sequence number is an integer (whole number) that is
generated for each new record. The numbers start at one (1) and
increment by one (1). A sequence number is never repeated, even if
the record it is assigned to is deleted from the file. Each file has its
own sequence numbers.

A default value sequence number should generally not be used in

a multi-user database. For more information about using sequence
numbers in multi-user databases, see “Managing Multi-User Databases,”
in the 4th DIMENSION Language Reference.
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Adding a Scroll Bar to a Text Field

Text fields and enterable objects can contain up to 32,000 characters.
4th DIMENSION allows you to attach a scroll bar so that the user can scroll
the information. Figure 4-26 shows text fields with scroll bars.

Entry for People E==—"————— 1=

2]

<o [&)

Figure 4-26
Text fields with scroll bars

You add a scroll bar by selecting the “Text with scroll bar” check box.

Whether or not a text field or enterable object has a scroll bar, the user
can also scroll the information by using the arrow keys.

Creating Styles

4th DIMENSION lets you define styles so that you can quickly specify
display formats and entry filters. Styles are useful when you use the
same display formats and entry filters in several places. For example, if
you display fields with the same entry filter in several layouts,

you can create the entry filter once and specify it with the style name
wherever you need it.

You create a style in the Styles dialog box. You must create a style
before you can use it in the Field Definition dialog box.

To create a style, follow these steps:
Choose Preferences from the File menu.
4th DIMENSION displays the Preferences dialog box.

For complete information about the Preferences dialog box,
see “Setting Preferences,” in Chapter 1.
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2. Click the Edit Styles button.
4th DIMENSION displays the Styles dialog box, shown in Figure 4-27.

Styles...
_ Name:
Name of style [Numbers
Format:
I2G0(H#R) #RH-HARE
Display format or
entry filter code
6[ Add | [ Delete | [ Done |
Figure 4-27

The Styles dialog box
3. Type the name of the style in the name box.

You can use any characters for the style name. You can use up to 20
characters for the style name.

For example, you would enter “Phone” in the Name box to create a style
named Phone.

4. Type the display format or entry filter you want to use in the Format area.

You create a display filter or an entry filter in the Styles dialog box just as
if you were typing it into the Field Definition dialog box. For information
about creating display formats and entry filters, see “Field Display
Formats” and “Using an Entry Filter,” earlier in this chapter.

For example, if you wanted to create a Phone entry filter, you could type
128O(#iH) #H##-#it#
5. If you want to create another style, click Add.
The style name you just created appears in the list of styles on the left.
8. When you have fipished adding styles, click Done.

You can edit any style by selecting it and changing the name or the code.
You can delete any style by selecting it and clicking Delete.

Using Styles

After you create a style, you can use in the Field Definition dialog box.
You enter the style name, preceded by a vertical bar, in the format display
area (for display formats) or the Entry Filter box (for entry filters).
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Figure 4-28 shows a style being used in the format display area and the
Entry Filter box.

- Field

Title

Entry Date
Cormments
Bonus

I |

|Phone Format

Vertical bar g::: ?f:e
precedes style or
filker name
- Data Entry
0 Entry filter:
Enterable P
[JMandatory Phong Filter
[J Choices List... — —
[]Required [List..) Minimun
[J Excluded List...] Magimum:
[Dient with scrol bay Default: | ’
O #rint sariabis frams &cript...) [ cancel ]
Figure 4-28

Styles used for the format and filter

Printing With Variable Frame

When you print Text fields, Picture fields, and enterable objects that
display text, you can instruct 4th DIMENSION to print them with “variable
frame” so that the entire contents of the field or object is printed.

To print with variable frame, select the “Print with Variable Frame” check
box in the Field Definition dialog box. Figure 4-29 shows the check box.

[J Print variable frame

Figure 4-29
The “Print variable frame” check box

If you select “Print variable frame” for a field or an object, during printing
4th DIMENSION expands the part of the layout containing the area, until
the entire field entry has been printed. Figure 4-30 on the following page
shows how variable frame prints such an object.
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Field to be printed
with variable frame

Layout: Variable Text ===V

AN Name Comments L

A7 First> <Last>
OlAl r
A’ [Comments ] r

MName Comments

Mary Fong
Mary has been a customer for three years.
Her needs have changed a lot since her first
purchase from us. We need to meet with her
soon to find out what her buying plans are for
the rest of the year.

Torn Johnson .
Tom is a new customer and has just decided to
switch from Consolidated. He expects to be
placing orders on a montly basis.

Jerry Jones
Jerry has been a very good customer for the
last sewven years. We must continue to call on
him on a regular basis. Our new product might
work well for him.

Figure 4-30

Layout and result of variable frame printing

If you want only what is displayed to be printed, deselect “Print variable
frame” in the Field Definition dialog box.

Because 4th DIMENSION repeatedly prints horizontal slices of the layout to
accomplish variable frame printing, do not enter anything next to the field
or object that you do not want repeated. Place elements above or below the
variable frame field or object. Figure 4-31 shows the result of placing an
element next to a variable frame field.

[}

E[[==———— Layout: Variable Text
Y Last Name Comments

A <First> <Last> Comments
OlAl
e

ISR

Printed result repeats

extra element
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[.Niﬂlﬂ Comments
Mary Fong Mary has been a custormer for three years.
Mary Fong Her needs have changed a lot since her first
Mary Fong purchase from us. We need to meet with her
Mary Fong soon to find out what her buying plans are for
Mary Fong the rest of the year.
Tom Johnson Tom is a new customer and has just decided to
Tom Johnson switch from Consolidated. He expects to be
Tom Johnson placing orders on a montly basis.
Jerry Jones Jerry has been a very good customer for the
Jerry Jones last seven years. We must continue to call on
Jerry Jones him on a regular basis. Our new product might
Jerry Jones work well for him.

Figure 4-31

Elements placed next to variable frame field
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Using Scripts

Each active object in a layout can have an associated script—a short series
of instructions that performs an operation or calculation. Generally, scripts
are used to manage the objects they are associated with. They tend to be
short—one to a few lines long. If you are familiar with spreadsheets, you
can think of scripts as macros.

Here are some of the things you can do with a script:
m Perform sophisticated data validation.

m Manage data in related files.

m  Respond to a user clicking a control.

m Perform calculations on the contents of fields.

The following script calculates a total based on data in two other fields:
Line Total := Price * Quantity

The next script provides a total of all the preceding line totals in a report:

Grand Total := Subtotal (Line Total)

Here is a script to make all characters in a Name field uppercase:

Name := Uppercase (Name)

This script takes the value in the Annual Salary field and calculates a
monthly salary value:

Monthly Salary := Annual Salary / 12

The following script concatenates values from a First Name field and a Last
Name field and assigns the results to a non-enterable object named vName:

non

vName := First Name +" " + Last Name

You assign scripts from within the Layout editor. See the 4th DIMENSION = <
Language Reference for a discussion of the purpose and use of scripts and ~ /
a description of the syntax and commands in the language. g”a;,ga' 7 /48

To add a script, follow these steps:

Create a new active object or field in the layout. Or double-click on an
existing active object or field. When the Object Definition or Field
Definition dialog box appears, click Script. Or, to quickly add or open a
script, hold down the Option key while you click on an existing object.
This action bypasses the Object Definition or Field Definition dialog box
and goes directly to the default Procedure editor.
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If an object or field is grouped with another object, it must be ungrouped
before you can open its script.

If you are creating a new script, and if you have not set a default Procedure
editor type in the Preferences dialog box, 4th DIMENSION displays the
“Procedure type” dialog box, where you select the Procedure editor you
want to use.

4th DIMENSION displays the Script window, as shown in Figure 4-32.
It contains the Procedure editor.

1

E[I=———= Script: vFuliName =i—F—U]

Keywords - -+ Routines
First Name Arrays

Last Name Boolean
Communications

If
Else
End if
Case of

End case

Figure 4-32
Script window

The name of the new window includes the word “Script” and the name
of the object or field.

Write the script as you would any other 4th DIMENSION procedure.

See Chapter 6 for more information on using the Procedure editors.
Also, see the 4th DIMENSION Language Reference for descriptions
of 4th DIMENSION’s language.

Close the Script window.
4th DIMENSION displays the layout you have been working on.

The script is now associated with the field or active object. Whenever
you use the layout in the User environment or Runtime environment,
4th DIMENSION performs the operation assigned to the object.

If you associate a script with a field, the script is executed several times:
before a record is displayed, each time the field is modified, when the field
is printed, and after the record is accepted. For information about the effect
of procedures being executed at certain times, see Chapter 5, “The Layout
Execution Cycle,” in the 4th DIMENSION Language Reference.
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If you associate a script with an active object, you can select the “Only if
modified” check box. Selecting “Only if modified” means that the script
executes only when the object is used or modified.

Active Objects in a Layout

This section is devoted to the active objects you can use in a layout
to control database and interface functions. Active objects include
buttons, pop-up menus, scrollable areas, graph areas, and enterable
and non-enterable areas.

This section explains how to use the Object Definition dialog box, and
how to place and modify active objects. The different active object types
are discussed in detail in the next section, “Types of Active Objects.”

Object Definition Dialog Box

Whenever you place an object in a layout, or modify the object
specifications, you use the Object Definition dialog box. Use the Object
Definition dialog box to name the object; specify its type; define its action;
set any display formats, data entry controls, or keyboard shortcuts;

and attach a script for the object.

Assign a The Object Definition dialog box, shown in Figure 4-33, is similar
Keyboard to the Field Definition dialog box.
Equivalent
N biect - Definition
ame objec |
] Name: | | Format: (Key...]
Choose type from
Type: |A Enterable ]
Type pop-up menu : l
Choose action or | e | 1
format from Action r Data Entry T g
pOp-Up menu... fatry filter
TNty
...or type in format in Ocnoices  [List..)
format display area [J]Required [_List... Minimum: I J
[JExcluded Maximum: ! I
Set data entry [ Text with scroll bar Default: | I
controls
Control printing for ] Print variable frame [ ancel ] [[ oK ]]
large text objects _J Scripty. | [ Only if modified

Attach a script

Figure 4-33
Object Definition dialog box
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Here are the settings available in the Object Definition dialog box.

Name box: This box is for the object’s name. The name of the object
is also the name of a variable that is automatically associated with the
object. A variable is a named location in memory that can be used to
contain data. A script or procedure can control the object by
referencing the object’s name as a variable. Use the object’s name to
control the object with the 4th DIMENSION language.

You must provide a unique name for every object in a layout. Some
types of objects have rules for names. (For example, each group of
Radio buttons must begin with the same letter.) Any rules for names
are explained under the heading for each type in the “Types of Active
Objects” section. '

For information about handling objects using the language, see the
4th DIMENSION Language Reference.

Type pop-up menu: This menu lets you specify the object type.
Figure 4-34 shows the Type pop-up menu.

Enterable
Non-enterable
O Button

® Radio Button
B Check Box
2 Pop-up Menu
B scrollable Area
Invisible Button
[ Highlight Button
QB Radio Picture

Graph

External Object
EE Thermometer
L Ruler

& Dial

Figure 4-34

Object types in the Type pop-up menu

The object type is the key to the other parts of the dialog box.

The choices available change, depending on which type you select.
An enterable object can use data entry controls and display formats.
A button does not use display formats or data entry controls, but can
have any of 15 different actions. The object types are discussed at
length in “Types of Active Objects,” later in this chapter.

Action pop-up menu: This menu allows you to choose a display
format or action for the object. If you are using an enterable or
non-enterable object, you can set the display format for the object
by choosing the format from a pop-up menu. The format you choose
is displayed in the Format display area, where you can edit it if
necessary. For complete information about display formats,

see “Field Display Formats,” earlier in this chapter.
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For buttons, the Format display area becomes the Button Text area,
where you enter the text to display on the button. For an external area,
the Format display area becomes the Procedure Name area, where you
name the procedure to use in the external area. For a thermometer,
ruler, or dial, the Format display area becomes the “Max; Min; Unit;
Step” area, where you define the parameters for the display.

Key button: You click Key to set a keyboard shortcut for a button.
You can assign combinations of keys that the user can press to activate
an object. The user can then activate button objects from the keyboard
as well by clicking with the mouse. See “Assigning a Keyboard
Shortcut,” later in this chapter, for more information.

Data Entry controls: Use the data entry controls to set attributes,
associate lists, establish a data entry filter, maximum or minimum
values, or a default value for an enterable object. For information
about data entry controls, see “Data Entry Controls,” earlier in this
chapter.

Script button: Use the Script button to attach a script to any active
object. For information about scripts, see “Using Scripts,” earlier in
this chapter.

Only if modified: You use this check box to instruct

4th DIMENSION to execute the script only when the object is
selected, modified, or activated in some way. If this check box is
deselected, the script will be executed in the before and after phases
of the execution cycle, and also while printing. For information
about the execution cycle, see Chapter 5, “The Layout Execution
Cycle,” in the 4th DIMENSION Language Reference.

Text with scroll bar: You select this check box to add a scroll bar
to a text object. The scroll bar allows the user to scroll hidden text
into view. For information about “Text with scroll bar,” see “Adding
a Scroll Bar to a Text Field,” earlier in this chapter.

Print with variable frame: You select this check box if you want the
entire text object to be printed. For complete information about
printing with a variable frame, see “Printing With Variable Frame,”
earlier in this chapter.
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Creating an Active Object

All objects are created in the Layout editor. When you place an object in a
layout, you must name it and define its type. You can also associate a key
with the object, set a display format, enter data entry controls, or add a
script.

To create an active object, follow these steps:

In the Layout editor window, click the Create Active Object icon in the
layout palette.

When you move the cursor into the layout area, it becomes a crosshair.
Position the crosshair where you want to place one corner of the object.

Drag the crosshair diagonally to define the size of the object, and then
release the mouse button.

4th DIMENSION displays the Object Definition dialog box.

Define the object by entering a name in the Name box, and choosing a
type from the Type pop-up menu.

When you choose the Type, 4th DIMENSION changes the remainder of
the dialog box to suit the object type you have chosen.

Continue setting specifications in the Object Definition dialog box.

When you are finished, click OK.

The object appears in the layout where you drew it. It takes the shape
appropriate to its type, and it displays the name you gave it or the text
you entered for it to display.

After you create an object, you can handle it as you would any other
layout object. You can resize most objects, apply a font, define a color for
display on a color monitor, and so on.

Modifying an Object

You can modify the object definition of any object placed in a layout. If
the object has been grouped with another object, you must ungroup it first.

To modify an object’s specifications, follow these steps:

Select the object you want to work with, and then choose Format from the
Object menu. Or double-click the object you want to work with.

4th DIMENSION displays the Object Definition dialog box for that object.
Make any changes you want, and then click OK.

4th DIMENSION establishes the new specifications for the object.
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Display Formats for Objects

(Qqag 4-33 The bject Definition dialog box provides the same display formats for
“both enterable and non-enterable objects as it does for fields. The display
format choices are available from the Action pop-up menu.

When you pull down the Action pop-up menu, you can choose a format
for number, date, time or picture data. Highlighting one of the choices
displays a submenu that displays the available formats. You choose the
format from the submenu.

The selected format is displayed in the format display area. You can edit
the format in the usual way. You type formats for Alpha objects directly
into the format display area. You can use styles to set formats. For
complete information about display formats, see the appropriate sections
in “Field Display Formats,” earlier in this chapter.

Figure 4-35 shows the pop-up and submenu for choosing a display format
for an enterable object.
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Figure 4-35
Choosing a display format for an enterable object

Data Entry Controls for Enterable Objects

The Object Definition dialog box provides the same data entry controls
for enterable objects as it does for fields. There are no differences at all.
You can use styles to set entry filters. For complete information, see “Data
Entry Controls” earlier in this chapter.

Scripts for an Object

The Object Definition dialog box allows a script to be attached to the
object. Click the Script button to attach a script. For complete information,
see “Using Scripts” earlier in this chapter.

The Object Definition dialog box allows you to restrict the execution of a
script by selecting “Only if modified.”
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If “Only if modified” is selected, the script for the object is executed only
during data entry, and then only when the object it is associated with is
modified or activated.

If you deselect “Only when modified,” the script is executed according to
the execution cycle. For information about the execution cycle, see
Chapter 5, “The Layout Execution Cycle,” in the 4th DIMENSION
Language Reference.

Assigning a Keyboard Shortcut

The Object Definition dialog box allows you to assign a keyboard shortcut
for buttons and check boxes. The user can then activate the button or select
the check box by typing, instead of having to use the mouse.

To assign a keyboard shortcut, follow these steps:
1. Click the Key button in the Object Definition dialog box.
4th DIMENSION displays the Key dialog box, shown in Figure 4-36.

Shift Associated Key...
Key: [ |
Command .
Option Modifiers: [ ][] [Clear )
[ cancel ]I[ 0K |
Control e
Figure 4-36

Key dialog box

2. While holding down any number of the Shift, Option, Command or
Control keys, type the key you want to use for the shortcut.

You are not required to use the Shift, Option, Command, or Control keys.
You can use any key alone as the shortcut.

3.  When you have finished, click OK.

If you want to change the shortcut later, simply open the Key dialog box
and type the combination you want to use. 4th DIMENSION displays the
new combination in the Key dialog box.
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Types of Active Objects

4th DIMENSION provides 15 active object types (in addition to fields):

®m enterable object

® non-enterable object
= button

m radio button

m check box

E pop-up menu

m scrollable area

m invisible button

® highlight button

m radio picture
m graph

®m cxternal area
m thermometer
® ruler

m dial

The sections that follow describe each kind of object in detail.

Enterable and Non-enterable Objects

You use enterable and non-enterable objects with variables. An enterable
object allows the user to enter a value into a variable and display the value.
A non-enterable object allows you to display the value of a variable.

Variables are used for temporary storage of data. You manage variables
using the 4th DIMENSION language. One common use for a variable is to
display calculations, such as vTotal := Quantity * Price. Another use is as a
temporary source of information. For example, you might use a variable to
provide a location in which the user enters a value to search for.

Figure 4-37 on the following page shows an non-enterable object being
created that displays a invoice line total.
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Object name
Object type

- Definition
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Figure 4-37

Creating an non-enterable object

An enterable object accepts data. You can set data entry controls for the
object as you would for a field. The entered data is associated with the
object name. You control the data with scripts or other procedures, using
the object’s name as a variable.

A non-enterable object displays data. The displayed data is associated with
the object’s name. You control the data with scripts or other procedures,
using the object’s name as a variable.

Enterable and non-enterable objects can be of any size. Since they display
characters, when the object area is resized, it snaps to a size depending on
its font size. Objects that contain alphanumeric characters, numbers, dates,
times, and pictures can make use of display formats. Text objects can use a
scroll bar and can be printed with variable frame.

Automatic Buttons

4th DIMENSION buttons allow you to create a custom interface with no
programming. You simply place the buttons in the layout. Automatic
buttons let the user accept, cancel, or delete records; move between
records; move from page to page in a multi-page layout; and open, delete,
or add records in an included layout.

Note that if you create one button in a layout, the standard User
environment Control Panel for data entry is removed. In other words, if
you create one button, you must create all the buttons you need.

Three kinds of buttons provide automatic actions:
= button

m highlight button

m invisible button

Figure 4-38 shows examples of these types of buttons.



DESIGN

Highlight button : —

Button { Button

Invisible button

Figure 4-38

Button, invisible button, and highlight button

Buttons are standard Macintosh buttons. They are displayed as boxes
with rounded corners. Button text is displayed in the selected font, size,
style, and color.

Highlight buttons are invisible until they are clicked. Then they are
highlighted. The user can drag the pointer off the button to avoid
activating it. Usually you place a highlight button on top of a graphic,
such as an icon or picture, that indicates to the user where to click.

Invisible buttons are invisible, and perform their actions immediately
when clicked. There is no indication to the user that the button has been
clicked except that the action is performed. You should use highlight
buttons in most cases, since highlight buttons provide notice to the user
that a button is about to be activated.

Figure 4-39 shows a button being created.

Object name - Definition -
Name: [Tras Button text:
Object type H |
Type: |= Button ]
’ 7} 1
Button action [2, Cance ]

PRRUp fehU Figure 4-39

Creating a button

After you have chosen Button, Highlight Button, or Invisible Button from
the Type pop-up menu, you can choose the button action you want from
the Action pop-up menu. Figure 4-40 shows the Action pop-up menu.

No Action
Cancel

Accept

Next Record
Previous Record
First Record
Last Record
Delete Record
Next Page
Previous Page
First Page

! Last Page
Open Included
7 Delete Included
D2 _Add to Included

Figure 4-40
Button Actions
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All variables associated with buttons, whether standard, highlight,
invisible, radio, radio picture, or check box, are initialized to O when the
layout is first opened in the User or Runtime environment. When the user
clicks the button, it becomes 1. You can associate a script with any button.

Buttons are dimmed in appropriate circumstances in the User or Runtime
environment. For example, when the first record is displayed, a First
Record button is dimmed.

The sections that follow discuss each button action.
No Action Button

Use a No Action button for a button that does not perform an automatic
action. You use a script to manage this kind of button.

Accept and Cancel Buttons
Clicking an Accept button saves a record.

Clicking a Cancel button abandons the current record without saving any
changes.

Delete Record Button

Clicking a Delete Record button displays an alert asking the user to
confirm the deletion. Clicking Yes in the alert deletes the current record. If
the user is using the input layout for a subrecord, Delete Record deletes the
current subrecord.

After the user clicks a Delete Record button, 4th DIMENSION
automatically returns to the output display in the User environment.

Record Buttons

The Next Record, Previous Record, First Record, and Last Record buttons
first accept the current record, and then make the specified record current.
The specific record made current by these buttons depends on the sort
order.

These buttons perform the appropriate actions for subrecords when the
user is in entering subrecords.

A button of this type is automatically disabled when its action is
inappropriate. For example, if the user displays the first record, a Previous
Record button would be disabled.

Page Buttons

The First Page, Last Page, Next Page, and Previous Page buttons display
the appropriate layout page. If there is only one page, these buttons are
inactive.
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A button of this type is automatically disabled when its action is
inappropriate. For example, if the user displays the first page, a
Previous Page button would be disabled.

Included Record Buttons

The Included Record buttons affect records in included layouts. You

can open, delete, or add to included records. Placed on a parent record’s
layout, they affect subrecords in an included layout. Here are the Included
Record button actions:

®  Open Included: This button is active when a record in an included
layout has been selected. If the user selects a record and clicks Open
Included, the Full Page layout for that record opens, and the user can
modify the record.

m Delete Included: This button is active when a record has been
selected in an included layout. Delete Included does not display an
alert, but erases the record immediately.

®  Add to Included: This button is active when an included layout
has been selected. When the user clicks an Add To Included button,
4th DIMENSION creates a new record in the included layout, scrolls
to the record, and places the cursor in the first enterable field.

Check Boxes

A check box is a type of button. A check box is either selected or
deselected. The effect of a check box is controlled with a script or
procedure. Like all buttons, a check box is initialized to 0 when the layout
is first opened. A script associated with a check box executes when the
check box is selected.

Figure 4-41 shows a check box being created.

~ Definition

Name: “

v Enterable I
MNon-enterable
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3 Pop-up Menu
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External Object
O Exclu EEE] Thermometer
3 Ruler

& Dial

Figure 4-41
Creating a check box
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A check box displays text next to a small square. When the user selects
the check box, the square is checked (an “X” is placed in it). When a
check box is selected, it has the value 1. When deselected, it has the
value 0. Any or all check boxes in a layout can be selected or deselected.
A group of check boxes allows the user to select several items.

The check box object is quite different from the check box format of a
Boolean field. The information in a check box object is not stored
automatically; instead, the information is available as a variable to be
used elsewhere in the application. The user might use check boxes to
establish printer settings, for example.

Radio Buttons and Radio Pictures

Radio buttons and radio pictures are objects that allow the user to select
one of a group of buttons or pictures. Radio buttons and radio pictures
work the same way; the difference between the two is strictly visual.

A radio button shows a small bull’s eye and text; a radio picture displays
an icon or picture.

A radio picture is like a highlight button, in that it is transparent until
selected; when selected, it highlights the picture behind it. The user can
move the pointer off the radio picture to avoid selecting it.

Figure 4-42 shows radio buttons and radio pictures.
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Figure 4-42

Radio buttons and radio pictures

The remainder of this section uses the term “radio button” to mean
either a radio button or a radio picture.

Radio buttons exist in exclusive sets. The name of each object in a group
of radio buttons must begin with the same letter (for example, bRadiol,
bRadio2, bRadio3). The effects of radio buttons are controlled with scripts
or procedures. Like all buttons, a radio button is initialized to O when the
layout is first opened. (When no button is selected.) A script associated
with a radio button executes when it is selected.

Figure 4-43 on the following page shows a radio button being created.
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Figure 4-43

Creating a radio button

Selecting one radio button in a group sets that button to 1 and all the others
in the group to 0. Only one radio button can be selected at a time.

The radio button object is quite different from the radio button format of a
Boolean field. The information in a radio button object is not stored
automatically; instead, the information is available as a variable to be used
elsewhere in the application. The user might use radio buttons or radio
pictures to choose which serial port to use, for example.

Pop-up Menus and Scrollable Areas

Pop-up menus and scrollable areas are objects that allow the user to select
from a list called an array. An array is a table in memory that is referenced
by the name of the array. A pop-up menu displays the array as a standard
Macintosh pop-up menu. A scrollable area displays the array in a list that
can be scrolled and used to select an item.

Figure 4-44 shows a scrollable area and a pop-up menu.

Keywords

Distributor
General Info Evaluation

Items in a list

Personal Info Farchasing

Contact Info Sottware

Figure 4-44

Pop-up menu and a scrollable area

When the user selects an item from an array, any script associated with
the array is executed. Typically, the value selected is moved to some other
place and saved, or used to control another procedure.
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Arrays always contain a finite number of items. The list of items is dynamic,
and can be changed by a procedure. Items in an array can be modified,
sorted, and added to.

Filling an array (entering the items into the array) is always performed
with the language. An array can be filled from a list, or from a selection of
records or subrecords, or it can be specified directly with the language.

For information about ways to create and use an array, see Chapter 9,
“Arrays and Pointers,” in the 4th DIMENSION Language Reference.

Graph Areas

A graph area can be used to display a graph in a layout. There are
many ways to bring values to the graph area for calculation and display,
all of which are controlled by the graphing commands in the language.
The subject is covered in the “Graphing” section of Chapter 13 in the
4th DIMENSION Language Reference.

External Areas

An external area is completely controlled by an external procedure. External
procedures are small routines, typically written in Pascal or C, that you
install in a 4th DIMENSION database.

You reference the external program by entering the procedure name in the
Procedure Name area, as shown in Figure 4-45.

Procedure name:

Calendar

Figure 4-45

Entering a procedure name

External areas extend the capabilities of 4th DIMENSION to include
custom actions such as word processing.

You install external routines in a 4th DIMENSION database by using the
4th DIMENSION External Mover utility. For complete information about
installing external programs into a database, see the 4th DIMENSION
Utilities Guide.

Thermometers, Rulers, and Dials

Thermometers, rulers, and dials are objects that can display a value. They
indicate a value graphically. The three objects work in the same way; they
differ only in their appearance.

You can use thermometers, rulers, and dials either to display values or to
set values. If a thermometer, for example, is given a value by a script, it
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shows the value given. It the user drags the indicator point, the value
changes. The value can be used in another object (a field or an enterable or
non-enterable object). Figure 4-46 shows these indicators, and how they
may be related to a field.

=g Ruler

Field entry is 40 0% 100%
reflected in
thermometer |__Sales: $68,900 —(uota: BOR
Figure 4-46
A thermometer, a ruler, and a dial
You use the Object Definition dialog box to establish the scale for each
of these objects. You set the minimum yalue, the maximum value, the units
for the tick marks on the scale, and the minimum steps that the indicator
will allow. For example, if you enter
0;100;10;5
the object would set the minimum to 0, the maximum to 100, place tick
marks every 10 units on the indicator, and would allow increments of 5.
Minimum on Figure 4-47 shows these values being set for a thermometer.
scale

Maximum on scale
Units determine

Nfin; Mag; Unit; Step

tick marks

0;100;10;1
- Step determines
L increments
l SESEEENS |
Figure 4-47

Scale and indicator settings

To establish the settings for the minimum, maximum, units, and step, type
the values you want 4th DIMENSION to use in the display area. Separate
the values with a semicolon. The settings are accepted only if all four are
entered. If you want to label the indicator, use a text area in the layout to
do so.

You place values into, or use values from, the thermometer, ruler, or dial

by means of scripts. For further information, see Chapter 4, “Layouts and
Scripts,” in the 4th DIMENSION Language Reference.
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Objects placed
on a grid

Objects on Grid

Sometimes you may want to place several similar active objects in a layout
at the same time, numbering them sequentially so that their names are
unique. For example, you may want to create a series of buttons that
perform database operations, as shown in Figure 4-48.
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Figure 4-48
Objects on a grid

The Layout Grid tool and the Objects on Grid command work together to
provide a quick and easy way to place objects on a grid.

To create an array of active objects, follow these steps:

Select the Layout Grid tool, and draw a rectangle big enough to contain
the objects you want to place in the layout.

4th DIMENSION displays the “Grid object” dialog box, as shown in
Figure 4-49.

6rid object...

Number of columns:
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Grid object with
three rows and four
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[ Cancel ] [[ 0K ]]

Figure 4-49
“Grid object” dialog box
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Enter the number of rows and columns you want in the grid, and click OK.

4th DIMENSION creates a grid with the specified number of rows and
columns. The grid is a graphic object that uses the current line width, fill
pattern, and border pattern.

Resize the grid, if necessary, making each cell in the grid a little larger
than the size of the object you want to display.

Resizing an object is described in Chapter 3.

Create a new active object of the size and type you require, and position it
in the upper-left cell in the grid object.

Give the new object a name without a number at the end.

Figure 4-50
An active object in first cell of a grid

Select both the grid and the active object.
Choose Objects on Grid from the Layout menu.

4th DIMENSION copies the active object to each cell in the grid, giving
each active object a unique number.

4th DIMENSION numbers the active objects from top to bottom in each
column. These numbers are added to the object name for each object, thus
creating a unique object at every grid cell.

Note: To number the series of active objects from left to right in each row,
hold down the Option key when you choose Objects on Grid.

Beisle Pags

You can now use the language to reference these objects by the names
they have been given. You can delete the grid or leave it in the layout.
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Figure 4-51 shows the objects created and placed on the grid.

Figure 4-51
Active objects on the grid

Using Included Layouts

Subfile layout included

You can display and print a layout from one file or subfile in an input layout
from another file. Such layouts are called included layouts. Included layouts
appear as small “output” layouts during data entry. You can use an included
layout to do several tasks:

® Display records from subfiles or from other files.
m Enter data into subrecords or records in other files.
m Print subrecords or records from other files.

m  Branch to the input layout of a subfile or other file.

Figure 4-52 shows included layouts from a subfile and a related Many file.
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Figure 4-52
Included layouts

An included layout is usually a layout associated with a subfile or a related
Many file. However, an included layout can be from any file in the database.
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Included layouts can appear in input layouts only. They can be printed,
however, when the layout is used for printing.

You can create included layouts automatically when you create a new
layout, or you can add the included layout to an existing layout in the
Layout editor. If you add the layout through the Layout editor, you must
have first created the layout you wait to include.

Creating an included layout automatically is described in “Selecting
Fields for the Layout,” in Chapter 3. See especially the section titled
“Using Included Layouts for Files and Subfiles.”

Entering Data in an Included Layout

Included layouts can be used for data entry in two ways. The user can
enter data directly in the included layout, or the user can enter it in an
input layout. Figure 4-53 shows both an included layout and an input
layout associated with it.

All Coast Tool Co. i
123 Main St. Invoice
Angtown, USA Invoice Number [1001]
~ 27
Customer [Smith Tool Co ] Date |[5/22/89
Terms |Net 30
Quantity Part Description Price
10(145-854 [Locking Bit
Included layout 100{187-992 |Small Tap
45|232-752 |2inc coated strap iron
36 |121-365 |Hex Nut and washers
Thank You for your business Invoice Total: $2,302
Items

Part Number 145-854

Input layout Description Locking Bit

Inyoice Number

Figure 4-53

Included layout and input layout

The layout used as the included layout is referred to as the multi-line
layout. The input layout is referred to as the full page layout.

You can allow the user to enter data through the multi-line layout, and you
can allow the user to double-click the multi-line layout to display the full
page layout. Figure 4-54 shows the Included Layout dialog box being used
to establish these options.
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Multi-line layout will
be displayed in
included layout area

Full Page layout will
serve as input layout

Enterable to allow
data entry in multi-
line layout

“Double clickable”

Included layout...

Input F
n’iu Expand
[] Full Page
& Multi-line
r{—} 0K
~ Data Entry Print Frame
X Enterable D haccdiins]
I Double clickable (2 Fined Uruncution
= (O Fized (multiple records)

allows full page
layout to be used

b |
SZLECCTPHELC

R

Figure 4-54

Setting data entry options for included layouts

Normally, an output layout is better suited for multi-line display and an
input layout is better suited for full-page display. If you do not specify a
full page layout, 4th DIMENSION automatically uses the default input
layout for that file.

Occasionally, you will want to prevent a user from using an included
layout for data entry. You can prevent data entry in an included layout by
deselecting the Enterable check box. And you can prevent the display of
the full page layout by deselecting the “Double clickable” check box.

You can add custom buttons to a layout to control records in an included
layout. These buttons are Open Included, Delete Included, and Add To
Included. For information about adding these buttons, see “Automatic
Buttons,” earlier in this chapter. DI#3

See “Entering Data in Included Layouts” in the 4th DIMENSION User {4,
Reference for complete information on how to enter data into included
layouts in the User environment.

Displaying Data in an Included Layout

An included layout typically displays several records associated with the
record in whose layout it appears. For displaying records, you usually
select an output layout. 4th DIMENSION calls the layout that is used to
display records in an included layout the multi-line layout. Figure 4-55
shows a multi-line layout in an included layout area.



Included layout area

Multi-line display

Invoices

Invoice Number m

Customer |Srm'th Tool Co.

Date 6/22/89

Terms [Net 30

Quantity Part Description Price
10]145-854 |Locking Bit 75.23

100(187-992 (Small Tap 45.32
45(232-752 |*10 Zinc Strip 125.99
Figure 4-55

Multi-line layout displays several records

You can adjust the included layout area as necessary to display the records.
The wider you make the area, the more columns can be displayed. The
taller you make the area, the more records can be displayed. An included
layout area automatically displays a scroll bar so that the user can scroll
through the records or subrecords.

When you create the included layout, you can tell 4th DIMENSION to
automatically resize the included layout area to display all the columns in
the multi-line layout. See “Creating an Included Layout,” later in this
chapter.

Printing Data in an Included Layout

You usually use an output layout to print records in an included layout.
Because there may be more records than can fit in the included layout area,
4th DIMENSION provides three options for controlling how records are
printed:

m  Variable frame. 4th DIMENSION expands or contracts the included

layout area to print all the records. This option is similar to “Print
with variable frame” for text fields.

m  Fixed frame (truncation). 4th DIMENSION prints the records that fit
into the area of the included layout. The layout is printed only once,
and those records that are not printed are ignored.

m  Fixed frame (multiple records). 4th DIMENSION prints the records
that fit into the area of the included layout, but prints the layout
several times to accommodate all the records.

CHAPTER 4: DESIGNING THE INTERFACE 183



Figures 4-56a, 4-56b, and 4-56c¢ show the results of each of these options.

Invoices
Invoice Number 1001
Customer iSmith Tool Co.
Date 6/22/89
Terms letzo
Quantity Part Description Price
10{145-854 [Locking Bit 7523
100/187-992 |Small Tap 4532
45|232-752 |*10 Zinc Strip 125.99
36(121-365 |Hex Nut 25.36
250(269-214 [Lock Washer 3752
75[435-878 [Ring Keeper 28989
Figure 4-56a ,
Variable frame print option for included layout
Invoices
Invoice Number 1001
Customer [Smith Tool Co
Date 6 /22/89
Terms betso
Quantity Part Description Price
10[145-854 |Locking Bit 7523
100(187-992 (Small Tap 4532
45(232-752 |*10 Zinc Strip 125.99
36[121-365 [Hex Nut 25.36
Figure 4-56b

Fixed frame (truncation) print option for included layout

Invoices

Invoice Number 1001

Customer [Smith Tool Co.

Date 6/22/89

Terms Net 30

Quantity Part Description Price

10|145-854 |Locking Bit 75.23
100(187-992 [Small Tap 4532
45|232-752 | *10 Zine Strip 12599
26(121-365 [Hex Nut 2536

Invoices

Invoice Number 1001
Customer [Smith Tool Co.

Date 6/22/839
Terms [Net 30
Quantity Part Description Price
250(369-214 [Lock Washer 3752
75|435-878 |Ring Keeper 28389
Figure 4-56c¢

Fixed frame (multiple records) print option for included layout
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Printer control markers also affect how records are displayed in an
included layout, and how those records are printed. See “Using Control
Lines,” in Chapter 5, for more information.

Creating an Included Layout

You create an included layout by adding an included layout area to a
layout.

To create an included layout, follow these steps:
Click the Included Layout Area icon on the layout palette.
When you move the cursor into the layout area, it becomes a crosshair.

Position the crosshair where you want to place the upper-left corner of the
included layout area.

Drag the crosshair diagonally to define the size of the included layout area,
and then release the mouse button.

4th DIMENSION displays the Included Layout dialog box, as shown in
Figure 4-57.

Included layout...

button

Phone Numbers K vk e
Children ] l FRE ] :":.E
[Cumﬁanies] |
Thumbnail display [Lines]
Line Item
o [ cancel |
Automatic included —
layout area size =] 0K |
r Data Entrg Print Frame
= ) — ) Variable
Data entry controls DJ Enterable (2858 ] || @ rised (truncation)
<] Double clickable ~ Fi > 2 i !
= () Fined (multiple records)

Printing controls

STJCcCa biT

Figure 4-57
Included Layout dialog box

In this dialog box, you select both the file and the layout you want to
include. You must first select a file for the included layout.

Select the file or subfile from which you will include a layout, and then
click Select.

4th DIMENSION places an asterisk next to the selected filename. The
asterisk indicates that this file is the file for the included layout.

Your next step is to select the layout you want to use from the file you
have selected.
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File selected for
included layout area
displays an asterisk

Expanded file shows
layout names

Selected layout is

Click Expand to see the names of all the layouts associated with the file or
subfile you have selected. Or double-click the filename or subfile name to
expand the list of layouts.

Figure 4-58 shows the list of files and subfiles expanded to show layout
names.

Included layout...

|Phone Numbers -

Children E——
[Companies] _

(o] .

3

t
In = | CIFun Page
[ Multi-line

Cancel

displayed in
thumbnail display
area

10.

l 0K l

lr Print Frame

<]

— Data Entry
Enterable
X Double cli‘ckable
<gieetabic

Figure 4-58

Expanded list of layouts

(O Dariable
@ Fined (truncation)
() Fised (multiple records)

Select the name of the layout you want to use to display records in the
included layout area.

The layout you select is displayed in the thumbnail display area so that
you can be sure it is the layout you want.

Click the Multi-line check box.

4th DIMENSION uses the multi-line layout to display records from the
selected file or subfile in the included layout area. Usually, you choose an
output layout that displays several records at the same time.

If you do not specify one layout as multi-line, 4th DIMENSION
automatically uses the default output layout for the included layout area.

Select the name of the layout you want to use as a full-screen display for
data entry, and then click Full Page.

You can specify the same layout as both Multi-line and Full Page, or you
can leave Full Page unselected and let 4th DIMENSION automatically
select the default input layout for full-page display.

If necessary, select a Print Frame option.

Use Enterable and/or “Double clickable™ to specify the kind of data entry
you want to have available for the included layout.
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If you deselect Enterable, the user cannot enter data into the multi-line
layout.

If you deselect “Double clickable,” the user cannot display or use the full
page layout.

If you want 4th DIMENSION to automatically set the horizontal size of the
included layout area to display all the fields, click Auto.

If you do not click Auto, the multi-line layout will be displayed in the area
you have drawn. If the area is too small, fields to the right will be invisible.

Click OK.

4th DIMENSION returns you to the current layout. The name of the file or
subfile you selected in the Included Layout dialog box is displayed in the
included layout area.

i Note: You will often want to place a frame around the included layout. Do so

by selecting the area and pressing Command—1. 4th DIMENSION displays
a rectangle around the area using the default line width and border pattern.

Modifying an Included Layout

To modify an included layout, follow these steps:

Double-click the included layout area in the layout. Or select the included
layout area, and then choose Format from the Object menu.

4th DIMENSION displays the Included Layout dialog box.

In the Included Layout dialog box, make any changes you want for the
included layout.

You can specify a different full page or multi-line layout, change the data
entry specifications, or make changes to the way the frame is printed.

Using Layout Menus

You can associate custom menus with a layout. A custom menu associated
with a layout is added to the menu bar in the User and Runtime
environments when that layout is used. Custom menus contain menu items
that activate procedures. 4th DIMENSION procedures can perform many
complex operations automatically.

One common use of layout menus is to let the user control data entry with
menu commands instead of buttons. You can create menu commands that
perform the OK, Cancel, Next Record, Previous Record, Next Page, and
Previous Page commands, and so on.
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Entry Order...

Bhients oo brido,

Turn Grid On
Hide Rulers %R

Define Grid...
Define Ruler Units...

Add to Layout...

Beiete Page

You use the Menu editor to create custom menu bars. Each menu bar
contains one or more menus. Each menu bar you create has a number. You
use the menu bar number to associate the menu bar with a layout. For
complete information about creating menu bars, menus, and menu items,
see Chapter 7, “Creating Custom Menus.”

In the User environment, a layout menu bar is appended to the right of the
User environment menu bar. A layout menu bar is displayed only when the
layout is used for input.

In the Runtime environment, a layout menu bar is appended to the right of
whatever menu bar is current. The appended layout menu bar disables the
other menus on the menu bar, unless you precede the layout menu bar
specification with a minus sign. If a layout menu bar is the same as the
current menu bar, it is not appended. (The user would not get two sets of
the same menus.) A layout menu works in both input and output layouts.

For more information about menus, see “A Custom Menu Example,” in
Chapter 7 of the 4th DIMENSION Language Reference.

To associate a menu bar with a layout, follow these steps:
Open the layout to which you want to associate a menu bar.
Choose Menu Bar from the Layout menu.

4th DIMENSION displays the “Associate with menu bar #” dialog box,
shown in Figure 4-59.

Associate with menu bar #:
3 ]
[ ok ]| [ cancel ]

Figure 4-59
Associating a menu bar with a layout

Type the number of the menu bar you want to associate with the layout,
and then click OK.

Subsequently, when this layout is displayed in the User or Runtime
environment, the menus on the menu bar you have associated with it are
appended to the right of the current menu bar.
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4th DIMENSION
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If you are associating a menu bar with a layout for use in the Runtime
environment, precede the menu bar number with a minus sign. The minus
sign instructs 4th DIMENSION to keep the current menu bar commands
active. In the absence of the minus sign, a layout menu bar disables
whatever menu bar is current, leaving only the layout menu bar active.

Figure 4-60 shows layout menus displayed to the right of standard User
environment menus.

[ ® File Edjt Use Enter Select Report Speclial_

menus

Associated menu

Sales Report
Inventory Report
Customer List

Figure 4-60
Layout menu displayed on the right

CHAPTER 4: DESIGNING THE INTERFACE 189



190



DESIGN -

CREATING LAYOUTS
FOR OUTPUT DISPLAY
AND REPORTS

QU(C{( /Qqé‘) C'J %
Ufl'loa,u;a/a Ch &



192

)FHA)J/V) ?Lu /Nd SAJ

(igy Onile applictio

€ 4(4 - ,9/ / 01‘17% /Vl /e/,/
, (27(6' 1 z{ o eji/w ‘A y «/m s
(}9/ J Uydl(’ ' NR 79(/( <hfus @77@ »
whe « Jedd-

I [eqmé r,L;/a Cod b Aame QL@/A

7 itk i a ?Zozaxluﬂ(‘ .

god pu e ol e Dk il

ﬁk Maine 5 Ag owbenal wiiwaclle

da



Quicle Reots Usq aéuit{e/qg DESIGN -

CREATING LAYOUTS FOR OUTPUT
DISPLAY AND REPORTS

4th DIMENSION layouts can be designed specifically for displaying
records and for printing reports. This chapter explains how the output
control lines in the Layout editor affect screen display and printed reports.

This chapter explains

m how to move the output control lines on the layout

m  where to place fields to display and print data from each record
m  where to place elements to be displayed or printed in a header
u

where to place elements to be printed in a footer

m how the sort order affects reports
m how to create additional breaks
m how to create break headers

how to use scripts for time, date, and page number

| |
m how to create totals, subtotals, and other summary calculations

Output Layouts

Output layouts are used to display records on screen, and to print reports.
Any layout can be used as an output layout, but the most common output
layout displays a list of records.

The Layout editor allows you to create Header, Detail, Break, and Footer
areas for an output layout. You can uses these areas to display and print
information in addition to the records themselves.

In a layout used for screen display, a Header area can contain column
labels that identify the information in each field. The Detail area is where
the records themselves are displayed. Figure 5-1 identifies the different
areas as they appear on screen.
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Header area

Detail area

Header area

Detail area

Employees: 60 of 60

irst Name Last Name Depart [Salary

Tom Johnson DES $26,500
Alice Bentley TRAN $28,000
Biff Davis SAL $43,780
Shirley Ransome MAN $36,040
Dennis Hanson ADM $40,520
Lydia Yernon SAL $36,370
Andy Venable ART $43,520
Jim Borrell SAL $36,540
Bryan Pfaff ADM $2€,440
Nancy Heizer SAL $26,270
Kathy Forbes ART $18,840
Garth Hammons SAL $50,100
Mary Sraith ADM $26,500
Frederic Bell MAN $25,200
John Martin ART Al $56,144
Shirley |Nalevanko DES $41,050
Marlys Wilson ADM $36,500
George Lyle SAL $47,300 y
<a] [
Figure 5-1

An output layout in the User environment

These areas work slightly differently in the User and Runtime
environments. See “Using Layouts for Screen Display,” later in this
chapter.

In a report, a Header area often contains the date, the time, and a running
title as well as column labels. Records appear in the Detail area. A
calculated total appears in the Break area. And the Footer area often
contains the page number. Figure 5-2 identifies the different areas as they
appear in a report.

Consumer Products Employees

Date: 06/23/1989 Time: 9:37 AM
Name Title Salary
Bentley, Alice Engineer $28,000
Borrell, Jim Salesperson $36,540
Davis, Biff Salesperson $43,780
Forbes, Kathy Secretary $18,840
Heizer, Nancy Clerk $26,270
Pfaff, Bryan Secretary $26,440
Ransorne, Shirley Supervisor $26,040
Yenable, Andy Engineer $43,520
_{Yernon, Ludia Supervisor $36,870

Break area
Footer area

Total Salaries for Company $296,300
Salary Report Page: 1
Figure 5-2

A printed report
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A report may have additional Break areas for subtotals and other
calculations. And a report may have additional Header areas that appear
within the body of the report. These additional areas are discussed in
“Parts of a Report,” later in this chapter.

Output Control Lines

You establish Header, Detail, Break, and Footer areas by using the output
control lines in the Layout editor.

Each layout starts with four control lines. The control lines define areas on
the layout. You can move the control lines to allow more or less area for
each one. Any object that you place in these areas is displayed or printed at
the appropriate location. '

Figure 5-3 shows how the output control lines in the Layout editor mark
the lower boundaries of the Header, Detail, Break, and Footer areas on the

layout.

Hsaid S=—— layout: Control Lines =—————TF|
eader area T :%H

OJAl i

o [so

= —

=& r100
Detail area =|E

E | r

— 150

il 1 [
Break area K
Footer area O

Figure 5-3
Control lines define areas

Label 6&J)idH Hapkep

Here is how these areas work when the layout is displayed or printed:

m Header area: The Header area is displayed at the top of each screen
in the User and Runtime environments and is printed at the top of each
page of a report.

m Detail area: The Detail area is displayed on the screen once for each
record in the User and Runtime environments and is printed once for
each record in a report.

m Break area: The Break area is displayed once at the end of the list of
records on the screen in the User and Runtime environments and is
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Control marker
Label

printed once after the records have been printed in a report.

m  Footer area: The Footer area is displayed once at the end of the list of
records (following the Break area) in the Runtime environment and is
printed at the bottom of every page of a report.

Whenever a layout is used for output, either for screen display or printing,
the output control lines take effect, and the areas display or print at
designated locations. The output control lines also take effect when a
layout is used as the multi-line layout in an included layout area.

The output control lines have no effect in a layout used for input.

Scripts that are associated with objects in these areas are executed when
the areas are printed or displayed. For example, if you place in the header
a script to print the time, it is executed each time the header is printed.

You can create additional control lines to define additional Break areas and
Header areas for a report. These additional areas allow you to print
subtotals and other calculations in a report, and to display other
information effectively.

Working with the output control lines and the areas they define are
described in detail in subsequent sections of this chapter.

Moving Output Control Lines

A control line can be moved so its area is precisely defined.

Output control lines are displayed as lines across each layout. Each control
line has an identifying marker and label that is displayed in the ruler. The
control marker is the triangle in the ruler, and the label is the letter or
letters next to the marker.

Figure 5-4 identifies control markers and labels.
ru

Lo
40

Sl

Fbo F

Figure 5-4

Control markers and labels

In order to move a control line, the ruler must be displayed.

To move a control line, drag the control marker or the marker label.

Holding down the Shift key while dragging a control marker moves all
control lines below that control marker.
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For example, to drag all control lines together, hold down Shift and drag
the Header marker. To move all lines except the Header line, Shift-drag the
Detail marker.

The control lines cannot be dragged out of order. For example, if you
attempt to drag a Footer control line higher than a Break control line, the
drag operation automatically stops when the Footer marker reaches the
Break marker.

You can place markers and lines on top of one another. Placing one marker
on top of another reduces its area to nothing, effectively disabling its
operation. For example, if you have nothing to print in a Footer area, you
can drag the Break marker on top of the Footer marker. Doing so prevents
4th DIMENSION from allowing space for a Footer. The report can thus
utilize all the space available on the page.

Similarly, if you have nothing to print or display in a Break area, you can
place the Detail marker on top of the Break marker (B0), reducing the
Break area to nothing. If you want to print no Details, drag the Detail
marker on top of the Header marker. If you want no Header, drag the
Header marker to the very top of the layout (at point 0).

Using Layouts for Screen Display

- ( ﬁ ,D /( When you use a layout for screen display, the Header, Detail, Break, and
Saved Ky Yyss . . . . . .
e ——— Footer areas display in specific locations on the screen, and in relation to
W

o #  the records.
Hots /‘//m’«'u(. Jc‘;"f} e records

You can place an active object in the Header and Detail areas on the
~layout, and write an appropriate script to control it. Be sure to deselect the
.\k “Only if modified” check box in its Object Definition dialog box. See
- “Scripts for an Object,” in Chapter 4, for information about “Only if
modified.”

—

In the User environment, the Header area is displayed at the top of each
screen or included area. The Detail area takes up the remainder of the
screen or included area. One Break area is displayed at the end of the list.
The other control lines have no effect.

»)
O

Figure 5-5 shows how an output layout displays Header, Detail, and Break
areas in the User environment.
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Header area = Employees: 60 of 60 ==—=—oa=——3|
displays at top First Name Last Name Depart [Salary )
Tom Johnson DES $26,500 ‘[\ /’ ; ‘_{,. Nox
Alice Bentley TRAN $28,000 Y& Z vin
[girt Davis SAL $43780| 7 LI - . (
Shirley Ransome MAN $36,040 / HUE ﬂ ra
Dennis Hanson ADM $40,520 «") / ny ot
Lydia Vernon SaL $36,870 [
Detail area Andy Venable ART $43 520 (s S’f
displays records Jim Borrell SAL $36,540
Bryan Pfaff ADM $26,440
Nancy Heizer SAL $26,270
Kathy Forbes ART $18,840
Garth Hammons SaL $50,100
Mary Smith ADM $26,500
Frederic Bell MAN $25,200
John Martin ARTA] $56,144
Break generated at Shirley Nalevanko DES $41,050
end of list Fhis is the Break area -
<a] [
Figure 5-5

exbne azea

Output layout screen display in User environment

In the Runtime environment 4th DIMENSION displays, in addition to the

Header, Detail, and Break areas, a Footer area containing any custom
buttons. The custom buttons in the Footer area are displayed below the
Break area, as shown in Figure 5-6.

Custom
First Name Last Name Depart [Salary
Tom Johnson DES $26,500
Alice Bentley TRAN $28,000
Biff Davis SAL $43,750
Shirley Ransomne MAN $36,040
Dennis Hanson ADM $40,520
Lydia Vernon SaL $36,870
Andy Yenable ART $43,520
Jim Borrell SAL $36,540
leryan Pfaff ADM $26,440
Naney Heizer SAL $26,270
Kathy Forbes ART $18,840
Garth Hammons SAL $50,100
Mary Smith ADM $26,500
Custom buttons Frederic Bell MAN $25.200
displayed in This is the Break area
footer area . — =
(" Delete ) [ "Search ] [ " 0K ]
Figure 5-6

Output layout screen display in Runtime environment

Report Designs

A report is a printed version of a database’s data in records, along with
explanatory and calculated information, designed to be easily read and
understood. Reports are often standardized, so that the same format is used
regularly; the reader can then scan the report for exceptions or unusual
changes in the data.
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A 4th DIMENSION report can use information from any file. Scripts and
procedures can perform operations using 4th DIMENSION’s advanced
procedural language.

i Q 4th DIMENSION provides the Quick Report editor in the User environment
wuic l’ v fe P’J’R(: for designing and printing most reports. You should use a layout to create a
, ‘ report only when you need the Layout editor’s control over graphic
elements, when you use procedures to manage the report, or when you
need a noncolumnar report.

This section describes several report designs, and explains how the sort
order affects reports.

Columnar Reports

In its simplest version, a columnar report is a table containing all the data
from the records in a file. Field values are printed in columns, and each
record is represented by a row. In the absence of any calculations, this kind
of report prints only the Details from each record in the selection.

Figure 5-7 shows a simple columnar report.
Field names are

colu mn Headers Customer Product Date Price
[ AtHhe Data Corp ATN 700 1/27/88 $12,780.00
Acme Data Corp STS 2000 6/22/88 $36,425.00
American Data ATN 700 9/14/88 $12,450.00
American Data STS 1000 3/17/88 $22,450.00
American Data STS Service 4/17/88 $3,300.00
American Data Training Class 6/3/88 $4,500.00
Conner Systems ATN 700 7/22/88 $13,560.00
Conner Systems STS 4000 8/19/88 $91,250.00
Eachrowis a DataMatic ATN 850 11/12/88 $19,252.00
record DataMatic STS 2000 12/10/88 $37,425.00
— |DataMatic STS 4000 5/5/88 $86 ,425.00
DP Network STS 1000 2/20/88 $21,680.00
DP Network STS 2000 6/14/88 $73,640.00
Omni Data Service ATN 850 1/30/88 $20,980.00
Omni Data Service STS 1000 2/14/88 $24,360.00
Omni Data Service STS 2000 9/25/88 $47,250.00
Omni Data Service STS 3000 4/25/88 $71,025.00
Omni Data Service STS 3000 10/1/88 $55,230.00
Omni Data Service STS 4000 7/14/88 $95,420.00
L Omni Data Service Training Class 2/5/88 $4,500.00

Figure 5-7

A columnar report

Columnar reports are easy for the reader to understand. The data is
conveniently arranged in tabular form. Usually, the records have been
sorted into a useful order so that they fall into natural and comprehensible
groupings. In the case of the records in Figure 5-7, the Sales records have
been sorted by customer and product. As the reader reads down the report,
the data reflects the sales to different customers. And for each customer,
the product sold by the company is reported on.

Such a report is useful chiefly as a printed version of the data, a copy of
the information in the records.
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Summary Information in Reports

4th DIMENSION can automatically calculate totals and subtotals and print
these summaries in convenient places. Figure 5-8 shows a columnar report
that includes subtotals for each customer and a total at the end of the report.

Sort level 1: Customer —————

Sort level 2: Product

Customer ! Product Date Price
American Data ATN 700 9/14/88 $12,450
American Data STS 1000 3/17/88 $22,450
American Data STS Service 4/17/88 $3,300 .
American Data Training Class 6/3/88 $4 500 SUthtaI pnnted
stotn $42.700 —— at level 1 Break
Horizon Services ATN 850 10/18/38 $25 364
Horizon Services STS 1000 11/17/88 $24,123
Horizon Services STS 2000 5/7/88 $74,250
Subtotal $123,737 e
James Research ATN 500 6/22/33 $2 ,900J
Subtotal $8,900 e
Omni Data Service ATN 350 1/30/88 $20,980
Omni Data Service ATN 850 10/5/88 $7,%00
Ornni Data Service STS 1000 2/14/88 $24,360
Omni Data Service STS 3000 6/22/88 $53,252
Omni Data Service STS 3000 4/25/88 $71,025
Omni Data Service STS 2000 1071738 $55,230
Omni Data Service STS 3000 9/25/88 $47,250
Omni Data Service STS 4000 7/14/88 $95,420
Omni Data Service STS 4000 8/3/88 $83,740
Omni Data Service STS 4000 5/17/88 $92,450
Omni Data Service Training Class 2/5/88 $4,500
Omni Data Service Training Class 7/7/88 $4,500
Subtotal $566,607 ==
Thomas Info Systerns ATH 700 1/27/88 $12,780
Thomas Info Systems STS 2000 6/22/88 $36,425
Subtotal $49,205 e Total printed at

level 0 Break

: Total $791,149
Figure 5-8
Columnar report with subtotals and total
Again the records have been sorted by customer and product. After the
records for each customer have been printed, the subtotal for the customer
is calculated and printed. After the records for the entire report have been

printed, the total is calculated and printed.

The subtotal calculations take advantage of a natural division that is created
by the sort order of the records. These divisions are called “Breaks,”

and understanding them is vital to creating reports. As you can see in

Figure 5-8, the subtotals are calculated and printed after the records for each
customer. 4th DIMENSION knows when to perform the calculation and print
the subtotal because it has been instructed to do so when the value in the
first sort field changes (where it “breaks”).

The customer subtotal is calculated in what is called a level 1 break,
because it is based on a change in the first sort level (in this case, the first
Sort field). The grand total is calculated in a level O break. A level 0 break
includes all the records and occurs at the end of a report.
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Figure 5-9 shows another example of calculations during a break, using
the same records, but using a different sort order to create a different
break. This time the records have been sorted by product and customer.
The subtotals are calculated when the value in the Product field changes.
This is still a level 1 break, but the break is on a different field.

Sort level 2: Customer

R |
Custorner | Product Date Price
Jarnes Research ATNS0D | 6/22/88 $5,9200
Sort level 1: Product 1 Sbtotal 43,900
American Data ATN 700 9/14/88 $12,450 .
Thomas Info Systems ATN 700 1/27/88 $12,780 Subtotal printed at
Subtotal 425,230 —— a level 1 break
Horizon Services AT 850 10/18/88 $25,364
Ornni Data Service ATN 850 1/30/88 | $20,980
Omnni Data Service ATN 850 10/5/88 $7,900
Subtotal $54,244 —
American Data STS 1000 3/17/88 $22 450
Horizon Services STS 1000 11/17/88 $24,123
Ormni Data Service STS 1000 2/14/38 $24,360
Subtotal $70,933
Thomas Info Systems ISTS 2000 Js /22/88 $36,425J
Subtotal $326,425 e
Horizon Services STS 3000 5/7/88 $74,250
Orni Data Service STS 2000 6/22/88 $53,252
Ornni Data Service STS 3000 4/25/38 $71,025
Omni Data Service STS 3000 1071788 $55,230
Omni Data Service STS 3000 9/25/88 $47,250
Subtotal $301,007 —yi
Ornni Data Service STS 4000 T/14/58 $95,420
Ornni Data Service STS 4000 8/3/88 $89,740
Omni Data Service STS 4000 5/17/88 $92,450
Subtotal $277,610
American Data STS Service 4/17/88 $z ,3Gﬂ
Subtotal $3,300 —f
American Data Training Class 6/3/88 $4,500
Omni Data Service Training Class 2/5/88 $4,500
Omni Data Service Training Class 7/7/88 $4,500
Subtotal $13,500 — Total printed at
Total  $731,14s _____ alevel O break
Figure 5-9

Changed report using the same records

Additional Break Levels

You can provide additional locations for summary calculations by adding
another sort level, thus creating another break level and an additional
opportunity for 4th DIMENSION to calculate useful information.

Figure 5-10 on the following page shows sales records sorted by customer,
product, and salesperson. Summary calculations show two sets of
subtotals: One subtotal for each customer, and, within each customer,
subtotals for each product for the customer. Finally, this report calculates a
total for the entire company. These are examples of calculations performed
at level 2 breaks, at level 1 breaks, and at the level O break.

CHAPTER 5: CREATING LAYOUTS FOR OUTPUT DISPLAY AND REPORTS 201



202

Custorner Product Date Price

Subtotal printed
atalevel 1 break |

Omni Data Service ATN 850 1/30/88 $20,980
Omni Data Service ATN 850 10/5/88 $7,900
Subtotal for ATN 850 $28,880 -—
Ormni Data Service STS 1000 2/14/88 $24,360
Subtotal for STS 1000 $24,360
Ornni Data Service STS 3000 4/25/88 $71,025
Ormnni Data Service STS 2000 6/22/88 $53,252
Omni Data Service STS 2000 9/25/38 $47,250
Omni Data Service STS 3000 10/1/88 $55,230
Subtotal for STS 3000 $226,757
Omni Data Service STS 4000 5/17/88 $92,450 X
Orni Data Service 5TS 4000 7714788 $95,420 Subtotal printed
Subtotal for STS 4000 $187,870 —— at a level 2 break
Omni Data Service Training Class 2/5/88 $4,500
Ornni Data Service Training Class 7/7/88 $4,500
Subtotal for Training Class $9,000
Subtotal for Omni Data Service $476,867
Thomas Info Systemns ATN 700 1/27/88 $12,780
Thomas Info Systems ATM 700 6/22/88 $24,745
Subtotal for ATN 700 $37,525
IThomas Info Systems STS 4000 8/3/88 $89,740

Subtotal for STS 4000 $89,740 —

Subtotal for Thomas Info Systerns $127,265 Total printed at

Figure 5-10 a level 0 break

Subtotals at two break levels

Total $604,132

The subtotal calculations are performed only over the group of records that
precedes the break. For example, the subtotal for each product is
calculated only for each product by customer. The subtotal for the
customer is calculated for all products sold to that customer.

Summary Reports

You can create a report that prints only summary information. Such a
report hides all the Details and displays only the subtotals and totals, with
appropriate additional text. Figure 5-11 shows a report with only summary
information.

Sales Summary Report
Subtotal for ATN 850 $28,880
Subtotal for STS 1000 $24 260
Subtotal for STS 3000 $226,757
Subtotal for STS 4000 $187,870
Subtotal for Training Class $9,000

Subtotal for Omni Data Service $476,867

Subtotal for ATN 700 $37,525
Subtotal for STS 4000 $29,740

Subtotal for Thomas Info Systems $127,265

Total $604,132
Figure 5-11
Summary report
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In the report shown in Figure 5-11, the records are sorted by customer,
product, and date, and the calculations are performed during the breaks
created by the sort order. The details are not printed; they are used only to
provide values for the calculations. (You create this kind of report by
placing the Detail control line on top of the Header control line, leaving no
space for details to print.)

Summary reports of this kind are useful for reporting the overall
performance of a company instead of the details of individual sales.

You can ask 4th DIMENSION to perform additional calculations, including
running totals, averages, maximum and minimum values, page totals to be
printed in a footer, and weighted averages. These calculations, and others,
require some familiarity with 4th DIMENSION’s language. For a complete
introduction to using the language, see the 4th DIMENSION Language
Reference. In particular, see “Printing Reports,” in Chapter 13, and
“Statistical Functions,” in Chapter 17.

Creating Additional Control Lines

Some of the report examples shown in this section use break headers and
additional break levels. To create areas for these features, you create
additional control lines. You can create additional control lines for Break
areas and for the headers for those levels.

In general, you create the additional control lines by holding down the
Option key while clicking the appropriate control marker. You can create
as many Break level control lines and Break Header lines as you need.

You should create one Break area for every level of break that will be
generated by the sort. If you do not need anything printed on one of the
break areas, you can reduce its size to nothing by placing its marker on top
of another Break area marker. If you have more break levels than Break
areas, the last Break area will be repeated during printing.

Figure 5-12 shows additional control lines.

Level 1 Break
Header area

Level 1 Break area

Level 0 Break area

Figure 5-12
Additional control lines for additional areas
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¥

To create a new Break line, follow these steps:
Hold down the Option key and click any Break marker.
4th DIMENSION creates a new Break line.

The new Break line is positioned in back of the existing line; to see the
new line, you need to drag the existing line off it.

Drag the existing line below the new line.

Position both lines where you want them.

To create a new Break Header line, follow these steps:
Hold down the Option key and click a Header marker.
4th DIMENSION creates a new Header line.

The new Header line is positioned in front of the existing line; to see the
new line, you need to drag it off the existing line.

Drag the new line below the existing line.
Position both lines where you want them.

To delete Break or Break Header lines that you have created, hold down
the Command key and click on the Break line or Break Header line you
want to delete.

4th DIMENSION deletes the line and renumbers the remaining lines, if
necessary.

You cannot delete the original control lines H, D, B0, and F.

An Example Report

This section describes an example report and shows how the finished
report is related to a layout in the Layout editor and to the scripts that
control the printing.

Figure 5-13 on the following page shows a finished report.

Simelar

Tubsriel Porsopmel 13
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I Detailed Sales Report 06/27/1989
744 PM
Awmerican Data

Product Purchase Date Cormrrents Price

ATN 700
9/14/88 Configured for fast access times $12,450
Subtotal for ATN 700 $12,450

STS 1000
3/17/88 Needed additional power of the 1000 $22,450
4/17/88 Plan to purchase additional 1000's $3,300
Subtotal for STS 1000 $28,750
Subtotal for American Data $38,200

Omni Data Service

Product Purchase Date Corrnrrrents Price
STS 1000 .
Lz /14 /88 Trying out the 1000 $24,360
Subtotal for STS 1000 $24,360
STS 3000
4/25/88 Needed additional power of 3000 $71,025
6/22/88 Now use 3000 as standard machine $53,252
9/25/88 Third 3000 $47,250
Subtotal for STS 3000 $171,527
STS 4000
5/17/88 Needed 4000 for special application $92,450
7/14/88 Special configuration $95,420
Subtotal for STS 4000 $187,870
Subtotal for Omni Data Service $383,757
Thomas Info
Product Purchase Date Cowrnrrrents Price
ATN 700
1/27/88 First purchase of ATN 700 $12,780
6/22/88 Will use many 700's $24,745
Subtotal for ATN 700 $37,52%
STS 4000
£/3/88 Needed 4000 for new data center $89,740
Subtotal for STS 4000 $89,740
Subtotal for Thomas Info $127,268
Total $549,222
Ligirtwave Cornpurter Corporation paxgj

Figure 5-13

A typical report

In this example, the page header contains the date, the time, and the report
title. The break headers contain column headings for the information
calculated during the first break. The Detail areas contain data drawn
directly from the records. The level 2 Break areas contain subtotals for
products for each customer. The level 1 Break areas contain subtotals for
each customer, and the level O Break area contains a total for the report.
The footer contains the page number.

The report is sorted on one more level than break levels. In this report, the
sort fields are Q}}ﬂg@@r, E@Q},‘Et’ and Date. 4th DIMENSION requires one
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more sort level than break level for the break processing method used in

this report. There is another method that requires the same number of sort

levels as break levels. For information, see the 4th DIMENSION Language

Reference, especially the “Printing Reports™ section of Chapter 13. ;.. /5¢
v

The Report Layout ¢, ~u0 /b4

Figure 5-14 shows the report layout that created the report in Figure 5-13:

L2l

Header line - esesss——— Detailed Sales Report — Fs=——_[
. jLeeu - ¢H
Break Header 1 line [Customer | [0
. Purchase Date Corvrrerenrts Price L
Break Header 2 line , : P
Detail line {Date Comment |Erice ] :ﬂ'ﬂj;
Break 2 |!ne Subtotal for <[Sales]Product: “;,._:";:: B2
Break 1 |!ne Subtotal for <[Sales]Customer> M:ﬁn B1
Break 0 line _ : Total ":‘ e
Footer line Lightwave Cornpurter Corporation el F
:ZUU
50 100 150 200 250 200 250 400 4501 500 171
Figure 5-14

Control lines and control areas

Each control line in the layout defines the bottom of its area. Whatever is
placed in the layout is printed at the appropriate place in the report. The
Header area contains the elements that will be printed at the top of each
page; the Detail area contains the elements that will be printed for each
record; and so on.

Table 5-1 shows what each of these control lines means.

Table 5-1
Control line labels

Label Meaning Effect

H Header area Printed once at the top of each page

H1 Level 1 Header area Printed once before each level 1 break

H2 Level 2 Header area  Printed once before each level 2 break

D Detail area Printed once for each record in the selection

B2 Level 2 Break area  Printed once at each level 2 break (when
the value in the second Sort field changes)

B1 Level 1 Break area  Printed once at each level 1 break (when

the value in the first Sort field changes)
BO Level O Break area  Printed once at the end of the report
F Footer area Printed once at the bottom of each page

There can be additional Break areas, and additional Break Header areas.



DESIGN

The Report Scripts

The non-enterable objects that are placed in the Header, Break, and Footer
areas are controlled by scripts. This section describes the scripts used to
print values in these locations.

The date is drawn from the system date by placing a non-enterable object
named vDate in the Header area with this script:

vDate := Current Date

The time is drawn from the system clock by placing a non-enterable object
named vTime in the Header area with this script:

vTime := Current Time

The subtotal for sales in the level 2 Break area is calculated and displayed in
an object named vSalesProd with the following script:

vSalesProd := Subtotal (Sales) ([Safes]Price)

The subtotal for sales in the level 1 Break area is calculated and displayed in
an object named vSalesCust with the following script:

vSalesCust := Subtotal (Safes)

And the total for sales in the level 0 Break area is calculated and displayed
in an object named vSalesTotal with the following script:

vSalesTotal := Subtotal (Sales)

Note that even though all three objects use the same calculation, they create
different results. Because they are placed in different Break areas, they are
executed at different times and perform their calculations over different
groups of records. For an explanation of break levels, see “Report Design,”
earlier in this chapter.

The page number in the Footer area is displayed in an object named vPage
with this script:
vPage := "Page " + String (Printing page)

The Printing page function returns the page number.

Important: All scripts used in a report must have the “Only if modified” check
box deselected. “Only if modified” is useful only in input layouts. It needs to be
deselected for a script to be executed during printing.
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Basic Steps for Creating a Report

Depending on the nature of the report you want to print, you can perform
most or all of these steps. The actual order of steps is not critical.
Commonly, you design a report and preview it on screen, then return to
the layout to make adjustments. The order given here is typical.

Create a layout.

You can use any of the layout templates, or you can create a custom
layout.

For information about creating a layout, see Chapter 3.

Move the control lines so that you’ll have enough space to place the
various elements of the report.

For information about moving control lines and adding control lines,
see “Moving Control Lines” and “Creating Additional Control Lines,”
earlier in this chapter.

Move elements into position.

You can place fields, text, non-enterable objects, and graphic objects.
Take time to align the objects to one another, and to check the justification
of data to be displayed in fields and active objects.

4th DIMENSION displays page size lines in the layout so that you can
place elements for printing.

Place fields in relation to the sort order you plan to use so that data is
printed in an understandable way. Usually, the first sort field is placed
on the left of a columnar report.

For information about placing fields and active objects in a layout, see
Chapter 4.

Adjust the control lines if necessary.

Working with the relationship between control lines and elements to be
printed, you can create the right amount of space for printing the header,
the details, the break, and the footer elements.

Create any necessary scripts to calculate values, concatenate strings of
characters, print additional text, and display the date, time, and page
numbers, if you have used these elements.

Be sure your scripts are not “Only if modified,” otherwise the script will
not execute during printing.

For information about creating scripts, see “Using Scripts,” in Chapter 4.
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For complete information about using 4th DIMENSION procedures, see the
4th DIMENSION Language Reference.

6. Go to the User environment to test the report layout.
7. Create the selection of records you want to use for the report.

For information about creating a selection of records, see “Selecting,” in
the 4th DIMENSION User Reference.

8. Sort the records according to how you have designed the report.

For information about sorting records, see “Sorting,” in the 4th
DIMENSION User Reference.

9. Preview the report by printing it to the screen.

The report layout uses the Page Setup settings that were in effect when the
layout was created in the Design environment. If you make any changes to
the Page Setup settings, be sure to make the same changes in the Design
environment.

If the report layout needs to be adjusted, return to the Design environment
to make any necessary changes.

10. If the report is satisfactory, print it on the printer.

For information about printing in the User environment, see “Printing,” in
the 4th DIMENSION User Reference.

Quw(( /Re?m(: g = (/sz?_ d()u,c(c CV%OG o = i
Zye 93~
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Variable printing area

Printing Included Layouts, Pictures,
and Text Fields

You can use an included layout area in a report. The included layout area
can expand during printing to print all the records.

Figure 5-15 shows a layout for a report that prints an included layout.

Layout: Included ———————D
All Coast Tool Co. H
123 Main St Inv°|ce
Anytown, USA Invoice Number [Tnvoi)

Customer [Customer ] Date. |Date

Terms [Terms

[Items]
Thank You for your business Invoice Total: fTotad—__ |

Figure 5-15
Included layout area in report layout

Figure 5-16 shows the report printed from the layout in Figure 5-15.

All Coast Tool Co i

123 Main St. InVOIce

Anytown, USA Invoice Number 1001
Customer [Smith Toal Co. | Date [6/22/89
Terms |Net 30
Quantity Part Description Price
[ 10[145-854 |Locking Bit $75
100(187-992 [Small Tap $45
45(232-752 |Zinc coated strap iron $125
36(121-365 |Hex Nut and washers $25
250|369-214  [Lock Washer $37
75(435-878 |Ring Keeper $289
451145-269  |Large bit grinders $729
150 |262-785 |Center drilled ring loops $0
150(148-255 |Large Grinding bit $450
300|246-789 |Srall Grinding bit $375
25|123-098 |Zinc Coated Straps $89
Thank You for your business Invoice Total: $2299
Figure 5-16

Report that prints included records

For information about included layouts, see “Using Included Layouts,” in
Chapter 4.
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Included layout areas, picture fields, and text fields can be set to print
with either fixed frame or variable frame. If the area or field is set to print
with variable frame, 4th DIMENSION expands the layout to accommodate
a variable amount of information. You need to take this into account when
designing the layout.

Variable-frame printing allows each record as much space as necessary
to print all the records in an included layout area, the entire picture in a
Picture field, or the entire text in a Text field. To expand the layout,

4th DIMENSION repeatedly prints a horizontal area of the layout until
the variable area is printed.

Figure 5-17 shows how variable-frame printing works.

oI

[First Name | [Last Name |

50
H
S0 100 150 200 250 141

Smeldorf Garbando

printing

I
==

Figure 5-17

Variable printing repeats a slice of the layout

When you use elements with variable printing designations, be careful
when you place another object in the same horizontal area. The adjustment
4th DIMENSION makes to complete the variable printing can cause the
other object to be repeated or moved out of position.

Printing Labels

You usually use the Label editor in the User environment to generate
labels. But 4th DIMENSION allows you to design a custom output layout
for labels, using special graphics, fonts, or scripts. You can print the labels
from the User environment.

The special report format described here can be used for unusual reports
that require a side-by-side placement.
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To create a label report layout, follow these steps:

1. Set the label width by dragging the label width marker on the bottom ruler
of the Layout editor.

The label width determines how many labels 4th DIMENSION prints
across the page, as shown in Figure 5-18.

S=——— layout: lLabels =—————5|
ol

Label width line
visible by clicking on
label width marker

[l rz
[T

1

O

Label width marker

Figure 5-18
The label width marker

2. Design the label layout to the left of the label width marker.

Labels can contain fields, active and graphic objects, text, and scripts. An
included layout is not printed in a label.

Figure 5-19 shows a label design in the Layout editor.

s[j=————————— | ayout: Labels
Label — .

elements wEirstLas

vCitySTa

r-
1
(e

] |l E] m O[0f~
HOEE

[T

Label width marker

Figure 5-19
Designing a label layout
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3. Go to the User environment to print the labels.
Choose Labels from the Report menu to display the Label editor.
Select “Use layout™ in the Label editor in the User environment.

For complete information about using the Label editor, see the
4th DIMENSION User Reference.

Using Embedded Fields and Variables

You can embed fields and variables in text areas. During printing,
the value from the field or variable is inserted in the text. Use this
capability to create mail merge documents, or any output that prints
varying information within text areas.

Figure 5-20 shows fields and variables placed in a text area.

SFE———— layout: Letter g@%l
[ 4H

Information from
field

Text in text area

“Dear <First|Name>

Our records currently show that you have fallen behind in
your yearly dues to the Green Acres Club. Please send us

rs0

: <vDuegOwed> as soon as possible. If you have any
Valnalblte questions please call the Business office between 8:00 A
calcuiatos and 5:00.
amount due

_Thank You [.150

Figure 5-20
Form letter with fields and variable

To embed fields and variables in a text area, follow these steps:

1. Create a text area in the Detail area, or select one that already exists
in the layout.

2. Select the Text Area tool, and create an insertion point in a text area.

Place the insertion point where you want the value from the field to
be placed.
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Option-click shows
pop-up menu of fields
from the master file

Shift-Option-click
shows pop-up menu
of all files and fields

Type a field name or a variable name between the less than symbol (<) and
the greater than symbol (>).

You can use a field from any file in the database. Fields from the master
file do not have to specify the file; they can be entered like this: <field>.
Fields from other files must specify the filename; they are entered like this:
<[file] field>.

When the layout is printed, the information from the field for each record
replaces the <field> element in the text area.

A variable must be defined with the language in a script or procedure. For
information about defining variables, see Chapter 2 in the 4th DIMENSION
Language Reference. '

4th DIMENSION provides a shortcut for inserting fields in a text area. The
shortcut allows you to choose the field name from a pop-up menu.

To insert a field follow these steps:
Click to create an insertion point where you want the field.

Position the pointer in the text area, and hold down the Option key while
you press and hold the mouse button.

4th DIMENSION displays a pop-up menu of fields from the master file,
from which you can choose the field you want.

To choose a field from another file in the database, hold down Shift-Option
while you press and hold the mouse button. 4th DIMENSION displays a
pop-up menu of files in the database that displays a submenu of fields from
the selected file. You can choose the file and field you want.

4th DIMENSION places <field> or <[file] field> in the text area at the
insertion point.

Figure 5-21 shows the pop-up menus for fields from the master file and for
fields from all files.

| Last Name Last Name
First Name Departments k| First Mame
Start Date Start Date
Title Title
SSNumber SSNumber
Department Code Department Code
Bonus Bonus

214

Figure 5-21
Choosing from pop-up menus to embed fields
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CREATING PROCEDURES

This chapter tells you how to create and modify 4th DIMENSION
procedures. A procedure is a series of instructions that tell
4th DIMENSION to do something.

Although you can create a powerful database without writing your own
procedures, the language lets you extend your database’s capabilities to
include

m calculated fields
customized menus
advanced interfaces

special reports

completely customized database applications

This chapter provides information on using 4th DIMENSION’s Procedure
editors to build and modify scripts and procedures. To learn more about
4th DIMENSION’s programming language, see the 4th DIMENSION
Language Reference, which provides detailed information on the
programming commands and syntax.

4th DIMENSION Procedures

4th DIMENSION provides four types of procedures:
m  scripts

m layout procedures

m file procedures

m global procedures

Scripts

A script is a short procedure associated with a field or other active object
in a layout. If you are familiar with spreadsheet applications, scripts are
similar to macros. You create scripts in the Layout editor. The script is
executed during data entry, display, and printing.
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Scripts can perform many database tasks automatically. Use scripts to
® provide default and calculated values

m perform calculations

B manage buttons

® manage pop-up menus and scrollable areas

® manage thermometers, rulers, and dials

m validate entered data

Layout Procedures

A layout procedure is associated with a single 4th DIMENSION layout.
4th DIMENSION executes the instructions in the layout procedure
whenever you open that layout for data entry, display, or printing. The
instructions in the procedure apply only to that layout.

Use layout procedures to
m validate entered data
m provide values for fields that do not appear in the layout

m perform calculations

File Procedures

A file procedure is associated with a single database file. Unlike a layout
procedure, which is associated with a single layout, the file procedure is
active for every layout associated with the file. 4th DIMENSION executes a
file procedure when any input layout from that file is used. You should use
file procedures when you want to perform a specific action each time you
use any input layout. In practice, file procedures are rarely used.

When you open an input layout for a file, 4th DIMENSION executes the
entire file procedure before it executes the layout procedure for that layout.

Global Procedures

Global procedures can be master procedures, activated by a menu
command or by choosing Execute Procedure in the User environment. Or
they can be subroutines, called from within other global procedures, layout
procedures, file procedures, or scripts. They are not associated with a file
or layout. In a runtime application, global procedures are required to
perform actions initiated by menu commands.
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Use global procedures as
® custom menus for applications
® subroutine

m startup procedures

The Procedure Editors

4th DIMENSION provides two editors in which you can build, modify, and
test your procedures. Each editor allows you to use a different method of
writing a procedure:

m The Listing Procedure editor is a structured programming editor in
which the procedure appears as a list of statements.

m The Flowchart Procedure editor is a graphically oriented editor in
which the procedure appears as a chart of graphic symbols.

Figure 6-1 shows how the two Procedure editors appear on screen.

& File Edit Use Design Flowchart
==H EJ=======—o— Procedure: Search Flowchr! =]

EARCH SELECTION([Emplogees])

(aTPUT
AYOUT([Employees ], Employer
15t)

FISPLAY SELECTION [Empiogees D

& File Edit Use Design Search
S Procedure: Search Listing

‘Search Routine,

" Gy
SEARCH SELECTION([Employees])

OUTPUT LAYOUT((Emplogees]; Employee List)
DISPLAY SELECTION((Emgloyees])

OUTPUT LAYOUT((Emplogees], Emgloyee List )
€nd ] =

Return to calling procedure or mens

Keywords - Employess - Routines . PUT
e Rt o H =
e e Comems sasetves
eaiond [Dispaying Return to calhng

el Olrss et S e froceire o .

whil (B auttons Drie o] o]
i i g BE RaLT i)
Figure 6-1a Figure 6-1b
Procedure editor (listing) Procedure editor (flowchart)

It is more common to use the Listing Procedure editor, unless you are
familiar with the flowchart method of programming and want to create
procedures as flowcharts.

In the Preferences dialog box, you can set a default editor for scripts, file,
and layout procedures. If you do not set a default editor, you must choose
which Procedure editor to use just before you create a new procedure.
After you create a procedure, you can modify the procedure only with the
same Procedure editor.

Note: You cannot use one editor to modify a procedure created
with the other editor.
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Design
vStructure
Layout... 8L
Procedure... %*P
Menu... %M
Passwords

Lists

Creating a New Procedure

For global, layout, and file procedures, you begin in the Procedure dialog
box. For scripts, you begin in the Layout editor. In all cases, you end up in
one of the two Procedure editors, where you create the procedure itself.

Creating a Global Procedure

To create a global procedure, follow these steps:
Choose Procedure from the Design menu.

4th DIMENSION displays the Procedure dialog box, as shown in
Figure 6-2.

Procedure... ::@l
File/Layout Procedures 1 figiete

Employees

e

Lines

5]
Name: " | Access: | ]
Figure 6-2

Procedure dialog box
The dialog box lists existing procedures in the Procedure area.

Select Global Procedures in the Procedure area.
Click New.

4th DIMENSION displays the “Procedure type” dialog box in which you
select which Procedure editor you want to use. The dialog box also
supplies a default procedure name.

Click Listing or Flowchart.
Type a procedure name (or use the default name).

Procedure names can be up to 15 characters long. They can include letters,
numbers, the space character and the underline character.

Click OK.

4th DIMENSION opens an empty Procedure editor window, of the type you
selected, where you can begin adding statements to the new procedure.
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Directions for using the Listing or Flowchart editor are provided under
“Using the Listing Editor,” and “Using the Flowchart Editor,” later in this
chapter.

Creating a File or Layout Procedure

To create a file or layout procedure, follow these steps:

In the Procedure dialog box, select File/Layout Procedures in the
Procedure area.

Click Expand.
4th DIMENSION displays the names of files in the database.

To create a file procedure, select the name of the file for which you want to
create the procedure, and then click Open.

To create a layout procedure, expand the filename that contains the layout
you want, select the layout, and then click Open.

If you haven’t specified a Procedure editor type in the Preferences dialog
box, 4th DIMENSION displays the “Procedure type” dialog box so that you
can select the Procedure editor you want to use.

Select Listing or Flowchart.
Click OK.

4th DIMENSION opens an empty Procedure editor window, where you can
begin writing the new procedure.

Directions for using the Listing or Flowchart editor are provided under
“Using the Listing Procedure Editor,” and “Using the Flowchart Procedure
Editor,” later in this chapter.

Creating a Script

To create a script, follow these steps:

In the Layout editor, open the Field Definition or Object Definition dialog
box for the field or active object for which you want to create a script, and
click Script. Or in the Layout editor, hold down the Option key and click
the field or active object.

If you haven’t specified a Procedure editor type in the Preferences dialog
box, 4th DIMENSION displays the “Procedure type” dialog box so that you
can select the Procedure editor you want to use.

Select Listing or Flowchart.
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3. Click OK.

4th DIMENSION opens an empty Procedure editor window, where you
can begin writing the new script.

Directions for using the Listing or Flowchart editor are provided under
“Using the Listing Editor” and “Using the Flowchart Editor,” later in this
chapter.

Opening an Existing Procedure

After you create a procedure, you can reopen it and make changes.
4th DIMENSION automatically opens the same Procedure editor that you
used to create the procedure. :

You can open any existing procedure from the Procedure dialog box. If
you want to work with a layout procedure, you can also open it through
the Layout dialog box. You can open scripts only through the Layout
editor.

ﬁ Note: You cannot delete layout procedures, file procedures, or scripts. To
disable a procedure or script, erase all the commands in the procedure or
script. For a script, you can also delete the object and then replace it with a

new object.

To open an existing procedure from the Procedure dialog box, follow these
steps:

1. Choose Procedure from the Design menu.

2. In the Procedure dialog box, expand the list of procedures so that the one
you want is displayed.

3. Select the procedure you want to use, and then click Open. Or double-click
the procedure name.

4th DIMENSION displays the procedure in the Procedure editor window.

To open a layout procedure from the Layout dialog box, follow these
steps:

1. Choose Layout from the Design menu.

2. Inthe Layout dialog box, expand the list and select the name of the layout
whose procedure you want.

3. Click Procedure.

4th DIMENSION displays the layout procedure in the Procedure editor
window.

To open a script, follow these steps:
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Open the layout that contains the object to which the script is attached.

Open the Field Definition or Object Definition dialog box for the field or
object, and then click Script. Or hold down the Option key as you click the
object.

4th DIMENSION displays the object’s script in the Procedure editor
window.

Using the Listing Editor

4th DIMENSION’s Listing editor is a text editor. When you create a
procedure with the Listing editor, you write the procedure as a list of

text

statements. You can also select elements of the procedure from lists

provided by the editor.

You can scroll through the procedure. Although a procedure is rarely
longer than a page, you can enter up to 32,767 characters (roughly 25
pages) in a procedure.

Figure 6-3 shows the Listing editor.

O

Procedure: Procedurel =ice———=015

Fields list

Keywords list

Keywaords + Employees I I Routines

Else
End if

If
Case of

End case

Boolean
Communications

Compiler Directives
Data Entry
Displaying
Exceptions

E Execution Cycle

Figure 6-3

The

Listing editor

The Listing editor contains four areas:

Editing area: The editing area contains the text of the procedure. You
enter and modify the procedure text in this area. The editor
automatically indents procedure text for clear program structure. You
can include comments inside the procedure text for reference.

Keywords list: The Keywords list is a scrollable area that provides
commonly used programming keywords such as If or Case of. A
keyword is a word, symbol, or phrase that has a specific use in a
procedure statement. When you click a keyword, 4th DIMENSION
inserts it at the location of the insertion point in the editing area.
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Group names are
pop-up menus

Fields list: The Fields list displays the names of fields and layouts

in the database. You click field names to enter them at the location of
the insertion point in the editing area. The area’s title bar displays the
name of the file whose fields and layouts appear in the list. You can
display fields and layouts from other files by clicking the cycle arrows
in the title bar. Clicking a filename inserts it in the procedure at the
location of the insertion point.

If no filename appears in the title bar, the fields displayed are
from the master file.

When you include a field name in the procedure by clicking in the
field area, 4th DIMENSION automatically provides the correct field
syntax, adding filenames or subfilenames as required. If you click the
name of a subfile field, 4th DIMENSION opens a window where you
can select a subfield name.

Layout names are added to the end of the list of fields for each file.
Clicking a layout name inserts it in the procedure at the location of
the insertion point.

Routines list: The Routines list displays the names of all

4th DIMENSION programming commands and functions. The routines
are grouped according to their function. Each group name is a pop-up
menu from which you can choose an individual command or function.

To display an alphabetical list of commands and functions, click
the title bar of the Routines list. At the end of the list of routines,
4th DIMENSION displays the names of global procedures that you
have developed and external procedures added to the database.

Figure 6-4 shows the commands displayed in groups and in
alphabetical order.

Routines Routines

ABORT

Abs

ACCEPT
ACCUMULATE
ACTIVATE LINK
ADD RECORD
ADD SUBRECORD
ADD TO SET
After

ALERT

ALL RECORDS

Arrays

Boolean
Communications
Compiler Directives

ADD RECORD

MO0 IFY RECORC
ADD SUBRECORD
MODIFY SUBRECORD

Import and Export

Figure 6-4
Routines displayed in groups and in alphabetical list

If you prefer writing procedures without selecting components from
the Keyword, Field, and Routines lists, you can suppress their display
by setting an option in the Preferences dialog box. See Chapter 1 for
more information on setting preferences.
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Writing a Procedure

Writing a procedure is usually a combination of typing and selecting
elements. You can successfully create procedures by typing the entire text,
if you want. You can select elements of the procedure from the Keywords,
Fields, and Routines lists, and you can use the “at” sign (@) wildcard to
speed the creation of procedures.

The 4th DIMENSION procedure editors provide basic syntax
error-checking. Additional error-checking is performed when the
procedure runs.

Typing Text

4th DIMENSION uses standard Macintosh text editing techniques for
typing and editing in the Listing editor.

As you type, the characters appear at the location of the insertion point.
End each line by pressing Return.

You can move the insertion point by clicking at the location you want.
You can select words, whole lines, or several lines by dragging the
[-beam pointer over them.

You can use the arrow keys to quickly move from line to line. Using
the arrow keys to move across several lines is quick because the editor
delays evaluating the line for errors.

When you press Return, 4th DIMENSION automatically indents each
line to its proper level in relation to the preceding line. 4th DIMENSION
also automatically changes commands and functions to bold type.

Figure 6-5 shows a procedure in the Listing editor.

Léﬂé_ Procedure: Add Employee §E§|

+CONF IRM("That record does not exist. Click OK to add a new record.”)
If (0K=1)

_ 1

-ADD RECORD([Ernployess]) :[
End if |

Keywords Employees Routines

If
Else
End if
Case of

. Boolean
Communications

End case
‘While

Figure 6-5
A sample procedure
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Bullets indicate error

Selecting Procedure Elements

You can quickly enter keywords, filenames, fields, layout names,
commands, and functions by selecting them from the Keywords, Fields,
and Routines lists in the lower portion of the window. Select elements
from these lists to ensure accuracy and for speed.

When you click an element, 4th DIMENSION inserts it at the insertion
point in the editing area, using the correct syntax for that element. The
element can be modified as normal text.

Using the Wildcard Character

You can enter most commands and filenames by typing the first few
characters and the wildcard character (@). 4th DIMENSION automatically
searches the list of routines and filenames, and enters the command,
function, or filename that begins with those characters.

Double-check each entry. You must type enough of the routine or filename
so that it is distinct from any other routine or filename. If more than one
routine or filename fits the instruction, 4th DIMENSION picks the first one
that fits. A filename always begins with a left bracket ([).

Checking and Correcting Syntax Errors

4th DIMENSION automatically checks the procedure syntax to see if it is
correct. If you enter text or select an element that is not compatible with
proper syntax, and if you press Return to end the line, 4th DIMENSION
marks the error with bullets, as shown in Figure 6-6.

E[J=——— Procedure: Add Employee
CONF IRM("That record does not exist. Click OK to add a new record.")
If (OK=1)
ADD RECORD( e[Emple )
End if |

Keywords Routines
Arrays
Boolean
Communications

Compiler Directive:

Employees

If
Else
End if
Case of

Data Entry
Displaying
Exceptions
Execution Cycle

End case
While

Figure 6-6
Syntax errors marked with bullets

You can immediately check the syntax of the current line by pressing the
Enter key. 4th DIMENSION evaluates the line, formats it, marks any errors,
and places the insertion point at the end of the line.
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When a line of a procedure is marked as having improper syntax, fix the
entry and press Enter. If the line is now correct, 4th DIMENSION removes
the bullets.

The Listing editor can check only for obvious syntax errors (misspellings
and the like). It does not check for errors that occur only during execution.
Execution errors are trapped by 4th DIMENSION when the procedure is
executed. 4th DIMENSION provides tools for handling and correcting these
errors. For more information about language error-handling, see Chapter 8,
“Debugging,” in the 4th DIMENSION Language Reference.

Finding and Replacing Text

When the Listing Procedure editor is active, 4th DIMENSION provides

the Search menu for performing search-and-replace operations on a
procedure. Use the Search menu to locate character strings in a procedure
and, if necessary, replace these characters with new ones. 4th DIMENSION
searches only from the current position of the insertion point to the end of
the procedure.

Figure 6-7 shows the Search menu.

Find... 8BF
Find Next #6
Replace... %R
Replace Nexnt T

Figure 6-7
Search menu

Here is a description of the Search menu commands:

® Find: Opens a dialog box in which you specify a character string
for a search. When you click OK, the editor finds and selects the next
occurrence of the string. The editor searches from the location of the
insertion point to the end of the procedure.

If you select text prior to choosing Find, the text is entered as the
string to search for. You can use this text or replace it by typing.

m  Find Next: Performs the previously defined search again.

m  Replace: Opens a dialog box in which you specify a character string
for a search-and-replace operation. The procedure editor searches
from the current location of the text insertion cursor to the end of
the procedure. When it finds text that matches the character string,
it replaces it with the new character string.
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If you select text prior to choosing Replace, the text is entered as the
target string to search for. You can use this text or replace it by typing.

m Replace Next: Performs the previously defined search-and-replace
operation again.

Managing the Listing Editor Window

You can change the relative sizes of the Editing area and the other
scrollable areas in the Procedure window to fit your needs. Just drag the
black bar—the Hide Keywords divider—that separates the Editing area
from the list areas.

Figure 6-8 shows the Hide Keywords divider.

E[J==——= Procedure: Add Employee E_—EEI
CONF IRM("That record does not exist. Click OK to add 2 new record.”)
If (0K=1)

ADD RECORD([Employees])
End if

Hide Keywords divider

Routines
Arrays
|Boolean
Communications
g Compiler Directives

+ Employees
{p|First

Last

Salary

Start date

Figure 6-8
Dragging the Hide Keywords divider

By dragging the divider up, you increase the number of keywords, fields,
and routines that you can see. By dragging the divider down, you reduce
or remove the Keywords, Fields, and Routines lists completely. You can
also hide the Keywords and the other lists by setting an option in the
Preferences dialog box. See Chapter 1 for more information on setting
preferences.

The Flowchart Editor

The Flowchart editor lets you create and edit 4th DIMENSION procedures
graphically, by adding steps and tests to a flowchart. The Flowchart editor
lets you create the same kinds of procedures that you create with the
Listing editor, except that you build your procedures visually.
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You can think of a flowchart as resembling plumbing in a house. The
procedure, like water, flows through the pipes and its movement is
determined by the state of valves in the plumbing. If a valve is open
(TRUE), the water (procedure) will flow through. If the valve is not open
(FALSE), the flow will stop at that point, or go elsewhere.

Figure 6-9 shows an example flowchart procedure.

® File Edit Use Design Flowchart

Procedure: Search Flowchrt

Test
Step

“Search Routine

fE ARCH SELECTIONC[Employees])

UTPUT
AYOUTC[Employees];"Employes
ist")

>KL‘ [?ISF‘LM SELEC TIDN([Em;louee:])J
=1 v,
UTPUT ]

M EA%DUT( Employees];"Employes
ist")

Duplicate icon

Flow line

Formula

“Return to calling
rocedure or menu

Figure 6-9
The Flowchart editor

In a flowchart, there are two types of objects: steps and tests. In addition,
there are flow lines that connect steps and tests. Each step and test also has
a formula that defines the operation of the step or test. The formula is
written in a dialog box. The flowchart palette provides icons that you click
to create steps and tests, to set a new starting point, and to duplicate
objects.

Here are descriptions of the four major Flowchart Procedure elements:

m  Step object: Directs 4th DIMENSION to perform a specific operation
or calculation (a statement). For example, a step can use the
NEXT RECORD command to make the next record in the database the
current record. Unlike a test, a step is not conditional—the event in the
step occurs each time the procedure executes the step.

m Test object: Tells 4th DIMENSION to evaluate a condition (a Boolean
expression) to determine the direction that the procedure will follow.
A test must evaluate to TRUE or FALSE. Each test object has two flow
lines leading to other steps or tests—a Yes flow line and a No flow
line. For example, a test can be associated with a condition such as
“Salary >= 50000”. When 4th DIMENSION reads the contents of the
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Salary field, it will follow the Yes flow line if the field contains a value
greater than or equal to 50,000.

m  Flow lines: Flow lines connect the steps and tests in the flowchart and
provide the direction of movement through the flowchart.

The direction of movement is shown by the way a flow line enters and
leaves a step or test. The flow line that connects the top of a step or
test brings information or instructions to the step or test. The result of
a step flows out the bottom of a step. The Yes result of a test flows out
the side of a test; the No result of a test flows out the bottom of a test.

m Formulas: Each step and test must be associated with a one-line
formula. The formula defines the precise step to be carried out or test
to be performed. The process of creating a formula is described later
in this section.

The Flowchart Menu

When the Flowchart editor is active, 4th DIMENSION provides a menu
for performing flowchart operations on a procedure. These commands
duplicate the functions of the icons in the flowchart palette.

Figure 6-10 shows the Flowchart menu.

New Step #EN
New Test BT
Set as Start 31

Figure 6-10
Flowchart menu

The Flowchart menu contains these commands:
m  New Step: Adds a new step object to the flowchart.
m New Test: Adds a new test object to the flowchart.

m Set as Start: Specifies a new starting point in the flowchart.

Creating a Flowchart Procedure

There are three basic steps for creating a procedure with the Flowchart
editor:

Use the icons in the palette or the Flowchart menu commands to add steps
and tests in the Flowchart window.

Create a formula for each step and test in the window.
Draw flow lines between the objects.

4th DIMENSION provides basic syntax error-checking. Other
error-checking is performed when the procedure runs.
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Creating Steps and Tests

With the Flowchart editor active, click the Step or Test icon in the palette.
Or choose New Step or New Test from the Flowchart menu.

When you move the cursor into the Flowchart area, it becomes a crossbar.

Position the crossbar where you want the upper-left corner of the object to
appear and click on the location.

4th DIMENSION creates the test or step. The crossbar becomes the standard
pointer again.

Creating a Formula

You use a formula (a one-line procedure) to control each step or test. To
create a formula, follow these steps:

Double-click the Step or Test object for which you want to create a formula.

4th DIMENSION displays the Formula editor, as shown in Figure 6-11.

Employees +] Routines

{> Arrays

l Boolean
Communications

Compiler Directives

Data Entry

Displaying

Keywords

[ Cancel ][[ 0K

Figure 6-11

The Flowchart formula editor

The Formula editor contains the same four areas as the Listing editor.

You use the Formula editor in exactly the same way as the Listing editor,
except that the Formula editor exists in a dialog box, not an editor window,
and it allows only one-line statements. You cannot move or resize the
dialog box, nor can you change the relative size of the editing area and

the lists at the bottom.

The formula, like a procedure, can contain up to 32,000 characters.

A step formula must result in an instruction to do something. The
statement ADD RECORD is an example of a step formula.

A test formula must result in TRUE or FALSE (a Boolean expression).
OK=0 is an example of a test formula.
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As you create formulas for steps and tests, 4th DIMENSION automatically
checks the formula syntax to see if it is correct. If you enter text or select
an object that is not compatible with proper syntax, 4th DIMENSION
marks the error with bullets.

Write the formula, and then click OK.

4th DIMENSION displays the Flowchart editor. The formula is displayed
in the step or test for which it was created.

Drawing Flow Lines

To define the flow of a procedure through the chart, you need to draw
flow lines between the objects in the Flowchart window. To draw a
flow line, follow these steps:

Position the pointer on the lower boundary of a step object, or on one
of the corners of a test object.

The pointer becomes a small, upward-pointing arrow.

To draw a Yes line from a test, position the pointer on the left or right
corner; to draw a No line from a test, position the pointer on the bottom
corner.

Drag away from the object and towards the object to which you want
to connect the flow line.

Figure 6-12 shows a flow line being drawn.

Procedure: Procedure4 E_Eél

JIIIT}

ADD RECORDL [Ernployees])

B[—HH[e

Figure 6-12
Drawing a flow line

Release the mouse button at the border of the object you want to connect.
4th DIMENSION draws a flow line between the two objects.

4th DIMENSION lets you draw through other objects to connect objects in
the flowchart.
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If you are drawing flow lines from a test object, 4th DIMENSION
automatically labels the lines as Yes and No.

To erase a flow line, follow these steps:
Position the pointer on the flow line you want to delete.

When the pointer becomes a small, upward-pointing arrow, drag the line
to an area between objects (so that the pointer is not touching any object)
and release the mouse button.

The selected flow line disappears.
Specifying a First Step

When you create a flowchart procedure, the first step you create is shown
in bold outline, indicating that it is the first step. The first step is where the
procedure begins when it executes. You can change the first step at any
time. Setting a new first step is a way to isolate parts of the flowchart
procedure in order to debug problems.

When you set a new first step, 4th DIMENSION ignores all steps and tests
before the new starting point.

To set a new first step, follow these steps:
Select the step you want to specify as the first step in the procedure.

Click the Set as Start icon in the palette. Or choose Set as Start from the
Flowchart menu.

4th DIMENSION displays the step in bold as the new starting point.
Editing a Flowchart Procedure

You can change the way a flowchart is displayed, moving and resizing
the elements so that the flowchart is clear and easy to read. And you can
change the formulas that define the steps and tests.

There are several ways to select flowchart objects:
m Click the test or step in the Flowchart editor window.
4th DIMENSION highlights the selected object.

m  Select multiple objects by dragging a selection rectangle around the
tests or steps you want to select.

m  Select multiple objects by pressing Shift while clicking the tests or
steps you want to select.
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To move an object, follow these steps:
Select the object in the Flowchart editor window.
Drag the object to its new location in the window.

If there are flow lines connected to the object you are moving, they
follow the object.

To resize an object, follow these steps:
Select the object in the Flowchart window.

4th DIMENSION highlights the step or test, and displays a resizing
handle in the upper-left corner.

Move the pointer over the resizing handle on the selected object.

The pointer changes into a multi-directional arrow, as shown in Figure 6-13.

SCJ=——— Procedure: Procedured =————(15|

o) s

234

i

ADD RECORD(C [Ernployees])

| 8=}

Figure 6-13
Resizing an object

Drag the handle toward the center of the object to shrink it, or away from
the center to enlarge it.

4th DIMENSION resizes the object.

To duplicate an object, follow these steps:

Select the object or objects that you want to duplicate.
Click the Duplicate icon in the palette.

4th DIMENSION duplicates the object or objects. If you previously
assigned a formula to the object, the copy possesses the same formula as
the original.
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To delete an object, follow these steps:

Select the object or objects that you want to delete.
Choose Clear from the Edit menu.

Or

Press the Backspace key.

4th DIMENSION deletes the selected object or objects. The deletion also
removes any flow lines connected to the deleted object.

To edit a formula for a step or test, follow these steps:
Double-click the test or step object whose formula you want to edit.

4th DIMENSION displays the Formula editor. The existing formula appears
in the Formula area.

Edit the formula, using the editing techniques described in “Writing a
Procedure” earlier in this chapter.

Also, see the 4th DIMENSION Language Reference for more information
on programming commands and syntax.

Click OK to accept the formula and return to the Flowchart window.

Click Cancel to discard the formula or editing changes and return to the
Flowchart window.

Formula Syntax Errors

4th DIMENSION automatically checks the formula syntax to see if it is
correct. If you enter text or select an element that is not compatible with
proper syntax, and if you press Return to end the line, 4th DIMENSION
marks the error with bullets, as in the Listing editor. You can immediately
check the syntax of the current line by pressing the Enter key.

4th DIMENSION evaluates the line, formats it, marks any errors, and
places the insertion point at the end of the line.

When a formula is marked as having improper syntax, fix the entry and
press Enter. If the line is now correct, 4th DIMENSION removes the
bullets.

The Formula editor can check only for obvious syntax errors (misspellings
and the like). It does not check for errors that occur only during execution.
Execution errors are trapped by 4th DIMENSION when the procedure is
executed. 4th DIMENSION provides tools for handling and correcting
these errors. For more information about language error-handling, see
Chapter 8, “Debugging,” in the 4th DIMENSION Language Reference.
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CREATING CUSTOM MENUS

You can create custom menus for your databases and runtime applications.
Because pull-down menus are a standard feature of the Macintosh user
interface, their addition will make your databases easier to use, and will
make them feel more familiar to users. With menus, your databases will
perform more like “stand-alone” applications.

When you create a runtime application, you must create at least one menu
bar with at least one menu. (See the 4th DIMENSION Language Reference
for detailed information on creating runtime applications.)

Designing Menus

In general, menus provide commands that the user chooses to perform
database tasks: modifying records, searching for records, printing reports,
and so on. Figure 7-1 shows an example of a custom menu.

% File Edit

=T Companies
New #EN
Modify 3EM

Menu item

Report 3R

Figure 7-1

Menu bar, menus, and menu items

A menu bar is a group of menus that can be displayed on a screen together.
Each menu on a menu bar can have many items in it, including lines that
divide the menu items into groups. A menu item, when chosen, calls a
global procedure that performs an operation. Menu items are sometimes
called menu commands.

Each menu bar you create has, by default, the Apple menu that displays
your desk accessories, the File menu with the Quit command, and the Edit
menu with the standard Undo, Cut, Copy, and Paste menu items. You
cannot edit the Apple menu or the Edit menu. You can add items to the
File menu, and you can add as many other menus as you like. As a
practical limit, the small Macintosh screen can display seven or eight
menus, depending on the length of the menu titles.

You can have many separate menu bars for each database. You can use one
menu bar that contains menus for standard database operations, and
another that becomes active only for reporting. One menu bar may contain
a menu with commands for entering records, whereas the menu bar that
appears with the input layout may contain the same menu, but with the
commands dimmed because the user doesn’t need them during data entry.
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When you design menus, keep two rules in mind:
m Use menus for functions that are suited to menus.

Menu items should perform fairly large-scale procedures such as
adding a record, searching for records, or printing a report.

m  Group items by function.

A user should be able to go to a menu of associated commands to find a
menu option. For example, all commands that browse through database
records should be in the same menu. For another example, you might
have all operations for a certain group of records on one menu.

You use the Menu editor to create menus. You can perform these operations
in the Menu editor:

Specify styles for menu items.

Specify keyboard equivalents for menu items.
Add dividing lines to menus.

Assign password groups to menu items.
Enable or disable menu items.

View sample menus while you are creating the menu structure.

Paste in a custom graphic associated with each menu bar.

Each of these tasks is explained in this chapter.

Creating Menus

4th DIMENSION allows you to create entire menu bars. A menu bar is the
collection of menus that appear at the top of your Macintosh screen.

The menu bar displays the menu titles; the menus pull down to display the
menu items. Every menu item should be associated with a global procedure.

Basic Steps for Creating Menus

These are the steps for creating custom menus:

Create one or more menu bars. See “Creating a Menu Bar,” later in this
chapter.

Create the menus that will pull down from the menu bar. See “Adding
Menus,” later in this chapter.

Add menu items to each menu in the menu bar. See “Adding Menu Items,”
later in this chapter.
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Assign a global procedure to each menu item. When the user chooses that
item, the procedure performs the operation associated with it.
See “Assigning Procedures to Menu Items,” later in this chapter.

Write the global procedures that perform the menu commands.

See Chapter 6 for more information on using the Procedure editors.
See the 4th DIMENSION Language Reference for detailed information
about 4th DIMENSION’s programming language.

Make any enhancements you want, such as special font styles, separator
lines, keyboard shortcuts, and so on. See “Enhancing Menus,” later in
this chapter.

Assign password access groups to menu items (optional).
See Chapter 8, “Managing Password Access.”

Creating a Menu Bar

To create a menu bar, follow these steps:
Choose Menu from the Design menu.

4th DIMENSION displays the Menu Bars dialog box, which lists
any menu bars previously created for the database. See Figure 7-2.

Menu Bars...
[Benupsari Tl e
3 l Open I
Figure 7-2

Menu Bars dialog box

4th DIMENSION assigns menu bar numbers sequentially—Menu Bar #1
appears first. You cannot change menu bar numbers.

Important: If you delete a menu bar, 4th DIMENSION automatically
renumbers any remaining menu bars. If you refer to menu bars in
a procedure, you may need to update the procedure to reflect new
menu bar numbers.
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Click New.

The new menu bar appears in the Menu editor window, as shown in
Figure 7-3.

S[J=————— Menu Bar #| =———03|
Menus Items Procedures
. File K| Ko K
Menus list
ltems list
Procedures list - - ||
[ < I
[0 Keuboard: _] O sai¢
Oiine [ ttatic
[Jinabies [ ingertine
O sutiine
Password:[ ][O $hagnu
=)
Figure 7-3
Menu editor

The editor window displays the name and number of the new menu bar.

At this point, you can begin assigning menus to the menu bar and adding
menu items to the menus.

The Menu editor window displays menu information in three lists.
m  The Menus list displays the name of each menu in the menu bar.

m  The Items list displays the name of each menu item in the menu selected
in the Menus list.

m  The Procedures list displays the name of the procedure assigned to each
menu item in the Items list.

Notice that the File menu appears in the Menus list, but neither the Apple
menu nor the Edit menu appears. You can add items to the File menu, but you
cannot edit the Apple or Edit menu. When the menu bar is in use, the Apple,
File, and Edit menus occupy the first three places at the left end of the menu
bar.

Note: The File menu should always include Quit as the last item.
4th DIMENSION automatically adds the Apple and Edit menus to the
menu bar when the menu bar is displayed.

Adding Menus

You can add menus to either a new or an existing menu bar.

The number of menus you can add to a menu bar depends on the size of your
screen—a large display can show more menus than the screen of a Macintosh
Plus or SE. If the runtime application will be used on a standard Macintosh
screen, make sure that the menu bar will fit in the smaller display area.
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There are two ways to add menus:
m  Append a new menu to the end of the current list of menus.

m Insert a new menu anywhere in the current list of menus.
To append a menu, follow these steps:

With the Menu editor window open, choose Append Menu from the Menu
menu. Or double-click in the space below the last menu in the Menus list.
Or select the last menu name and press Return.

4th DIMENSION frames an area at the end of the Menus list so that you
can enter the menu title.

Type the name of the new menu in the box.

The maximum length for a menu title is 15 characters. Additional
characters are ignored.

As you enter the menu name, 4th DIMENSION displays the name to the
right of the current menu bar to show how it will look in the finished
application. You can pull down this sample menu in the same way that you
pull down active 4th DIMENSION menus. When you add menu items, they
appear in this sample menu.

Figure 7-4 shows a menu being added to a menu bar.

€ File Edit Use Design Menu Employees

Modify Employee

] l‘—ndu Employee

l Delete Employee

Figure 7-4
Adding a new menu

Repeat steps 1 and 2 to add more menus.
To insert a menu, follow these steps:

In the Menu editor window, select the menu that is to appear below the
menu you are adding.

4th DIMENSION inserts the new menu above whichever menu is currently
selected. This allows you to insert a new first menu.

Choose Insert Menu from the Menu menu.

4th DIMENSION frames an area above the previously selected menu title
so that you can enter the new menu title.

Type the name of the new menu in the box.
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Adding Menu ltems

For each menu in the menu bar, you must create the menu items—the
commands that appear when the menus are pulled down.

The standard Macintosh screen can display up to 18 menu items at one
time. The user can scroll additional menu items into view to choose them.

There are two ways to add menu items to the Items list in a Menu editor
window:

m  Append a new menu item to the current list of menu items.

m Insert a new menu item at any point in the current list of menu items.
To append a menu item, follow these steps:

Select the menu that you want to provide with a menu item.

Choose Append Item from the Menu menu. Or double-click in the space
below the last menu item in the Items list.

4th DIMENSION frames an area at the end of the Items list so that you can
enter text. A frame also appears in the Procedures list so that you can enter
a procedure name.

Type the name of the new menu item in the box.

Any menu item you add appears in the sample menu on your current menu
bar when you pull down the menu.

Repeat steps 1 through 3 to add more menu items to the Items list.
To insert a menu item, follow these steps:

In the Menu editor window, select the item that is to appear below the item
name you are adding.

4th DIMENSION inserts a new menu item above whichever item is
currently selected. This allows you to insert a new first item.

Choose Insert Item from the Menu menu.

4th DIMENSION frames an area above the previously selected item name
so that you can enter the new item name. A frame also appears in the
Procedures list so that you can enter a procedure name.

Type the name of the new menu item in the box.

Any menu item you add appears in the sample menu on your current menu
bar.
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Assigning Procedures to Menu ltems

To enable a menu to perform its function, you must assign global
procedures to the menu items. These procedures perform the actual
functions indicated by the menu items. For example, the menu item
Monthly Report can call a global procedure that prepares a monthly report
from a file of financial data.

In the Menu editor, each menu item is assigned a global procedure in the
Procedures list. When a menu item is chosen, 4th DIMENSION executes
the global procedure assigned to it.

You create the global procedure with a 4th DIMENSION Procedure editor.
You can create the procedure before or after you assign it to the menu
item. For information about using the Procedure editors, see Chapter 6.
For complete information about using 4th DIMENSION’s language, see the
4th DIMENSION Language Reference.

You can assign the procedure when you create the menu item or at a later
time.

To assign a procedure to a menu item, follow these steps:
Create the menu item, or select it if it already exists.

When 4th DIMENSION frames an area for the menu item, it also frames an
area in the Procedures list for the procedure name.

Select the area in the Procedures list.

Type the name of the global procedure you want to assign to the menu
item.

ﬁ Note: If you change the name of a procedure that is used in a menu,
you must update the procedure name here in the Menu editor.

Enhancing Menus

You can change the font style of menu items, add separator lines between
groups of menu items, assign a keyboard equivalent for an item, and
enable or disable items.

Figure 7-5 on the following page shows the Menu editor being used to
enhance a menu item.
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& File Edit Use Design Menu ployee
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S[J=———— Menu Bar #1 Modify Employee
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File [+ Add Employee n Delete Employee
Emplogees Modify Employee
Delete Employee
1 w ]
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Figure 7-5

Using the Menu editor to enhance menu items

Changing Font Styles

4th DIMENSION lets you customize menus by applying different font
styles to the menu items.

You can customize your menus with these styles:
Bold

Italic

Underline

Outline

Shadow

Be cautious when applying font styles to your menus—too many styles
will be distracting to the user and give a cluttered look to your application.

To apply a style, select the menu item you want to embellish, and then
choose the style from the check boxes.

Enabling and Disabling Menu ltems

You can specify whether a menu item will appear enabled or disabled.
An enabled menu item can be chosen by the user; a disabled menu
item is dimmed and cannot be chosen. Unless you specify otherwise,
4th DIMENSION enables each menu item you add to a custom menu.

To enable or disable a menu item, follow these steps:

Select the menu item you want to enable or disable.
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If the Enabled check box is selected, the menu item appears black in the
menu. If the Enabled check box is deselected, the menu item appears
dimmed, signifying that it cannot be chosen.

Adding Separator Lines

To enable the menu item, select Enabled.

To disable the menu item, deselect Enabled.

Groups of menu items in a menu can be separated by a dotted line.
This convention is useful for grouping associated commands by function.

Figure 7-6 shows a menu with a separator line.

Employees

Aag Fmpioges %N
Modify Employee

Delete Employee

Figure 7-6
Menu with separator line

To add a separator line, follow these steps:
Select the menu you want to work with in the Menus list.
The menu items for that menu appear in the Items list.

Choose Insert Item or Append Item to frame a location in the Items
list where you want to add the separator line.

Click Line.

In your Items list, the framed area remains blank. The separator line
does not appear in the editor window.

Click Disabled so that the line cannot be chosen.

Pull down the sample menu to see how the separator line appears
in the menu.

Assigning Keyboard Equivalents

In standard Macintosh applications, there are some menu commands that
you can choose by pressing a combination of keys rather than by using
the menu. These commands are said to have keyboard equivalents.

If a command has one of these shortcuts, you’ll usually see a symbol for
it next to the menu item. For example, “3C” appears next to the Copy
command on the Edit menu. This means you can copy a selection by
holding down the Command-key (&§) and pressing the C key.
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4th DIMENSION lets you assign keyboard equivalents to the items in your
custom menus. You can use any alphanumeric keys in combination with
the Command key as a keyboard equivalent except for the keys reserved
by standard Macintosh commands that appear in the Edit and File menus.
These reserved key combinations are shown in Table 7-1.

Table 7-1

Reserved Keystrokes

Key Operation
Command-C Copy
Command—Q Quit
Command-V Paste
Command-X Cut
Command-Z Undo

Command-. (period) Stop action

To assign a keyboard equivalent, follow these steps:

Select the menu item to which you want to assign a keyboard equivalent.
Click Keyboard.

In the Keyboard entry box, type an alphanumeric character that you want
to associate with the command.

The user can choose the menu command by holding down the Command
key and pressing the assigned key.

Pull down the sample menu to see how the keyboard equivalent appears in
the menu.

ﬁ Note: An active object can also have a keyboard equivalent. If Command key
assignments are duplicated, the active object takes precedence.

Editing Menus and Menu ltems

You can copy, move, and delete menus and menu items.

Copying and Moving Menus

You can copy a menu to place it on a different menu bar. You can move a
menu to a different menu bar, or to a new location on the same menu bar.

When you copy or move a menu, you are copying or moving the menu
title, all menu items, and their associated procedure names.
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To copy a menu, follow these steps:
Select the menu you want to copy in the Menus list.

When you select a menu, the names of commands assigned to the menu
appear in the Items list.

Do not select any text in the menu title, otherwise only the selected text is
copied.

Choose Copy from the Edit menu.

4th DIMENSION copies the menu, menu items, and procedures to the
Clipboard.

Create a new menu bar where you want the copied menu to appear.

You can append a menu to the bottom of the list of menus, or insert the
menu between other menus.

Choose Paste from the Edit menu.
4th DIMENSION pastes the menu, menu items, and procedures into place.

To move a menu, use the Cut command on the Edit menu instead of the
Copy command. If you want to insert the new menu, first select a current
menu. If you want to append, click the last menu.

Deleting Menus

You can remove a menu at any time. A deleted menu no longer appears on
the menu bar. You might not want a particular menu on a certain menu bar.
You might delete a menu after you have placed its menu items on other
menus. Or you might delete menus that you have placed on different menu
bars.

To delete a menu, follow these steps:
Select the menu you want to delete in the Menus list.

When you select a menu, the names of commands assigned to the menu
appear in the Items list.

Double-check to make sure this is the menu you want to delete.
Choose Delete Menu from the Menu menu.

4th DIMENSION removes the menu from the Menus list. The deleted menu
will no longer appear in the application’s menu bar.
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Deleting Menu Items

You can delete a menu item at any time. You might delete a menu item
that is out of date. You might delete a menu item after you have placed it
on another menu. Or you might delete a menu item that has been replaced
by another menu item.

To delete a menu, follow these steps:
Select the menu item you want to delete.
Choose Delete Item from the Menu menu.

4th DIMENSION removes the item from the Items list.

Previewing Custom Menus and
Adding a Splash Screen

fppend lem
insart tiem
Beipte Item

Show Custom Menus

As you develop your runtime application, 4th DIMENSION lets you view
the custom menus and menu bars as they will appear in the application.

While previewing a menu bar, you can also embellish each menu bar with
a “splash screen,” a custom graphic displayed under the menu bar when it
appears. A splash screen can include a company logo or other design
elements.

Before you can add a splash screen, you need to do two things:

m Create the graphic using a Macintosh graphics application, by
scanning, or by some other means.

m  Copy the graphic into your Scrapbook.
To preview the menu bar and add a splash screen, follow these steps:
Choose Show Custom Menus from the Menu menu.

4th DIMENSION displays the menu bar as it will appear in the custom
application and prompts you to copy a picture to accompany the menu bar.

Figure 7-7 shows a menu bar being previewed.

& File Edit Departments

AU LITEEE Reports
Add Emplo
Modify Employee
Remove Employee

Figure 7-7
Custom menu bar

Open the menus listed on the menu bar to preview the contents of the
menus.
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If you are going to add a splash screen, copy the graphic from the
Scrapbook and paste it into the Splash Screen area.

4th DIMENSION centers the graphic image beneath the menu bar. Figure 7-8
shows an example of a custom splash screen.

® File Edit Selection Report

MiniFans
@ 1988 ACIUS Inc.

Paste a picture to use with this menu bar. Click anywhere in the window to exit.

Figure 7-8
Custom splash screen

When you are satisfied with your splash screen, click anywhere in the
screen to exit the preview.

The splash screen will appear whenever this menu bar is used in the runtime
application.

Menus and Runtime Applications

-~

Menu bars provide the major interface for runtime applications. For each
runtime application, you must create at least one menu bar with at least one
menu. See the 4th DIMENSION Language Reference for more information
on creating runtime applications. Bhy Use a Lavguase L4

Menu Bar #1 is by default the menu bar that is displayed in the Runtime
environment. You can change the menu bar with the language.

If you define a menu item without assigning it a procedure, choosing

~ that item causes the application to quit. If you are using the full

4th DIMENSION application and do not have a password system, quitting
from the Runtime environment returns you to the User environment.

A password system can be set up to control where each user is placed when
quitting from the Runtime environment. If you are using the application
with 4th DIMENSION Runtime, quitting takes you to the Finder.
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MANAGING PASSWORD ACCESS

This chapter provides information about 4th DIMENSION’s Password
Access editor. If more than one person uses a database, you may want

to provide different kinds of access to the database. If you are designing
applications for use in a multi-user environment, it is essential that you
provide security for sensitive data by assigning passwords to users and
creating access groups that have different levels of access to information in
the databases or database operations.

Use the Password Access editor to
m specify users of an application or database
m provide users with passwords

m create groups of users with different levels of access to the database or
application

®m nest groups of users within other groups to create a hierarchy of users
After you create access groups, you can manage access to

® input and output layouts

m database files

m procedures

® menu commands

In addition to providing security for your applications and databases, the
access system also maintains a user history—the Password Access editor
can tell you how many times a user has used the database and the date of
the most recent use.

CHAPTER 8: MANAGING PASSWORD ACCESS 255



256

Access System Overview

4th DIMENSION’s password access system is based on users and groups.
You assign passwords to users. You assign users to groups, and you assign
each group access rights to appropriate parts of the database.

Figure 8-1 shows file access rights being assigned to various groups.

File Attributes...

Filename: || Iy [IT=H

Record Access

Load: [AIl Groups |

Save: |Human Resources |

Add:  [Human Resources |

Delete: Al Groups

Finance

Engineering 0K I
MIS

Hurnan Resources

Figure 8-1

Assigning access privileges

A user types the password to open the database. Then, depending on
which groups the user belongs to, and which parts of the database the
groups have been assigned to, the user can operate the parts of the
database that his group membership allows.

Figure 8-2 shows the Password dialog box for the user to enter a
password when opening a database.

Enter password:

Guest
Designer
Adrninistrator
halll
Terri
Sabra
Tess
Erian
Susan

Kathryn

(Concei )
(aaaaaE| [ (T |
Figure 8-2

Opening a database with a password

The user operates the database in a normal fashion. When the user
attempts to use a layout, menu item, procedure, or file that the group is
not permitted to use, 4th DIMENSION displays an error message, shown
in Figure 8-3 on top of the following page.
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Error
s Your password does not allow you to use Privilege Error.
this menu item.

Action

lﬁe procedure cannot be executed.

Figure 8-3a Figure 8-3b
Access error for menu items and layouts Access error for procedures and files

ﬁ Note: If an ON ERR CALL procedure is installed, the error message for
procedures and files is not displayed. See the 4th DIMENSION Language
Reference for more information.

An Access Hierarchy Scherhe

The best way to ensure the security of your database and provide users
with different levels of access is to use an access hierarchy scheme. This
section discusses some approaches to such a scheme.

Users can be assigned to appropriate groups, and groups can be nested to
create a hierarchy of access rights. An example of an access hierarchy is
shown in Figure 8-4.

F=======——= Posswords S| sswords = Posswords B3|
Users... Groups... vy Users...
] (@ vesigner K& [Hreveit P Designer Fi
@ Administrator | [Ereveri2 ‘ |® Raministrator | B Administrator
| [Brevel s ‘ Level 3 ‘ 1 |
|
' L] | \ 1
33 | | }R | ] l =
F' - ® Administrator ] [ K [P Raministrator [ T K Administrator 1]
i 33 tever 2 | }D} Level 5 |
l =
[ [
Figure 8-4

An access hierarchy

In this example, a user is assigned to one of three groups, depending on the
user’s responsibility. Users assigned to group Level 1 are responsible for
data entry. Users assigned to group Level 2 are responsible for maintaining
the data, including updating records and deleting outdated records. Users
assigned to group Level 3 are responsible for analyzing the data, including
performing searches and printing analytical reports.

The groups are then nested so that privileges are correctly distributed
when the groups are assigned. Level 3 contains only high-level users.
Level 2 contains data maintenance users, as well as Level 3 users, so that
the users in Level 3 have the privileges of Level 2 as well. Level 1
contains data entry users, as well as Level 2 users, so that users who
belong to Level 2 and Level 3 enjoy the privileges of Level 1 as well.
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You can decide which group to assign access privileges to based on
responsibility. If you assign group Level 1 to a menu item, for example,

it means that everyone can use this menu item. If you assign group Level 2
to the menu item, it is restricted to members of Level 2 and Level 3. If you
assign group Level 3, only members of Level 3 can use the menu item.

Such a hierarchical system makes it easy to remember which group to
assign a new user. You only have to assign each user to one group, and
you use the hierarchy of groups to determine access.

As part of designing your access system, another consideration to keep

in mind is the level at which a user should be restricted. You can think of
each of the parts of a database to which access can be controlled—menu
items, procedures, layouts, and file operations—as being part of a natural
hierarchy. For example, if only a file is restricted, a user may get through
the menu that calls a procedure that displays a layout only to be restricted
at the file level.

Here is the general order of restriction:
1. Menu item.

2. Procedure.

3. Layout.

4. File operation.

Your access scheme should restrict access at the highest appropriate level,
usually at a menu item.

One useful approach avoids the need for groups altogether: You can create
a menu bar for a specific user that contains unrestricted menus appropriate
for his or her needs. You can then create a startup procedure that assigns
that menu bar to that user. When you add the user to the password access
system, you can specify the startup procedure to execute when that user
opens the database.

Important: If you allow users to have access to the User environment,
it is important to assign access privileges to procedures, layouts, and files
in the database. Normally, the User environment allows unrestricted access
to procedures, layouts, and files.
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Users’ Access to Environments

4th DIMENSION provides users with certain standard access privileges
to the three environments and certain powers within each environment.
Once a password access system has been initiated, these standard
privileges take effect.

The most powerful user is named Designer. When the Designer opens
the database, it opens in the environment specified in the Preferences
dialog box. The Designer has control over the design of the database.
The Designer can create user groups, assign access privileges to groups,
and use the Design environment. No aspect of the database is closed to
the Designer. The Designer can use the Design environment, User
environment, and Runtime environment. Menus, layouts, procedures,
and files that have limited access are open to the Designer.

After the Designer, the next most powerful user is the Administrator.
When the Administrator opens the database, it opens in the User or
Runtime environment, depending on the environment specified in the
Preferences dialog box. The Administrator can have access to both the
User and Runtime environments. Using the language, the Administrator
can be given the power to add users and groups, assign and change
passwords, and assign users to groups. The Administrator’s access to the
database is limited by group membership. The Administrator is placed in
every new group, but you can remove the Administrator’s name from the
group.

All other users are ordinary users. When a user opens the database, it
opens in the User or Runtime environment, depending on the environment
specified in the Preferences dialog box. A user can have access to both the
User and Runtime environments. Users’ access is limited by group
membership.

You can restrict a user to the Runtime environment by creating a startup
procedure. You can assign a startup procedure to any user. Any entry in
the “Startup procedure” box, even a dummy entry that has no actual
procedure to execute, restricts a user or Administrator to the Runtime
environment. The Designer’s access to environments is not affected by
a startup procedure.
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Group Owners

You can designate an owner for each group. Usually, the owner is the
Administrator, but you can designate any group member as the owner.

The group owner can be given the ability to add users to the group and
remove users from the group. The users to be added must already exist.
Group owners cannot create users, or create or change user passwords.

Group owners can add and remove individual users only. Group owners
cannot add or remove other groups from the group.

Guests

4th DIMENSION makes a provision for opening a database without a
password. As a guest, any user can open a database without a password
and can operate any part of the database that is open to all groups.

If all users have passwords, a guest is limited to the Runtime environment.
A guest can view data, display layouts, and use any menu items that are
not protected by access groups.

Using Startup Procedures

A startup procedure can be assigned to each user. The startup procedure
executes each time the user opens the database. You can use a startup
procedure to

m restrict a user to the Runtime environment
m display a personalized message

m display a menu bar other than Menu Bar #1
m do special initialization

Initiating the System

You initiate the 4th DIMENSION password access system by assigning a
password to the Designer.

Until you give the Designer a password, 4th DIMENSION allows anyone to
use any part of the database.

When a password is assigned to the Designer, all the access privileges you
have assigned to files, layouts, menus, and procedures take effect. In order
to open the database, users must enter a password, or accept guest status.

FI_P’/ Warning: Do not forget the Designer’s password. If you do, you will

be unable to open the database in the Design environment.
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Assigning Users and Groups

You use the Password Access editor to create access groups and assign
passwords to users.

To open the Password Access editor, choose Passwords from the Design

vStructure menu.
Layout... 3L
Procedure...

4th DIMENSION opens the Password Access editor, shown in Figure 8-5.

Passwords
S[J=——= Passwords ———="0|
Users... Groups...
(@ pesi K> K
gner [ [
@ Administrator
Users list
Groups list
] ]
i i
o <
=)

Figure 8-5
The Password Access editor

The Password Access editor displays four scrollable areas. The upper
Users list displays user names. The users designated Designer and
Administrator appear at the top of the list. The lower Users list displays
the names of any groups a selected user belongs to.

The upper Groups list displays the names of access groups. The lower
Groups list displays the names of users who belong to a selected group.

When the Password Access editor is active, the Passwords menu is
available.

You use the commands on this menu to add users and groups.
Adding Users and Passwords

When you add a user and assign a password, you can also specify a startup
procedure to perform a special operation when the user opens the database.

To add a user and assign a password, follow these steps:

1. Choose New User from the Passwords menu.

Passwords
£4it Yepr..
New User... #

4th DIMENSION displays the Edit User dialog box, shown in Figure 8-6.

£4if Graup...
New Group...

Save Groups...
Load Groups...
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— Edit User

ser name:
Password:

Startup procedure: l

Last use: 00/00/00
Number of uses: D

[ Cancel ][[ 0K ]]

Figure 8-6

Edit User dialog box

The dialog box provides areas for entering a user name, a password, and
the name of a startup procedure. In addition, the Designer or Administrator
can view information about an individual’s use of a database or database
application.

Type a new user name.
Type a password for the user.

You can use up to 15 alphanumeric characters for a password. The
Password Access editor is case sensitive—the user must enter the
password exactly as it is entered in the Edit User dialog box. For example,
if you define a user’s password as “alPHa”, the user must enter it with a
capital P and capital H, or 4th DIMENSION will not accept the password.

ﬁ Note: After you specify a user password, that password is not available for
view the next time you open the dialog box. Asterisks display in place of the
password characters.

If you wish, enter the name of a startup procedure for the user.

For a startup procedure to execute, you must create a global procedure
with the name you assign. See Chapter 6 for information about creating a
global procedure. For information about using 4th DIMENSION’s
language, see the 4th DIMENSION Language Reference.

| If you assign a startup procedure for the user, 4th DIMENSION executes

that procedure every time the user opens the database. To restrict a user to
the Runtime environment, specify a dummy startup procedure name, such

_as X.

Click OK to save the user information.
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To change user names and passwords, follow these steps:

1. Select the user name in the list of users and choose Edit User from the
Passwords menu. Or double-click the user name.

4th DIMENSION displays the Edit User dialog box.
2. Make the modifications you want in the dialog box.

3. Click OK to save the changes you made to the user profile.

Creating Access Groups

When you create a group, you can designate a group owner from among
the users.

To create a group, follow these steps.

Passwords 1. Choose New Group from the Passwords menu.

Edit Usor.., .

New User... %N 4th DIMENSION displays the Edit Group dialog box, shown in Figure 8-7.
43 Group...

New Group... Edit Group

Save Groups... This group contains 0 users.

Load Groups...

Group name: |RISTINEIEII 8]

Group owner: [Administrator ]

[ Cancel ] [[ 0K ]]

Figure 8-7
The Edit Group dialog box

2. Enter a group name in the Group Name box.
The group name can be up to 15 characters in length.

3. Click on the Group Owner box and select a user from the pop-up menu of
users.

The group owner can add users to and remove users from the group.

4. Click OK to add the group to the access system.
The name of the new group appears in the group list.
To change access groups, follow these steps:

1.  Click the group name in the list of groups and choose Edit Group from the
£cHt User.. Passwords menu. Or double-click on the group name.

New User... 3N
4th DIMENSION displays the Edit Group dialog box.

New Group... 2

Enter a new group name or specify a new group owner in the dialog box.
Save Groups...

Load Groups... CHAPTER 8: MANAGING PASSWORD ACCESS 263




3. Click OK to save the changes you made to the group.
Assigning Users to Groups

You can assign users to any group. You can assign a user to several access
groups. You are not required to assign a user to a group.

To assign a user to a group, drag the user name from the Users list over the
name of the desired group in the Groups list, then release the mouse
button.

Figure 8-8 shows a user name being added to a group.

S(I=—— Passwords —————0F]|
Users... Groups... )
@ Designer | |IJ Executive &
P administrator | | |JFinance
[ Terri [EEE¥TES
[ sabra [JJHuman Resource
[J Tess [JJAdministration | |
[J Brian [
<+ |8 Administrator ||
O] =
@
Figure 8-8

Assigning a user name to a group

The user name appears in the lower Groups list of users assigned to the
selected access group. The group name appears in the lower Users list of
groups assigned to a selected user. The assigned user now has all the
privileges that you provide that group.

Click any group name to see a list of users who belong to that group.
Removing Users from Groups

To remove a user from an access group, follow these steps:

1.  Click the group name in the upper Groups list to view the names of users
assigned to the group.

2. Drag the user name from the lower Groups list to the Users list and release
the mouse button.

The user name disappears from the list of users assigned to the selected
group. The user no longer enjoys the privileges that you provide that
group.
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Nesting Groups

To create a user hierarchy, you nest groups, placing one group within
another group. The users of the nested group obtain the privileges of both
groups. For example, if you nested the group Lapis inside the group
Emerald, users assigned to the Lapis group would automatically get the
privileges of Emerald in addition to the privileges accorded the Lapis
group. However, users inside Emerald are denied access to the privileges
of the Lapis group—they have only the privileges assigned to Emerald.

For further explanation of how a hierarchical access system works, see
“An Access Hierarchy Scheme,” earlier in this chapter.

To assign a group to another group, drag the group name from the list of
groups over the name of the group whose privileges you want it to assume,
and release the mouse button. Figure 8-9 shows a group being added to
another group.

E[[==——— Passwords =————11¢
Users... Groups...
® Designer [JJ Executive K
Administrator @ rinance
[ win [JJEngineering
[@ Terri [EEENTES
[J sabra [JJ Human Resource
[ERCIT I W [ Adrministration g
[J) Brian
K¢ |@® Administrator K3
® pesigner
- ! ]
| |G svecwiive 5
@
Figure 8-9

Dragging a group name

The nested group name appears in italics in the list of users assigned to the
selected group. In addition to its assigned privileges, the nested group now
has all the privileges of the group it has been placed in.

Removing Nested Groups

To remove a group from another group, follow these steps:

Select the group name in the upper Groups list, to display the names of
users and groups assigned to the group.

Select the group name in the lower Groups list, drag the name to the Users
list, and release the mouse button.

The group name disappears from the list of users for the selected group.
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Design

vStructure
Layout...

Procedure...

Passwords
Lists

Saving and Loading Groups

4th DIMENSION allows you to save and load groups. When groups are
saved, everything about the current users and groups are saved. Later,
when loaded again, the original users and groups are installed.

The ability to save groups means that you can preserve the access system
of one database and transfer it to a modified version of the same database
or to a new database. The users of the database do not have to learn an
entirely new access system. All the user names, passwords, startup
procedure names, groups, group owners, and group memberships are
preserved.

To save the current groups, choose Save Groups from the Passwords
menu.

4th DIMENSION provides a “create-file” dialog box so that you can name
and save the group.

To load groups, choose Load Groups from the Passwords menu.

4th DIMENSION displays a File Directory dialog box so that you can
open the Groups file.

Assigning a Group to Menus, Procedures,
Layouts, and Files

After you define users and access groups, you can assign groups to menu
items, procedures, layouts, and file operations.

You may assign only one group to a menu item, procedure, layout, or file
operation. For this reason, it is important to design the access groups so
that more powerful users belong to all the groups below them in the access
hierarchy.

See “An Access Hierarchy Scheme,” earlier in this chapter for a discussion
of how to organize users and access groups.

Assigning a Group to a Menu ltem

When you assign a group to a menu item, only users belonging to that
group can use that menu item.

To assign access privileges, follow these steps:
Choose Menu from the Design menu.

4th DIMENSION displays the Menu Bars dialog box.
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Select the menu bar that contains the menu and menu item you want to
assign an access group to, and click OK.

4th DIMENSION displays the Menu editor.
Select the menu item you want to assign an access group to.
Choose the group from the Access pop-up menu.

Figure 8-10 shows a group being assigned to a menu item.

Design
vStructure
Layout... 3L
Procedure... #P
Menu... %M
Passwords

Lists

E[[==———= Menu Bar #1 EEEI
Menus Items Procedures
File K p| Add Employee Add Empl g
Employees Modify Employee Mod Empl i
Delete Employee Del Empi
[ 2] <
[JKeyH anGroups [ Bold
i Executive N
[JLine Finance [ 1talic )
[J Enab| Engineering [ underline
MIS P
Hurnan Rezauroes D Outline
Password: [ Shadow
&

Figure 8-10
Assigning a group to a menu item

Click the close box to close the Menu editor.

Assigning a Group to a Global Procedure

When you assign a group to a global procedure, only users belonging to
that group can use that procedure.

To assign access privileges, follow these steps:
Choose Procedure from the Design menu.
4th DIMENSION displays the Procedure dialog box.

Expand the Global procedures in the Procedures list until you see the
procedure you want to assign to an access group.

Select the procedure you want an access group assigned to.
Choose the group from the Access pop-up menu.

Figure 8-11 shows a procedure being assigned to a group.
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Global Procedures K
Add Empl 1 Delete

Mod Empl
Add Dept 1 Sart
File /Layout Procedures s

Access menu L

= [ Done ] 1l Groups
popped Up z;e;;tewe
Name: |Del Em -cess: | Engineering

| D‘ J Rccess o |

Human R

fupand

Figure 8-11
Assigning a Group to a Procedure

5. Click Done.
Assigning a Group to a Layout

When you assign a group to a layout, only users belonging to that group
can use that layout for data entry.

To assign access privileges, follow these steps:

Design
Layout... - ¥l
Procedure...
Menu... M
Passwords
Lists

1. Choose Layout from the Design menu.

4th DIMENSION displays the Layout dialog box.

2. Expand the filename that contains the layout.

3. Select the layout you want to assign an access group to.
4. Choose the group from the Access pop-up menu.

Figure 8-12 shows a group being assigned to a layout.

Layout... ,g'j:
Employees B
Delete
e B
Qutput (21 I - =y
Add | =y
Report Procedure i ———
S " —]
- o

New |

§
§

[ 1
{-} Done A1l Groups
Executive
[J Input Name: Finance
D output Engineering
utpu S
P Access: |l

Adrinistration

Figure 8-12
Assigning a group to a layout
5. Click Done.
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Assigning a Group to File Operations

New Field... #®F
{ hange figld..

Pop-up menus for
assigning access
groups

You can assign different groups to each of the four file operations.
You can thus specify which groups can load, save, add, or delete records
from a file. These privileges can be very sensitive for some applications.

You can allow some users the right to add records, without being able to
load and view any other records. You can allow others the right to modify
records, but not add any new ones.

To assign access privileges to a file, follow these steps:

In the Structure window, select the file image of the file you want to
protect.

Choose Rename File from the Design menu.

4th DIMENSION displays the File Attributes dialog box, as shown in
Figure 8-13.

File Attributes...

Filename: |[ Iyl {75

~ Record Access

Load: }RII Groups

Save: All Groups

Add: All Groups

Delete:] |All Groups

| cancel | [[ 0K []

Figure 8-13
File Attributes dialog box

Here are the file operations that groups can be assigned to:

m Load allows users to load records and view them. It does not provide
the right to modify records, create new records, or delete records.

m Save allows users to save modified records. It does not provide the
right to load records, add new records, or delete records.

m  Add allows users to create new records. It does not provide the right to
load records, modify existing records, or delete them.

m  Delete allows users to delete records. It does not provide the right to
load records, modify existing records, or add new records.
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Edit Output ASCII Map...
Edit Input ASCII Map...

Choose a group for each action from the pop-up menus.

You must provide Load privileges for any group that has Save, or Delete
privileges.

When you have finished, click OK.

System Maintenance

Once a password access system is in place, occasional maintenance of the
system is necessary. Users must be added, groups need new members, and
passwords need to be changed. The Designer can create a procedure that
allows the Administrator to have control over users and groups, and each
group owner to have control over members of his or her group.

The Administrator and the Designer can also view the usage history of
each user as necessary for maintenance.

Administrator and Group Owner Procedure

Execute Procedure...

*E

The Administrator does not have access to the Design environment.
However, if the Designer creates a global procedure that contains the
command EDIT ACCESS, the Administrator and group owners can have
limited power to control users and groups.

The EDIT ACCESS command can be made part of a procedure placed in a
custom menu in the Runtime environment, or the procedure can be
executed with the Execute Procedure command from the User
environment. If the procedure is executed by a user who is not the
Administrator or another group owner, it has no effect.

When the procedure is executed, the result depends on whether the user is
the Administrator or a group owner.

If the Administrator executes the procedure that contains the EDIT ACCESS
command, 4th DIMENSION displays the Password Access editor.

The Administrator can create and edit groups; create users; edit user
information, including changing passwords; assign users to groups; and
remove users from groups. Essentially, the Administrator has complete
control of the Password Access editor and can make changes as necessary.

The Administrator cannot assign groups to layouts, files, menu items, or
procedures. Only the Designer can assign these access groups.

If a group owner who is not the Administrator executes the procedure that
contains the EDIT ACCESS command, 4th DIMENSION displays the
Password Access editor, but displays only the groups that the group owner
owns. The group owner can add users to the groups, and remove users
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from the groups. The group owner cannot create users, edit user
information, or add groups. The menu commands for adding and editing
users and groups are dimmed.

Viewing Usage

The Edit User dialog box contains the date of the user’s last use of the
database, and the total number of uses. The Administrator or Designer can
view this information by opening the Edit User dialog box for any user.

To open the Edit User dialog box, follow these steps:

Choose Passwords from the Design menu. Or execute the procedure that
contains the EDIT ACCESS command.

4th DIMENSION displays the Password Access editor.

Select the user name you want to see from the Users list, and choose Edit
User from the Passwords menu.

The Edit User dialog box displays the date of the user’s last use of the
database, as well as the number of times the user has opened the database,
as shown in Figure 8-14.

— Edit User

User name:
Password: [W]

Startup procedure: |Initialize I

Last use: 6/27/88
Number of uses: 56

[ Cancel ][[ 0K ]]

Figure 8-14
Sample user profile

CHAPTER 8: MANAGING PASSWORD ACCESS 271



272



CREATING LISTS




274



DESIGN

CREATING LISTS

This chapter tells you how to create and use lists. A list is a set of possible
values for a field or enterable object. You can use a list to

m provide the user choices from which to select an entry for a field or
enterable object

m restrict the valid entries to those in the list

m  exclude the entries in the list from being entered

When a list is used as a choice list for a field or enterable object, the user
can simply select from the list instead of typing the entry. For example,
you may want to create a choice list for entering job titles in a personnel
database.

You can also use lists to provide restrictions on data entry. One list may
provide the required values for a field, excluding all others. Another list
may provide the excluded values for a field, preventing any value in the
list from being entered.

Your lists can offer up to 8,000 choices in a single database, and each
choice can contain up to 30 characters.

For information about adding a choice list to a field as a field attribute,

see “Field Attributes,” in Chapter 2. For information about using lists with
data entry controls, see “Data Entry Controls,” in Chapter 4. You can also
use lists to store arrays. For complete information, see the 4th DIMENSION
Language Reference.

You create all 4th DIMENSION lists with the List editor. You use the List
editor to

m create lists

add items to lists
delete lists

delete items from a list

sort items in a list

set a list as modifiable

CHAPTER 9: CREATING LISTS 275



Designing Lists

The basic purpose of a list is to provide the user with a list of values from
which to choose during data entry. Here are some considerations about
lists that stem from this basic purpose:

®  You can make a list available for every layout, or just for selected
layouts.

m  If the list has many items, you can divide it into two or more lists.

m  If there are very few items, you may want to dispense with a list
altogether.

®m  You can restrict the possible entries to those in the list, or you can
allow the user to type additional entries.

®  You can allow the user to modify the list, or you can prevent the user
from modifying the list.

You can attach a list to a field, as one of the field attributes. Attaching a list
to a field causes the list to appear whenever that field is selected during
data entry. The user can select an entry from the list. If the list is sorted,
the list automatically scrolls as the user types characters at the keyboard.
The user can stop typing when the desired choice appears, and select it
from the list.

Or you can attach the list to the field as a data entry control in a layout,
instead. The list will appear only when the field is selected in this input
layout, not in all layouts.

Figure 9-1 shows a choice list displayed during data entry.

& File Edit Use Enter Select Report Special

== Choices for Health Plans =

ol

Employee Inform

King HMO
Mational
jone

N
Last Name Garbando White Cross
i =y
proem First Name [Smeldorf
Start Date  |Thu, Mar 6,
Salary $19,610.0q

N
T
R

i

Title Clerk
Heslth Plan | [ cancel ] [ Modify |
o]
<2 RE
Figure 9-1

A choice list for data entry
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Some lists are actually too short to bother with. For example, if you keep
track of the sex of your employees, you could create a list with two entries,
“Male” and “Female.” But this is the kind of information that is best stored
in a Boolean field and entered by clicking a radio button. Even three or
four choices can usually be handled with check boxes in a layout.

Some lists are so long and dull that they don’t work as choice lists at all.
Using a list of zip codes for an address file might work well for one small
city, but using a list for all United States zip codes would take more time
than typing the zip codes.

Linked Lists

4th DIMENSION allows you to link an item in a list to another list.
Selecting such an item displays the linked list.

How you use linked lists depends on circumstances. For example, a list of
abbreviations for states would include 50 entries. You can link lists of
these entries in various ways.

You can often divide one list into two lists. If you find that 80% of the
entries for the State field are the same few states, you can put those states

in one list and place the remainder in another list, as shown in Figure 9-2.
Select any of

these .States to Ny
enter in field —_—————————— —_———
Lists... Items...
States| <+ [california K3
More States HIlinois
IMichigan
Select More Staets INew York
to display another \Dhio
list with all the Texras
other states More States More States
5 -
[@
Figure 9-2
Divided lists

With such a divided list, the user can usually select the entry from the first
list. When another state is required, the user simply clicks More States,
and another choice list appears that contains the remaining states.

Another solution is to nest lists, using a master list with subordinate lists.
For example, you could divide the states into different regions. The first
list that appears provides choices for each region. The subordinate lists
contain the states for each region, as shown in Figure 9-3.
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= |ists ===

Lists... Items...
States Q‘ Alabama K
More States Alaska
Arizona
Arkansas
Colorado
Connecticut
Delaware
Florida
Georgia
v |Hawaii Y
il
Figure 9-3
Nested lists

With such nested lists, the user makes two choices: first to select the
regional list, then to select the state in that region. Each subordinate list
could include a choice to return to the list of regions.

Finally, you can link lists in such a way that you can go from any list to
any other. Suppose you need a Western-region state 35% of the time, and
you often need states from the other regions also. You can link all four
regional lists, as shown in Figure 9-4.

me———— Jmry- =
Lists... Items...
Regions K+ [Arizona <>
Central Region California
North East Region Nevada
Southern Region Oregon
Western Region Washington

Central Region Central Region
North East Region North East Region
South Region Socuthern Region

<]
<7

@

Figure 9-4

Interlocking lists

Since the Western list is attached to the field, it appears when the field is
selected. The user can then go to any of the other lists if necessary. The
user can go from any list to any other and back again because each list is
linked to the others.

Required and Excluded Values

Some data entry tasks are somewhat informal. If you enter a value that
does not appear in a list, it may be perfectly all right. However, you may
have an application in which an entry must be one of the values in a list.
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Any different value would cause a serious consequence, such as delays in
paying bills.

4th DIMENSION allows you to make a list required as part of the data
entry controls on a layout. This type of data entry control prevents a user
from entering any value other than the ones in the list. For example, your
company may have a specific group of job titles that are allowable in a
personnel database.

Another data entry control makes it possible to exclude the values in a list.
The user then cannot type in a value that should not appear in the field. For
example, your company may be prevented from doing business in certain
countries. Placing them in an excluded list prevents them from being
entered.

Non-sequential Ranges of Values

One of the most useful data entry controls is the Maximum and Minimum
setting for a number, date, or time field. Setting 2 maximum and minimum
prevents a user from entering a value outside this range.

But suppose you have three acceptable ranges for the field. You can use a
list to create such non-sequential ranges. If you then make this list required
for a field, values outside the three ranges are not accepted.

Figure 9-5 shows a list of ranges.

Lists... Items...

Enroliment Periods ¢ [1/5/89..1/12/89 [
4/6/89..4/14/89
7/2/89..2/9/89
10/6/89..10/13/89

Figure 9-5

Using a list for non-sequential ranges

Conversely, you could create a list that specifies the ranges that are not
valid. If you then make this list an Excluded list for a field, any entry
within the ranges is not accepted.
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Layout... 3L
Procedure... 3P

Creating Lists

You create lists with the List editor. You can modify any list at any time
by returning to the List editor and making changes.

To open the List editor, choose Lists from the Design menu.

The List editor appears, as shown in Figure 9-6.

Menu... ®M E(—————"——— lists EE‘EI
Passwords
Lists... Items...
& &
List of lists
List of items
] &
&

m 1.

ety

i#saer Madifiahie

Figure 9-6
The List editor

The List editor displays the names of existing lists on the left. On the right
side of the editor, a list of items in the selected list is displayed. The menu
bar provides two menus, Lists and Items.

To view the items available in a list, select the list name in the Lists
column.

The items in the selected list appear in the Items column.
To create a new list, follow these steps:
With the List editor window open, choose New from the Lists menu.

4th DIMENSION creates an empty frame in the Lists column and displays
an insertion point in the frame.

Type the list name.

You have created a new empty list. You still have to create the items that
will appear in the list, as described next.

Adding Items to Lists

When you are adding items to a list, you can append new items to the end
of the list or insert them anywhere in the existing list.
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To append items to a list, follow these steps:

Select the name of the list to which you want to add items.

If the list already contains items, they appear in the Items column.
Choose New from the Items menu.

4th DIMENSION creates an empty frame in the Items column and displays
an insertion point in the frame.

Type the item name.

Figure 9-7 shows an item being entered.

S lists =—"—"r — 11
Lists... Items...
Regions | {WesY )
] |
&
Figure 9-7

Entering an ltem in a list

To add more items to the list, choose New from the Items menu to open an
empty frame in the Items column. Or press Return to open an empty frame
in the Items column.

When you have finished, click the close box to save the current lists and
close the editor window.

To insert an item in a list, follow these steps:
Select the item that is to appear below the item you are adding.

4th DIMENSION inserts the new item above whichever item is currently
selected. This allows you to insert a new first item.

Choose Insert from the Items menu.

4th DIMENSION creates an empty frame in the Items column above the
previously selected item.

Type the item name.

Click the close box to save the current lists and close the editor window.
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Items
New 8N
Insert I
Delete

Sort

Lists
Delete

Deleting Items and Lists

vUser Modifiable

To delete an item, follow these steps:

With the List editor window open, select the list that contains the item you
want to delete.

From the Items column, select the item you want to delete.
Choose Delete from the Items menu.

4th DIMENSION deletes the item from the list and removes the space it
occupied in the list.

To delete a list, follow these steps:
With the List editor window open, select the list you want to remove.
Choose Delete from the Lists menu.

4th DIMENSION deletes the list and removes the space it occupied in the
list.

Copying Lists

You can copy a list. You can then rename the copied list, modify it, and
avoid having to retype many entries.

When you copy a list, you are copying the list name and all the items.
To copy a list, follow these steps:

Select the list you want to copy in the List column.

Choose Copy from the Edit menu.

4th DIMENSION copies the list and items to the Clipboard.

Choose Paste from the Edit menu.

4th DIMENSION pastes the list and its items into place.
Linking Lists

You can link any list to any other list. Typically, you create an item that
names the list it displays.

To link one list to another, follow these steps:
Create at least two lists.

For this example, suppose the two list titles are List One and List Two.
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Add “To List One” as an item in List Two.
“To List One” is the choice that will display List One.

Position the pointer over the “To List One” item and press and hold the
Option key.

The pointer becomes a sideways-pointing marker.

Continue to hold down the Option key as you drag from “To List One” to
the List One title, then release the mouse button.

Figure 9-8 shows the dragging operation.

S[ece————= lists =="ir—"—=1=
Lists... Items...
ListOne 4l Kol (Firstitem 2
List Two N .| [|Second Item
’ “1Third Item

To List One

T

]

Figure 9-8
Adding a list as an item

4th DIMENSION displays List One in smaller type next to the “To List
One” item. List One has been added to List Two. Whenever List Two is
displayed, selecting the “To List One” choice displays List One.

To link lists to each other, follow these steps.

In the following example, List One and List Two become linked to each
other.

Link List One to List Two as described earlier in this section.
Add an item to List One that reads “To List Two.”

Press the Option key as you drag from the “To List Two” item to the List
Two title, then release the mouse button.

Figure 9-9 on the following page shows the dragging operation.
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Figure 9-9
Adding another list as an item

4. Release the mouse button.
4th DIMENSION adds List Two to List One.

Now the two lists are linked to each other. List One has a choice that
displays List Two; and List Two has a choice that displays List One.

Specifying Ranges in a List

4th DIMENSION allows you to enter ranges of numbers, dates, and
times in a list. You can use these ranges as data entry validation ranges
by making the list required or excluded in a layout.

To create ranges in a list, follow these steps:
1. Create the list you want to use for ranges.

2. For each item, enter the minimum value of the range, then two periods (..),
then the maximum value.

For example,
100..150
defines the range between 100 and 150, inclusive.

Continue specifying ranges as separate items until you have defined as
many as you need.

Sorting a List

4th DIMENSION maintains the list of items in the order in which you enter
them. You can sort the list alphabetically so that entries are more easily
accessible to database users. Since a sorted list automatically scrolls to
match characters typed at the keyboard, sorting makes data entry easier.
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To sort a list, follow these steps:
In the List editor, select the list that contains the choices you want to sort.

Choose Sort from the Items menu.

Making a List Modifiable

4th DIMENSION allows you to specify whether a list of items can be
changed by the user. Whenever you create a list, it starts as modifiable.
4th DIMENSION places a check mark in the lists menu to show that the list
is user modifiable.

If you allow a list to be user modifiable, the user has access to a special
List editor in the User environment. The special List editor is for the
assigned list only. The user cannot add lists, delete lists, or change any
other list. If a list is modifiable, the user can make any change to that list’s
items.

Figure 9-10 shows the special List editor in the User environment.

Items in list

Sort
Insert |

| nppena || [ cancel ]

2] ([ betlete | [ ok

INew Entry I

Figure 9-10
Special User environment List editor

In a multi-user environment, lists cannot be modified by the user.
To make the list user-modifiable, follow these steps:

Select the list that you want to make modifiable.

Pull down the List menu.

If the User Modifiable command has a check mark, the list is user
modifiable. Release the mouse button without making a menu choice.

If the User Modifiable command does not have a check mark, go to the
next step.
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Figure 9-11 shows User Modifiable with a check mark.
| Lists

New
Delete

vUser Modifiable

Figure 9-11
Check mark shows list is user modifiable

Choose User Modifiable from the List menu.

4th DIMENSION adds check mark to the menu item. The list can be
modified in the User environment.

To prevent the user from modifying a list, select the list and choose User
Modifiable to remove the check mark.
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4th DIMENSION SPECIAL TOPICS

This chapter provides guidelines for using 4th DIMENSION to best
advantage under different circumstances. It describes

m how to specify the operating environment: single-user or multi-user
how to update Structure and Data Files

how 4th DIMENSION uses memory

how 4th DIMENSION works under MultiFinder

how to optimize 4th DIMENSION performance

m how to repair damage

Setting Single-User or Multi-User

4th DIMENSION needs to know whether to operate in a single-user
environment or in a multi-user environment.

To set single-user or multi-user, follow these steps:

Start 4th DIMENSION, and while it is starting, hold down the mouse
button.

4th DIMENSION displays the dialog box for setting single-user or
multi-user, as shown in Figure 10-1.

Database Access
@ Single-user "
O Multi-user B

Store Temporary Files:
@ In 'data file' folder
) In structure folder
O In 4th DIMENSION® folder

((cancel | [ ok ]

Figure 10-1
Dialog box for single-user or multi-user setting

You also use this dialog box to specify any preferred location for
temporary files that 4th DIMENSION may create.

Select the appropriate button, and then click OK.

4th DIMENSION puts away the dialog box. Subsequently, 4th DIMENSION
operates as you have instructed it until you change the setting again.
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Changing this setting affects 4th DIMENSION itself, not just a particular
database.

o) . . , . . .
7, Note: In a multi-user environment, if one user is using the Design
environment for a database, no other users can open that database.

Updating Structure and Data Files

You can make copies of updated versions of structure and data files to send
to other users, or to preserve as backups. You might do this when you alter
the structure with an editor in the Design environment, by creating new
files, fields, layouts, and so on, or when new information has been added
to a database.

Caution: Do not update either the data file or the structure file
until you have made backup copies of both files and have stored the
originals in a safe place.

The ability to update the structure file allows you to continue working on a
database application after users have begun to use it. You can then
substitute an improved structure for the original, giving the database new
functionality.

To update a structure file, follow these steps:

Change the structure by using any of the editors in the Design
environment.

The structure file contains all the specifications for the database structure
(files, fields, field attributes), layouts, procedures, menus, password access
groups, and lists.

Clone the structure file.

The new structure file is an updated version of the old structure file. You
can send it to anyone who needs to use the new structure. It works with the
data file that it created, a clone of that data file, or the old data file.

4th DIMENSION can use the old data file because it is tolerant of changes
in structure. An updated structure can be used with an old data file even if
you have added fields or files te the database. Be sure that any updated
database follows these rules:

m The data file must have at least as many files as the structure.

m In the data file, each file must have at least as many fields as in the
structure.

The structure file controls how the database operates; the data file follows
any change in the structure file. You can change field types or attributes,
including the Indexed attribute, at any time.
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4th DIMENSION builds any new indexes when the User environment or
Runtime environment is first used. For large databases, this can take some
time. It happens only the first time a new index is added. Subsequently, the
index is updated only when data is added or modified in the indexed field.
4th DIMENSION does not normally need to rebuild an index file.

The ability to update the data file allows you to distribute new data to all
users that need it.

To update a data file, follow these steps:
Update the information, using 4th DIMENSION.
Duplicate the data file.

The new data file is an updated version of the old data file. You can send it
to anyone who needs to use the new data. It works with the structure file
that created it, or a clone of that structure file.

How 4th DIMENSION Uses Memory

4th DIMENSION requires memory for the program itself and for each
record that it loads. The amount of memory that a record uses is dependent
on the data that is stored in the record. For example, if the record contains
the name and address of a preson, the record may only be 100 bytes in
size, but if the record contains a picture of the person, it may take 3000
bytes.

4th DIMENSION caches records to improve performance. When a
low-memory condition exists, 4th DIMENSION compensates by swapping
data to and from the disk. This swapping may cause some performance
degradation in data access and screen refreshing. If you notice a
performance degredation, you should allocate more memory to

4th DIMENSION.

Temporary files are created during the swapping operation. The temporary
files are named “Temp1,” “Temp2,” and so on. If any are left on disk, you
can throw them away. Such files remain only as a result of a power failure
or similar mishap.

ﬁ Note: For specific databases, precise memory configuration specifications

for optimizing performance can be given. This should be done only by
experienced designers. For information, see “4th DIMENSION Customizer”
in the 4th DIMENSION Utilities manual.
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4th DIMENSION Under MultiFinder

4th DIMENSION is completely compatible with MultiFinder. No special
setup is needed.

In order to optimize performance, you should allocate as much memory as
possible to 4th DIMENSION.

4th DIMENSION can run in the background, performing such operations as
printing, searching, sorting, or executing a procedure. Some operations
give very little time to foreground programs, so you may experience some
performance degradation in the foreground application. For example, if
you use 4th DIMENSION to sort in the background, you may slow your
word processing program. '

Optimizing 4th DIMENSION Performance

To ensure that 4th DIMENSION works as effectively as possible, use a
hard disk. 4th DIMENSION is designed to work with a hard disk. It is
unlikely that you will achieve satisfactory performance with a floppy
drive.

If you are going to purchase equipment specifically in order to increase
4th DIMENSION'’s performance, you should keep the following facts in
mind.

For single-user systems:

m CPU speed is the most important consideration.

A Macintosh II, IIx, or Ilcx, or an SE with an accelerator card
improves 4th DIMENSION’s performance. An SE 30 has an improved
SCSI bus transfer rate that makes it work as fast as a Macintosh II.

m  Additional memory improves performance.

RAM caching is not necessary. For optimum performance, turn RAM
caching off in the Macintosh Control Panel. 4th DIMENSION provides
its own data cache.

m A faster hard disk improves performance.

4th DIMENSION regularly loads and saves to disk. Hard disk speed
can greatly affect performance.
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For multi-user systems:
m  The network speed is the most important consideration.

Faster networks such as EtherTalk can greatly improve performance.
m The file server performance affects 4th DIMENSION performance.

The file server is a CPU with a storage device. The same
considerations that affect single-user systems affect the file server
for multi-user systems.

Repairing Damage

4th DIMENSION features automatic database repair. 4th DIMENSION
detects any data damage and warns you of its existence. Typically, when
any damage has occurred, only one record is damaged. You can choose
one of the following options:

m Delete the damaged record.

m Ignore the damaged record.

4th DIMENSION automatically marks the damaged portion of the disk
and subsequently avoids using that portion.

After encountering damage, 4th DIMENSION may need to rebuild its
index table. For some databases with large data files, this operation can
take some time.

Only data files can be repaired. You should retain backup copies of
your structure files, as they cannot be repaired.

Occasionally, damage to a data file may be so extensive that you

must use the 4th DIMENSION Ugtilities provided in your package.
For information about using the Ultilities, see the 4th DIMENSION
Utilities Guide.
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Cast of characters

& (ampersand)
in entry filter code 150
for scientific notation 139

<<< (angle brackets), in number
field 137

* (asterisk), in number display
format 137

@ (at symbol)
as wildcard character 54
in filter arguments 152
for writing procedures 226

[ (bracket), with filename in
procedure 226

A (caret), in number display
format, 137

$ (dollar sign), in number field
138

! (exclamation point), for
placeholder character 153

> (greater than symbol), for
embedded fields or variables
213

- (hyphen), in filter arguments
150

< (less than symbol), for
embedded fields or variables
213

() (parentheses), as dead
characters 154

.. (periods), in range 284

# (number sign)
#D (current date) 156
#H (current time) 156
#N (sequence number) 156
in Alpha field format 141-142
in entry filter code 150,
152-153
in number display format 137

; (semicolon)
in filter arguments 150
in number field 138

~ (tilde), in entry filter code, 150

_ (underline), placeholder as 153

J
| (vertical bar)
in Alpha field format 142
for number display format 139
with style name 158-159

.
Accept button 172
access hierarchy 257-258
nesting access groups 265
removing nested groups 265
Access pop-up menu 267, 268,
269
access privileges, assigning 256,
266-270
Action pop-up menu 167
button actions on 171
active editor, menus and 19
active objects 69-70
adding to layout 98-100,
163-168
creating 166
defined 129
display formats for 167
duplicating 104-105
keyboard equivalents for 248
modifying 166
on grid 178-180
scripts with 161-163,
167-168
specifications for 70-71
types of 169-179
Add Field icon/tool 86,98, 116
adding list items 281-282
adding a menu 242-243
Add to Layout command 88, 116
add operations, access to 269
Add To Included button 173, 182
Administrator
in access hierarchy 259
as group owner 260
system maintenance role
270-271
Align to Grid command 89, 104
aligning layout objects 101-104
Alignment icons/tools 101-102
on layout palette 87

((} Q16 ¥

Alpha field formats 141-142
Alpha field type 43-44
setting length for 153
Alpha object formats 167
ampersand (&)
in entry filter code 150
for scientific notation 139
angle brackets (<<<), in number
field 137
Append Item command 244, 247
Append Menu command 243
Apple menu, with custom menu
bars 239, 242
applications, runtime 10-11
argument, in entry filter code 150,
151-152
arrays 175-176
arrow keys, for writing procedures
225
arrow pointer, for modifying
flowchart 234
Arrow icon/tool 99
for selecting a layout object
92,93
on layout palette 86
“Associate with menu bar #”
dialog box 188
asterisk (¥), in number display
format 137
at symbol (@)
as wildcard character 54
in filter arguments 152
for writing procedures 226
audit trail “Can’t modify” fields
for 47
Auto button, for included layout
area 187
automatic buttons 170-173
for layout 81-82
automatic database repair 293
automatic file naming 39
automatic layout designs 80
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automatic relations 53
See also related files
creating records with 58
data integrity with 59
indexed fields for 61
manual relations vs. 53
search and sort operations with
59
wildcard look-ups with 56-57

B
backing up 8
Backspace (Delete) key
for deleting flowchart objects
235
for deleting objects 107-108
bitmapped graphics, in Picture
fields 45
Boolean expressions, test objects
with 229-230
Boolean field radio button, radio
button object vs. 175
Boolean fields
display formats 142-144
lists vs. 277
Boolean field type 45
borders
for included layout 187
setting lines 91-92
setting patterns 111
Border submenu 89, 111
bracket ([), with filename in
procedure 226
Break area
adding 203-204
establishing 195-196
in reports 194, 195, 205, 206,
207
in screen display 193, 197,
198
Break Header lines
adding 203-204
deleting 204
in report example 206

break levels, multiple 201-202

Break lines
adding 203-204
deleting 204
in report example 206

Break marker 197, 204

breaks, defined 200

bullets, syntax errors marked with
226,227, 235

buttons
as active objects 129
automatic 170-173
automatic layout 81-82
customizing 126, 127
for included layouts 182
keyboard shortcuts for 82, 165
radio 174-175

Button Text area 165

C
calculations
in reports 200-203, 207
scripts for 207
Cancel button
for abandoning record 172
in creating fields 43
keystroke equivalent for 82
in standard interface 126
Can’t modify attribute 47
capitalization
scripts for 161
tilde character for 150
caret (M), in number display format
137
case sensitivity, in passwords 262
characters
dead 154
in filter arguments 150, 151,
152
as placeholders 153
check boxes 173-174
formatting Boolean fields as
143-144
lists vs. 277

choice lists
example of 276
for data entry 148
role of 275
Choices check box 148
Choices attribute 48
Clear command 26, 107-108, 235
Clipboard
copying lists to 282
copying objects to 106
placing deleted objects on
107, 108
viewing contents of 26
cloning a database 7
Close Editorname command 25
closing a window 20
Collapse button 22,23
Color command 89
color display
automatic relation lines on 63
changing 111-112
Color submenu 89, 112
columnar reports 199
Command-1, for included layout
frame 187
Command-click, for selecting
object 100
Command key
for creating border 111
in keyboard equivalents 247,
248
reserved key combinations
248
Command-Left Arrow, for
previous record 82
Command-period, as Cancel
button equivalent 82
Command-Right Arrow, for next
record 82
commands
See also menu items
Add to Layout 88,116
Align to Grid 89, 104
Append Item 244, 247
Append Menu 243
Border 89, 111



Clear 26, 107-108, 235
Close Editorname 25
Color 89, 112

Copy 26, 106, 249, 282
Cut 26, 108, 249

Define Grid 88, 103
Define Ruler Units 88, 97
Delete (Items menu) 282
Delete Item (Menu menu) 250
Delete Menu 249

Delete Page 88, 116
Duplicate 7, 89, 105
EDIT ACCESS 270-271
Edit Group 263

Edit User 263

Entry Order 87, 119-120,
121, 122

Fill 88

Find 227

Find Next 227

Format 89, 166, 187
Group 89, 101
Hide/Show Rulers 88, 97
Insert Item 244, 247
Insert Menu 243
keyboard equivalents for
247-248

Labels (User environment)
213

Layout 71, 83, 84, 90, 222,
268

Line Width 88

Lists 280

Load Groups 266

Menu 241, 266-267
Menu Bar 88, 188

Move to Back 89, 102, 107
Move to Front 89, 107
New (Items menu) 281
New (List menu) 280
New Database 24

New Field 41-42

New File 39

New Group 263

New Step 230, 231

New Test 230, 231

New User 261
Objects on Grid 87, 178, 179
Open 3,5
Open Database 24
Page Setup 24
Passwords 261, 271
Paste 26, 106, 249, 282
Position 89, 95, 96
Preferences 24, 157
Print 25
Print Scripts 25
Procedure 220, 267
Quit 25, 242
Rename File 39, 269
Replace 227-228
Replace Next 228
Revert to Saved 25
Save Editorname 25
Save Groups 266
Select All 26, 106
Set as Start 230, 233
Show Clipboard 26
Show Custom Menus 250
Sort (Items menu) 285
Turn Grid On/Off 88, 104
Undo 26, 108
Ungroup 89, 101
User Modifiable 285-286
control lines. See output control
lines
control markers 196-197
adding 203-204
control panel, in standard interface
126-127
Copy command 26, 106, 282
for menu item 249
copying layout objects 104—106
copying lists 282
copying a menu 248-249
Create Active Object icon/tool
86, 98, 166
create-file dialog box, for new
database 4
creating a button 171-172
creating a check box 173-174
creating a database 3-4, 24

DESIGN

creating a database structure
35-64

creating enterable/non-enterable
objects 169-170

creating fields 4043

creating a flowchart procedure
230-233

creating a formula 231-232

creating graphs, User environment
for 10

creating included layouts
185-187

* creating labels, User environment

for 10
creating layouts 71-82, 90-91
creating linked lists 282-284
creating lists 280, 282-284
creating procedures 220-222
creating a radio button 174-175
creating records, in related files
57-58
creating reports 208-209
User environment for 10
creating scripts 221-222
creating styles 157-159
crosshair/crossbar pointer 99
for creating active object 166
for included area 185
for placing field 132
in flowchart area 231
cursor types. See pointers
custom applications, Runtime
environment for 10-11
custom buttons 126, 127
for included layouts 182
saving in Scrapbook 105-106
custom data entry order, creating
119-122
custom interface, automatic
buttons for 170-173
custom layouts 92114, 127-129
example of 67
for labels 211-213
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custom menus 239-251
adding to menu bar 242-243
adding “‘splash screen” to 250,
251
copying and moving 248-249
creating 188-189, 240-245
creating menu items for 244
deleting 249
designing 239-240
keyboard equivalents for
247-248
for layouts 187-189
maximum number of 239
maximum title length 243
previewing 250
runtime applications and 251
Cut command
for deleting an object 108
for menu item 249
for moving an object 26

D
damage repair 293
database folders 3
database operations, setting
preferences for 26-28
databases
automatic repair of 293
backing up 8
creating 3-4, 24
data files 5-6. See also data
files
defined 31
duplicating 7
external routines in 176
flat-file 33
maximum size of 34
opening 5, 24
relational, defined 34
startup environment for 27
structure files, 5, 6. See also
database structure

database structure 31-35
creating 35-64
creating new fields 40-43
creating related files 60-63
field types 43-46
files in 32-35
multiple-file 33-34
for new file 38-39
renaming a file 3940
single-file 32-33
Structure editor 36
subfiles 34-35, 46
updating 290-291
data entry
controls on. See data entry
controls
Enterable layout attribute for
76
in included layouts 181-182
in related files 54
menu commands vs. buttons
for 187
User environment for 10
data entry controls 146157
default values 156
enterable and mandatory
attributes 147
entry filters 149-155
excluded values 279
for defining objects 165
for enterable objects 167
in Field Definition dialog box
131
lists for 148-149, 275,
276-280
maximum and minimum
values 155
non-sequential range of values
279-280
required values 278-279
data entry order 118
in groups 121-122
restoring 122
standard 122
standard vs. custom 118-119
viewing and changing
119-122

data files 5-6
automatic repair of 293
backing up 8
duplicating 7
updating 290-291
data import and export, User
environment for 10
data integrity, in related files
59-60
data validation. See data entry
controls
date, script for 207
Date field formats 134-135
Date field type 45
dead characters 154
decimal numbers, Real field type
for 44
decimal point display 137
default data entry order 118
default font size, for layout 73
default justification 109
default layout attributes, Enterable
related fields 76
default layout settings,
establishing 108, 109
Default menu bar, in Runtime
environment 251
default Procedure editor 219
default startup environment 27
default values 156
Define Grid command 88, 103
“Define grid” dialog box 103
Define Ruler Units command 88,
97
“Define units” dialog box 97
Delete (Backspace) key, for
deleting objects 107-108
Delete button
for layouts 83
in standard interface 126
Delete command (Items menu)
282
Delete Included button 173, 182
Delete Item command (Menu
menu) 250
Delete Menu command 249



Delete Page command 88, 116
Delete Record button 82, 172
delete operations, access to 269
deleting a flowchart object 235
deleting a layout page 116
deleting layouts 83
deleting list items 282
deleting menu items 250
deleting objects 26, 107-108
Design environment 9
access to 259
as default startup 27
editors in, 12-18. See also
specific editors
for Runtime applications 11
moving to and from 11
Designer
in access hierarchy 259
assigning password to 260
system maintenance role
270-271
Design menu
Layout command 71, 84, 90,
222,268, 983
Lists command 280
Menu command 241, 266-267
Passwords command 261, 271
Procedure command 220, 267
Rename File command 269
windows on 19
desktop, remembering 28
desktop files 5-6
Detail area
establishing 195
for embedded fields or
variables 213
in reports 194, 205, 206
in screen display 193, 194,
197, 198
dialog boxes, expanding and
collapsing lists in 22-23
dials 165, 176-177
Disabled check box 247
displayed file, changing 23-24

display formats
customizing 134-146
in Field Definition dialog box
131
for Alpha fields 141-142
for Boolean fields 142-144
for buttons 171
for Date fields 134-135
for included layout area
182-183, 186
for number fields 136-140
for objects 164
for Picture fields 144-146
for Time fields 135-136
selecting 28
Display only attribute 47, 147
divided lists 277
dollar sign (S), in number field
138
“Double clickable™ check box
deselecting 182
for included layout area 186,
187
Duplicate command 7, 89, 105
Duplicate icon/tool 87, 105, 234
duplicating a database 7
duplicating layout objects
104-105

E
EDIT ACCESS command

270-271
Edit Group command 263
Edit Group dialog box 263
editing, in text areas 113, 114
Editing area, in Listing editor 223
Edit menu 25-26
Clear command 26, 107-108,
235
Copy command 26, 106, 249,
282
Cut command 26, 108, 249
Paste command 26, 106, 249,
282
Select All command 26, 106
Show Clipboard command 26

DESIGN

Undo command 26, 108
with custom menu bars 239,
242
editor windows 19-21
closing 25
printing contents of 25
saving 25
Edit Styles button 157
Edit User command 263
Edit User dialog box 261-262,
263, 271
embedded fields and variables
213214
Enabled check box 247
Enterable check box 186, 187
Enterable layout attribute 76, 147
enterable objects 169-170
adding scroll bars to 157
as active objects 129
assigning lists to 148-149
choosing display formats for
167
data entry controls for
146157, 167
in data entry order 120
entry filters for 149-155
printing with variable frame
159-160
Enter button 82
in standard interface 126
entering data. See data entry
Enter key
as Enter button equivalent 82
for checking syntax 226-227,
235
Entry Filter box 150
entering styles in 158-159
entry filters 149-155
arguments in 151-152
codes used for 150
dead characters in 154
display characters for 153
examples of 154-155
initiating 150151
placeholders in 152—153
selecting as style 28
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Entry Order command 87,
119-120, 121, 122
entry order pointer 119
environments 8-11
See also specific environments
single- vs. multi-user 289-290
startup 27
users’ access to 259
erasing. See delete operations;
specific operations
error correction 293 LAl
execution 227, 235
in formulas 235
in Procedure editors 225,
226-227
syntax 235
Undo command for 26
error message, in password access
system 256-257
exclamation point (!), for
placeholder character 153
Excluded check box 149
Excluded lists 279
executing procedures, User
environment for 10
execution cycle, “Only if
modified” check box and 168
execution errors 227, 235
Expand button 22, 23
for included layout 186
in Procedure dialog box 221
exporting data, User environment
for 10
external areas 176
naming procedure for 165
external procedures, defined 176

F

field attributes 41, 4648
changing 48-49
lists as 276

Field Definition dialog box
130-131
assigning lists in 149
for creating script 161, 221
for opening script 223

“Print variable frame” check

box in 159

selecting field from 132-133
Field dialog box 42-43

field attributes set in 46

Field for Filename dialog box. See

Field dialog box
Field list, in Field Definition
dialog box 131
field names 32, 41
changing 48
in columnar reports 199
fields
adding to layout 73
as active objects 129
assigning lists to 148-149
creating 40-43
data entry controls for
146-157
defined 31
deletion problem with 41
display formats for 134-146
embedded 213-214
entry filters for 149-155
layout attributes for 147
layout specifications for
130-146
layouts with or without 69
modifying 4849
modifying layout of 69, 133
related 50
relating vs. related 53
scripts with 162
selecting for layout 72, 73-79
subfields 46
Fields list, in Listing editor 224,
226, 228
field types 32, 40, 43-46
See also specific types
changing 48, 49
for related fields 60
File Attributes dialog box 39-40
for assigning access 269-270
file icon 39

file images
moving 37-38
resizing 38
selecting 37

file/layout Procedures 221

File menu 24-25
Close Editorname command
25
with custom menu bars 239
Duplicate command 7
New Database command 24
Open command 3, 5
Open Database command, 24
Page Setup command 24
Preferences command 24, 157
Print command 24
Print Scripts command 25
Quit command 25, 242
Revert to Saved command 25
Save Editorname command
25

filenames 4, 40
in Layout dialog box 90-91
in procedures 226

file operations, assigning access to
269-270

file procedures
creating 221
role of 218

files
access to. See password access
system
changing displayed 23-24
creating 38-39
displaying menu of 24
included layouts from 77-79
layouts and 68
in New Layout dialog box
73-74
related, 49-64. See also related
files
renaming 39-40
selecting 37
sequence numbers in 156
subfiles 46

file server 293



Fill command 88

fill patterns, specifying 110

Fill submenu 110

Find command 227

Finder, for duplicating a database
7

Find Next command 227

First Page button 172

First Record button 82, 172

fixed-frame printing 211
included layouts with 183,
184

flat-file database 33

Flowchart formula editor
231-232

Flowchart menu 230
New Step command 230, 231
New Test command 230, 231
Set as Start command 230,
233

flowchart objects, modifying
233-235

Flowchart editor 14, 15, 219,
228-235
creating a procedure with
230-233
editing procedures in 233-235
modifying procedures in
234-235
role of 228-229
specifying first step in 233
using 230-235

flowchart procedures
editing 233-235
elements of 229-230

flow lines 230
drawing 232-233

folders 3,4
for duplicate database 7
structure and data files in 5-6

Font menu 89

fonts/font size
for layout 73
for menus 246
for objects 89, 109

Footer area
establishing 196
in reports 194, 205, 206, 207
in screen display 193, 197,
198
Footer line, in report example 206
Footer marker 197
Format command 89, 166, 187
Format display area, entering
styles in 158-159
Format pop-up menu
date formats in 134-135
number formats in 136
picture formats in 144
time formats in 135-136
form letters 213-214
Formula editor 231-232
editing flowchart in 235
formulas
creating 231-232
in Flowchart procedures 230
layout name change and 84
modifying 235
syntax errors in 235
4th DIMENSION
application icon 3
desktop files 5-6
interface in 18-28
memory use by 291
MultiFinder and 291, 292
optimizing performance of
292-293
setting single- vs. multi-user
environment for 289-290
starting 3-5
framing an included layout 187
Full Page button 186
Full Page layout
with included layout 181-182,
186
preventing display of 182
full-screen window 20

DESIGN

G

global procedures
assigning to menu items 245
creating 220-221
in custom interface 128
menu items and 239
role of 218-219
graph areas 128-129, 176
graphic objects 70
adding to layout 98-100
changing appearance of
108-109, 110-112
text areas as 113
graphics
in Flowchart editor 228-229
Object icons/tools for 86
in Picture fields 45
for splash screen 250, 251
graphs, User environment for 10
greater than symbol (>), for
embedded fields or variables
213
Grid Object dialog box 178-179
Grid On/Off icon/tool 87, 104
grid settings 103-104
Group command 89, 101
grouped data entry order 121-122
grouping custom menu items 240
grouping layout objects 100-101
Group Name box 263
Group Owner box 263
group owners 260
system maintenance role
270-271
groups
in access hierarchy 257-258
assigning access privileges to
256, 266-270
assigning to operations
266-270
assigning users to 264
creating 263-264
removing users from 264
saving and loading 266
viewing users list for 264
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Groups list

adding users to 264

in Password Access editor 261
guests 260

H

hard disk 292

hardware recommendations
292-293

Header area
establishing 195, 196
in reports 194, 195, 205, 206,
207
in screen display 193, 194,
197, 198

Header lines
adding 204
in report 206

Header marker 197

“Hide keywords” check box 27

Hide Keywords divider 228

Hide/Show Rulers command 88,
97

hierarchical lists, expanding and
collapsing 22-23

highlight buttons 171

hyphen (-), in filter arguments
150

|
I-beam pointer 225
icons
4th DIMENSION application
3
in Layout editor window 85,
86-87
opening database with 5
importing data, User environment
for 10
included layout area 77-79, 129
Included Layout dialog box
181-182, 185, 187

included layouts 180-187
creating 181, 185187
displaying 182-183
entering data in 181-182
modifying 187
preventing data entry in 182
printing data in 183-185
in reports 210-211

Included Layout icon/tool 86, 98,
185

Included Record buttons 173

Indexed attribute 47
for related files 61

indicator settings, establishing
177

initiator, in entry filter code 150

Input check box 83

input layouts
See also layouts
establishing 82-83
example of 68
file procedures and 218
included layouts as 180, 181
lists with 276
multiple 69
role of 68
template type for 80, 81

Insert command (Items menu)
281

Insert Item command (Menu
menu) 244, 247

Insert Menu command 243

Integer field type 44

interface 18-28
design options for, 125-129

See also specific options

interlocking lists 278

invisible buttons 171

invisible grid, using 103-104

Items column
adding list items to 281-282
deleting list items from 282
lists in 281

Items list
adding menu items to 244
in Menu editor window 242

[tems menu
Delete command 282
Insert command 281
New command 281
Sort command 285

J, K
justification, specifying 109-110
Keyboard button, 248
Keyboard entry box 248
keyboard shortcuts
assigning 168
for automatic layout buttons
82
for buttons 165
for menu items 247-248
Key button 165, 168
Key dialog box 168
keystroke equivalents. See
keyboard shortcuts
Keywords list, in Listing editor
223, 226, 228

L
Label editor (User environment)
211,213
labels
for output control lines 206
printing 211-213
User environment for 10
Labels command (User
environment) 213
label width marker 212
Last Page button 172
Last Record button 82, 172
layering objects 106—107
Layering icons/tools, on layout
palette 87
layout attributes
for related fields 76
setting 147
Layout command 71, 83, 84, 90,
222
for assigning access 268



Layout dialog box 71, 90-91
changing layout name in 84
deleting a layout in 83
input and output designations
in 82-83
for opening a procedure 222

Layout editor 13-14, 73, 84-90
active objects created in 166
Add Field icon/tool 132
adding included layout with
181
adding layout page in 115
assigning lists in 148-149
Create Active Object icon/tool
166
creating scripts in 221
elements of 85-90
Font menu 89
for opening a script 222
for reports 199
getting to 90-91
grouping objects in 100-101
label report layout in 212-213
Layout menu 87-88
layout palette 85, 8687
menus in 85, 87-90
Object menu 88-89
opening layout in 90-91
output layout specifications in
193
reverting to last version of 25
role of 84, 85
rulers in 96-98
scripts assigned in 161
Style menu 90

Layout Grid icon/tool 87, 99, 178

Layout menu 87-88
Add to Layout command 88,
116
Define Grid command 88, 103
Define Ruler Units command
88,97
Delete Page command 88, 116
Entry Order command 87,
119-120, 121, 122

Hide/Show Rulers command
88,97
" Menu Bar command 88, 188

Objects on Grid command 87,

178, 179
Turn Grid On/Off command
88, 104

layout menu bar, customizing
188—-189

layout objects
active 69-70, 129
adding to layout 98-100
aligning 101-104
changing appearance of
108-112
copying all 105-106
creating 166
deleting 107-108
deselecting 92, 93
display formats for 167
duplicating 104-105
fields as 130, 133
graphic 70
grouping 100-101
handling 92-114
hidden, viewing 107
layering 106-107
modifying 166
moving 94
naming 164
Object Definition dialog box
163-165
resizing 95-96
saving in Scrapbook 105-106
scripts for 167-168
selecting 92-94

layout palette 85, 86—87
alignment icons/tools
101-102
using 98-100

layout procedures
creating 221
role of 218

DESIGN

layouts
See also input layouts; Layout
editor; layout objects; output

layouts

adding fields to,a 116118
assigning access to 268
assigning lists to 148-149
basic vs. customized 67
buttons in 170-173
changing names of 84
check boxes in 173-174
creating 71-82, 90-91
customizing 92-114, 127-129
custom menus for 187-189
deleting &3
elements of 68-69
establishing 82-83
field display formats for
134-146
fields and 69
Multi-line 181
multi-page 114-116
naming 73
page dimensions for 91
placing fields in 132-133
placing objects in 163-168
printing 91-92
radio buttons in 174-175
role of 68
viewing 91

layout templates 80-82
for standard interface
126127

less than symbol (<), for
embedded fields or variables
213

Line button, for menu item
separators 247

Line icon/tool 98

Line Width submenu 88, 110

linked lists 277-278
creating 282-284

List editor 17-18, 280
getting to 280
role of 275
in User environment 285
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List editor window
deleting items from 282
entering items in 281-282
Listing editor 14, 15, 219,
223-228
hiding keywords in 27
Search menu with 227-228
syntax error checking in
226-227
using 223-228
Listing editor window, managing
228
List menu
New command 280
User Modifiable command
285-286
lists
adding items to 281-282
assigning 148-149
Boolean fields vs. 277
choice 148
Choices attribute 48
copying 282
creating 280, 282-284
deleting items from 282
designing 276-280
excluded 149
hierarchical, expanding and
collapsing 22-23
linked 277-278, 282-284
look-up 55-57
maximum number of 275
Required 148
role of 275,276
size considerations for 276,
277
sorting 284-285
specifying ranges in 284
user modifiable 285-286
Lists command 280
Load Groups command 266
load operations, access to 269,
270
logical fields. See Boolean field
type
Long Integer field type 45
look-ups. See searching

M
Macintosh editing operations
Edit menu for 25-26
for writing procedures 225
Macintosh files, for new database
4
Macintosh hardware
recommendations 292
Macintosh interface, standard
interface and 126
macros, scripts as 161
mail merge documents 213-214
Mandatory attribute 4647
Mandatory layout attribute 147
manual relations 53
See also related files
creating records with 58
data integrity with 59
search and sort operations with
59
Many file 51-52
selecting fields from 77-79
markers 196-197
marquee 93
master file
adding fields to layoutin 117
selecting fields from 74-75,
214
master file fields, in Field
Definition dialog box 133
master list, with nested list
277-278
master procedures, global
procedures as 218
maximum and minimum values
155
memory use 291
Menu Bar command 88, 188
Menu Bars dialog box 241,
266-267
menu bars
creating 241-242
custom menus for 187-189,
239
deleting 241
previewing 250

restricted access 258
runtime applications and 251
“splash screen” for 250, 251
Menu command 241
for assigning access 266-267
Menu editor 16
assigning access in 267
for custom menus 188
for enhancing menu system
245-246
role of 240
Menu editor window 16, 242
adding to Items list in 244
for adding menus 243
menu items 239
See also commands
adding separator lines to 247
assigning groups to 266-267
assigning procedures to 245
copying and moving 248-249
for custom menus 244
deleting 250
enabling or disabling 246-247
enhancing 245-248
keyboard equivalents for
247-248
Menu menu
Append Item command 244,
247
Append Menu command 243
Delete Item command 250
Delete Menu command 249
Insert Item command 244,
247
Insert Menu command 243
Show Custom menus
command 250
menus  18-19
See also specific menus
in custom interface, 128-129
See also custom menus
enhancing 245-248
maximum number of 239
Menus list, in Menu editor
window 242



menu title, maximum length of
243
Min; Max; Unit; Step area 165
setting values for 177
modifying an included layout 187
modifying an object 166
modifying data, User environment
for 10
modifying fields 48-49
Move to Back command 89, 102,
107
Move to Back icon/tool 102, 107
Move to Front command 89, 107
Move to Front icon/tool 107
moving a file image 37-38
moving layout objects 94
MultiFinder
compatibility with 292
memory use under 291
Multi-line check box 186
multi-line layout 181-182
displays 182-183
for included layout area 186,
187
multi-page layouts 114-116
adding a page to 114-115
creating 114
deleting pages from 116
moving in 115
multiple-file structures 33-34
multiple layout objects, selecting
93-94
multiple records, printing included
layouts with 183, 184
multi-user databases
password access system
255-271
sequence numbers in 156
multi-user environment, setting
289-290
multi-user systems, hardware
recommendations 293

N
Name box 164, 166
navigation icons, in standard
interface 126
negative number display 138
nested groups, removing 265
nested lists 277-278
nesting access groups 265
networks
password access system for
255-271
recommendations for 293
New button 4
for layout 71,72
for menu bar 242
New command (Items menu) 281
New command (List menu) 280
New Database command 24
New Field command 41-42
New File command 39
New Group command 263
New Layout dialog box 72,
116-117
selecting fields in 72, 73-79
New Step command 230, 231
New Test command 230, 231
New User command 261
Next button, in creating fields 43
Next Page button 82, 172
Next Page icon 115,116
Next Record button 82, 172
No Action button 172
non-enterable objects 169, 170
in report example 207
number display, as progress
indicator 28
number field formats 136-140
number field types 44-45
numbers, in filter arguments 151,
152

ol 0

number sign (#)
#D (current date) 156
#H (current time) 156
#N (sequence number) 156
in Alpha field format 141-142
in entry filter code 150,
152-153
in number display format 137

o
Object Coordinates dialog box
96, 98
Object Definition dialog box
163-165
adding scriptin 161
assigning keyboard shortcuts
in 168
for creating script 221
display format choices in 167
getting to 166
for opening a script 223
scale and indicator settings in
177
object markers, in rulers 97
Object menu 88-89
Align to Grid command 89,
104
Border command 89
Border submenu 111
Color submenu 89, 112
Duplicate command 89, 105
Fill submenu 88, 110
Format command 89, 166,
187
Group command 89, 101
Line submenu 110
Line Width command 88
Move to Back command 89,
102, 107
Move to Front command 89,
107
Position command 89, 95, 96
Ungroup command 89, 101
Objects on Grid command 87,
178, 179
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objects. See active objects; graphic
objects; layout objects;
variables
Object icons/tools, on layout
palette 86
On Background format 146
One file
Many file and 51-52
selecting fields from 75-76
“Only if modified” check box
163, 165, 167-168
output layout scripts and 197,
207
Open button
for creating a procedure 221
for existing database 5
for new database 34
for opening a procedure 222
Open command
for existing database 5
for new database 3
Open Database command, 24
Open data file dialog box 5-6
Open Included button 173, 182
opening a database 5, 24
with password 256
startup environment for 27
opening a procedure 222-223
opening a script 222-223
open windows, listing of 19-20
Option-click
for inserting fields 214
for opening a script 223
Option key
for adding control lines
203-204
for cloning a database 7
for Open data file dialog box 6
Output check box 83
output control lines
adding 203-204
for report example 206
Output devices, Picture fields and
45

output layouts
See also layouts
adding control lines to
203-204
establishing 82-83
example of 68, 194
for labels 211-213
output control lines 195-197
for printing included layouts
183-185
for reports 198-204, 206-207
role of 68, 193
for screen display 197-198
template type for 80, 81
Oval icon/tool 98

P
page border lines, setting up
91-92
Page buttons 172-173
Page Down key, for next page 82
Page Setup command 24
for reports 209
Page Setup dialog box 91-92
Page icons/tools, on layout palette
87
Page Up key, for previous page
82
parent file 34, 46
parentheses (), as dead characters
154
parent records 35, 46
Password Access editor 1617,
261
getting to 261
role of 255
for viewing usage 271
password access system 255-271
assigning access privileges
256, 266-270
assigning users to groups 264
creating access groups
263-264
environments and 259
group owners in 260
groups in 256

guests in 260
hierarchy scheme 257-258
importance of 255
initiating 260-261
maintenance of 270-271
nesting groups 265
opening a database 256
Quit command and 251
removing nested groups 265
removing users from groups
264
for renamed file 40
saving and loading groups 266
users in 256-257
passwords
assigning to users 261-263
changing 263
for opening database 5
Passwords command (Design
menu) 261, 271
Passwords menu 261
Edit Group command 263
Edit User command 263
Load Groups command 266
New Group command 263
New User command 261
Save Groups command 266
Paste command
for copying lists 282
for menu item 249
for moving objects 26
for saving objects 106
periods (..), in range 284
PICT/PICT?2 formats, in Picture
fields 45
Picture fields
display formats 144-146
placing fields in layout with
132
printing with variable frame
159-160
Picture field type 45
pixels, moving objects by 94



placeholders
in Alpha field formats 141
dead characters with 154-155
display characters for 153
in entry filter code 150,
152-153
in number field formats 137
pointers
crossbar/crosshair 99, 166,
185, 231
entry order 119
I-beam 225
points, for measurement scale 97
pop-up menus 175-176
Action 164
as active objects 129
for inserting fields 214
Type 164
Position command 89, 95, 96
preferences
for Listing editor 224
setting 26-28
Preferences command 24, 157
Preferences dialog box 5, 26-28,
157
default Procedure editor in
219
for hiding lists 228
users assigned in 259
previewing a custom menu 250
Previous Page button 82, 172
Previous Page icon 115,116
Previous Record button 82, 172
Print command 25
printer control markers, included
layouts and 185
Print Frame option, for included
layout area 186
printing
See also specific print
operations
included layout data 183-185
multi-page layouts and 114
output control lines for
195-197
output layouts for 198-204

Picture fields and 45
scripts and 196
setting specifications for 24
with variable frame 159-160,
183, 184, 211
printing data, User environment
for 10
printing labels 211-213
printing layout pages 91-92
printing reports 209
fixed-frame vs. variable-frame
211
with included layouts
210-211
with Picture fields 211
with text fields 211
Print Scripts command 25
“Print titles” check box 27
“Print variable frame” check box
131, 159, 165
Procedure command 220
for assigning access 267
Procedure dialog box 220
for assigning access 267
creating file or layout
procedures in 221
for opening a procedure 222
Procedure editor, choosing for
script 162
Procedure editors 14-16, 219
See also Flowchart editor;
Listing editor
reverting to last version of 25
specifying 27-28
Procedure editor window 220
for opening a procedure 222
for writing script 222
Procedure Name area 165
procedures 14, 217-235
assigning access to 267-268
check boxes and 173-174
creating 220-222
custom menus for 187
defined 217
disabling 222
example of 225

Dl B0

executing, User environment
for 10
external 176
hiding keywords in 27
layout name change and 84
naming 220
opening 222-223
radio buttons and 174
types of, 217-219. See also
specific types
updating, Menu editor and
245
writing, in Listing editor
225-227
Procedures list, in Menu editor
window 242
procedure titles, printing 27
Procedure type dialog box 220,
221
for choosing a script 162
progress/process indicator,
selecting 28
pull-down menus. See custom
menus
punctuation marks
as dead characters 154
in filter arguments 150

Q

Quick Report editor, indications
for 199

Quit command 25, 242
password system and 251
procedure assignment and 251

R

radio buttons 174-175
in custom interface 128-129
formatting a Boolean field as

143
as layout objects 175
lists vs. 277

radio pictures 174

RAM caching 292

range of characters, in filter
arguments 150
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ranges, in lists 284
Real field type 44
Record buttons 172
records
in columnar reports 199
defined 31
memory use by 291
in related files. See related files
sequence numbers 156
subrecords 35
Rectangle icon/tool 98
related fields 50
relating fields vs. 53
related files 49-64
automatic vs. manual relations
53
creating new layouts from
73-79
creating records in 57-58
creating relations 60-63
entering data in 54
included layouts from 180
maintaining integrity in 59-60
multiple-file structure for
33-34
One file and Many file 51-52
relating vs. related fields 53
removing 64
removing relations 64
searching in 58-59
in series 59
sorting in 58, 59
wildcard look-ups in 54-57
relating fields 53
wildcard character in 54-57
relational database, defined 34
Relation dialog box 62
Remember check box 28
Rename File command 39
for restricting access 269
Replace command 227-228
Replace Next command 228
Report menu, Labels command
213

reports
creating 208-209
designs for 198-204
example of 194, 204-207
making space for 197
output layouts for 193-197,
206-207
printing 210-211
sample scripts for 207
summary information in
200-203
summary-only 202-203
User environment for 10
Required check box 149
Required lists 278-279
for data entry 149
reserved key combinations 248
resizing a file image 38
resizing layout objects 95-96
Revert to Saved command 25
Rounded Rectangle icon/tool 98
Routines list, in Listing editor
224,226, 228
rulers 176-177
changing 96-98
defining parameters for 165
runtime applications
custom menus for 239-251
menu bars and 251
previewing menus for 250
Runtime environment 10-11
button variables and 172
custom menus for 187-188
default menu bar 251
guest access to 260
included layout area display
79
layout menu bar 188-189
moving to and from 11
output layout screen display
198
restricting access to 259, 262

S
Save button, for new database 4
Save data every...minutes 27
Save Editorname command 25
Save Groups command 266
save operations, access to 269
Scaled to Fit format 145
scale and indicator settings 177
scientific notation 139
Scrapbook, saving layout objects
in 105-106
screen display
number of commands and 244
output control lines 195-197
output layouts for 193-194,
197-198
scripts and 196
viewing layout pages on 91
Script button 161, 165, 167, 221
in Field Definition dialog box
131
for opening a script 223
scripts 128-129
adding 161-163
attaching to objects 167-168
buttons and 172
check boxes and 173-174
copied 106
creating 221-222
in custom interface 128-129
defined 161,217
disabling 222
layout name change and 84
opening 222-223
with output layout objects
196, 197
printing 25
radio buttons and 174
for report example. 207
role of 161,217-218
using 161-163
Script window 162
scrollable areas 175-176
as active objects 129
changing size of 228
in custom interface 128-129
in Password Access editor 261



scroll bars, adding to text objects
165
scrolling 21
search conditions
Boolean fields and 45
for related files 58-59
searching
Boolean fields and 45
in procedures 227-228
in related files 58-59
User environment for 10
wildcard character (@) for
54-57
Search menu 227-228
Find command 227
Find Next command 227
Replace command 227-228
Replace Next command 228
security. See password access
system
Select All command 26, 106
selection rectangle 93
semicolons (;)
in filter arguments 150
in number field 138
separator lines, for menu items
247
sequence numbers 156
Set as Start command 230, 233
Set as Start icon 233
Shift-Option-click, for inserting
fields 214
shortcuts
assigning 168
for buttons 165
for inserting fields in text area
214
for menu items 247-248
Show Clipboard command 26
Show Custom Menus command
250
Show Page box 21
single-file structures 32-33
single-page layout, as standard
126

single-user environment, setting
289-290
single-user systems, hardware
recommendations 292
size box, for windows 20
Sort command (Items menu) 285
sort fields, breaks in 200-201
sorting
in related files 58, 59
User environment for 10
sorting a list 284-285
sort levels, break levels and 201,
205-206
spaces, as dead characters 154
special characters, in filter
arguments 150
Special dialog box 289
splash screen 250, 251
standard data entry order 118,
119, 122
standard interface 125, 126-127
starting 4th DIMENSION 3-5
setting single- vs. multi-user
environment 289-290
startup environment, choosing 27
startup procedures, for restricted
access 258, 259, 260, 262
step formula 231-232
Step icon, in Flowchart editor 231
step objects, in flowchart 229,
232-233
structure, reduced view of 21-22
Structure editor 12-13, 36
Alpha field length setin 153
assigning lists in 148-149
file images in 37-38
indexed fields display 47
structure files 5, 6
duplicating 7
updating 290-291
Structure menu
New Field command 41-42
New File command 39
Rename File 39

DESIGN

Structure window 12
creating related files in 61-63
file images in 37-38, 39
for new database 4
protecting file in 269
removing relations in 64
Style menu 90
styles
changing for menus 246
creating 157-159
for number display format 139
specifying 109
Styles button 28
Styles dialog box 157, 159
subfields 46
Subfile fields 46
subfiles 34-35, 46
included layouts from 180
nesting 46
selecting fields from 77-79
submenus (Object menu)
Border 89,111
Color 89,112
Fill 88,110
Line Width 88, 110
subrecords 35
Unique attribute in 48
subroutines, global procedures as
218
subtotals, in reports 200-203
summary calculations
in reports 200-203
scripts for 207
summary reports 202-203
syntax errors
in formulas 235

in writing procedures 225,
226-227

T

telephone numbers 141-142
entry filters for 158

templates, selecting for layout 73

temporary files 291

test formula 231-232

Test icon, in Flowchart editor 231
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test objects
drawing flow lines from
232-233
in flowchart 229
text areas
changing appearance of
109-110
embedded field and variables
for 213-214
inserting fields in 214
modifying 113-114
role of 113
Text Area icon/tool 98
for embedded fields or
variables 213
on layout palette 86
Text fields
adding scroll bars to 157
printing with variable frame
159-160
text areas vs. 113
Text field type 44
“Text with scroll bar” check box
131, 157, 165
thermometer
defining parameters for 165
as progress indicator 28
thermometers 176177
tilde (~), in entry filter code, 150
time, script for 207
Time field formats 135-136
Time field type 45
totals
non-enterable objects for
169-170
in reports 200-203
scripts for calculating 161,
207
Truncated format 145
truncation, printing included
layouts with 183, 184
Turn Grid On/Off command 88,
104
Type pop-up menu 164, 166
choosing button from 171

U
underline (_), placeholder as 153

Undo command 26, 108

Ungroup command 89, 101

Unique attribute 48

updating structure and data files
290-291

Use menu, for changing
environments 11

User environment 10
button variables and 172
custom menus for 187, 188
grouped objects in 100
included layout area display
77,79
Label editor in 211
layout menu bar for 188-189
List editor in 285
moving to and from 11
output layout in 194
output layout screen display
197-198
for printing labels 213
restricting access in 258
standard interface for
126-127

User Modifiable command
285-286

user-modifiable lists 285

user names, changing 263

users
access to environments by 259
in access hierarchy 257-258,
259
adding 261-263
assigning to groups 264
removing from groups 264
viewing usage by 271

Users lists, in Password Access
editor 261

\'
values
default 156
excluded 279
non-sequential ranges of
279-280
required 278-279
scale and indicator settings
177
scripts for calculating 161
setting maximum and
minimum 155
variable-frame printing 159-160,
211
with included layouts 183,
184
variables
buttons and 172
embedded 213-214
enterable and non-enterable
objects with 169-170
role of 169
vertical bar (l)
in Alpha field format 142
for number display format 139
with style name 158-159
viewing layout pages 91

w

welcome screen 3, 5

wildcard character (@), for
writing procedures 226

wildcard look-ups, in related files
54-57

windows
editor 19-21
moving 20
reduced view of 21-22
scrolling through 21

word processing, external area for
176

z

zero, in number display format
137
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